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Introduction

A CT!is the best-selling contact manager software on the market today;
it’s used by more than 4 million professionals and 11,000 corporations
worldwide. For many of these users, ACT! represents their first foray into the
area of contact relationship management (CRM). Contact management soft-
ware is a little more complex to understand than other types of software.
With a word processor, each document that you create is totally separate; if
you make a mistake, you need only to delete your current document and
start fresh. Contact management, however, builds its way into a final product;
if you don’t give a bit of thought as to what goal you wish to achieve, you
could end up with a muddled mess.

[ am a fanACTic, and I'm not ashamed to admit it. | use ACT! at work. I use
ACT! on the road. I use ACT! at home. I've even inspired my friends to use
ACT!. I'm excited about the product and know that by the time you discover
how to unleash the power of ACT!, you’ll be excited, too.

So what am [ so excited about? I've seen firsthand how ACT! can save you
time and help make you more efficient in the bargain. To me, accomplishing
more in less time is an exciting thought — it allows more time for the fun
things in life. Best of all, ACT! is a program that’s very easy to get up and run-
ning in a very short time. You’ll be amazed not only at how quickly you can
set up a database but also at how easily you can put that database to work.

Maybe by the time you finish this book, you, too, will become a fanACTic!

About This Book

ACT! 2007 For Dummies is a reference book. As such, each chapter can be
read independently and in the order you want. Each chapter focuses on a
specific topic so you can dive right in, heading straight for the chapter that
interests you most. Having said that, however, | must say that I've tried to put
the chapters into a logical sequence so that those of you who are new to ACT!
can just follow the bouncing ball from chapter to chapter. More experienced
users can use the Table of Contents and the index to simply navigate from
topic to topic as needed.

Essentially, this book is a nuts-and-bolts how-to guide for accomplishing vari-
ous tasks. In addition, drawing on many of my own experiences as a full-time
ACT! consultant and trainer, I include specific situations that should give you
a feel for the full power of ACT!.
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Conventions Used in This Book

Like in most Windows-based software programs, you often have several dif-
ferent ways to accomplish a task in ACT!.

For the most part, I show you ways to perform a function by using the ACT!
menus. When an instruction reads Choose File>Open, you must access the
File menu (located at the top of the ACT! screen) by clicking it with the left
mouse button and then choosing the Open option from the subsequent menu
that appears. In most cases, you can access these commands from anywhere
within ACT!, but I generally advise new ACT! users to always start a task from
the Contact Detail view, which is the first window you see when ACT! opens.
If you must be in a particular area to complete a task otherwise, I tell you
where.

[ also present you with keyboard shortcuts here and there. Generally, ACT!
shortcuts are triggered by simultaneously pressing the Ctrl key and another
key on the keyboard. For instance, the shortcut for recording a history is
Ctrl+H.

When you need to access one of ACT!’s hidden menus, click an appropriate
area of the screen with the right mouse button and then choose from the con-
textual menu that appears. In these instances, I simply say right-click when
you need to right-click.

What Vou Should Read

Of course, I hope that you're going to sit down and read this entire book from
cover to cover. But then again, this book isn’t The Great American Novel.
And, come to think of it, the whole reason why you bought this book in the
first place is because you want to get your ACT! together (no groans, please!)
as quickly as possible because you’re probably finding yourself with too
much to do and too little time in which to do it.

For the time being, I'm going to let you get away with reading just the parts
that interest you most. I'll let you read the last chapter first and the first
chapter last if you like because this book is designed to allow you to read
each chapter independently. However, when you find yourself floating in a
swimming pool, soaking up the sun, and wondering what to do with all your
spare time, you might want to go back and read some of those chapters you
skipped. You just might discover something!
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What Vou Don’t Have to Read

This book is intended for both new and existing ACT! users. Most of the
instructions apply to both groups of readers. Once in a while, I include some
information that might be of special interest to more advanced readers.
Newbies, feel free to skip these sections! Also, any information tagged with a
Technical Stuff icon is there for the truly technically inclined. Everyone else
can just skip this info.

Foolish Assumptions

One of my least favorite words in the English language is the word assume,
but I've got to admit that I've made a few foolish — albeit necessary —
assumptions when writing this book. First of all, I assume that you own a
Windows-based computer and that ACT! is installed on it. Second, [ assume
that you have a basic knowledge of how to use your computer, keyboard, and
mouse, and that ACT! isn’t the very first application that you're trying to
master.

[ also assume that you have a genuine desire to organize your life and/or
business and have determined that ACT! is the way to go.

Finally (and I feel quite comfortable with this assumption), [ assume that
you’ll grow to love ACT! as much as I do.

How This Book Is Organized

[ organized this book into six parts. Each part contains several chapters cov-
ering related topics. The following is a brief description of each part, with
chapter references directing you where to go for particular information:

Part I: The Opening ACT!

In Part I, you get an introduction to the concept of a database and why ACT!
has become such a popular choice of database users (Chapter 1). In this part,
you read about what to expect the first time you fire up ACT! (Chapter 2) and
how to set the main preferences in ACT! (Chapter 3).
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Part II: Putting the ACT!
Database to Work

Part Il focuses on putting your contacts into ACT! (Chapter 4) and, more
importantly, how to find them again (Chapters 6). I show you how to view all
the details about one contact, how to pull up a list of all your contacts, and
even how to create an easy list report.

After you master organizing your contact information, Part Il helps you orga-
nize your day. ACT! makes it easy to take notes (Chapter 7) so that you start
relying on ACT! more and your memory less. You find out how to schedule
appointments, calls, and to-do’s — and other important events in your life.
And, you discover how to view those activities in the daily, weekly, and monthly
calendars (Chapter 8). Your life can become complicated, but have no fear
because ACT! does its best to help you navigate through the maze. The
History, Documents, and Secondary Contacts tabs allow you to accumulate
lots of information about each and every one of your contacts (Chapter 5).

Part 111: Sharing Your Information
with Others

Corporate America lives for reports, and ACT! is up to the challenge. Whether
you want to print labels or telephone directories on commercially printed
forms or prefer to utilize the ACT! built-in reports, Part Ill shows you how. I
even tell you about building your own reports from scratch (Chapter 9).

One of the best features of ACT! is the ability to communicate easily with the
outside world. Part Il shows you how to work with templates to automate
routine documents as well as how to send out mass mail merges — whether
by snail mail, fax, or e-mail (Chapter 10). You also discover the advantages of
using ACT! for your e-mail clients (Chapter 11).

Part JU: Advanced ACTling

We're all different and often like to do things in our own unique way. ACT!
understands that concept, and Part IV helps you to customize ACT! to your
heart’s content. At first glance, ACT! might seem like just an over-the-counter
piece of software, but by adding fields (Chapter 12) and placing them on
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customized layouts (Chapter 13), you can make it perform as well as an
expensive piece of proprietary software.

Every database needs an Administrator. If you're elected to the job, you need
to know how to perform administrative tasks, such as performing routine
maintenance, backing up your database, and checking for duplicate data
entry (Chapter 14). You'll read about ACTdiag, the higher-level maintenance
tool, and how to add multiple users to your database (Chapter 15). If you
have remote users who need to access all or parts of your database, you
need to know how to synchronize your database (Chapter 16).

Part U: Commonly Overlooked
ACT! Features

Part V focuses on four of the most frequently overlooked ACT! features:

v Microsoft integration: Synchronize your ACT! and Outlook address
books and calendars; attach a Web site in Internet Explorer directly to
an ACT! contact; and explore the various ways that you can use ACT!
and Excel together (Chapter 17).

v~ Sales opportunities: Track your prospective sales, prioritize them,
and analyze what you did right — or wrong — in making the sale
(Chapter 18).

v Groups: Group your contacts to add a new dimension to your database
(Chapter 19).

v Companies: The Company feature enables you to view and edit contacts
that all “belong” to the same company (Chapter 20).

In addition, I show you how to install and customize ACT! Premium for Web,
the online version of ACT! (Chapter 21).

Part Ul: The Part of Tens

With apologies to David Letterman, Part VI gives you two of my favorite ACT!
lists. First, I discuss a few of the features that are only found in ACT! Premium
for Workgroups (Chapter 22). Finally, [ give you ten of my favorite ways to
help you utilize ACT! to its fullest extent (Chapter 23).

5
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Igons Used in This Book

A Tip icon indicates a special timesaving tip or a related thought that might
help you use ACT! to its full advantage. Try it; you might like it!

A Warning icon alerts you to the danger of proceeding without caution. Do
not attempt to try doing anything that you are warned not to do!

Remember icons alert you to important pieces of information that you don’t
want to forget.

A Technical Stuff icon indicates tidbits of advanced knowledge that might be
of interest to IT specialists but might just bore the heck out of the average
reader. Skip these at will.

Where to Go from Here

For those of you who are ACT! old-timers, you might want to at least skim the
entire contents of this book before hunkering down to read the sections that
seem the most relevant to you. My experience is that the average ACT! user
probably uses only a portion of the program and might not even be aware of
some of the really cool features of ACT!. You might be surprised to discover
all that ACT! has to offer!

For the ACT! newbie, | recommend heading straight for Part I, where you can
acquaint yourself with ACT! before moving on to other parts of the book and
the ACT! program.
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In this part . . .

know that you're excited about all the possibilities

that ACT! has to offer and want to dive into the pro-
gram as soon as possible. Here’s where you find an
overview of some of the cool features that you find in
ACT!. You also become familiar with the many faces of
ACT!; after all, you wouldn’t want to get lost along the
way. But first, you have to do a bit of homework and whip
ACT! into shape by fiddling with a few preference settings
to ensure that ACT! produces the type of results that
you’re looking for.




Chapter 1

An Qverview of ACT!

In This Chapter
What is ACT!?
Who uses ACT!?
Basic ACT! concepts

A few basic ground rules
The two ACT! flavors

5) what is ACT!, anyway? I find that one of the hardest things that I have
to do with ACT! is to explain exactly what it is. I like to initially explain
ACT! by using very politically correct terminology. For example, ACT! 2007

v [s a contact management software package

v Provides users and organizations with powerful tools to manage their
business relationships

v Can be customized based on your company’s requirements

v Is the world’s leading contact management software

Feel free to use these points to impress your friends. You might want to men-
tion some of the wonderful features of ACT!, which I do in the first section of
this chapter. I also describe the typical ACT! user and give you a brief primer
on some pertinent ACT! terminology. I give you a few ground rules that I've
established over the years after watching new users wrestle with certain
aspects of using ACT!. Finally, I talk about the two versions of ACT! that are
available to you.
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What Does ACT! Do?

Because [ want you to enjoy the benefits of using ACT!, ['ve put together a
little shopping list of features so that you can see all that ACT! can do for you,
too. In parentheses after each item, I include a chapter reference where you
can find more information about a particular feature (if you're so inclined).

ACT! is a multifaceted personal management tool that

v~ Stores complete contact information, including name, company,
phone numbers, mailing addresses, and e-mail addresses. (Chapter 4)

v Comes with over 50 predefined fields for each contact that you add to
your database. If you want to add additional fields to meet your specific
needs, go right ahead. (Chapter 12)

v Records an unlimited number of dated notes for each of your contacts
so that you can easily keep track of important conversations and activ-
ities. This feature is particularly useful for those of us who (unlike our
friend, the elephant) do forget things on occasion. (Chapter 7)

1 Keeps more than a boring, old calendar. Your scheduled activities are
cross-referenced with the appropriate contact so that you have a full
record of all interactions that you've had — or will have — with that
contact. In addition, you can set an alarm to remind you of the impor-
tant stuff as well as roll over less-important things until the next day.
(Chapter 8)

v Prints out anything from simple phone lists or address books to
detailed reports on activities, notes, leads, and sales opportunities.
You can print reports of your reports if you feel so inclined. (Chapter 9)

v Creates mailing labels and envelopes. Or, if you prefer, perform broad-
cast faxes and e-mails with ACT!. (Chapters 9 and 10)

1 Manages your sales pipeline with built-in forecasting tools. You can
easily print a few sales reports or create a graph showing your open,
won, or lost sales. (Chapter 18)

v Synchronizes data with remote users. If you have other ACT! users in
remote locations, you can send database changes to them and vice
versa. (Chapter 16)

1~ Lets you design and activate a series of activities to automate your
tasks, thus assuring that none of your contacts “fall through the
cracks.” (Chapter 8)



Chapter 1: An Overview of ACT!

The Typical ACT! User

So just who is the typical ACT! user? Well, with more than 4 million registered
ACT! users and 11,000 businesses currently using ACT!, you're safe to assume
that nearly every industry is represented among its user base. Although ACT!
started primarily as a tool for salespeople wanting to follow up on their
prospects and customers, ACT! has evolved into a tool used by any individual
or business trying to organize the chaos of daily life.

[ think it’s only fair to warn you about one of the possible side effects that
you might develop if you use ACT!. If you're anything like me, you’ll become
addicted to ACT! and eventually use it to manage all facets of your busy exis-
tence. You might just become a fanACTic. (Quite simply, a fanACTic is an ACT!
user who has become addicted to using ACT!.)

So just who is using ACT!? Everyone.
v A CEO uses ACT! because he wants to know what his salespeople are

doing and how his customers are being treated.

v An administrative assistant uses ACT! to automate routine tasks and to
keep a schedule of various tasks and activities.

v A salesperson uses ACT! to make sure that she’s following up on all her
prospects.

v A disorganized person uses ACT! to help him become more organized.

v A smart person uses ACT! because she knows that she’ll have more time
to play by working more efficiently.

v Alazy person uses ACT! because he knows it’s more fun to play than
to work.

So what kinds of businesses use ACT!? All kinds.

v Large businesses that want to improve communication among employees

v Small businesses that have to rely on a small staff to complete a multi-
tude of tasks

v Businesses of all sizes looking for software that can automate their busi-
ness and make them more productive in less time

v Businesses looking to grow by marketing to their prospects

v Businesses looking to retain their current customers by providing an
excellent level of customer service and developing lasting relationships
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A Few Concepts to Get Vou Started

Nobody likes technical jargon, but in the course of showing you how to use
ACT!, I might end up lapsing into Geek Speak and use a handful of somewhat
technical terms; I just can’t avoid it. Becoming familiar with them now is less
painful in the long run.

First things first. ACT! is a database program. A database is a collection of
information organized in such a way that the user of the database can quickly
find desired pieces of information. Think of a database as an electronic filing
system. Although most ACT! users create a database of contacts, some users
develop ACT! databases to collect information about things other than con-
tacts. For example, you might create an ACT! database to catalog all the CDs
and DVDs in your collection.

Traditional databases are organized by fields, records, and files:

v~ Field: A field is a single piece of information. In databases, fields are the
smallest units of information. A tax form, for example, contains a
number of fields: one for your name, one for your Social Security
number, one for your income, and so on. In ACT!, you start with 50 sepa-
rate fields for each individual contact. You find out how to add informa-
tion into these fields in Chapter 4. And, in Chapter 12, I show you how to
change the attributes of existing fields and how to add new ones to your
database if you're the database administrator.

1 Record: A record is one complete set of fields. In ACT!, all the informa-
tion that you collect that pertains to one individual contact is a contact
record.

v~ File: A file is the entire collection of data or information. Each database
that you create in ACT! is given a unique filename. You can create more
than one file or database in ACT! — head to Chapter 3 to find out how.

The Basic ACT! Ground Rules

Sometimes you just need to learn things the hard way. After all, experience is
the best teacher. Luckily for you, however, I've compiled a list of rules based
on a few mistakes that I see other ACT! users commit. You're not going to find
these rules written down anywhere else, and they might not even make a
whole lot of sense to you at the moment. However, as you become more and
more familiar with ACT!, these rules will make all the sense in the world. You
might even want to refer to them from time to time.
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Karen’s Four Rules of Always:

v Always log in to ACT! as yourself.

v Always strive for standardization in your database by entering your data
in a consistent manner.

v Always input as much information into your database as possible.

v Always perform routine maintenance of your database at least once a
week and create a backup after any session that involves new data input!

The Two Versions of ACT! 2007

ACT! 2007 comes in two separate editions. Everything I cover in this book
applies to both versions of ACT!, which are

v ACT! 2007
v ACT! 2007 Premium for Workgroups

Every feature found in ACT! 2007 is also found in ACT! 2007 Premium for
Workgroups as well. However, from time to time, [ point out a feature that is
found only in the workgroup version. You might also look at Chapter 22 for a
full list of some of the cooler ACT! 2007 Premium for Workgroups features.

All users sharing the same database must be using the same edition of ACT!;
this means that one user can’t be in ACT! 2007 while another is in ACT! 2007
Premium for Workgroups. It also means that users of an older version such as
ACT! 6, or even ACT! 2005 or 2006, can’t share a database with users of an
ACT! 2007 database.

So what are you waiting for? Boot up your computer, grab the book, and get
going. After all, it’s time to get your ACT! together (pun intended).
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Chapter 2
The Various Faces of ACT!

In This Chapter

Starting the correct database

Logging in correctly

Knowing about the My Record
Maneuvering in ACT!

Getting help with ACT!

A fter getting the hang of maneuvering in ACT!, you'll find that it’s an
amazingly easy program to master. The key is to become familiar with
the lay of the land before you start building your contact database. By doing
s0, you avoid playing hide-and-seek later. To that end, I show you how to log
into and open an ACT! database. Although initially getting around in ACT! is
pretty easy, you might become lost in the maze of views and tabs that ACT! is
divided into. I help you navigate through that maze by taking you on a tour of
ACT! so that you can become familiar with the various ACT! screens. Finally,
you discover the places that you can turn to if you need additional help.

Locating the Correct Database

When you open ACT!, by default, ACT! opens up the database that was last
open on your computer. Easy enough, huh? If, however, you stumble into the
incorrect database by mistake, you need to know how to find the correct one.
If you're lucky enough to have inherited a database that someone else devel-
oped (someone who maybe even placed that database on your computer for
you), be sure to ask where that database is located — before that person
walks out of your life.
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|
Figure 2-1:
Opening an
ACT!
database.
|

The default database location is the place on your computer that ACT! uses to
store any new databases that you create and look in to open any existing
database. If your database isn’t in the default location, you have to move
your database to the correct location, change the default location (as I dis-
cuss in Chapter 3), or browse to the location of your database.

The first screen that you see when opening an ACT! database each and every
time is the Contact Detail window. If you click around and end up in any of
the other ACT! screens by accident, don’t panic. One of the nice things about
ACT! is that you can execute most commands from any ACT! screen (unless

I tell you otherwise). And [ promise that pretty soon, the various screens
become so familiar to you that you’ll be able to navigate through ACT! with
the best of them.

To open an existing database, make sure that ACT! is open and then follow
these steps:

1. Choose File=>Open Database from the ACT! Contact Detail window.
The Open dialog box appears (as shown in Figure 2-1).

Open [2]%]
Lockin: | [ Databases ~ Q e 0 gl ¥ 4

5 [CIACT For_Dummies-database fles:
@ actodemo.pad

My Recert @ACF_For_Dummies.pad
Documents

G

Diesktop

My Documents

o
My Computer
]
R -
Places
Hezetee ACT! Database ".PAD) v

2. Click the drop-down arrow to the right of the Look In box.
3. Double-click the folder that contains your database to expand.
4. Click the name of your database and then click Open.
If you prefer, double-click the name of the database that you want to open.
When you open an ACT! database, you actually use a shortcut; these short-

cuts all end with the .pad file extension. Every ACT! database actually stores
three different groups of data:
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v Main database: The main database consists of all your contacts’ infor-
mation, activities, notes, histories, and so on. The database files are
stored on your local machine by default. You can move the database and
all associated files to another location or even over to a network drive if
you so desire.

1 Database supplemental files: These files and folders are automatically
created when you create a new database and include layouts, templates,
e-mail messages, and any attachments associated with a contact record.
You can’t change the location of these files in the database; they are
automatically stored as part of your database.

1 Personal supplemental files: These files, which are saved to your local
computer, include files such as word processing documents not associ-
ated with a contact, newly created layouts, and templates. E-mail mes-
sages and attachments associated with contacts are also saved as
personal supplemental files.

The ACT! Login Screen

|
Figure 2-2:
Logging on
to ACT!.
|

If more than one person shares your ACT! database, ACT! presents you with a
login screen each time you attempt to open your database. If you are the only
person using a database, the login screen won’t appear. Essentially, the login
screen (as shown in Figure 2-2) asks you for your user name and your pass-
word. Your user name and password are not case sensitive (that is, you can
enter your name by typing either lowercase or UPPERCASE letters). You also
need to make sure that you correctly enter your user name and password
information. For example, if your user name includes your middle initial with
a period, you must type that middle initial — including the period — to gain
access to your database.

Log on to ACT_For_Dummies

Enter your user name for this database:

Gary Kahn

Enter your password for this database:

[] Remember password

Generally, the Administrator of your database determines your password. The
database Administrator is the person responsible for making major changes to
the database and for performing routine database maintenance. (For more infor-
mation, see Chapter 14.) Although several users may all have access to an ACT!
database, ACT! doesn’t require that each user have a password. If the database
Administrator didn’t assign you a password, just leave the password area blank.

17
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If you are assigned a password, notice that dots appear while you type it in.
That’s normal. Just like when you type your ATM card PIN, your ACT! data-
base password is hidden while you type it to prevent any lurking spies from
learning your password. You're able to change your own password; see
Chapter 3 to find out how.

Figure 2-2 shows that ACT! gives you the option of saving your password.
Although this option helps you to log on to your database a little faster in the
future, think about making this decision. First of all, what good is a password
if it always magically appears anytime that you attempt to access your data-
base? Secondly, by having ACT! remember your password, you may eventu-
ally forget it yourself!

The Importance of Being My Record

<MBER

The first contact that you see when opening an ACT! database is your own —
that’s your My Record. My Record is nothing more than a contact record that
is associated with a user of the database. Your My Record stores all your own
information, which automatically appears in some of the preset templates
that come with ACT!. For example, a fax cover sheet includes your telephone
and fax numbers; a report has your name at the top; and a letter has your
name at the bottom.

If someone else’s information appears as the first contact record that you see
when you open your database, explore these three possibilities:

+~ Did you log in as yourself? If not, do so. Then when you open ACT!
again — logged in as yourself — your My Record appears.

v Did you inadvertently change your own contact information? If that’s
the case, change it back.

v If you’re 100 percent certain that you logged in as yourself and haven’t
changed your contact information, your database is likely corrupted.
I'm not trying to scare you, but I recommend that you turn to Chapter 14,
where | show you how to perform a little CPR on your database.

Taking the time to enter all your own contact information is very important. If
you don’t, you might find that you're missing key information when you start
to work with templates and reports. For example, if you never enter your own
fax number, your fax number doesn’t appear on the Fax Cover Sheet tem-
plate, which means you have to fill it in every time that you send a fax. Save
yourself the trouble and fill in your My Record right off the bat.
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Your My Record also allows you to use a few other important ACT! features:

v Permission to perform various functions is based on the security level of
your My Record.

v Contacts, notes, histories, activities, and opportunities marked as
Private can be viewed only by the Record Manager who created them.

v Every time you enter a new contact, your name appears as the creator of
that contact.

1 When you delete a contact, a history of that deletion appears in the
History area of your My Record.

v Every time that you add a note to a contact record, your name appears
as the Record Manager of that note.

1 When you schedule an activity, your name automatically attaches to that
activity.

Finding Your Way around in ACT!

The purpose of this book is to serve as a reference for both new and existing
ACT! users. I certainly don’t want to lose anyone along the way. New ACT! users
might be somewhat intimidated when they encounter ACT! for the first time.
Be assured that this experience is akin to the first time you drive a new car at
night in the rain — momentary panic sets in. After you've driven the car for a
week or so, the location of the light and windshield wiper controls becomes
second nature. | guarantee you’ll have the same experience with ACT!.

Navigating through ACT! is fairly easy. However, to make the navigating even
easier, I highlight throughout this section a number of pitfalls that you want
to avoid.

The title bar

The title bar at the top of the screen provides you with two pieces of key
information: the software name and the database name.

Don’t overlook the importance of this wealth of information! If your title bar
reads FreeCell, you've stumbled into the wrong piece of software. If the
database name indicates ACT9demo, chances are pretty good that you're in
the wrong database and could be adding hundreds of new contacts to the
wrong place. And if the user name is not yours, you might not be getting the
appropriate credit for all your hours of hard work. You can see the title bar,
along with other key areas of ACT!, in Figure 2-3.

19
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Layout button

The record counter

ACT! supplies you with a record counter in the top-left corner of the Contact
Detail window (as shown in Figure 2-3). The first number indicates the
number of your record as it relates alphabetically to the other members of
your current lookup. A lookup refers to the contacts in your database that
you're currently working with. (You can find out everything that you will ever
want to know about a lookup in Chapter 6.) This number changes when you
add or remove contacts. The second number supplies you with the total
number of contacts in either your entire database or your current lookup.

To the left and right of the record counter is a set of left- and right-pointing
triangles. You can click these triangles to navigate through the contact records.
For instance, to go to the previous record, you simply click the left-pointing
triangle.
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I recommend getting into the habit of checking the total number of contacts
in your database each time that you open ACT!. If the total number of con-
tacts changes radically from one day to the next, you just might be in the
wrong database. Worse yet, a dramatic change in the number of contacts
might indicate corruption in your database.

The layout

One of the biggest sources of confusion to the new ACT! user is the use of lay-
outs. The layout refers to the order in which fields appear on the ACT!
screens as well as the colors, fonts, and graphics that you see. You can spec-
ify the colors, fonts, and graphics in the layout as well as the position and
order of fields. If the database Administrator creates new fields for the data-
base, he needs to add them to a layout. In Chapter 13, I explain how you can
create your own customized layouts in one of the following ways:

v Modify the contact, company, and group layouts or create your own
layouts to suit your needs.

There’s no right or wrong layout — only the layout that you prefer. For
example, maybe the Sales Department needs to see one set of fields, but
the Customer Service Department needs to see an entirely different
group of fields and wants them to appear in a specific order.

+* Remove fields that you don’t use or move fields to other tabs.
v Add fields to your layout.

v Change the order of the tabs.

1 Add your own tabs to the bottom of a layout.

Renaming and reordering the tabs to your liking helps you organize your
fields. For example, you might want to keep all the personal information
about a customer on one tab and the products that he’s interested in on
another tab.

You can find the name of the layout by clicking the Layout button in the
lower-left corner of the ACT! screen, as shown in Figure 2-3. If you inadver-
tently switch layouts, you might not be able to see all the information in your
database, or you might see your information arranged in a different order.

At this point, panic often sets in. Don’t worry — your data is most probably
alive and well and viewable with the help of the correct layout. To switch lay-
outs, click the Layout button to access a list of all layouts; from that list,
choose a different layout.

21
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Make sure that you take the time to acquaint yourself with the name of the
layout that you’re using. You might find yourself the victim of one of those
random, drive-by clickings you've been hearing so much about and end up in
the wrong layout. If you know the name of your preferred layout, you can
easily find it.

The menu bar

Like most software programs, ACT! comes equipped with a menu bar that
appears at the top of every ACT! screen. These menus include all the options
available for the current view. You can customize all menus to fit your needs;
check out Chapter 3 for the details.

A quick way to familiarize yourself with ACT! is to click each and every one of
the menu items. You might see something that piques your interest. You
might click the Schedule menu and notice the Activity Series option.
Hopefully, curiosity overcomes you, and you have an overwhelming desire to
find out more about that feature. Or you might notice the Sort choice listed in
the Edit menu and think hmmm, maybe [ can sort my database in a different
order than alphabetically by company.

Many times, you'll find that you can accomplish a task in a variety of ways. If
you'’re a keyboard shortcut aficionado, you'll find the most frequently used
shortcuts in the front cover of this book. You can also glean these shortcuts
from the menus. In Figure 2-4, you see that the shortcut appears to the right
of each menu item. In addition, notice that an icon appears to the left of some
of the menu items; this means that you’ll find that corresponding icon some-
where on the icon bar if you prefer to click instead of using the menus or key-
board shortcuts.

Contacts | Groups Schedule Write Re
@ New Contact Ins
& Duplicate Contact...

=} Insert Note... F9
& Record History... Ctrl+H
[# Attach File... Ctrl+l
& Display Map...
New Secondary Contact Ctrl+Ins
Opportunities >
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The toolbar

ACT! also features a toolbar at the top of each window. The toolbar includes the
most commonly used tasks of the current view. Toolbars work much the same
way as the menu bars. You can customize each toolbar to include the tasks
that you use most frequently; see how in Chapter 3. And, like the menu bars,
toolbars vary depending on the view that you’re in. For example, the toolbars
that you see in the calendar views include a Show Filter/Hide Filter icon to
change the view settings on your calendar, and the toolbar that you see in
the Group Detail window includes icons for creating groups and subgroups.

The Back and Forward bar

Lurking just below the toolbar is the Back and Forward bar, which provides
you with a road map of sorts by letting you know the exact area of ACT!
you’re working in. And, like your Internet browser, the Back and Forward bar
has handy-dandy left- and right-pointing arrows that allow you to return to
the previous window you were viewing.

The Contact Detail window

When you first open ACT!, you land in the Contact Detail window, which
allows you to see information about one specific contact. You can use the
Contact Detail window to enter, modify, and view information about your con-
tacts. Each contact record displays as a single page that is divided into a top
and bottom half:

v The top half of the screen contains generic fields such as name, busi-
ness address, and phone number that are probably used by just about
all ACT! users everywhere. Many of these fields are used extensively in
the templates (that is, reports, letters, fax cover sheets, and labels) that
ACT! has already set up for you.

v~ The tabs at the bottom provide additional fields for each of your con-
tacts. These are generally the fields that you don’t use as much, such as
home address and spouse’s name.

v You can — and should — customize the bottom half of the screen to
better serve the needs of your business. You can click through the page
tabs in the middle of the screen to get an idea of some of the fields sug-
gested by ACT!. You can customize the top half of the screen as well if
you so desire. [ show you how to add new fields into your database in
Chapter 12 and how to modify those tabs in Chapter 13.
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The Divider bar

One of the fast food chains used to have a jingle about “having it your way” a
number of years back, and you might want to hum a few bars of that tune
each time you open ACT!. A case in point is the Divider bar that separates the
top half of the Contact Detail window containing the fields from the bottom
half containing the tabs. Got a lot of fields in the top half of your screen? Grab
the Divider bar and drag it down. Want to have more room to view some of
the tabs along the bottom? Grab that bar and drag it up a bit.

The Navigation bar

The ACT! Navigation — or Nav — bar is the column of icons located along the
left side of the program. The Nav bar allows you to move quickly between the
various areas in ACT!. For example, to view all the information about one par-
ticular contact, click the Contacts icon; to see a list of all your groups, click
the Groups icon.

The ACT! tabs

Because ACT! comes with approximately 50 predefined fields — and because
your database Administrator might add another 50 or so customized fields —
placing those fields where you can see them clearly is important. Plunking
100 fields on one half of your screen gives you a jumbled mess. | suppose that
you could lay out those fields by using a smaller font, but the result (although
neat) is impossible to read!

ACT! solves this dilemma in a rather unique fashion. The top half of the
Contact Detail window displays the most basic fields that are fairly typical to
all contacts. In this portion of the screen, the fields include places for the
name, address, and phone numbers as well as a few miscellaneous fields. The
bottom half of the ACT! screen displays additional information about your
contact that’s divided into categories, which you access by clicking tabs
located across the middle of the Contact Detail window.

The first seven tabs (refer to Figure 2-3) — Notes, History, Activities,
Opportunities, Groups/Companies, Secondary Contacts, and Documents —
are called system tabs. The system tabs are actually tables; they don’t hold
single fields with a single piece of information in each one. Rather, you can
add an unlimited number of like items to the same tab. For example, you can
add multiple notes about your contact via the Notes tab, or you might have
numerous sales opportunities that involve your current contact displayed on
the Opportunities tab.
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Because the system tabs contain tables rather than fields, you can’t customize
them in the same way as the other tabs. However, you can remove system
tabs or change their order. Chapter 13 shows you how to fix the order.

Depending on the layout you’re using, you probably see several additional
tabs after the system tabs. These tabs generally display less frequently used
information about your contact. You generally find ten user fields on one of
those tabs; you can find out how to customize the user fields in Chapter 12
and the layouts in Chapter 13.

Do not proceed to add new information in the User Fields without first renam-
ing them. Many new ACT! users make this mistake and end up with an unruly
assortment of information in each of these fields. Worse yet, other users of
your database might misinterpret this information — or start entering their
own data — further complicating the whole mess.

All the tabs are dependent on the layout that you're currently using. If you
switch layouts, your tabs change as well. Some of the ACT! add-on products
place new tabs to your ACT! screen. For example, the ACT! QuickBooks link
draws information from QuickBooks and plops it into a brand new tab called
QuickBooks.

Getting Help When You Need It

In addition to the information that I provide in this book, ACT! 2007 comes
with a very good — and quite extensive — online Help system that supplies
step-by-step instructions for just about any ACT! feature that you might want
to explore.

You can access the ACT! online Help system in one of two ways when ACT!
is open:

v~ Press the F1 key on your keyboard.
1 Choose Help from any ACT! menu bar.

When you access the ACT! Help menu, you're treated to several options. All
these Help options provide a wealth of information, and you shouldn’t be
afraid to use them.

v~ Help Topics: This option supplies you with lots of information based on
the window that’s open. Use this option when you find yourself scratch-
ing your head about something, and you’ll probably be rewarded with
just the answer you’re looking for.
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v How to Use Help: This area of Help provides you with the most informa-
tion. In fact, you can find so much good information that this section is
further subdivided into three tabbed areas:

¢ Contents: Think of the Contents tab as the Table of Contents in a
book. The Contents tab presents you with the major topics cov-
ered in ACT!. Click the plus sign next to each topic to find a more
detailed listing of the subject.

¢ Index: As its name implies, the Index tab is just like the index that
you find at the back of this book. It provides you with an alphabeti-
cal listing of every feature found in ACT!. You can either scroll
through the list of features or type in the first few letters of the fea-
ture that you're looking for.

e Search: The Search tab provides you with the most in-depth infor-
mation about the various ACT! features. This feature is particularly
helpful if you aren’t sure of the exact name of the feature that you're
trying to find. For example, say you're looking for instructions on
how to force a field to display only capital letters. A search of the
Index tab doesn’t help you (the feature is actually called Initial
Capitalization), but you can find the information by typing capital
in the Search tab. Figure 2-5 gives you an idea of all the help you
can find in the ACT! Help menu.

=

elp

‘-‘ Help Topics
#3 How To Use Help
EEE— Feature Tours 3
. Online Manuals 3
Flgl!re 2-5: Getting Started Wizard...
Usingthe |& acti update...
ACT! H3|p Service and Support 3
menus. Register ACT!...
— About ACT!

1 Feature Tours: We all learn in our own way, and the Feature Tours are
designed for those of us who want someone to take us by the hand and
walk us through a few of the more complex ACT! features. When you
open one of the tours, you're treated to ACT! screenshots walking you
through a process. All the relevant icons and buttons have been labeled
so that you get a real understanding of how the process works.

v Online Manuals: ACT! comes with two nifty PDF files. One is a Quick
Reference card that you can print to help you with the most common of
ACT! features. The other is a rather large document that you can refer
to — or print — when you need extra help.
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v Getting Started Wizard: In your zealous haste to start working with
ACT!, you might choose to ignore the wizard that pops up immediately
after you first fire up ACT!. The Getting Started Wizard ensures that your
word processor and e-mail preferences are set correctly and helps you
to either convert an existing database or create a new one.

v ACT! Update: As much as you might want to think that the software you
purchase is perfect in every way, it’s not. Very often, users like you dis-
cover bugs, or little errors in the software. Sometimes, major changes
such as the release of a new operating system can cause your software
to exhibit some bad behavior. An update patch generally corrects these
problems. The ACT! update ensures that you have the latest and great-
est release of ACT!; best of all, there is no charge for this service!

v Service and Support: Ever wonder how to find help when you really
need it? Three great options here can provide a bit of extra handholding:

¢ Contact information: Includes a link to the various support options
offered by Sage Software.

¢ Knowledge Base: Includes articles written by ACT! tech support
about commonly asked questions and procedures.

¢ ACT! Consulting: Your best source of help for ACT! is an ACT!
Certified Consultant (ACC). ACCs earn their livelihood by working
with people like you. They are certified ACT! fanACTics who spend
a great portion of their day working with any and all things ACT!.
They can help you with anything from converting to ACT! from
another program and customizing your database to training your
employees. Most ACCs even make house calls. Clicking the ACT!
Consulting option takes you for a field trip out to an Internet site
that contains a listing of all local ACT! consultants.
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Chapter 3

Getting Your ACT! Together

In This Chapter

Creating a new database

Changing the ACT! preferences

Customizing your toolbars and menus

Icould easily have titled this chapter “Have It Your Way” because here’s
where I show you how to set up a new database. You discover some of the
preference settings that you can change in ACT!. If you’re sharing your data-
base across a network, you’ll read about the preferences that are specific to a
network. Finally, if you’re a real power-user, you’ll be excited to know how to
change your menus and toolbars.

Creating a New ACT! Database

¢MBER
é@

If your initial meeting with ACT! entailed looking at the Act9Demo database
that comes with ACT!, you know that it’s a great demo database to use for
learning purposes before actually starting to work on your own database.
After playing with the demo for only a short time, you're probably eager to
start working on your very own database. The easiest way to create your first
database is by using the Getting Started Wizard. In addition to setting you up
with a new database, the wizard helps you to set a few of the most basic pref-
erences needed for ACT! to work correctly.

The Getting Started Wizard opens automatically when you first install ACT!.

Follow these steps to set up your new ACT! database with the Getting Started
Wizard:
1. From any ACT! screen, choose Help=>Getting Started Wizard.
The first of the five Getting Started Wizard screens appears.

At this point, feel free to put your feet up on the desk, answer a few
questions, and let ACT! do the grunt work for you.
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|
Figure 3-1:
Settingup a
new ACT!
database.
|

2. On the wizard’s introductory screen, click Next to get started.

Quick as a flash, the Getting Started Wizard - Word Processor screen
appears. Here’s where you get to choose your word processor. It’s an
either/or proposition; you have only two choices (see the next step).

. Choose Microsoft Word (if Word is installed on your computer); other-

wise, choose the ACT! word processor.

Chapter 10 explains how to create a mail merge. If you're using Word,
you’ll want to use this as your preference because you're already famil-
iar with most of its features.

. Click Next.

In the next screen, you get to tell ACT! which e-mail client you're using.
(For information on determining which e-mail client you need to be
using, scurry over to Chapter 11.)

. Select the e-mail program of your choice and then click Next.

If you want, you can even tell ACT! that you prefer to skip the e-mail
setup for now. You can read more about setting up your e-mail in
Chapter 11.

By now, I'm sure you realize running a wizard means clicking the Next
button a lot. Smart reader! However, the next step in the wizard gets a
wee bit more challenging because you have to decide whether to create
a new database, convert an existing database from a prior version of
ACT!into ACT! 2007 format, or just skip the database setup. I make the
assumption that you're setting up a brand-new ACT! database; that’s the
direction the steps take.

. Select Set Up Database Now and then click Next.

In this step of the Getting Started Wizard, you get to make a couple of
decisions about the future of your database, as you can see in Figure 3-1.

ACT! by Sage Premium for Workgroups 2007 (9.0) Getting Started Wiza...

New Database
Before you can begin entering currt_ads. acli\_t'rt\es‘ or opportunitites, you will need to \
create an ACT! database and specify where it will be stored.
Database name [no spaces, punctuation, must begin with a letter):
ACT_For_Dummies
Location:
C:A\My Documents ACT \Databases
[[1 Share this database with other users
User name:
Karen Fredricks
Password (Optional):

=
]
v
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Database Name: You might want to give the database a really cool
moniker, such as the name of your company so that you can easily
identify it later.

The name of your database cannot include spaces or punctuation
marks. However, you can use an underscore and capital letters. For
example, consider naming your database My_Company rather than
Mycompany.

Location: By default, the database is saved to the default database
folder. Unless you change that preference, the default location is
C:\My Documents\ACT\ACT for Windows 9\Databases. You
can also indicate whether you want to share this database with
other people with whom you might be networked.

User Name: The person setting up the database is also one of the
database Administrators. Keeping this in mind, indicate the name
of the database Administrator.

Password: The good news is that as you type your password, each
character appears onscreen as a dot just in case someone is lurk-
ing over your shoulder trying to nab your password. The bad news
is that because you can’t see what you're typing, you might just
type something you didn’t intend to. ACT! demands that you retype
your password to ensure that you didn’t misspeak the first time.

An ACT! database does not require a password. It’s better to leave
the password blank than to add one — and forget what it is!

7. Fill in the appropriate information and then click Next.

The final screen of the Getting Started Wizard appears, recapping all the
important decisions that you just made about your new database. If you
made a mistake or simply change your mind, now’s the time to click the

Back button and fix things!

. Double-check your answers carefully, make the appropriate changes

(if any), and then click Finish.

The newly created database opens.

When you’re ready to add contacts to the database, head to Chapter 4.

You don’t need to use the wizard every time you want to create a new, blank
database. If you already set your preferences (see the upcoming section,
“Giving ACT! the Preferential Treatment”), you can create a new, blank data-
base by simply doing the following:

1. Choose File=> New Database from any of the ACT! views.

The New Database dialog box appears. By coincidence, it is identical
to the New Database screen of the Getting Started Wizard (refer to
Figure 3-1).
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2. Fill in the database name, location, user name, and (optional) pass-
word and then click OK.

Your currently opened database will close and the newly created data-
base will open.

Working with Passwords

If you're the only user using your ACT! database, security might not be an
important issue for you. When you start ACT!, it will not prompt you for a
user name and password. But if you're like most people, you probably prefer
not to share every tidbit of information in your database with anyone who
wanders into your office. Whether you want to prevent certain personnel
from changing the basic field structure of your database or adapt a look-but-
don’t-touch attitude with the computer-challenged among your employees,
ACT! has a variety of security methods that can help you accomplish your
security goals. You can choose one of the following:

1 Assign a specific security level to each user; I show you how to do that
in Chapter 15.

v Purchase ACT! 2007 Premium for Workgroups and determine which
contacts and fields any one user can access; you can read about ACT!'s
Contact Access feature in Chapter 15.

1 Password-protect your database; I discuss this option throughout the
rest of this section.

Setting a password

Both the database Administrator and the individual database user can set a
password for the user. The theory for this is that the individual can pick a
password that has some meaning to him — and so, hopefully, he doesn’t
forget it. If a user does forget his password, however, the Administrator can
reset it; you can see how to do that in Chapter 15.

If you have access to a database and are afraid that some nasty person might
use your name to gain access illegally, | recommend assigning a password to
yourself, which is ridiculously easy. Here’s what you do:

1. From any of the ACT! screens, choose File~>Set Password.

The Set Password dialog box appears, as shown in Figure 3-2.
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Figure 3-2:
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Set Password

Current Password:
New Password:
Confirm New Password:

Password Policy Requirements

Azero (0) setting means no limitation.

The password must:
+ Be at least 8 characters in length
* Be different from the last 0 used
+ Contain 2 of the following character groups:
+ Lower-case (a-z)
* Upper-case (A-Z)
+ Numeric (0-9)
+ Special characters (such as |@%5%&)
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2. Leave the Current Password text box empty.

3. Type your new password in the New Password text box. Then for
added excitement, type it once more in the Confirm New Password

text box.

You'll notice that the Set Password dialog box also indicates the pass-
word policy that has been set by your Administrator.

4. Click OK.

Changing a password

After you add a password to your database, or if multiple users access your
database, you are prompted to supply your user name and password each
time you try to open your ACT! database.

From time to time, you might want to change your password. Perhaps you
feel that a former employee compromised your security (or maybe you've
just been watching too many James Bond movies). Whatever the case, you
can follow these steps to create a new, improved password:

1. From any ACT! screen, choose File~>Set Password.

2. Enter your old password in the Current Password text box.

3. Type your new password in the New Password text box. Then for added
excitement, type it once more in the Confirm New Password text box.

4. Click OK.
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Sometimes the unthinkable happens and you can’t log into the database no
matter what password you try. At this point, you might have to bribe the
database Administrator into resetting your password. I find that chocolate
chip cookies work the best, but feel free to pick the bribe of your choice.
Then make sure the Administrator follows these steps:

1. Choose Tools=>Manage Users from any ACT! view.

If you're going through this chapter section by section, you already
know that you can do this from within any of the ACT! screens. I don’t
mean to sound like a broken record here; I just want you to get used to
the idea.

The Manage Users dialog box opens.

2. Double-click the name of the user for which you want to change the
password.

3. Enter the new password in the New Password text box.
4. Enter the new password again in the Confirm New Password text box.
5. Click OK.

You might not know your password because you don’t have one. So, before
tracking down your Administrator with that plate of cookies, try leaving the
password field blank. (I frequently get phone calls and e-mails from ACT!
users who have no idea what password is assigned to them. Guess what?
They often don’t have one!)

Giving ACT! the Preferential Treatment

After you install ACT! on your computer, becoming familiar with various pref-
erences is a good practice. If you're the sole user of the database, these set-
tings will likely save your sanity. If you share the database with other users,
these settings can probably save you all a lot of head scratching.

If you create your original database by using the Getting Started Wizard,
some of your preferences are already set. However, reviewing your work
never hurts! Your preference settings is the place to turn to if you're the kind
of person who likes to have things your own way. You might routinely store
all your documents in a specific location and want ACT! to follow that same
example. Or you might have a fondness for fuchsia and orange and want to
have your ACT! screens coordinate with this color scheme.
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Here’s how to change several of the most basic preference settings. Feel free
to flip through the various preference tabs to get an idea about additional
preference settings that you might also want to tweak. You can find the ACT!
Preferences dialog box by choosing Tools=>Preferences. The Preferences
dialog box is arranged into six tabs, each of which I discuss in the following
sections.

General

As the name implies, you find an assortment of preferences on the General
tab. General preferences allow you to specify settings for your database, such
as how names and salutations display on your contact records, whether
checking for duplicate records is enabled or disabled, and where files associ-
ated with your database are stored. ACT! automatically stores your database
in the My Documents folder. Your database contains all your basic contact
information as well as supplemental files such as layouts, templates, and
saved e-mail messages. In addition, you might want to have your own set of
personal supplemental files; this area is where you can tell ACT! where you
prefer to have them saved.

A few of the preference settings might not be available to you if you're not the
database Administrator; for example, you can’t change the history or dupli-
cate checking options that appear on the General tab of the ACT! preferences.

Colors & Fonts

You can set the colors and fonts for almost any area of ACT!, including all list
views, tabs, and calendars. However, there isn’t a global color setting; you must
set the colors and fonts for each item separately in the Colors & Fonts tab.

You might want to make sure that the colors you pick for the text and back-
ground colors result in a legible combination. For example, choosing black
text with a black background would not be a great idea, nor would the combi-
nation of a yellow font on a white background.

Calendar & Scheduling

The Calendar & Scheduling tab allows you to change the way your calendars
look and to determine the default for scheduling activities.
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When you click the Calendar Preferences button, you can set the days of the
week that you want to appear on your work week calendar, the minute inter-
vals for your daily and work week calendars, and various calendar options,
such as whether you want to see pop-ups when you hold your mouse cursor
over a scheduled activity.

When you click the Scheduling Preferences button, you can set options for
each activity type, but you must set the options one activity type at a time.
The options you can include for each activity type include the default activity
priority level, the interval of time before the activity you want the Ring Alarm
to sound, and the default duration for each activity type.

E-mail

Exactly as advertised, the E-mail preference tab is the area where you tell
ACT! exactly how you want to handle your e-mail. The preferences you might
want to set include the e-mail system you want to use with ACT! (Microsoft
Outlook, Outlook Express, Lotus Notes, or Internet Mail), composing options
(including signatures), how often you want ACT! to notify you about newly
received messages, and how you want to handle attachments that you receive.

Communication

The Communication tab lets you choose your word processor and fax prefer-
ences, including your default word processing and fax software, spell check-
ing options, and Dialer options. (Use Dialer options if you want ACT! to
automatically dial an outgoing number and record the length of the phone
call.) You'll also find the Quick Print header and footer options that are used
when printing any of the ACT! lists, including Company, Group, Opportunity,
Contact, Notes, History, Activity, and Secondary Contacts.

Although the Dialer feature can be a great timesaver, you must have the
appropriate hardware installed in order to use it. Quite simply, dialing requires
that your computer can access a dial tone. This can be accomplished through
the use of a dialup phone modem or a telephone system equipped with
Telephone Application Programming Interface (TAPI) hardware and the
appropriate telephone driver software.

Startup

The Startup options dictate both the default settings for each new contact
added to your database and how ACT! starts up every time you run the pro-
gram. The Startup tab preferences includes the Record Creation settings that set
the default to Public or Private for each new contact, group, and opportunity
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that you add to the database as well as whether you want to automatically
link each new contact to his company record and record a history of the
event. You can also specify whether you want ACT! to open in the Contact
Detail or Contact List view and which database you want ACT! to open auto-
matically each time you run ACT!. You're even given the option to automati-
cally check for new ACT! updates.

Administrators of a shared database want to deselect the Automatically
Check for Updates option. Applying updates, which I discuss in Chapter 14,
should always be initiated first on the server by the database Administrator
and then on the local workstations. The automatic update option presents
users with an enticing invitation to initiate an update. This can lead to prema-
ture baldness of the Administrator.

Customizing the Navigation Bar

|
Figure 3-3:
The ACT!
Navigation
bar.
|

One of the things you might find the most endearing about ACT! is your ability
to mold the program to how it feels the most comfortable to you. You might

decide that for whatever reason, you don’t like the look of the Navigation (Nav)
bar (those big icons that run down the left side of ACT!, as shown in Figure 3-3).

Navigation (Nav) bar

[ ACTT by Sage Premium for W, 2007 (9.0) - ACT_For_Dummi BEE]
File |Edit View Lookup Contacts Groups Schedule Write Reports Tools Help
" 50f164 ¢ » (@ Contacts | @ ContactList (2 [ & @ & [Ei L =3 [=N=-NE)
ed 3 Contact Detal
A i &
) Company Tech Benders [)  Address 8608 Eagle Run Drive E-mail dummiss@techbenders.com
FaTE Contact Karen Fredricks G Messenger ID
\m/': Salutation Karen
Title ACT! Guru - ity Boca Raton v| ID/status  |Employes v
Contact List
= Department v State FL v Spouse
\ Phone (561)470-5¢50 |[L.] Ext] ZIP Code 33474 Birthday -
Ermizs Mobile = Country v|  ReferredBy v
| Fax (888) 470-5450] ) Website | wwwischbenders.com
Companies
Last Results v Edit Date v
E;‘[ Last Reach v Last Attempt. ~ Last Meeting v
Monthly
Calendar
l__'.':‘_‘s Notes | History | Activities | Opportunities || Groups/Companies | Secondary Contacts || Documents | Contact Info || User Fields | Home Address
Work Dates: |All Dates | @ Select Users (= Options -
Dale. = | Time Regarding & |E |Record Manager Contact
Taist
Opportunity
List
=
E-mail
[+
i |
< ;
|Lookup: All Contacts
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To customize the Nav bar and “have it your way,” all you have to do is right-
click it and then pick your poison, er, menu options from the right-click menu
that appears. Note the menu that appears is divided into sections. The first
section determines the size of the Nav bar icons. The second section pro-
vides you with several preset menu options. Feel free to click the various
combinations until you feel comfortable with the Nav bar.

If you're still not happy with the look and feel of the Nav bar, feel free to choose
the Customize option. A little window opens magically that allows you to drag
additional icons to the Nav bar — or get rid of the ones you don’t want.

The calendar icon is an example of a Nav bar icon that you might want to
replace. By default, clicking it brings you to the daily calendar. That’s fine if
that’s the calendar you're most comfortable using. However, many of you
might prefer to use the weekly — or work week — calendar instead. If that’s
the case, customize the Nav bar by dragging away the calendar icon and
replacing it with the calendar item of your choice.

Modifying the Icon Bar

\\3

Customizing the various ACT! menus and toolbars to include functions that
you use on a regular basis is a great way to improve your efficiency. Changing
your toolbar literally allows you to perform various functions at the click of a
button.

Adding items to the toolbar

One thing you might find a little unique in ACT! is the variety of toolbars that
you encounter along the way. You see one toolbar while working in the
Contact Detail window but a different toolbar when you foray into the Group
Detail window. That said, realize that an icon you add to one of your toolbars
doesn’t appear on another. That’s okay because adding icons to any one of
the ACT! toolbars is easy.

I encourage you to do a little homework before tackling the toolbar. Don’t
worry, the assignment is fairly simple; you need to decide in advance which
icon you want to add as well as which menu it’s located on. Although this
step isn’t critical, it saves you from floundering around later. After doing your
homework, follow these steps to add an icon to any toolbar:
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1. From any of the ACT! screens, choose Tools=>Customize~>Menus and

Toolbars.

For the right-clickers in the audience, you can also give the toolbar a
click with the right button of your mouse and choose Customize.

2. Click the Commands tab in the Customize Menus and Toolbars dialog
box (see Figure 3-4).

Customize Menus and Toolbars

Menus are active while this dizlog box is open. Drag-and-drop to change|

position or right-click @ menu item for more options.

Toolbars | Commands | Options || Keyboard || Custom Commands

Categories:

Contact Detail Toolbar

Contacts

I ]
dit

File

Groups

Help

Lookup

Opportunity List Toolbar
Reports

Schedule

Tools

View

Write

Commands:

Pr=

Contacts [l
MNew Secondary Contact

Attach File.

Delete Contact

Duplicate Contact.

Edit Contact Access »
Add Users/Teams...

Creste Mew Access List.

Edit Access List.. [

Close

3. Select the name of the menu that contains the command that you want
to add to your toolbar.

If you did your homework, pat yourself on the back. If you didn’t, have
fun flipping through all the choices in the Categories list and scrolling
through all the corresponding commands until you stumble upon the
item that you want to add to the toolbar. I hate to be an “I told you so,”

but. ...

4. Drag the desired command to the toolbar.

As you drag the command to the toolbar, a black line materializes that
indicates exactly where the icon is going to appear.

5. Click the Close button on the Customize Menus and Toolbars
dialog box.
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Tweaking the toolbar icons

I'm almost embarrassed to tell you how easily you can further customize the
icons on your toolbars. But, because you're such a good person, | am going
to tell you. You might store this information away for future reference and use
it to impress your friends some time in the near future. To customize a tool-
bar icon

1. Right-click the toolbar and choose Customize.

By the way, Customize is not only the choice you want to choose — it’s
your only choice!

2. Drag any icon you want to another spot on the toolbar.
Now’s your chance.

3. Right-click the icon that you want to modify.

4. Chose the modification items of your choice.

e Reset All: Resets all your toolbar and menu customization to the
original value

e Delete: Deletes the currently selected icon
e Name: Allows you to rename the icon’s ToolTip

¢ Default Style: Shows just an icon on the toolbar without including
any text

e Text Only: Shows only a text command on the toolbar without
the icon

* Image and Text: Shows both an icon and text command on the
toolbar

¢ Begin Group: Places a light vertical bar to the left of the icon to
allow grouping of similar icons

5. Click the Close button on the Customize Menus and Toolbars
dialog box.

Monkeying with the Menus

After you master the icon bar, customizing the menus will seem like a piece
of cake. Most of the techniques that I mention here will sound eerily familiar
because you modify your menus in pretty much the same way as you do your
icon bar.
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Ordering additional menu items

For your first feat, add some new goodies to your menus as follows:

1.

Right-click the toolbar and choose Customize.

If you feel a slight sense of déja vy, it’s because you're treading on very
familiar territory.

. Click the Commands tab of the Customize Menus and Toolbars

dialog box.

. Select the name of the menu that contains the command you want to

add to your toolbar menu.

. Drag the desired command up to the menu that you want to modify.

This is where you do things slightly differently than you did with the
icon bar (see the preceding section). When you drag the command to
the menus, they pop open. Resist the temptation to let go of your mouse
button! If you linger your mouse on any of the sub-menu items, they pop
open for you as well. When you arrive at your scheduled destination, a
black line materializes that indicates exactly where the item is going to
appear.

. Let go of your mouse button.

I'll bet you thought [ was never going to say that! If your finger feels
numb, that’s okay — the reward of having your new items appear on
your menus is certainly worth any pain you might have encountered.

. Drag any menu item you want to another menu.

You'll probably find that ACT!’s menus seem pretty logical, but as they
say — different strokes for different folks. If you decide that Preferences
should be located on the Edit menu or that the Backup command should
really be listed on the Tools menu, go for it. Hover your mouse over the
menu with the target item; when the menu pops open, drag it to the cor-
rect spot on the new menu.

. Click the Close button on the Customize Menus and Toolbars

dialog box.

Adding a custom command

Normally I shudder when someone asks me whether they can perform a task
“with the click of a button.” As you can see throughout this book, most proc-
esses take a couple of clicks. However, you can create custom commands to
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|
Figure 3-5:
Make a
custom
command
here.
|

make ACT! run one of your favorite software programs or some of your cus-
tomized reports and templates. Want to open Excel from ACT! with the click
of a button? Add it to one of your ACT! menus or toolbars. Have you created
some templates that you use repeatedly? You might want to think about
adding those goodies to the Write menu. To add a custom command

1. Right-click the toolbar and choose Customize.

2. Click the Custom Commands tab (as shown in Figure 3-5) from the
Customize Menus and Toolbars dialog box.

Customize Menus and Toolbars

Menus are active while this dialog box is open. Drag-and-drop to change
position or right-click a menu item for more options.

Toolbars | Commands | Options | Keyboard | Custom Commands

o]

Command name: | Excel
Tooltip text: Open Excal

Command line:  |C\Program Files'\Microsaft OFf

Choose icon: @

Close

3. Click the New button.
4. Type a name for the command in the Command Name field.

The name you choose is simply used to identify your custom command.
You don’t need to wrack your brain here. If you decide to add Excel to a
menu, you might want to name the command Excel.

5. Enter a short description of the command in the Tooltip Text field if
you want a pop-up description to be associated with a new icon.

6. Click Browse to navigate to either the location of the application’s exe-
cutable file or to one of ACT!’s customized documents.

7. Click OK to close the navigation dialog box and then click the Add
Command button.
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After you create a custom command, your next task is to get it to magically
appear on one of your ACT! menus. I know, by now, you’re getting tired of
reading all about menu bar customizations. You don’t want to follow an entire
new set of commands. I don’t blame you. But guess what? If you've read
through this chapter, you know how to add those new custom command
items to your menus. Hop back to the section “Ordering additional menu
items” to find that those directions are just about all you need to make it
happen.

Refer to Figure 3-5 to see that one of the categories listed is Custom Commands.
What a coincidence. You can find all your newly created custom commands
just sitting there, waiting to be dragged to the appropriate menu. Time to go
put your feet up and rest a bit — you’ve worked very hard!
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Part I

Putting the ACT!
Database to Work

The Sth Wave By Rich Tennant
ORATENNANT

“Look you’ve got Project Manager, Acct.

Manager, and Opportunity Mamager but

Suckmg Up tothe Manager just isn’t a
field the program comes with.”



In this part . . .

Okay, after you whip ACT! into shape (see the preced-
ing part of this book), it’s time to get your life in order.
ACT! is a contact manager, which (as the name implies)
makes it a great place to manage your contacts. First, you
add new contacts into your database, and then you need to
know how to find them again. After you locate your con-
tacts, you can schedule an activity with any one of them,
set a reminder, and maybe add some notes for good mea-
sure. (Sure beats the heck out of a yellow sticky note!)




Chapter 4
Making Contact(s)

In This Chapter

Inserting new contacts
Removing existing contacts

Updating contact information

A database is only as good as the contacts that it contains. In ACT!,
adding, deleting, and editing the contacts in your database is easy to
do. In this chapter, I show you how to do all three of these tasks to maintain
an organized, working database. Adding new contacts is only half the fun;
being able to find them is why you have the database in the first place.
Inputting contacts in a consistent manner ensures that all your contacts are
easy to find. If you need to change that contact’s information or delete the
contact, stay tuned. I demonstrate how to change contact information and
even how to “unchange” changes that you might make by mistake!

Adding New Contacts

On the very simplest level, the main purpose of ACT! is to serve as a place to
store all your contacts. You can add and edit your contacts from the Contact
Detail window because it contains all the information that pertains to one
particular record and allows you to see all your contact fields.

Every time that you add a new contact, ACT! automatically fills information
into three fields: Record Creator, Record Manager, and Create Date. If you click
the Contact Info tab of your layout, you'll notice these three fields. When you
add a new contact, ACT! inserts your user name into the Record Creator and
Record Manager fields and the current date into the Create Date field. This tab
enables you to search for all the new contacts that you created within a given
date range. The Record Creator and Create Date fields serve as a permanent
record, and you cannot change them. Managers and Administrators can over-
ride the contents of the Record Manager field if they so desire.
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You probably have lots of contacts that you're dying to enter into your data-
base, so what are you waiting for? Jump right in and follow these steps:

1. If you aren’t already in the Contact Detail window, go there by click-

ing the Contacts icon on the ACT! Navigation (Nav) bar.

Don’t know about the Nav bar? Check out Chapter 2, where you find out
all you need to know about the Nav bar and then some.

. Choose Contacts=>New Contact in the Contact Detail window to add a

new contact to your database.

Alternatively, you can click the New Contact icon on the toolbar or press
Insert (on the keyboard). In any event, initiating any of the preceding
commands results in a blank contact record; you’re now ready to enter
the new contact’s information.

. Begin entering information by clicking in the Company field and

typing the contact’s company name.

ACT! doesn’t distinguish between actual contacts and blank contacts.
Failure to enter information or repeatedly pressing Insert results in
numerous blank contact records, which are of no use and serve only to
clog the database. So, although you are free to leave any of the ACT!
fields blank, you’ll want to enter something — at the very least, I
recommend the key pieces of information such as the contact’s name,
company name, and phone number — so you might as well begin with
the company’s name.

You can always go back to a record and delete, add, or change any infor-
mation in any field. See the sections, “Deleting Contact Records” and
“The Contacts, They Are AChangin’,” later in this chapter.

. Click in the next field where you want to enter information and start

typing.

You can also use the Tab key to advance to the next field. In your initial
excitement to start entering all your existing contacts, if you inadver-
tently press Tab once too often, you might find that you advanced one
too many fields and ended up in the wrong field. Don’t fret: Press and
hold down the Shift key and then press Tab to move your cursor in the
reverse direction. If you prefer, you can also get back to any field simply
by clicking in it with your mouse.

. Continue filling in fields.

As I mention in Chapter 2, ACT! comes with approximately 50 prepro-
grammed fields that are needed by most users. Many of the fields are
fairly self-explanatory (and reflect the type of information that you prob-
ably expect to find in any address book): contact name, company name,
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phone, city, state, and Zip code. These are conveniently located in the
top half of the Contact Detail window. A few of the fields are a little less
obvious:

e Address: If you assume that the three fields ACT! provides for the

address is meant to store three alternative addresses, you're
wrong! The second and third address fields are meant for really
long addresses. These fields are good places to include a suite
number or building name if it is an integral part of the address.

ID/Status: The ID/Status field is essentially the category field, and it
files each of your contacts into categories. By using the ID/Status
field, you don’t have to manually set up a variety of databases: one
for your friends, one for your clients, one for your vendors, and so
on. The ID/Status field comes preset with a few dozen of the most
commonly used categories in its drop-down list, including employ-
ees, customers, vendors, and competitors, which makes searching
for each of these categories a snap.

Salutation: This field refers to the name that comes after the word
Dear in a letter, which is used in your letter templates. By default,
ACT! (being the friendly type) uses the first name.

If you prefer using the more formal salutation as the default setting,
choose Tools=>Preferences and click the Salutation Preferences
button conveniently located on the General tab.

Referred By: This field is one of the most commonly overlooked
fields in the database. Information entered into this field is used in
the Source of Referrals report; failure to enter Referred By informa-
tion renders the report useless. So what'’s the big deal? Suppose
you’re paying for advertising in two newspapers — wouldn’t know-
ing which one attracted the most prospects be nice? If you're attend-
ing trade shows or putting a lot of time and effort into your Web
site, wouldn’t you like to know whether your efforts result in any
new business? And, if an existing customer sends you lots of new
leads, wouldn’t remembering him with a nice gift at holiday time be
nice? Utilizing the Referred By field can help you do all this.

User: Notice the several User fields in the bottom half of the
Contact Detail window. These fields hold information that’s spe-
cific to your business. In Chapter 12, I explain how you can change
these field names to better reflect their contents. For example, you
might rename User 1 to Social Security number.

[ recommend leaving these particular fields blank until you rename
them. If you don’t, you might end up with various kinds of data entered
into one field.
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Figure 4-1:
An ACT!
drop-down
list.

6. Don’t be alarmed when ACT! automatically formats some of your field

data when you enter information.

See the section, “Letting ACT! do the work for you: Automatic formatting,”
later in this chapter for the lowdown on what ACT! does and doesn’t do
for you.

. Add your data as uniformly as possible.

Check out the section, “Getting the most out of ACT!: Using the drop-
down lists,” later in this chapter to find out how to easily keep your data
uniform and yourself sane.

. If necessary, add multiple entries to a field.

Generally, limiting yourself to one item per field is the best practice.
From time to time, however, you find a situation in which a contact falls
into two categories. For example, a contact might be both a friend and a
client. In this situation, you can use a multi-select drop-down list to
select more than one item into a field. By default, the ID/Status field is
set to be a multi-select field; Chapter 12 shows you how to create as
many multi-select fields as you’d like.

To select criteria to be included in a single field, follow these steps:
a. Place your cursor in the field.
b. Click the down arrow to the right of the field.

Figure 4-1 gives you an example of a drop-down list.

Employes;Friend ~

Contractor

[] Customer

[] Distributor

[¥] Employes

[] Family

[w] Friend

[] Gate Keeper

[] Influencer v

Edit List Values

c. Click the desired entries from the list.
d. Click anywhere outside the dialog box to close it.

The various entries appear in the field, separated by a comma.

9. When you fill in the information for each new contact, don’t forget to

click the various tabs at the bottom of your layout.

You find additional fields lurking on these tabs. The Home Address tab is
where you record personal information about a contact. Depending on
your database and the layout you're using, you might see other tabs
with fields waiting for your data.
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Different layouts display different tabs. If you change your current
layout, you're probably looking at a different set of tabs. Confused?
Check out Chapter 2 for a quick refresher.

If you forget to click those tabs along the bottom of the Contact Detail
window, you just might overlook some of the fields that hold important
information. Although you can always fill them in later, it’s a good idea
to input the information while it is still fresh in your memory, so be sure
to click those tabs!

10. Save the new contact information.

Theoretically, you don’t have to save new contact information; it’s saved
if you do one of the following:

e Execute any other ACT! command, which includes anything from
adding a note or sales opportunity to scheduling an appointment.

® Mouve on to another record in the database.

Although it’s not necessary, feel free to do one of the following to save
your information:

e Click the Save button (the small floppy disk icon on the toolbar).
e Press Ctrl+S.

Letting ACT! do the work for you:
Automatic formatting

Entering a new contact into the ACT! database is so easy that you might over-
look some of the magical things that happen when you begin to input contact
information. ACT! is here to help by automatically formatting some of the
contact information that you input, including

1 Automatic phone number formatting: A great example of ACT!’s magic
is found in any of the phone fields. When you type in a phone number,
notice how ACT! automatically inserts the necessary parentheses and
hyphens. ACT! automatically inserts the dialing format for the United
States each time that you enter a new phone number. Have relatives
living in Turkmenistan? Have no fear: If you click the ellipsis button (the
three little dots) to the right of the Telephone field, ACT! pops open the
Enter Phone Number dialog box. By default, the country is listed as the
United States, but you can scroll through the list of the countries for just
about any country that you can think of, including Turkmenistan (see
Figure 4-2). After you click OK, the correct telephone country code and
format are applied to the telephone number.
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|
Figure 4-2:
Automatic
telephone
formatting.
|

Figure 4-3:
The Contact
Name
dialog box.
|
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Enter Phone Number
Country: Turkmenistan [393] w
Format: Free Form v
Phone Number: | [593) 5614705450
[ Edit Formats.. | [ oK ] [ Cancel
» Automatic name formatting: Another field that ACT! automatically

provides you with is the Salutation field. The Salutation field holds the
text that appears after the word Dear in a letter. For example, if you
enter Mary Ellen Van der Snob as the contact name, Mary Ellen magically
appears as the salutation. Of course, if you prefer to address your con-
tacts in a more formal manner, feel free to change Mary Ellen to Ms. Van
der Snob. When you enter a contact name into the database, ACT! auto-
matically divides it into a first, middle, and last name. Again, if you click
the ellipsis button to the right of the Contact field, ACT! shows you how
it plans to divide the contact’s name. This allows you to sort your data-
base alphabetically by last name or to look up a contact by first name.
This chapter and Chapter 5 both include ways to sort your database. If
you attempt to enter a rather large, unique name, ACT! automatically
opens the Contact Name dialog box, as shown in Figure 4-3, and asks
you how you want to divide the name.

Contact Name

ACT! uses the First Name and Last Name for sorting and lookups

ACT! has determined the following to be the First Name, Middle
MName, and Last Name of this contact. If any of these names is
incorrect, select the correct name from the dropdown list.

Name

Contact:

First name: Mary Blen R
Middle name: v
Last name: Van Der Snob »

Automatically show this dislog if the contact name contains mare

than

details

two names

Cancel

ACT! is an amazingly smart and intuitive program. You might want to
input the contact name as Ms. Alyssa Fredricks or Andrea Fredricks, MD.
ACT! knows that words like Mr., Miss, and Ms. are usually not first names,
and PhD, MD, and Esq. are generally not last names, so feel free to add
them to the contact name if you’d like.
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Figure 4-4:
An ACT!
date field.
|

v~ History fields: Any changes to a history field are preserved on the
History tab. Say you have six steps that you want your staff to perform
when dealing with prospects. You might change the drop-down informa-
tion for your history field to reflect those six steps. When you perform
one of the steps and you enter the information into the field, the date
and time of the change appear on the History tab so you know exactly
when each step took place.

Out of the box, only two fields — ID/Status and Last Results — are history
fields. Theoretically, any field can be a history field, and Chapter 12
shows you how to do it.

v Date fields: The one thing you don’t ever want to forget is the birthday
of your significant other. However, as you discover in Chapter 6, entering
data consistently is important if you have any hope of ever finding it
again. What if an important birthday occurs in January, but you aren’t
sure whether the date was entered as January, Jan, 01, or 1? By now,
you've probably guessed that ACT! came up with a cure for the birthday
blues with the addition of date fields. All date fields have a drop-down
arrow, which you can click to bring up a mini-calendar, as shown in
Figure 4-4. Click the appropriate date, buy a card, and you’re ready to
roll. If you prefer, you can also manually enter the date as 01/17/06 or
1/17/06, and ACT! translates it to the calendar mode automatically.

Birthday 1/17/2006 ¥

Referred By 4 January 2006 >
SMTWTEFS

Edit Date

Last Meeting

Getting the most out of ACT!:
Using the drop-down lists

One sure-fire way to sabotage your database is to develop new and creative
ways to say the same thing. In Florida, users often vacillate between Fort, Ft,
and Ft Lauderdale, resulting in a bad sunburn and the inability to correctly
find all their contacts. You'll notice that several of the ACT! fields contain drop-
down lists. In these fields, you can select an item in the list, or you can type the
first few letters of an item; the field then automatically fills with the item that
matches what you typed or clicked. When you type an entry that isn’t in the
drop-down list for the Title, Department, City, and Country fields, the item is
automatically added to the list so that you can then select it for other contacts.
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Figure 4-5:
Edit a drop-
down list
here.
|
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You have two ways of using the drop-down lists to enter information:

v Type the first few letters of an entry that already appears in the drop-
down list, and ACT! auto-completes the word for you. For example, if
you type Bo in the City field, Boise magically appears; then, if you add
an s, Boston appears.

v Access the drop-down list by clicking its arrow and then choosing the
desired item(s) from the list.

Using these drop-down lists whenever possible helps ensure consistency
throughout your database. In Chapter 12, I explain how to add additional
drop-down fields to your database and control how you use them.

If you want to change the content of the drop-down lists that come with ACT!,
follow these steps:

1. Click in a field that has a drop-down list.

2. Click the drop-down arrow in the field.

3. When the drop-down list appears, click the Edit List Values button.
The Edit List dialog box appears, as shown in Figure 4-5.

Edit List

Enter drop-down list values:

Value
Fort Collins

FortLauderdale
Fort Myers
Fort Fierce
Fort Smith

Fort Wayne
Fart Worth
Frankfort
Fremont

Description -~

Fresno

Ft Lauderdale
Ft. Lauderdale
Gainesville
Galveston
Garland

Gary

Grand Rapids
Green Bay

freansharn

4. In the Edit List dialog box, do one of the following:

e To add an item to the list: Click the Add button. A new blank line
appears at the bottom of the list. Enter the text that you want to
appear in the list.
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¢ To remove an item from the list: Select an item and click the Delete
button. Click Yes when ACT! asks you to confirm the deletion.

e To modify an existing item: Double-click it and edit it exactly like
you would in a word processor.

5. Click OK when you finish editing your list.

That’s all there is to it. A pretty easy way to ensure consistency, don’t you think?

Deleting Contact Records

What do you do if you find that a contact is duplicated in your database? Or
that you're no longer doing business with one of your contacts? For whatever
reason you decide that a name no longer needs to be a part of your database,
you can just delete that contact record.

ACT! allows you to either delete one contact record or a lookup of contact
records. (A lookup is the group of contacts that displays after a database
search. Peruse Chapter 6 for more information about lookups.) Just realize
that you are deleting either the current contact that you're viewing or the
current group of contacts that you just created a lookup for. When you’re on
the contact that you want to delete, do one of the following:

1 Choose Contact->Delete.
v Press Ctrl+Delete.
v Right-click the contact record and choose Delete Contact.

Clicking the Delete Contact button deletes the current contact you're
viewing. If you click the Delete Lookup button, you delete the current
contact lookup.

Any one of these choices brings up the warning, as shown in Figure 4-6.

|
Figure 4-6:
You getan
ominous
warning
when Delete Contact | [ Delete Lockup | [ Cancel ]
deleting a
contact.
|

ACT!

Deleting contacts cannot be undone. Would you like to delete the current contact or the entire lookup?
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Thinking before deleting a contact

Although the procedure is rather simple, you might want to rethink deleting
contacts. When you delete a contact, you also delete all the associated notes
and histories tied to that contact. For example, suppose that State College
uses ACT! to keep track of all prospective students that it has contacted —
or has been contacted by. State College admissions personnel receive thou-
sands of inquiries a month and fear that the database will become too large
to manage . . . and subsequently think that deleting all prospects that they
haven’t had contact with in over a year is the best course of action. However,
some of those prospects might be attending different schools that they aren’t
happy with and might want to enter State College as transfer students. Other
prospects might transfer after completing two years at a community college,
and still others might consider attending State College as graduate students.

What to do in such a situation? I'd consider moving the contacts that you no
longer need into another archival database. That way, should the need ever
arise, you can still find all the original information on a contact without
having to start again from scratch. How nice to be able to rekindle a relation-
ship by asking, “So tell me, how did you find the accounting department at
Podunk University?” Although the setup of an archival database is beyond
the scope of this book, an ACT! Certified Consultant (ACC) can assist you
with this matter.

Three warnings before deleting a contact

Losing contacts in your database is a very scary thought. You undoubtedly
rely very heavily on your ACT! database; losing that data can be potentially
devastating to your business. Worst of all, when you realize that you just acci-
dentally removed several — or even hundreds — of contacts from the data-
base, panic can set in!

Avert this panic by following these tips before you attempt to delete any of
your contacts:

v Know the difference between deleting a contact and deleting a
lookup. That way, you don’t delete numerous contacts when you want
to delete only a single record.

e Contact: The single record that you view from the Contact Detail
window.

e Lookup: The group of contacts that displays after a database search.
Chapter 6 gives you more information about creating lookups.
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+ Read the warning and make note of the number of contacts that
you’re about to delete. Don’t be afraid to click Cancel if a large number
of contacts start to disappear.

+ Remember the three rules of computing: backup, backup, backup!
Chapter 14 provides you with instructions on how to create a backup. A
good backup provides the easiest method to restore all your information
after you accidentally deleted it.

The Contacts, They Are A’Changin’

Companies relocate and change their names, people move, and your fingers
sometimes slip on the keyboard. People change e-mail addresses. You might
want to add additional contact information for one of your contacts. All these
predicaments require the editing of contact fields. Not to worry; changing the
information that you store in ACT! is as easy as entering it in the first place.

ACT! gives you two ways of updating contact information:

v Click in the field that you want to change and then press the Delete or
Backspace key to remove the existing field information. Then simply
type in the new information.

v~ Highlight all the information in a field. By typing in the new informa-
tion, the old information is automatically replaced.

P If you accidentally overwrite information in a single ACT! field, press Ctrl+Z
to undo the changes that you just made to that field — before you move your
cursor to another ACT! record. If you made multiple changes to a contact
record or for those who are keyboard challenged, an alternative is to choose
Edit=>Undo from the main menu. After you move on to another record, nei-
ther of these options are available to you.

After you execute another ACT! command or move on to another record,
ACT! automatically saves the record. At that point, you can’t automatically
undo any changes you made to a contact record.
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Chapter 5
A Few Good Tabs and Lists

In This Chapter

Discovering ACT! lists and tabs
Remodeling ACT! lists and tabs

Putting secondary contacts in the right place

Linking documents to the Documents tab

¢MBER
é@

Froughout this book, you find all the neat ways in which you can cus-
tomize ACT!. In this chapter, you discover how to change the appearance
of the various ACT! lists and tabs. And, although you encounter numerous
lists and tabs in your travels through ACT!, you’ll soon discover that you can
modify them in exactly the same way.

After you've seen one list or tab, you've seen them all! And, if you're a fanACTic,
the lists and tabs work pretty much like they did in previous versions.

Meeting the Lists and Tabs

The bad news is that numerous lists and tabs are sprinkled through ACT!,
and new users might find themselves lost in a maze of windows. The good
news is that lists and tabs all have pretty much the same look and feel to
them — if you master one, you master them all!

You can find all lists by clicking View on the menu bar and then explore one
by selecting a list that sounds fun and exciting. Two of the lists — the Task
List and the Opportunity List — are so much fun that they are included in the
Navigation (Nav) bar running along the left side of ACT!. And, if you feel so
inclined, you’'re welcome to flip back to Chapter 3 to find out how to add all
the list items to the Nav bar.
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Here’s a few of the lists you’ll work with most often:

v Contact List: Lists all your contacts; the list is filtered based on your cur-
rent lookup. (For more on lookups, see Chapter 6.)

v~ Task List: Lists all the tasks and activities you scheduled for all your
contacts. You can filter these by date, type, priority, user, public versus
private, timeless, cleared status, and Outlook relationship.

v Group List: Lists all groups and can optionally include subgroups.
v Company List: Lists all companies and can optionally include divisions.

v Opportunity List: Lists all the sales opportunities that you enter for all
your contacts. You can filter opportunities by date, status, process,
stage, probability, amount, and public versus private.

The two types of tabs are

v~ System tabs: These are the same for any and all layouts you use. The
system tabs include

e Notes: Lists all notes you record for the current contact, company,
or group. You can filter the notes by date, private versus public,
and user. See Chapter 7 for more on the Notes tab.

¢ History: Lists all correspondence, activities, and document infor-
mation that were recorded automatically by ACT! for a contact,
group, or company. You can filter the histories by date, private
versus public, type of history, and user. Turn to Chapter 7 to find
out more about the History tab.

e Activities: Lists all activities for the contact, group, or company.
You can filter the activities by date, private versus public, cleared,
timeless, type of activity, priority, and user. I go in depth about the
Activities tab in Chapter 8.

e Opportunities: Lists the financial lowdown on all the selling oppor-
tunities for the current contact, group, or company. You can filter
the opportunities by date, status, private versus public, and user.
Chapter 18 covers the Opportunities tab.

e Documents: Lists all files attached to the current contact, group, or
company. Note: You can't filter this tab. See the section,
“Documenting Your Documents,” later in this chapter for more
about the Documents tab.

Contacts: Lists all the contacts associated with the current group or
company. You see this tab only in the Group Detail window or the
Company Detail window.
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Minding your filters!

When viewing the various system tabs, you
must be aware of the effect that the filters have
on what information you see — or don't see. In
ACT!, you can choose to filter information or to
include it. Different tabs have different filters;
however, all tabs include a date filter and a user
filter. If the filter is set to show only items in the
future and you have an activity scheduled for
today, you don't see today’s activity. And, if you
schedule an activity but you set the filter to
include only Alyssa’s activities, you don't see

When frustrated, check your filters! You might
be puzzled when information you just know
has been entered into the database mysteri-
ously disappears. This becomes increasingly
important on the Activities tab, which contains
several filter options (including three buried
away behind the Option button). The Task and
Opportunity lists can be even more confusing;
these lists contain a variety of filter options —
all of which can be hidden away with one click
of the Hide Filters button.

01

your activity, either.

e Secondary Contacts: Lists the secondary contacts (for example, the
butcher, the baker, and the candlestick maker) that are directly
associated with the current contact. Note: You can't filter this tab.
Flip ahead a few pages to the “Corralling Your Secondary Contacts”
section in this chapter where I discuss the Secondary Contacts tab.

e Groups/Companies: This tab has a dual personality. You'll notice
the addition of the Show Membership For drop-down list that lets
you indicate whether you want to view the groups or the compa-
nies that the contact is associated with. This tab appears only in
the Contact Detail window.

\P
) The first five tabs appear on the Contacts, Groups, and Companies

windows. That’s because you can add a note, an activity, and so on to
either an individual contact record, or to a company or group record.

v~ User tabs: You can rename and modify these to best fit the way you
work. (See Chapter 13.)

Customizing Lists and Tabs

One of the reasons that you might find the lists and tabs to be so useful is the
ease with which you can customize them. You can add or remove columns,
change the order of the columns, widen the columns, sort on any one of the
columns, and then print out your final product. In this section, I cover a few
ways in which you can change the look of your lists and tabs.
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Figure 5-1:
Adding
columns to
the Contact
List.
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Adding or removing columns

Probably the first thing that you want to do to modify your lists and columns
is to add or remove a column — or two or three! Follow these steps:

1. Click the Options button (in the top-right corner) on any list or tab
and then choose Customize Columns from the menu that appears.

The Customize Columns dialog box appears (see Figure 5-1).

5] Customize Columns
Availablefields: Show as columns in this order:
Access Level i IsUser
Address 3 Private Contact
Alternate Extension Company
Alternate Phone Contact
Birth Date Phone
Country Extension
Create Date Title
Customer 1D Address 1
Department Address 2
E-mail << City
Edit Date - State
Fax Extension ZIP Code
Fax Phone i

Because variety is the spice of life, you right-clickers will also find that
you can right-click any of the ACT! lists or tabs to get to the Customize
Columns dialog box.

2. Select the field (column) that you want to add by clicking the appro-
priate choice in the Available Fields list.

Depending on the list or tab you’re working with, you see various field
choices. Feel free to include as many or as few as your little heart desires.

3. Click the single right-pointing arrow.

If you're really into seeing a lot of information, you can click the double
right-pointing arrows; that adds all available fields to your list or tab.

4. To remove an item, click the appropriate choice from the Show as
Columns in This Order list and then click the single left-pointing
arrow.

If you really want to get rowdy, click the double left-pointing arrows
to remove all the current fields. You might do this if you have an over-
whelming desire to start from scratch.

5. Click the Close button when you’re done.
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Changing the order and width of columns

You can change the order of the fields from the Customize Columns dialog
box that I show you how to access in the preceding section. Click the appro-
priate choice from the Show as Columns in This Order list and click the Move
Up or Move Down buttons.

The order in which items appear in the Customize Columns dialog box is
exactly the way they appear in your final product. Knock yourself out,
arrange and rearrange all you want, and sleep peacefully knowing that if you
don’t like the outcome you can always change it again. Now, if I could just do
that with my living room!

You can also drag and drop the various column headings to change the order
in which columns appear on the lists and tabs. For example, if you want the
Date field to appear before the Time field, simply click the Time column head-
ing and drag the heading over to the left of the Date column heading. When
you start to drag one of the columns, a black vertical line appears, indicating
the intended location of the column.

Changing the width of a column is just as easy. If you move your mouse on
the line between any two column headings, your cursor transforms into a
double-headed arrow. When that arrow appears, hold down your left mouse
button and drag to the left or right to narrow or widen a column. The column
to the left of your mouse changes width.

Sorting your lists and tabs

In general, | hate terms like automatic and click of a button because your
vision of aufomatic might be quite different from that of a software engineer.
That said, sorting the entries in any of your lists and tabs is, well, automatic
and can be done with the click of a button: Just click the column heading that
you want to use to sort the list. Want the contacts in your Contact List sorted
alphabetically by city? Click the City column heading. Change your mind and
want it sorted by ZIP code instead? Click the Zip Code column heading.

ACT! automatically separates the contact’s name into a first and a last name.
When you click the Contact column heading in any of the lists or tabs, you’ll
notice that your information is sorted by last name so that Andrea Fredricks

appears alphabetically with the Fs rather than with the As.

When you click a column heading, an up arrow appears indicating that the
contacts are sorted in ascending order (in alphabetical, A-Z, or 1-10 order).
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To reverse the sort order, click the column heading again. If the list is sorted
in ascending order, contacts that have no information in the selected column
appear at the top of the list. In descending order, they appear at the bottom
of the list.

Sorting your contacts is so simple that you might decide to get really adven-
turous and sort based on another criterion. Go ahead — I dare you! Click any
column heading to re-sort the list by the field of your choice. Want to have
your Contact List sorted by more than one criterion? Sneak a peak at the final
section of this chapter for a crash course.

Contacting the Contact List

|
Figure 5-2:
The ACT!
Contact List.
|

The Contact List is a good way to view your contacts if you're working with
large numbers of contacts at one time. Changing the columns that appear in
the Contact List provides you with a way of comparing information between
your various contacts. For example, you might want to see how many of your
contacts purchased each of your products, and have the name of each prod-
uct appear in the Contact List, along with their telephone number.

Getting to the Contact List is half the fun

The road to the Contact List is simple to follow — just choose View=>
Contact List. A list of your contacts appears, displayed in columns as
shown in Figure 5-2.

Company Contact +[city State. ZIP Code
Fitness First Boca Raton FL 1434
Swim & Raquet Center of Boca Raton Boca Raton FL
La Vie Nails Gm
Fenstersheib Law Offices Kalle Andromidas Boca Raton FL
Rare Coins & Precious Metals ‘Susan Beasi Boca Raton FL
Central Medical Group Joanne Bellitte Tamarac FL
Sage Software Jos Bergera Norcross GA
Sage Software Rich Carey Scottsdale g
Ashleigh Caronite Delray Beach FL
Sage Software Latishz Carter Norcross GA
JoAnne Chamar Boca Raton FL
Sage Software Victor P Chernauskas Jr Scottsdale g
Sage Software Julie DeMeuse Scottsdale g
Sage Software Bob Duff Norcross GA
Florida State University AlyssaFredricks Tallzhassee FL
University of Florida Andi Fredricks Westminister cA
Susan Harrington Delray Beach FL
Kahnvoiceovers Gary Kahn Phd New York NY
Sage Software Beth Kohler Scottsdale o
Brad and Lisa Kruse iL
Sage Software Meliss Lorch Carter Norcross Ga 20083
Sage Software Richard Mchakin
Sage Software Larry Ritier
Frank Semerau Thomson GA 30824
Tam O'Shanter Country Club John Steinman Pompano Beach FL
Sage Software Ian Vondrasek Scottsdale 5 25258
Sage Software Ja e Scottsdale o 85258
Kanouse & Walker Susan Walker Boca Raton FL
Skin Care by Nancy \wilson Nancy Wiilson Delray Beach FL 334458748
Geldstein Lewin & Co. Norma \wolpin Boca Raton FL 23431
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When you come across a contact record in your list that requires a bit of
tweaking, you might want to flip to the Contact Detail window to make your
changes. You can get to the Contact Detail window in a number of ways:

v Double-click a contact in the Contact List.
+~ Right-click the contact and choose Look Up Selected Contacts.

1 Click the Back button on the Back and Forward bar if you were just in
the Contact Detail window.

The Contact Detail window appears with the selected contact’s record. To
return to the Contact List, choose View=>Contact List or click the Back button
on the Back and Forward bar.

Finding a contact in the Contact List

In Chapter 6, I show you how to create a lookup to find contacts that meet
your specific criteria. The Contact List also allows you to go to a specific con-
tact record in the blink of an eye. Here’s what you need to do:

1. Click the column heading to select that column.

For example, if you want to find a contact by last name, click the Contact
column heading.

2. Start typing the first few letters of the contact information that you
want to find in the Look For text field.

ACT! scrolls down the Contact List to the closest match. For example, if
you sorted the list by contact and typed the letter s, you might land on
the Colonel Sanders contact record. If you typed sm, you're probably
looking at all your Smiths.

3. Continue typing until you reach the contact for whom you are looking.

Tagging contacts in the Contact List

Using the Contact List, you can easily select — or tag — contacts to manually
create a lookup of your contacts. For example, say that you want to target
some of your best clients for a special promotion; a general lookup probably
doesn’t produce a list of those contacts because you don’t have a field that
includes special promotions. Instead, you can tag those contacts based on
your own instincts.
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To switch to Tag mode, just make sure that a check mark is showing next to
the Enable Tag Mode option, which is located at the top of the Contact List.
You can do the following things in Tag mode:

v~ Tag a contact. Click anywhere in the contact; a gray bar appears across
the contact record indicating that you tagged it. Figure 5-2 shows tagged
contacts.

v~ Untag a contact. Click anywhere in a tagged contact, and the gray bar
disappears.

1 Tag a continuous list of names. Click the first name in the list that
you're selecting, and then press the Shift key while clicking the last
name in the list that you're selecting. All the names between the first
name and the last name that you're selecting are automatically tagged.

Notice the four buttons to the right of the Enable Tag Mode option. After you
tag the contacts that you want to work with or those that you want to omit
temporarily, choose one of the following four buttons:

v~ Tag All: Allows you to select all the contacts currently showing in the
Contact List.

v Untag All: Allows you to deselect any contacts that you already selected.

v Lookup Selected: Allows you to create a lookup based on the contacts
that you tag.

v Omit Selected: Allows you to remove the contacts that you select from
the Contact List. Don’t panic — it does not remove the contacts perma-
nently from your database!

If you need to print out any lists or tabs, flip to Chapter 9 for the lowdown on
Quick Reports.

Corralling Vour Secondary Contacts

Does this scenario sound familiar? You have a main contact, but of course
that person, being the big cheese, is rarely available, so you often have to
work with his assistant. But of course, the assistant can’t do any true deci-
sion making, so you might need to speak to Mr. Big’s sales manager on occa-
sion. And, when the sales manager goes on vacation, you need to call the
assistant sales manager. Yikes! The Secondary Contacts tab, as shown in
Figure 5-3, allows you to store all the pertinent information about Mr. Big and
his partners in crime in the same area so you don’t have to go on a wild
goose chase hunting down names, telephone numbers, and e-mail addresses.
And, just like promotions that often happen, you can “promote” a secondary
contact into a main contact.



Chapter 5: A Few Good Tabs and Lists 6 7

|
Figure 5-3:
The
Secondary
Contacts
tab.
|

\\3

|
Figure 5-4:
Fill in
secondary
contact
information
here.
|

Notes || History || Activities | Opportunities || Groups/Companies | Secondary Contacts | Documents | Contact Info | User Fields || Home Address

New Secondary Contact Promote Options ~
B [Company Contact [ Title Phone City State

Voice Over New York \rlendy Dylan VO Diva (212)555-1234  New York NY

Tumn Me On Productions Leonard Kravitz Soul Man (561) 3451234 Miami FL

Tour de Lance Lance Livestrong Bike Boy Austin T

The Seeger Sessions Bruce Springstein The Boss Asbury Park N

My Maseratti-185 Joe Wilsh Master Hotel CcA

Tagged contact

Not sure whether you should add a contact as a primary or a secondary con-
tact? You might want to think of how you are going to use the secondary con-
tact. If you just want to be able to access an assistant’s phone number, then
the assistant is a good candidate for entry as a secondary contact. However,
if you want to be able to e-mail your monthly newsletter to the assistant or
include her in some of your mail merges, you need to add the assistant as a
primary contact record instead.

Adding a secondary contact

Of course, you can’t add a secondary contact until you create a main contact.
(See Chapter 4 to do so.) After you create the head honcho’s contact record,
here’s what you do to create the secondary contact record(s):

1. From the Contact Detail window, click the Secondary Contacts tab.

2. Click the New Secondary Contact button on the top of the Secondary
Contacts tab.

The Secondary Contacts dialog box appears (see Figure 5-4).

Secondary Contacts

Company: ‘ The Seeger Sessions |

Contact: ‘Bruce Springstein |

Title: ‘ The Boss v |

Phone: [ (s55) 888-1212 [ B |

Phone/E-mail | Business Address

Address: | The Stone Pony

City: | Asbury Park v
State: NI ~| Zip Code: l:l
Country: | v |




O8  Partil: Putting the ACT! Database to Work

3. Fill in all the juicy details for the secondary contact.

Although you don't fill in quite as much information as you can for a
main contact, you do have all the really pertinent fields. Don’t forget to
click the Business Address tab for even more fields.

4. Click OK to create the secondary contact.
Congratulations! Your main contact has now given birth to a secondary con-

tact. All the secondary contacts that you create appear on the Secondary
Contacts tab of the primary contact.

If you need to go back and edit or add information for the secondary contact,
just double-click the name from the Secondary Contact List and voila, you're
back to the Secondary Contact dialog box.

Deleting a secondary contact

Sorry to say, but some of the secondary contacts might drift off into the
sunset, leaving you with the need to remove them from your database. Not to
worry; you can delete a secondary contact by following the bouncing ball
through these steps:

1. Click the Secondary Contacts tab from the Contact Detail window.

2. Right-click the contact you want to delete and then choose Delete.

You can never say that ACT! doesn’t give you ample warning before
deleting a contact. As usual, when you attempt to delete even a sec-
ondary contact, ACT! shows you a scary warning.

3. Click Yes to delete the selected secondary contact.

Promoting a secondary contact

Promoting, promotion — it has a lovely ring to it, don’t you think? That lowly
assistant might be promoted through the ranks and some day become the
“big guy” — or at the very least a more important contact than he/she is
today. If you're worried that you have to reenter all that basic information
again, don’t be. Just promote the contact by following these steps:

1. Click the Secondary Contacts tab in the Contact Detail window.
2. Select the secondary contact that you want to promote.

3. Right-click and choose Promote from the menu.

The Promote Secondary Contact dialog box appears, as shown in
Figure 5-5.



|
Figure 5-5:
Promote a
secondary
contact
here.
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Promote Secondary Contact

‘\when prometing a secondary contact, you have the option to copy data from
the main contact’s primary fields to the secondary contact fields. Primary
fields are displayed in Define Fields

Options

(%) Duplicate data from main contact's primary fields

(O Do net duplicate data from primary fields

4. Select whether to duplicate the main contact’s primary fields.

With promotions come responsibilities and decisions. If the secondary
contact is sliding into the role of the current primary contact, you want
to copy all the primary contact’s information to the record of the newly
promoted contact. If, however, the secondary contact doesn’t have the
same basic information as the primary contact, you can choose to not
copy the primary fields.

5. Click OK.

Documenting Vour Documents

|
Figure 5-6:
Locate
documents
from here.
|

No matter how organized you think your documents might be, you probably
occasionally misplace one of them. Of course you can always have Windows
search for it, but ACT! offers an easier — and faster — solution. The Documents
tab, which you can find on the Contacts, Groups, or Companies windows,
allows you to attach any and all of your files related to the current contact,
group, or company. You can add a proposal created in Excel, a contract cre-
ated in Word, or even a PDF file that you scanned into your computer. By
adding them to the Documents tab, as shown in Figure 5-6, you are actually
cloning the original file and placing it in your ACT! database.

Notes | History | Activities | Opportunities || Groups/Companies | Secondary Contacts | Documents | Contact Info || User Fields | Home Address
[Z Add Document

] [Name +[Size File Type

5 | Water lilies.jpg 82 KB JPEG Image

) | userguide.pdf 2,808 KB Adobe Acrobat Document

thankyouletierwidget ADT 11KB ADT File

%] | order_2_slice.gif 1KB GIF Image

] | BFC_Skeletondls 2K Microsoft Excel Worksheet

T | ACT! QuickStart for QuickBooks.pdf | 59 KB Adobe Acrobat Document

After you add a document to the Documents tab, you can open the file
directly from ACT! to view, edit, or print. You can also link the same docu-
ment to multiple records. Removing a file from the Documents tab does not
remove the original document from your computer.
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Adding a document

Adding a file to the Documents tab is very easy, and considering the time you
save down the road, well worth the effort. Just follow these steps:

1.

Display the contact, group, or company record to which you want to
add a document.

2. Click the Documents tab.

. Click the Add Document button on the Documents tab icon bar.

Alternatively, you can right-click in the file list area and then choose Add
Document from the menu.

The Attach File dialog box opens.

. Browse to the document you want to add, select it, and then click Open.

ACT! adds the document to your ACT! database and displays the file-
name, size, type, and last modified date on the Documents tab. Because
the document is now part of your database, remote synchronization
users can now access the document as well.

You can also drag and drop a file to the Documents tab from Windows
Explorer or My Computer by dragging the document’s icon to the
Documents tab.

Opening a document

The true benefit of adding documents to the Documents tab is the speed in
which you can open the documents that pertain to a specific contact, group,
or company. Follow these steps:

1. Click the Documents tab.

2. Select the document you want to open.

3. Click the Edit Document button on the Documents tab icon bar.

Alternatively, you can right-click in the file list area and choose Edit
Document from the menu. Or, if variety is the spice of your life, simply
double-click the filename to open it.

Magically, the program associated with the document opens, revealing
the document. You're on your own here — just remember that you can
now edit, save, or print the document as you normally would. Any
changes you make are reflected the next time you open the document
through ACT!.
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Removing a document

After you add a file to the Documents tab, you might change your mind and
decide to make it go am-scray. Easy come, easy go. Follow these steps to rid
yourself of the offending document:

1. Display the contact, group, or company record that contains the docu-
ment you want to eliminate.

2. Click the Documents tab.
3. In the Document List, select the document you want to remove.
4. Click the Remove Document button on the Documents tab icon bar.

Alternatively, you can right-click in the file list area and then choose
Remove Document from the menu.

ACT! makes sure you want to remove the document by presenting a
warning. Software programs very often present you with scary messages
before deleting important information. This is a good thing. Heed the
warnings!

ACT! deletes the document permanently from the database. And
because the document doesn’t end up in the Recycle Bin, think very
carefully before deleting the document.

5. Click Yes to confirm that you really, truly want to remove the
document.

If you originally created the document somewhere in your computer, the doc-
ument is still there. Changes made to the cloned copy in ACT! do not affect
the original document. Too, deleting the document in ACT! does not delete
the original document.

Changing the Sort Order

By default, ACT! automatically sorts your data alphabetically by the company
name. If you open the Contact List, you see your contacts listed there in com-
pany order. Scroll to the first contact in the Contacts view — that contact
probably works at a company that starts with the letter A. But, like just about
all of ACT!, you can change that order.

Although the Contact List provides you with a quick-as-a-bunny way to sort
your contacts, it sorts the contacts based on the contents of a single field. If

/1
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|
Figure 5-7:
Set your
sort here.
|

\\3

you want to sort your contacts based on multiple criteria, you have another
way to do it:

1. Choose Edit=>Sort from either the Contact List or Contact Detail
window.

The Sort dialog box appears (see Figure 5-7).

27 Sort
Sort by: State + | |Ascending i
and then by: Compary w | | Ascending i
and finally by: || a5 Name | |Ascending -]

2. Choose an option from the Sort By drop-down list to specify the first-
level sort criterion.

3. Select the sorting order (Ascending or Descending).

Ascending sort order means from A-Z or from the smallest number to
the largest number. Records with no information in the field used for the
sort appear first. Descending means from Z-A or from the largest number
to the smallest number. Records with no information in the field used for
the sort appear last.

4. Choose a second field option from the And Then By drop-down list
and specify Ascending or Descending.

5. If you want a third level of sorting, choose a field from the And
Finally By drop-down list and specify Ascending or Descending.

6. Click OK.



Chapter 6

The ACT! Lookup: Searching
for Your Contacts

In This Chapter
Understanding the basic ACT! lookup
Querying companies, groups, and opportunities
Special searching

Performing advanced queries

If all roads lead to Rome, then surely all processes in ACT! lead to the
lookup. A lookup is a way of looking at only a portion of the contacts in
your database, depending on your specifications. A good practice in ACT! is
to perform a lookup first and then perform an action second. For example,
you might perform a lookup and then print some labels. Or you might do a
lookup and then perform a mail merge. Need a report? Do a lookup first! In
this chapter, I show you how to perform lookups based on contact informa-
tion, notes and history information, and advanced query information.

ACT! Is Looking Up

The theory behind the lookup is that you don’t always need to work with all
your contacts at one time. Not only is working with only a portion of your
database easier; at times, doing so is absolutely necessary. If you're changing
your mailing address, you probably want to send a notification to everyone in
your database. Comparatively, if you're running a special sales promotion,
you probably notify only your prospects and customers. And if you're send-
ing overpriced holiday gift baskets, you probably want the names of only
your very best customers.



74

Part II: Putting the ACT! Database to Work

Don't create an extra database —
Use the ACT! lookup instead

Some ACT! users originally create several data-
bases, not realizing that one database can be
used to store information about various types
of contacts. Although you might want to create
two separate databases — for instance, one for
customers and one for vendors — a better
alternative is to include both your customers and
vendors together in one database. To this one

contacts, including prospects who aren't yet
customers or referral sources that might lead to
new customers. Just make sure that each con-
tactis identified in some specific way; | recom-
mend using the ID/Status field. Then when you
want to see only vendors or only prospective
customers, simply perform a lookup to work
with just that particular group of contacts.

database, you can then add a few miscellaneous

\P
) Most computer programs use the term qguery to indicate the result of a data-

base search. However, ACT! generally uses the term lookup. Feel free to use
the terms interchangeably.

In ACT!, you can focus on a portion of your contacts by

v Creating basic lookups based on the information in one of the ten most-
commonly used contact fields in ACT! or from any one of your ACT! con-
tact fields. (See the later section, “Performing Basic Lookups.”)

v Conducting a query based on information stored in your groups, compa-
nies, and opportunities. (See the later section, “Searching Your Groups,
Companies, and Opportunities.”)

v Creating lookups based on information from other areas in your data-
base including notes, histories, activities, annual events, and contact
activity. (See the later section, “Performing Special ACT! Lookups.”)

v Creating your own, more advanced, queries based on the parameters of
your own choosing by using logical operators. (See the later section,
“Creating Advanced Queries.”)

Performing Basic Lookups

The easiest way to pose a query is to choose one of your main contact fields
from a menu and then fill in the search criteria. Although this way is easy
because the menus guide you, it’s also the least flexible way. The Lookup
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menu that ACT! provides is probably the best — and simplest — place to
start when creating a lookup; just follow these steps:
1. Choose the Lookup menu from the Contact Detail window.

Figure 6-1 shows you the Lookup menu that drops down and the criteria
that you can use to perform your lookup.

Lookup | Contacts Groups Schedul
My Record

All Contacts
Contact...
Company...

First Name...
Last Name...
Phone...

City...

State...

Zip Code...

1D/ Status...
E-mail Address...
Other Fields...

®

\
>

Groups »

=l
i3]

Companies 3

E]

Opportunities 3
i Keyword Search...
(| Annual Events... Ctrl+Shift+A

o)

|
Figure 6-1:
Define your By Example...
lookup here. Contact Activity...
— Advanced

2. Choose one of the criterion listed in Figure 6-1 to create a basic
lookup.

The ACT! Lookup Contacts dialog box appears, as shown in Figure 6-2.

Lookup Contacts

Look in this field Search for
City v ® oty
| Albarny v

Figure 6_2. For the cument lookup () Empty field
The ACT' Replace Lookup ha ) Non-empty figld

Replace Lookup
Add to Look
LOOkU p Narm?\' Lnﬂoklilpn
Contacts

dialog box.
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3. If you're searching based on an Other field, click the Look in This
Field drop-down arrow and choose a field from the drop-down list.

P If you come from a long line of right-clickers, you might prefer to simply
right-click whatever field for which you want to create a lookup and then
click Lookup. Sharp as a tack, ACT! opens up the Lookup Contacts dialog
box with your field already selected in the Look in This Field text box.

4. In the For the Current Lookup area, select an option:

e Replace Lookup: Creates a brand-new lookup based on your
criteria.

e Add to Lookup: Adds the contacts to an existing lookup based on
your criteria. For example, if you create a lookup for your contacts
based in Chicago, select this option to add your New York clients
to the set of Chicago clients.

e Narrow Lookup: Refines a lookup based on a second criterion. For
example, if you create a lookup of all your customers, you could
select this option to narrow the lookup to only those customers
based in Philadelphia.

5. In the Search For area, select an option:

e Field Name: The label for this field changes depending on the field
you choose in Step 2 or 3. In Figure 6-2, [ am searching for a com-
pany name, so the field name reads Company. Choosing this option
makes a blank field magically appear. Type the word to search for
or select a word from the drop-down list to look for contacts that
match a specific criterion.

e Empty Field: If you're looking for contacts who don’t have any data
in the given field — for example, people who don’t have an e-mail
address — choose this option.

e Non-Empty Field: If you want to find only those contacts who have
data in a given field — for example, everyone who has an e-mail
address — choose this option.

P When typing in the match criterion, remember that with ACT!, less is
more. ACT! automatically searches by the beginning of your string. For
example, in the sample database for this book, typing Tech returns Tech
Benders and Technology Consultants. However, typing Technology
returns only Technology Consultants.

6. Click OK.

If only one contact record matches your search criteria, that’s the
record that you see. However, if several contact records match your cri-
teria, the Contact List appears with a list of all your matches. In either
case, the record counter now reflects the number of contacts that match
your search criteria.

7. (Optional) Choose Lookup=>All Contacts when you’re ready to once
again view all the contacts in your database.
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Playing the wild card

Some of you old-timers might remember that
an asterisk (*) was the DOS wild card. That
same concept exists in Structured Query Lan-
guage (SQL)-based products like ACT! —
except that the percent sign (%) replaced the
asterisk (for some reason known only to the
technical gods).

Say you’re trying to find all companies that
are carpet cleaners. If you create a lookup with
the word carpet, you find Carpet Cleaning
by Joanne Chamar but not Joanne's Carpet
Cleaning. Enter the wild card and create your
lookup with %carpet. ACT! finds companies that
both begin and end with carpet.

/7

P Don’t panic right after performing a lookup, wondering what happened to the
rest of your contacts. You can always reassure yourself by doing a lookup of
All Contacts after each and every one of your lookups. Although this won'’t
hurt anything, this step is entirely unnecessary. After you finish working with
your current lookup, you can simply wait until you need to create another
lookup. Just do a lookup for your next criterion and save yourself a step.
Confused about the criteria that you used in creating your lookup? A gander
at the bottom-left corner of either the Contact Detail or Contact List screens
indicates the search criteria that you used.

Searching Vour Groups, Companies,
and Opportunities

Probably the most common lookups you create are based on your contact
fields. However, you aren’t limited to searching by just those fields. You can
also query your groups, companies, and opportunities for key information.
The best part is that all three queries work in pretty much the same way.

Grappling with your groups

When performing a Group lookup, you might look for the name of one spe-
cific group or for a group or groups that all contain the same information. In
other words, I might look for all groups whose names start with Technology,
or I might look for all groups that are located in New York City. To find the
groups that match your search criteria, here’s all you need to do:

1. Choose Lookup~>Groups and then choose from the following options:

e All Groups: Opens the Group List showing you a list of all the
groups in your database.
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e Name: Finds all groups that match the name you specify.

e Other Fields: Allows you to search through any and all group fields
for the groups that match your desired criterion. The list shows all
group fields that you can search in the database.

e Save Lookup as Group: If you just created a lookup (as described in
the preceding section) and want to save your results into a new
group, this is your option. You can also see other ways to create
Groups in Chapter 19.

If you choose the All Groups or Save Lookup as Group option, you're fin-
ished. If you choose the Name or Other Fields option, the Lookup
Groups dialog box opens, as shown in Figure 6-3. You have to continue
along your merry way following these remaining steps.

Lookup Groups
Look in this field Search for
Group Name v (®) Group Name
prospect v
[ Far the cument loakup () Empty field
- Replace Lookup A () Non-empty field
Figure 6-3:
The Lookup
Groups
dialog box.
I

2. In the Look in This Field area, select the Group field you want to
query from the drop-down list.

3. In the Search For area, type the word to search for or select a word
from the drop-down list.

4. In the For the Current Lookup area, select the Replace Lookup option.
5. Click OK.

Like magic, the Group List pops open, displaying a list of all the groups
that match your specifications.

Calling all companies

Hopefully, creating a lookup of companies seems vaguely familiar because it
is so similar to creating a group lookup. To find the companies that match
your search criteria, here’s all you need to do: Choose Lookup>Companies
and then choose from one of the options. The choices are almost identical to
the contact lookup choices and include the ability to search for all companies
or by company name, phone number, city, state, ZIP code or ID/Status. You
even see the Save Lookup as Company option that lets you create a company
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based on the currently displayed contact. In Chapter 20, I show you other
ways to create a company.

The Company Lookup works the same way as the Group Lookup. If you
choose the All Companies or Save Lookup as Company option, you're fin-
ished. If you choose any of the other options, the Lookup Companies dialog
box opens. From there, you can follow the same steps that you did for the
Group Lookup.

Ogling your opportunities

Those of you who won’t be using ACT! to help keep track of all your past,
pending, and future sales can skip this section. However, if your company has
an active sales force, you’ll want to run (don’t walk) to Chapter 18 to read
everything there is to know about ACT!’s cool Opportunity feature. After an
opportunity is created, you can search through all your sales opportunities in
a variety of ways.

1. Choose Lookup~>Opportunities.
2. Choose one of the following options:

¢ All Opportunities: Opens the Opportunity List, showing you a list of
all the opportunities in your database.

e Name: Finds opportunities that match the name you specify.
Typically, you want to use the quote number as the name of your
quote so that you can look up based on that criterion. Chapter 18
shows you how to name your quotes.

e Stage: Finds opportunities that match a specific sales stage.
¢ Product: Finds opportunities that pertain to a specific product.

¢ Total: Finds opportunities that match the total sale you specify.
You can also search for opportunities that are larger or smaller
than a specified dollar amount.

e Status: Finds opportunities that match a specific sales status.

¢ Record Manager: Lets you find any of the opportunities that are
associated with any one particular user.

e Other Fields: Finds all opportunities that match any other oppor-
tunity fields, including the eight opportunity fields that you can
customize.

If you choose the first option, you're whisked away to the Opportunity List.
If you opt for one of the other options, the Lookup Opportunities dialog
box appears, as shown in Figure 6-4. If you're getting bored, I apologize —
ACT! s just so darned consistent that you're probably finding that query-
ing your sales opportunities is every bit as easy as any of the other
lookups I cover throughout this chapter.
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Lookup Opportunities
Look in this field Search for
Product Name w (%) Product Name:
“basket v
For the cument lookup () Empty field
Replace Lookup hd () Non-empty field

Cancel

3. From the Look in This Field drop-down list, select the field on which
you want to search.

The list shows all opportunity fields that you can search.

4. In the Search For area, type the word to search for or select a word
from the drop-down list.

For example, if you're looking for all opportunities that are in the
Negotiation stage, select Stage from the Look in This Field drop-down
list and Negotiation from the Stage drop-down list. To find out how well
your various gift baskets are selling, choose Product Name from the Look
in This Field drop-down list and type %basket in the Product Name box.

The percent sign (%) is the wild card that allows you to search for all
your baskets, including Balloon Basket and Birthday Basket
Extraordinaire. For more information on using the percent sign, see the
sidebar, “Playing the wild card,” earlier in this chapter.

5. Select Replace Lookup from the For the Current Lookup drop-down list.
6. Click OK.

Although you might be as happy as a little clam when you’re using the
Opportunity lookup, you can achieve the same results by filtering your
Opportunity List. Filtering might even make you ecstatic because you’ll prob-
ably find it a bit easier and much more flexible. Chapter 5 shows you how to
filter your Opportunity List. Chapter 18 will further astonish you when it
reveals some of the other great Opportunity party tricks!

Performing Special ACT! Lookups

The ability to perform a simple lookup based on a single field criterion is an
element common to most databases, but ACT! isn’t your average database.
All databases contain fields, but only special databases contain things such
as notes and activities. And after creating a note to store a useful tidbit of
information (which I show you how to do in Chapter 7), you might want to find
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|
Figure 6-5:
Run a
keyword
search

from here.
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that information again. Some of you might want to use ACT! to send monthly
birthday and anniversary greetings. ACT! provides you with three special
query options to find information that was entered into ACT! in a special way.

Searching by keyword

A keyword search can be an extremely useful way to find data about your con-
tacts no matter where that information might be lurking. In fact, I've gotten
many ACT! users to start calling this search the “Senior Moment” search.

As your database increases, you might find yourself in a situation in which
you can remember only one tiny piece of information about a contact. ACT!s
keyword search enables you to dig for that information in the Activities,
Opportunities, Histories, Notes, and Fields portions of ACT!. For example,
suppose that you're looking for someone to design a new logo for your busi-
ness but you can’t remember where you stored that information. Is logo part
of the company’s name, did you enter it into the ID/Status field, or did you
stick it in a note somewhere? A keyword search searches throughout your
database, checking all fields, until it finds the word logo.

Here’s how to perform a keyword search:

1. From the Contact Detail window, choose Lookup~>Keyword Search.

The Keyword Search dialog box opens (see Figure 6-5).

a7 Keyword Search =@

Search

Stone Pory ~

Search these records Look in _

Create Lookup

Record type Activities

(®) All contacts Histories

() Currert contact Notes

) Cumert lookup Eielas

Contact Company Field Data

k2 Fredricks, Alyssa Florida State University Activity Location the Stone Pony
[ Kahn, Gary Kahnvoiceovers Opportunity Details  To be delivered to the Stone Porry
‘@ Fredricks, Andi University of Florida Regarding Meeting held at the Stone Pony

£ Kahn, Gary Kahnvoiceovers MNote He mentioned that his favorite hang
@ Boss, The The Stone Pony Company The Stone Pony

# Bruce Springstein  The Seeger Sessions Secondary Address_. The Stone Pony
@ Fredricks, Karen Tech Benders Referred By The Stone Pony
7 tems Found
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2. In the Search For area, enter the key piece of information that you’re
searching for.

3. In the Record Type drop-down list, indicate whether you’re looking
for a Contact, Group, or Company record.

4. In the Search These Records area, choose an option.

You can have ACT! search through All Contacts, the Current Contact, or
the Current Lookup.

5. In the Look In area, select all options that apply.

The keyword search is a powerful searching tool, and it does take a bit
longer to run than other searching methods. When you perform a key-
word search, ACT! sifts through every last bit of information in your

@ database, hoping to find a match that fits your specifications.
)

To speed up the process, limit the amount of elements to search. You
can limit your search to Activities, Opportunities, Histories, or Fields.

6. After making all your choices, click the Find Now button.

ACT! responds with a list of records, similar to what’s shown in Figure 6-5.
The lookup results show the contact’s name and company, the field in
which ACT! finds the matching data, and the data that it finds.

7. Decide what you want to do with the results.

Like the old saying goes, be careful what you search for because you just
might find it! Okay, the saying doesn’t go exactly like that, but after you
find a number of records via the keyword search, you must decide which
one(s) to focus on. Here are some of your options:

e All records: Click the Create Lookup button to see all the records in
the Contact Detail window. This is by far the coolest choice. When
ACT! places you in the Contact Detail window, your search crite-
rion will be selected. So, if you search for basket, ACT! might just
land you on the contact’s Opportunities tab with the appropriate
opportunity highlighted. If, however, the contact’s company name
contains basket, ACT! highlights that field in the Contact Detail
window.

e Single records: Double-click any part of a single record, and you
land on that contact record. To get back to your search, double-
click the Keyword Search tab that now appears in the bottom-left
corner of the Contact Detail window.

® Multiple adjacent records: Select multiple adjacent records by click-
ing the first record, pressing Shift, and then clicking the last
record. Right-click one of your selections and choose Lookup
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|
Figure 6-6:
The Annual
Events
Search
dialog box.
|

Selected Records. You now have a lookup that consists of only the
contacts that you selected.

e Multiple non-adjacent records: Select records that aren’t adjacent by
clicking the first record, pressing Ctrl, and then clicking the other
records that you want. Right-click one of your selections and
choose Lookup Selected Records. You now have a lookup that con-
sists of only the contacts that you selected.

Annual event lookups

In Chapter 12, I show you how to create Annual Event fields. Annual events
help automate the processes of tracking important dates, such as birthdays
or anniversaries. When you enter a date in an Annual Event field, ACT! auto-
matically tracks the event date from year to year. Because annual events don’t
appear on your calendar, you must perform an Annual Event lookup to display
them. You can use the Annual Event lookup to generate a printed list to dis-
play events for the current week, the current month, or a specified date range.

Combining the power of an Annual Event lookup with an ACT! mail merge is a
great way to save lots of time. Birthdays and anniversaries are good examples
of annual events; like it or not, they happen once per year. The Annual Event
lookup tracks them all down regardless of the year. You fellows out there will
be happy to know that you need only ask a woman her birthday because the
year is optional. (I show you how to perform a mail merge in Chapter 10.)

Here’s all you need to do to create an Annual Event lookup:

1. From the Contact Detail window, choose Lookup~>Annual Events.

The Annual Events Search dialog box opens, as shown in Figure 6-6.

-/ Annual Events Search [S[E]
Bith Date v :
e
O Curent Week
Ot it
(® Date Range Schedule To-do

1720 o 331200

— - -

Contact Company Phane Birth Date
Emily Dunn Boomer's Artworx
Joanne Bellite  Central Medical Group
Sarah \whiting CH Gourmet Gifis
Morty Manicotti Corleone’s Pasta Company (4
Alyssa Fredricks  Florida State University
Todd Homsby ~ Harbor Lights Restaurant
Gary Kahn Kahnvoiceovers 91
John Steinman Tam O'Shanter Country Club 56
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2. Select an annual event from the Search For drop-down list.

If you've added more than one annual event field to your database, you
can search for more than one of them at a time by selecting each one or
by selecting the All option to search through all your annual event fields.
For example, you might want to find everyone who has either a birthday
or an anniversary in the month of June.

3. Choose a Time Range option in which you want to search.
Your options are the current week or month, or a selected date range.
4. Click the Find Now button.

The results appear in the lower half of the Annual Events Search dialog
box. Your results vary, depending on the number of contacts that meet
your search criteria. And, as you might notice in Figure 6-6, the results
are based on the day and month but not on the year. If no contacts meet
your search criteria, you receive a message nicely telling you so.

5. Select one of the following option buttons:
® Go To Contact: Go to the contact record of the selected contact.

¢ Create Lookup: Create a lookup of all the contacts. Now that you
have a list of all the contacts that match your date range, you can
easily print out a set of labels (Chapter 9) or send out personalized
birthday e-mails (Chapter 10) based on this lookup.

e Schedule To-Do: Schedule an activity for the selected contacts.
Unfortunately, you can schedule an activity for only one contact
at a time.

e Print List: Print a list of the contacts.

Searching by contact activity

I've often estimated that at least 20 percent of the average database consists
of long-lost contact information. You can either ignore these forlorn contacts,
or you might realize that there’s gold in them thar hills! What if you could find
all the contacts that you haven’t contacted in, say, the last two years? Chances
are that many of those contacts will be glad to hear from you. Maybe they
lost your contact information or chose a company other than yours that they
weren’t happy with. Suddenly those “lost” contacts have become a virtual
treasure trove.

You can create a lookup of contacts based on the last time that you made any
changes to their record or contacted them through a meeting, call, or to-do.
You can look for the contacts that either have or have not been changed
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within a specified date range. You can also narrow the search according to
activity or history type.

To create a lookup by contact activity, follow these steps:

1. Choose Lookup->Contact Activity.

The Contact Activity dialog box opens, as shown in Figure 6-7.

Contact Activity
Look for Contacts that have
(%) Not Changed
() Changed
Since Date
1/1/2005 v
Search In
Contact fields
Notes
Opportunities
Histories
Al v
Activities
Al v

2. Select either Not Changed or Changed in the Look for Contacts That
Have area.

The neat thing about using the Contact Activity lookup is that you can
look for “touched” or “untouched” contacts. In other words, you can
search for all the contacts that you contacted in a certain time frame or
for all the contacts that you haven’t contacted in a certain time frame.

3. Select a date.

The date tells ACT! to look for records that have been changed — or
have not been changed — since that date. In Figure 6-7, I'm looking for
contacts that [ haven’t changed since January 1, 2005.

4. Select one or more options in the Search In area to narrow your search.

You can search in the Contact fields, Notes, Opportunities, Histories, or
Activities areas of ACT!.

If you decide to search through your History and/or Activities tabs, you
can even indicate which specific types of histories or activities you want
to include in your search.
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Many users make the mistake of using only a portion of ACT! — and
then find out later that they can’t take advantage of some of its coolest
features. In order for this search to work, you have to input information
in the appropriate spots. For example, you can’t look for modified
Opportunities if you never created them!

5. Click OK.

ACT! searches for the selected field or activity that was/was not modi-
fied within the specified date range. The Contact List appears and dis-
plays your selection.

ACT! searches through all your contact fields, notes, histories, and
opportunities, so it might take a moment or two to create your search
results. Relax and practice a few deep-breathing exercises while you wait.

In Chapter 4, I mention some of the system fields; these are the fields that
ACT! fills in for you automatically. These fields are easily identifiable because
they are grayed out. Although you can’t change the information in these
fields, you are free to create lookups on them. For example, every time you
change any of the information for a contact, ACT! automatically updates the
Edit Date field. Feel free to give any of the system fields a right-click and
search on them. For example, if you're looking for all the contacts that have
been created since before or after a given date, give the Create Date field a
right-click!

Creating Advanced Queries

You might want to consider the two lookup options in this section to be
“powerful” but not “advanced;” many of you might associate advanced with
difficult, and that is certainly not the case here.

If you need to base your lookup on multiple criteria, you can perform a basic
lookup and then use the Narrow or Add To Lookup options in the For the
Current Lookup drop-down list (refer to Figure 6-2) in the Lookup Contacts
dialog box to create a more specific search. This option works fine if you're
willing to create several lookups until you reach the desired results. A better
alternative is to use a query to create a lookup. A query searches all the con-
tacts in your database based on the multiple criteria that you specify and
then creates a lookup of contacts that match those criteria.

Looking up by example

The Lookup by Example function allows you to create an exact profile for the
contacts you're hoping to find. For example, you might want to have a look
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at all customers in the state of Arizona who originally found out about you
through a phone book advertisement. When you create a Lookup by Example,
ACT! responds by presenting you with a blank contact record and lets you
specify the fields and values that define the query.

This is what you do:

1. Choose Lookup~>By Example.

The Lookup By Example window opens. The Lookup By Example
window, as shown in Figure 6-8, looks just like any other contact record
with one major difference — all the fields are blank.

@ Lookup By Example
Lookup By Example
Type one keyword per field o perform a lookup. To use more than one keyword per field, click the Advanced Query bution
-~
py Address E-mail
Messenger ID
ion
v Gty ~|  ID/Status Customer
ment v State AZ v Spouse
[ ext] ZIP Code Birthday

G Country " ReferredBy | Phone Book

[} Web Site
bsults || v Edit Date [
< >
Notes | istory | Activities || Opportunities || Groups || Secondary Contacts | Documents || Contact Info | User Fields | Home Address

2. Click in the field that you want to query.

You can create a query on virtually any field in your database. Don’t forget
to check out some of those neat fields that might be located on your vari-
ous layout tabs. For example, the Contact Info tab contains the Record
Manager and Create Date fields, which are common things to query.

3. Fill in any criteria on which you want to search.

Fill in as many criteria as you need. The whole purpose of doing a
Lookup by Example is that you're looking for contacts that fit more than
one criterion. If you're looking for all customers who are located in
Arizona, type customer in the ID/Status field and AZ in the State field.
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4. Click the Search button when you’re ready to put ACT! to work dig-
ging through all your contact records.

ACT! happily displays a list of all the contacts that match your search
criteria in the Contact List.

The Advanced Query

After you use your database for a while and it slowly but surely fills up with
more and more contacts, you might feel the need to add a little more power
to your lookups. You also might find yourself constantly creating the same
lookup and wish to save it to save yourself a little time later on. In fact, you
might even start using the term query, which is computer-speak for fancy
lookup. Fortunately for you, although an Advanced Query packs a lot of
power, it’s still a piece of cake to run. Just follow these steps:

1. Choose Lookupr>Advanced=>Advanced Query.

The Advanced Query window opens, as shown in Figure 6-9.

¥ Advanced Query
File
D2R
Select criteria to find contacts.
Type Field Name: Operator Value:
Conizc > v > v
( [Type Field Name Operator Value ) |AndiOr
( Contact State Equal To (=) OR or
Contact State Equal To (=) CA or
Contact State Equal To (<) FL ) And
Contact E-mail Contains Data Nothing And
Opportunity Product Name Contains basket End
|
Remove Al
Figure 6-9: Frovion
The
Advanced
Query
window. | ..,
|

2. Select Contact or Opportunity from the Type drop-down list.

3. Select one of the available contact or opportunity fields from the Field
Name drop-down list.

To make life easy for you, you find all your fields listed in the Field Name
drop-down list.
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. Select one of the operators in the Operator field.

Knock yourself out! Indicate whether you’re looking for a specific word,
a field that contains a part of a word, or even a range of figures or dates.
You can search for fields that contain some data, or for fields that are
blank and don’t contain any data.

. In the Value field, select one of the available items that corresponds to

the selected Field Name item.

If the Field has a drop-down list, you’ll be happy to discover that it is
also available in the Advanced Query window.

. Click the Add to List button.

The query criteria appear in the columns in the middle part of the
Advanced Query window.

7. To select more than one criterion, repeat Steps 2-6.

8. (Optional) Click in the And/Or column for the item and select an

10.

11.

option if necessary.

As you build the query, you might want to make use of the And/Or
column to help you group your criteria to indicate the relationship
between each set of criteria. In Figure 6-9, notice that the three state cri-
teria are bracketed together and joined by the word or, indicating that
you’re looking for contacts from either Florida or Oregon or California.

. (Optional) Use the parenthesis column if necessary.

The example in Figure 6-9 groups the three state criteria together with
parentheses so that these queries are carried out together. This is a
particularly important step if your query contains both “and” and “or”
criteria.

Click Preview.

For those of you in need of instant gratification, you can see a list of all
the contacts that match your specification. If you goofed and no con-
tacts show up, you have several options available to you on the right
side of the screen:

e Remove: You can quickly remove a few of your criteria by selecting
them and then clicking the Remove button.

® Move Up/Move Down: Use this to easily squeeze in another crite-
rion or two if you initially left one out.

e Edit: Use this to tweak any of the criteria.
Choose File=>Save As if you’d like to use your query later.

The next time you want to run the same Advanced Query, you can
return to the File menu, choose Open, and open your saved query.
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12. When you finish selecting criteria, click OK.

13. At the Run Query Options message, select the Replace Lookup option
and click OK.

The results of the query display in the Contact List or Opportunity List.

Although the process of saving and reusing an Advanced Query is relatively
easy, you can combine this process with the Menu Customization techniques
outlined in Chapter 3 to really save yourself oodles of time. Yes, Virginia, you
can most definitely add saved Queries to the Lookup menu so that you can
find all those Customers in Oregon and Florida who love red widgets!



Chapter 7
Stamping Out the Sticky Note

In This Chapter
Using notes in ACT!

Creating ACT! notes
Understanding ACT! histories

Reviewing your notes

Look around your desk. If you have more than one sticky note attached to
it, you need to use ACT!. Look at your computer monitor; if it’s decorated
with sticky notes, you need to use ACT!. Does a wall of sticky notes obscure
your file folders? Do you panic when you can’t find your pad of sticky notes?
Do you have small sticky notes clinging to larger sticky notes? You need to
use ACT!!

In this chapter, I show you how to make a note in ACT!. I also tell you all about
the notes or histories that ACT! creates for you automatically, and then I give
you a short course in reviewing your notes.

Getting to Know ACT! Notes

What if one of your best clients calls requesting a price quote? You jot down
some information on a piece of paper, only to have the paper disappear in the
mountain of clutter that you call your desk.

Or imagine that one of your more high-maintenance customers calls you on
March 1 in immediate need of an imported Italian widget. You check with
your distributors and guarantee him one by March 15. On March 10, he calls
you, totally irate that he hasn’t yet received his widget.

Sound familiar? The ACT! note is one of the easiest features to master but
one that too many users overlook. A simple note in ACT! provides you with
several benefits. Your entire office can operate on the same page by having
access to the same client data. You have a record, down to the date and time,
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of all communications that you have with each of your contacts. You won’t
forget what you said to your customer — or what your customer said to you.
You have pertinent information at your fingertips without having to strip-
search your office looking for a lost sticky note.

Adding a note

Considering the importance of notes to the overall scheme of your business,
they are amazingly easy to add. Here’s all you have to do to add a note to a
contact record:

1. Make sure that you’re viewing the contact for which you’re creating
a note.

If you need help here, see Chapter 6 to help you look up the contact and
land in the Contacts view.

2. On the Notes tab (middle of the screen), click the Insert Note icon.

The Insert Note window appears, date- and time-stamped with the cur-
rent date and time. Take a look at Figure 7-1.

[2] Insert Note
vz Frechicks, Alyssa [Floida State Universiy] v
Date B2012008 v Time: [5:37 M v
Group/Company J Record Manager: | Karen Fradricks v
Regarding
=1 G F Microsoft Sans Serif|v| 8 -A-B I U F|=|= = =
Here's where |type in my important information. | can use various formatting including Zafes, olding and undediing. | can change the Fpint and font
| .
SIZE. | can even use strange colors but you want be able to see that in a black and white book |
Figure 7-1:
Create
a note in
ACT! here.
|

3. Start typing your note in the Regarding area.

Your note can be as long or short as you want. You can use the format-

ting options exactly as you do in any word processor to emphasize any
portion of your note.

4. Click OK to record your note.

That was almost too easy for you; now you can move on to a few tricks that I
have up my sleeve.
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Working with notes

After you create a note (see the preceding section), it appears on the contact’s
Notes tab. If you've read Chapter 5, you're already an old hat at customizing
this tab. Being the astute reader that you are, you might notice that the name
of the person who created the note appears in the Record Manager column.
This becomes particularly important if you're using ACT! in a multi-user envi-
ronment and want to avoid playing the “he said, she said” game.

The Notes tab has an extra, added attraction to it; Figure 7-2 shows you what
[ mean.

Notes | History | Activities | Opportunities | Groups/Cempanies | Secondary Contacts | Documents | Contact Info | User Fields | Home Address
Dates: |All Dates v |® Select Users (2} Options +
Date <[ Time Regarding Record Manager Group/Company |~ [ Here's where | type in my important
113072007 350 PN Idea: wine basket sampi Gary Kah fomation. | can use various
° 31 Wine basket samper Seryain formatting including 4afcs, bolding
7132006 7.00 PM You can add as many nctes as you need Chris Huffman i EheeeiE
612012006 538 PM Here's where | type in my mporiant infomation. |can  Karen Fredricks ... font
use various fomatting including #aiics, bolding and Fownt and
underining. | can change the Fowt and font EFE oo
: colors but you wont be able to see
SI1Z€ 1 can even use sirange colors but you that in a black and white book!
wont be able to see that in a black and white book! .
Yournote can be aslong 2 you'd
Your note can be as long as youd like. However, e e e
eventually t will become 5o long that you won' be able R moNona [ roO L
o s0¢ the whole fing able to see the whole thing.
That's where the side viewer comes
¥|| into play.
< >

Although you can virtually write a book — or at least a relatively large note —
ACT! shows only a portion of the note on the Notes tab. The Notes tab is
designed this way to squeeze multiple notes on the tab. However, this becomes
somewhat annoying because you need to open the note in order to display
its entire contents. The extra screen on the right side of the Notes tab serves
as a viewer that allows you to see the note in its entirety without having to
reopen the note. If you select a note from the tab, you'll see that it instantly
appears in this view screen.

After you create a note, you might need to change it. To edit a note, just
double-click it to get back to the Insert Note window. After you open it,
here are a few things you can change:

v Change the note information. Start typing in the Regarding area exactly
as you do with any word processor.

v Change the date on a note. No matter how much you depend on
your computer, sometimes you still rely on good old-fashioned paper.
Maybe you jotted down a note after you turned off your computer for
the day or made notes — both mental and on paper — at a trade show.
When you start to input those notes into ACT!, they all have the current
date rather than the date when you actually created them. To change
the date on a note, simply click the date and choose a new date from the
calendar that appears.
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Not all notes are created equal; some of your notes might be more impor-
tant than others. As your list of notes becomes longer, various key notes
can get lost in the shuffle. A real low-tech solution is to postdate the
note by giving it a date several years into the future so that your note
always appears at the top of the Notes tab.

v~ Attach files to a contact record. In Chapter 5, I talk about adding files to

the Documents tab so that you can view and edit them right from the
Contact Detail window. In addition, you can attach a file to a note in a
contact record. To attach a file to a note, follow these steps:

a. Click the Insert New Note icon on the Notes tab.

b. Click the Attach button in the Insert Note window.

c¢. Navigate to the file that you want to attach and then click Open.
d. Click OK to record the note.

To view the attached file, simply open the note and click the attached file.

v~ Spell-check a note. If you're like me, you type notes while doing a hundred

other things and end up with a lot of typos. Don’t fret; just run a spell
check by clicking the Spell Check icon in the Insert Note window. ACT!
opens the spell checker and locates any misspellings. Unfortunately, you
can check the spelling for only one note at a time.

v Add Group/Company info. If the note you're adding is specific to a

group or company, a click of this button allows you to attach your note to
a specific group or company. Later, when viewing the group or company,
you can filter your notes to include just the ones that are associated
with that group or company. You might want to head over to Chapter 19
to glean insight into Groups and Chapter 20 to comprehend Companies.

Discovering ACT! Histories

If you insist on doing things the hard way, feel free to skip this section. If you
love the thought of having someone else doing your work for you, read on!

Maybe you’ve noticed that the History tab is called, well, the History tab.
In the earlier sections of this chapter, I show you how to add and modify
notes. ACT!’s history entries are items that magically appear on the History
tab after you

 Delete a contact (Chapter 4).
v Complete a scheduled activity (Chapter 8).
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v Write a letter, fax, or mail merge (Chapter 10).
v~ Change information in a field designated to create history (Chapter 12).

When you perform one of these tasks, ACT! commemorates the occasion by
creating a history entry on the contact’s History tab of the person associated
with the task. ACT! even goes so far as to include the date and time the task
took place as well as the person who did the deed. You can edit or add activ-
ity details to the history, such as adding information about the decisions
made during the meeting. View these histories again later or create reports
based on activities with your contacts.

Creating field histories

ACT! provides you with a very powerful tool when you combine the use of
drop-down lists with the ability to create a history based on the changed
information in the field. By default, ACT! automatically creates a history
when you change the information in either the ID/Status or Last Results field.
When you enter information into either of these fields, it’s automatically
saved on the contact’s History tab.

Suppose that you create a ten-step sales process to coincide with the average
progression of one of your prospects into a customer. You can change the
Last Results field’s drop-down list to reflect those ten stages. When you
progress through the sales cycle and change the content of the Last Results
field, ACT! automatically creates a history indicating when the change took
place. Figure 7-3 shows both the content of the Last Results field and the
automatic histories that are created when the contact progresses through
the sales stages.

Notes | History | Activities | Opportunities | Groups/Companies | Secondary Contacts | Documents | Contact Info || User Fields | Home Address
Dates: |All Dates ~ | Types:  All | @y Select Users & [6] Options -
Date Time Result Regarding & Details [ |8 [Record Manager Group/Company
31372006 7:50 PM Field Changed  Field Last Results changed from "Qualified, OK to pursue” to Karen Fredricks
Just received information
3/8/2006 7:50 PM Field Changed  Field Last Results changed from"Followed up” to"Qualified, Karen Fredricks
OKto pursue™
3672006 7:50 PM Field Changed  Field Last Result from "D d "to Karen Fredricks
“Followed up”
172006 7:49 PM Field Changed  Field Last Results changed from ™ to "Discussed Karen Fredricks
opportunities”

By relying on the field’s drop-down list to create new content information,
you ensure that your information remains consistent. You can then create
reports on the various sales stages by creating a lookup based on the notes
and histories.
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Figure 7-4:
Clear an
activity here.
|

In Chapter 6, I show you everything you need to know about creating lookups —
and then some! Chapter 9 explains the various ACT! reports and shows you
how to filter them by date range.

Clearing activity histories

In Chapter 8, I explain how to use ACT! to plan your busy schedule. After you
hold or attend a meeting, place a call, or complete something on your to-do
list, clearing the activity is important. Figure 7-4 shows you the Clear Activity
dialog box that opens each time you clear an activity.

Clear Activity
Type: Meseting
Organizer: Karen Fredricks
Participants:  Alyssa Fredricks (Florida State University)
Associate With:
Date: Time: Duration
6/20/2006 v 8:00 PM v 3 hours »
Regarding:
(Gary's Bithday Bash
Results
(3) Clear | Meeting Held w
() Erase
[¥] Add Details to History
= &3 5 [ Microsoft Sans Ser |v||8 vlaA-B 7 U T 5
Attachment:
Attach...
Do

Select the Add Details to History check box, and ACT! automatically inserts
your notes as well as the history of the event on the History tab.

ACT! provides you with the same option when you get in touch with a contact
through a letter, an e-mail, or a fax. Figure 7-5 shows the Create History dialog
box that appears after you create a letter in ACT!. Of course, you can always
choose not to include a history, but you’ll probably find recording one more
useful. You can even add more details in the Regarding area.
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Figure 7-5:
Attach a
history to

a letter.
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Create History

Document Printed: Proposal for services doc

Record History

Would you likke to record a history for this contact?
(%) Yes, record history
Regarding

Sent proposal letter
EaFETE
(2 No, do not record histary

Prirt Envelope

Would you like to print an envelope?
OYes

®MNo

Manually recording a history

Situations arise when recording a history of an event just isn’t practical.

You can create a history record for a contact without scheduling and clearing
an activity for that person. You can even add a history for someone who isn’t
yet in your database. For example, you might have called a potential new
client from your car and found juggling the steering wheel, your phone, and
your lunch while typing on your laptop a bit too daunting. However, when
you return to the office, you still need to record the calls that you made and

the tasks that you completed.

You can also record one history for an entire group of people. For example, you
might have attended a meeting at your local Chamber of Commerce and want
to record a few details about the meeting for each of the attendees. Regardless
of why you need to do it, here’s how you create a history after the fact:

1. Find the contact for whom you want to record a history.

If you're creating a history for an entire group of people, create a lookup
of the contacts for whom you want to add a note.

2. Choose Contacts>Record History.

If you prefer, you can press H while holding down the Ctrl key on your
keyboard. Either way, the Record History window opens, as shown in

Figure 7-6.

3. Select an activity type from the Type list.

If you need more activity types, don’t worry. I show you in Chapter 12
how to increase your selection of activity types.

4. Select a Result option.
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! Record History
Type: Mezting v Result: | Mesting Held v
Contact Fredncks. Alyssa [Flond State Universiy] v
Date: 1/30/2007 v Time: |8:00 PM v Duration: |3hours [
Atecmert
Group/Company [] Record Manager: | Karen Fredricks -
Regarding 21st Bithday Bash -
Details
= G F | Tahoma v[8 -A-BFUF == ==
|
Figure 7-6:
Record a
history here.
Cnse
|
. . ) . . .
5. Click the Contact button if you’re creating a history for multiple
contacts.
The Select Contacts window, as shown in Figure 7-7, opens.
Select Contacts
Select from
Al Cortacts w
Lock for:
|
Contacts to select from: Selected Contacts:
@, Name Company ~ @, MName ‘Company
WIIES, JUIE HODEMS0N JOINery Andromidas, Kalle | Fenstersheib Law Offices
:!"”'Tk‘azin .?JakngFol Ckcns:mlng Beasi, Susan Rare Coins & Precious Mel
inoal. 3 ake Mlakes Inc. Bellitte, Joanne Central Medical Group
Moets, Edward MRP Enterprises Caronite. Ashleigh
I Morgan, Tommy Great Northern Coffee Chamar, ‘ane
- Murphy. Irene Mears Insurance Fredricks, Alyssa Florida State University
Flg“re 1-1: Nagengast. Scott Nagengast Estate Wine Fredricks, Andi University of Florida
Mara, Mary Spaghetteroni's .
Select the i \ = @) | Fredricks, Karen Tech Benders
Nguyen. Dylan Freemont Corp - @ | Kahn, Gary Kahnvoiceovers
contacts for poristrom. Fudy - |ake Pakes e Katz, Linds
ren, Alexander anxsys Financia
Parker, L Yellow J Bike Sh
a manual e e Yellow Jersey Bike Shav arker. “ance Srow jersey Bke Shop
history.
|

This step isn’t necessary if you're creating a history for just one contact
because that contact’s name would already appear in the Contact text
box of the Record History window. However, if you're trying to record a
history for the multiple contacts that are included in the lookup that you
created in Step 1, you have to do a little extra footwork.

a. Choose Current Lookup from the Select From drop-down list.

b. Click the double right-pointing arrows to move all the contacts in your
current lookup to the Selected Contacts area.

¢. Click OK to return to the Record History window.
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6. Enter date, time, and duration information.

7. Enter activity information in the Regarding field or select a description
from the drop-down list.

8. Add additional information in the Details area.

The information that you enter here is added to the Regarding field on
the History tab.

9. Click OK to record the history.

Your note is recorded in the contact’s record. If you created a history
for an entire group of contacts, the note appears in the contact record
of each individual in the group.

P If you click the Follow-up button rather than OK, you can schedule a
new, follow-up activity in the same way that you scheduled your original
activity. Talk about one-stop shopping! The result of a call might be that
you scheduled a follow-up meeting for the next week. By scheduling a
follow-up activity, you have the results of your original meeting as well
as a reminder of the meeting scheduled in the future. You can also
schedule follow-up activities for the next step in your sales process.

v?‘“\NG! Two of the most popular ACT! reports — the History Summary and the
S History Summary Classic — are based directly on the history created by
ACT!. If you never create a history manually, clear a scheduled activity, or opt
to create a history after a mail merge, you will be rendering these reports
useless. Find out more about these reports in Chapter 9.

Working with Vour Notes and Histories

The Notes and History tabs are very similar; consequently, you can use them
in similar ways. They are so similar, in fact, that in previous versions of ACT!,
they were actually combined into one single tab. Here are a few things that
you can do to edit your notes and histories:

v Delete a note or history. To delete a note or history, you must first
select it and then press Delete. You can also right-click the selected note
and choose Delete Selected from the contextual menu. Either way, ACT!
presents you with a warning before you remove the note permanently.

v Delete several notes and/or histories. Eventually, you want to delete
certain notes or even histories. To delete several notes in one fell swoop,
just select the notes that you want to delete and then press Delete.

e If you're selecting several contiguous notes, click the first note and
then press Shift while clicking the last note that you want to delete.

e [f the entries aren’t contiguous, press Ctrl while clicking each note
individually.
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Now that you know how easy deleting a history is, you might want to
prevent other users of your database from deleting them. If you're the
database Administrator, choose Tools=>Preferences. Then on the General
tab, remove the check mark next to the Allow History Editing option.

v Copy a note. When you find duplicate contacts in your database, you

probably want to delete them — but not any notes attached to them.

Or, maybe you want a note from one contact record also attached to
another record. Luckily, ACT! gives you the ability to copy or move notes
from one contact to another contact with a simple copy or cut-and-paste
procedure:

a. Highlight the notes or histories that you want to copy or move and
then press Ctrl+C to copy or Ctrl+X to cut.

b. Find the contact where you want to insert the copied notes. Then on
the Notes or History tab, press Ctri+V.

If you're feeling somewhat artistic, in need of a change, or just plain having
trouble with your 40-something eyesight, you might want to either add grid-
lines around your notes or change the color and/or font style. Or, you might
just decide to walk on the wild side and change the whole ball of wax. Take a
stroll down preference lane to accomplish this:

1.

N S G e W N

Choose Tools~>Preferences from any ACT! screen.

The Preferences dialog box opens.

. Click the Colors and Fonts tab.

. Click the Notes tab.

. Click the Font button to select a different font, style, or size.

. Click OK to close the Font window.

. Choose a text color and background color from the Appearance area.

. To have gridlines appear on the Notes tab, select the Show Grid Lines

check box.

The ACT! gridlines are just like the gridlines you see in Excel. If you
change your preference to show gridlines, horizontal lines appear
between each of your notes and vertical lines between columns.

8. Repeat Steps 3-7 for the History tab.
9. Click OK.

Your Notes and History tabs are now modified according to the prefer-
ence settings that you selected.



Chapter 8
Playing the Dating Game

In This Chapter

Scheduling activities

Viewing ACT! calendars

Putting the Task List to work
Sharing your activities with others

Creating an activity series

n this chapter, I show you how to schedule activities with your contacts,

how to view those activities and modify them if necessary, and even how
to find out whether you completed a scheduled activity. You also discover
the intricacies of navigating through the various ACT! calendars, how to use
your Task List to keep you on top of your activities, and the joy of sharing a
list of your scheduled activities with others.

Scheduling Your Activities

One of the most useful of ACT!’s features is its ability to tie an activity

to a contact. Most basic calendaring programs allow you to view your
appointments and tasks on your calendar, but they don’t offer a way of
cross-referencing an appointment to a contact. For example, if you schedule
an appointment with me and forget when that appointment is, you have to
flip through your calendar until you see my name. Plus, you can’t easily see a
list of all appointments that you've ever scheduled with me. However, ACT!
offers these helpful features.

In ACT!, every activity is scheduled with a specific contact. If the contact
doesn’t exist in your database, you must add the person to your database —
or schedule the appointment with yourself.

Here’s what you do to add an activity to your busy schedule:

1. Go to the contact with whom you’re scheduling an activity.
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Figure 8-1:
Schedule an
activity in
ACT! here.

Here’s the drill. You create a lookup (I show you how in Chapter 6) to
find a prospect’s phone number. You call the guy, and afterward, you
want to schedule a meeting. At this point, you're already on the contact
record of the person with whom you’re scheduling an activity.

. Schedule a call, meeting, or to-do in one of three ways:

¢ Click the Call, Meeting, or To-Do icon on the toolbar in the Contact
Detail window or the Contact List.

¢ Choose Call, Meeting, or To-Do from the Schedule menu in just
about any ACT! view.

¢ Double-click the appropriate time slot on any ACT! calendar.

Using different methods to schedule different activities is a smart plan
of action. For example, [ recommend scheduling meetings through the
calendars to make sure that you don’t have a conflict for a specific time
slot. When you’re scheduling calls and to-dos, however, which are gener-
ally “timeless” activities that don’t have to be set for a specific time, you
can simply click the corresponding icon on the toolbar.

In any case, all roads lead to the Schedule Activity dialog box, as shown
in Figure 8-1.

Schedule Activity
Options -
General | Details | Recumence | Availability
Activity Type: Start Date: Start Time: Duration:
To-do w | |5/30/2006 v | |Timeless w| |1hour b
End Date: End Time:
5302006 w [ Use Banner
Schedule 'with
Barkow, Janet [The French Connection] “
Associate With:
Regarding
Write thank you for use of cool NYC apartment. Merd Beaucoup! w
Resources Location:
None e
Priority: Color:  Ring Alarm:
ng v .E] Mo alarm . Schedule For...

3. On the General tab, fill in the various options.

If options is your name, ACT! is your game! The Schedule Activity dialog
box offers a myriad of scheduling options from which to pick, and ACT!
has thoughtfully filled in many of these options based on your default
scheduling preferences. (Chapter 3 walks you through changing some of
these preferences.) You can leave the information in the following fields
as is or override the default preferences:
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e Activity Type: Choose Call, Meeting, To-Do, Personal Activity, or
Vacation from the drop-down list.

e Start Date: Click the arrow to the right of the field to display the cal-
endar and select the date of the big event.

e Start Time: Enter a start time for the event. Choose Timeless for the
Start Time if you're scheduling a call or to-do that doesn’t need to
occur at a specific time.

e Duration: Click the arrow to the right of the field to choose the
duration for the activity. You can also manually specify a time
range; an hour-and-a-half-long meeting can be entered as either
90 m or 1.5 h.

The End Date and End Time are automatically set based on the
starting date and time you specify. If you change the duration, ACT!
automatically adjusts the end date and time.

e Use Banner: This option lets you display a banner on the monthly
calendar if an activity involves one or more full days.

e Schedule With: The name of the current contact automatically
appears here. Select a different contact by typing the first few
letters of a contact’s last name to locate the contact in the list.

If you click the Schedule With drop-down list, you’ll notice that the
names appear alphabetically by last name. If you're having trouble
remembering someone’s last name, simply click the Company
column heading to arrange those contacts alphabetically by
company. You can then type the first few letters of a company
name in the Schedule With box.

¢ Contacts: Click the Contacts button and then choose Select Contacts
to select more than one contact, New Contact to add a new contact,
or My Record to schedule a personal appointment.

¢ Regarding: You'll want to give a brief description of the activity
because it is later reflected on the contact’s History tab. Type it
here or choose an item from the drop-down list.

The Regarding drop-down list reflects the Activity Type that you
choose, so scheduling a Call gives you different options from
scheduling a Meeting. Don’t like the items in the drop-down?

As usual, you'll find the Edit List Values options button. Click it
to create your very own customized drop-down list for each one
of the activity types.

e Resources: If you're using ACT! 2007 Premium for Workgroups, you
can place first dibs on shared commodities such as the conference
room, LCD projector, or the office stash of candy bars.

¢ Location: It never hurts to let everyone know, including yourself,
where the big event is going to take place.
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Figure 8-2:
Send an
e-mail
reminder of
a scheduled
activity.
|

e Priority: Choose High, Medium-High, Medium, Medium-Low, or Low.

Don’t see the Medium-High and Medium-Low options? Chapter 12
shows you how to customize your Priorities list.

e Color: Click the arrow to the right of this field to display a color
palette, and then choose the color that you want to assign to the
activity. Feel free to design your own system of color-coding your
calendar.

¢ Ring Alarm: Enabling this sets an alarm to remind you of a sched-
uled activity at a specified interval before the event.

e Schedule For/By: Click this button to assign a task to one of your
co-workers (as if ACT! hasn’t made life easy enough for you
already!).

4. (Optional) Click the Options button.

If you want, click the Options button (top-right of this window) and
select one of these options:

¢ Confirm the activity with the contact(s) involved by selecting the
Send Activity E-mail to Contacts option. ACT! automatically opens an
e-mail message filled in with the critical details in the body of the
e-mail like the one shown in Figure 8-2 and includes an attachment
in ACT! format. When the e-mail recipient receives the e-mail, he
can double-click the attachment (the instructions for this are also
included in the body of the e-mail) and have the activity automati-
cally placed in his ACT! calendar.

¢ Create a separate activity for each participant if you're scheduling
your activity with more than one contact.

-] Meeting scheduled regarding: ACT! 2007 Premium for W Training - ACT! E-mail [BE]
File Edit View Insert Format Spelling Actions Tools Help
Bsend & B4 % H G
B 7 U ==z |82 G4AE
From [Micrasoft Outlock - Karen Fredricks =] iy Momal |
Create
To,.. [Fredicks, &ssa H‘:foa [Subiect arly =]
[l I Retum recsipt

Gty [Mesting schedlied regarding: ACT! 2007 Premriam for Workgiougs Traiing

Just a reminder concerning our upcoming meeting:
REGARDING: ACT! 2007 Premium for Workgroups Training
DATE: Tuesday, May 30, 2006

TIME: 9:00 AM

DURATION: § hours

Sincerely,

Karen Fredricks

Tech Benders
5614705450
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5. (Optional) On the Details tab, add additional details and print the
details.

These are two relatively important tasks:

¢ Details: Add additional information regarding an activity. For exam-
ple, you might want to add special instructions about the items
that you need to bring to a meeting.

e Print: This is where you can print the activity details.

6. On the Recurrence tab, designate the activity as recurring if that’s the
case; otherwise, go to Step 7.

If the activity that you’re scheduling repeats on a regular basis, you can
designate it as a recurring activity rather than setting up several separate
activities. For example, if you're taking a class that meets once a week
for the next 12 weeks, you can designate the class as a meeting with a
weekly recurrence. Be sure to specify the date on which the activity
stops recurring.

Here are the recurring option settings:

¢ Daily: Select to schedule an activity that occurs daily and the date
on which the activity stops.

e Weekly: Select to schedule an activity that occurs weekly, on which
day or days of the week the activity is scheduled, and the date on
which the activity stops.

® Monthly: Select to schedule an activity that occurs monthly by indi-
cating the week in the month, the day of the week, or the specific
day of the month on which the activity will be occurring and the
date on which the activity stops.

e Yearly: Select to schedule an activity that occurs every year, and
the date on which the activity stops.

\P
P The Annual Event field can eliminate the need to set reminders for

activities, such as birthdays, anniversaries, and renewal dates.
Find out how to set up an Annual Event field in Chapter 12.

7. Click OK.

You have a real, live scheduled activity!

After you create activities, ACT! is a worse nag than your mother! You can see
your activities — and ACT! reminds you to complete them — in a number
of ways:

v Alarm: If you asked ACT! to ring the alarm when scheduling an activity,
the ACT! Alarms window appears at the specified time before the activity
is due. It also appears each time that you open ACT!.

v Per contact: The Activities tab for a selected contact enables you to see
what specific activities you scheduled with that particular contact.
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v~ All contacts: The Task List shows a listing of everything you scheduled
for all your contacts during a specified time period.

v~ Calendar: All ACT! calendars — including the monthly, weekly, and daily
views — show a listing of the current day’s activities.

Later in this chapter, in the section “Exploring Activities,” | show you how to
view, edit, clear, and share your scheduled activities.

Q‘&N\BER Regardless of your method of viewing your activities, remember this tip:

& When frustrated, check your filters. If you're just not seeing everything that you
know is supposed to be showing in your calendar, check your filters! Not seeing
anything scheduled for the future? Maybe your date range is set to show the
activities for today only. Seeing too much? Perhaps your filters are set to
show everyone’s Task List or calendar. Not seeing any of your activities at all?
Perhaps your filters are set to include everything except your own activities!
Flip to Chapter 5 if you want a refresher course in those frustrating filters!

Working with the ACT! Calendar

The various ACT! calendars are great for viewing scheduled tasks. Here are a
couple of ways to get to your calendars:

v From any ACT! screen, choose Viewr>Calendar and specify the type of
calendar that you want to view.

1 Click the calendar icon on the Navigation (Nav) bar.

You can view your calendar in any one of four different ways, depending on
which way you feel the most comfortable:

v Daily calendar: Shows you the time-specific activities of the selected day
as well as a listing of the day’s tasks. (See Figure 8-3.) The day is divided
into half-hour intervals.

\3
P Not happy with half-hour intervals? No problem; you can change that

default setting in ACT!’s preference settings. Not sure how to do that?
Take a peek at Chapter 3 to tweak your preferences.

1 Work Week calendar: Shows you the time-specific activities of the selected
week as well as a listing of the day’s tasks. Each day is represented by a
single column and divided into half-hour intervals.

v Weekly calendar: Shows the entire week including Saturday and Sunday.
(See Figure 8-4.)

+* Monthly calendar: Shows you the time-specific activities of the selected
month as well as a listing of the day’s tasks.
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Figure 8-5:
The mini-
calendar.
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The mini-calendar

A mini-calendar appears to the right of any of the ACT! calendars. The mini-
calendars work a little differently from the daily, weekly, and monthly calendars
in that they are used to change a date and not to just schedule an appointment.
You can access a three months’ supply of mini-calendars by pressing F4 from
any ACT! view. (See Figure 8-5.) Right-click the day that you want to check,
and a small window appears, displaying all activities scheduled for that day.

Mini-calendar
A4 4 May 2006
SMTWTFS
12345¢8 2
w7 8 910111213 =
(14151617 121920 =2
21222324 2526 27 =
2829 30 31 =

July 2006 oo
SMTWTFS
1

June 2006
SMTWT

F 5

23 3=
45678 910 #/2345¢673¢8
111213141516 17 2| 2 101112 1214 15
1819621222324 ={16171819 2021 22
2526 27 28 29 30 (23242526 2728 29
#3031 1 2 4

-

2
2

After you access any of the ACT! calendars, you can navigate to a different
date in one of the following ways:
v View today’s activities by pressing Ctrl+Home.
v Switch to a different day by clicking any day on the mini-calendar.
v Get a daily synopsis by right-clicking any day on the mini-calendar.
v Go to a different year by clicking the double arrows.

» Go to a different month by clicking the single arrows.

The Recap List

If you take a peek at any of the calendars, you notice a mini-calendar in the
top-right corner. As I mention earlier, this calendar provides you with a quick
way to view a different calendar date by clicking it. A miniature to-do list —
the Recap List — appears right below the calendar. The Recap List lists all
your scheduled activities on a specific day.

You can view the Recap List of only one user at a time, but you can have
access to multiple users’ Recap Lists. When you select multiple users, but-
tons with each user’s name appear in the Recap List. Click the user’s name to
open or close his Recap List. If a selected user has no scheduled activities for
the selected date, her name doesn’t display in the Recap List. To view
another user’s Recap List, follow these steps:

1. Click the Calendars icon on the Nav bar.
2. Click the Select Users button.

The Select Users dialog box appears.



Chapter 8: Playing the Dating Game ’ 09

3. Select the users whose Recap Lists you want to view and then click OK.

P When you select multiple users, their tasks all appear on both the calen-
dar and the Recap List. This can get confusing — not to mention make
you feel that you have too much to do if you forget you're viewing every-
one else’s activities. This is where a bit of color-coding can come into play.
Gary’s activities might all be in blue, and Alyssa’s might be in magenta.
That way, you’ll be sure to know which activities belong to whom.

4. From the calendar, select the date for the Recap List you want to view.

The user’s tasks display in the Recap List. If you selected multiple users,
you can click the button with the user’s name to view that user’s tasks,
as you see in Figure 8-4.

Using the Task List

Like the Honey-Do list hanging from your husband’s workbench, the ACT!
Task List gives you a listing of all the activities for all your contacts.

The Task List is readily accessible by clicking the Task List icon on the ACT!
Nav bar. Figure 8-6 shows a sample Task List.

You can filter the Task List by using different criteria, such as the date range,
type, priority, and the users whose activities you want to view.

§ ACT! by Sage Premium for Workgroups 2007 (9.0) - ACT_For_Dummies E]
File Edit View Lookup Contacts Groups Schedule Write Reports Tools Help
wEem R QAR @
[+ Back Task List B Hide Fillers
= Dates: All Dates v | Types: | All ~ | Priorities: | All v | @ select Users Options -
4 Type |5, | Date [ Time Priority Scheduled With | Regarding [ [Duation [} [ [AssociateWith [~
Contacts Y 252006 Fone Figh Raze Stevens Send Lieratur 5 minutes
= = High Jackie Jorgensen
&, @& Lo Morgan Kennedy
R = Medium Thomas Andrews Modern Electric
3 High Enily Dun
= B Wilhelm Loke
& High Chris Huffman
CErTE 7® ow Chris Huffman
" High Janet Barkow
= Benny Lender
Calendar ) Chris Huffman
z " 611512006 <Multiple
" 611512006 <Multiple. 1 hour
T = 6/19/2006 Sendy Ryen ollo 30 minutes
™ /2012008 Pilates Class 1 hour
i " 62012008 10:00 AM Ashleioh Carorite ~ Haircut 1 hour
" 62012006 12:00PM Craig Potts Voiceover recarding for national spot 3 hours
CEnTy - 62012006 400 PM Jobnne Chamar  Follow-upon Delivery - did they receive all.. 30 minutes
. " /2012008 MyssaFrediicks  Gary's Birthday Bash 3 hours
=] Y 612112006 Chris Huffman ~ Tumn in 1 hour
b = 61212006 Albert Barry 1 hour
E-mail - 672112006 Joanne Bellitte 2hours
" 612212006 Liz Dittmeier 1 hour Erandee's Bakery
EEq) " 612412006 John Steinman 1 hour 30
Internet "R 6252006 Conn, Frances 2 hours
I Sz W 61262006 <Multiple.. = 1hour CH Gol
i 61262006 <Multiple = 1hour CHG
H A " 62612008 <Multiple = 1hour CHG
Flgure 8-6: "R 6262006 <Multiple. 5 1hour CHG
= 6 Lo Paul Brushman 3 Bn
The ACT! ) High Chris Huffman 5 minutes c
H =l 7130/2008 Low Jofnne Chamar 1 hour Friends
Task List. P 81012006 1200PM  Medium Emms Francis o 2 hours v
EEE— All Dates: 152 Activities - 34 Calls, 79 Meetings, 31 To-do's, 8 Custom Activities
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You can also include a few more activity options by clicking the Options button
and opting to add Private, Timeless, Cleared, and/or Outlook activities to the
Task List.

Creating a lookup from the Task List

Here’s the scenario. You wake up bright-eyed and bushy-tailed, ready to face
another new day. You get to the office, view your Task List, and stop dead

in your tracks: The length of your Task List is so long that you don’t even
know where to begin. Consider creating a lookup directly from the Task List.
By spending the first hour of your day sending out all those faxes and brochures
that you promised — and then the next hour returning your phone calls —
you get everything done.

When you break down your tasks into manageable pieces — instead of
having a breakdown yourself — the Task List becomes less intimidating.

Having said all that, I feel compelled to add that Rome wasn’t built in a day,
and you might not be able to complete all your tasks in a single day, either.
ACT! has a preference that enables you to roll over your tasks to the next day.
Check out Chapter 3 for a quick refresher on changing ACT! preferences.

1. To open your Task List, click the Task List icon on the ACT! Nav bar.

2. Select the date range of the activities for which you want to create a
lookup.

3. Select the activity types in the Types area to indicate the activities
that you want to work with.

When you select these options, your Task List hopefully becomes a bit
shorter. You can filter your Task List even further by selecting the priority
types you’d like to include and making sure that your tasks are the only
ones visible in the Task List.

4. Right-click the Task List and select Create Lookup.

ACT! creates a lookup of the selected activities. You can now scroll
through your contacts and work on all similar tasks at the same time.

Printing the Task List

As great as ACT! is, it can be totally useless if you don’t have access to a com-
puter or hand-held device. Or maybe you work with a technically challenged
co-worker (your boss?) who prefers to have a copy of his or her Task List
printed on a daily basis. No need to fret; ACT! can easily perform this task

for you:
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1. Click the Task List icon on the Nav bar.

2. Choose File>Quick Print Current Window.
The Quick Report dialog box opens.

3. Click OK to print the Task List.

Exploring Activities

|
Figure 8-7:
The
Activities
tab.
|

A\

In the first section of this chapter, “Scheduling Your Activities,” I show you how
to do exactly that. After scheduling an activity, you might want to review it.
Or edit it. Or clear it. Or maybe even share it with others. So in this section,

[ show you how to do all these things.

Viewing the Activities tab

If you click the Activities tab at the bottom of the Contact Detail window, ACT!
displays all the activities scheduled with the current contact. This is a great
way to have a list of all the activities that you’'ve scheduled with a contact.

You can see the Activities tab in Figure 8-7.

Notes | History || Activities || Opportunities | Groups/Companies || Secondary Contacts || Documents | Contact Info | User Fields | Home Address

Dates: |All Dates w| Types: | All + | Priorities: | All v | @y Select Users Options -
[ [Type [, [Date Priority Scheduled With | Regarding 5] B [B [Associate With -~
O @ =, 772008 Megium Chris Huffman~~ C = CH

O & =, 7ezs Lo Chris Huffmen T CH

O s =, 7132005 L <Multigle

0O & = Mediur Chris Huffman

O & 5 Chris Huffman

O # 772005 Hi Chris Huffmen

O & =, see20s Medium Chris Huffman

O = Hi <Multiple

O ma Lo <Multipke.

- 1212005 Low <Multile.

O & 9132005 Megium-High Chris Huffmn -

All Dates: 35 Activities - 3 Calls, 10 Mestings, 18 To-do's, 4 Custom Activities

You can filter your activities so that only certain activities show on the
Activities tab. Your choices include dates range, activity type and priority,
users, as well as private, timeless, cleared, and Outlook activities.

Can'’t find the filter options for Private, Timeless, Cleared, and Outlook activi-
ties? Click the Options button, and you’ll find them.

After you set your filters, you can also determine the columns that you want
to appear on the Activities tab. Chapter 5 explains all the possibilities.
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After you determine the columns that you want to view onscreen, you can
easily print a down-and-dirty report. In Chapter 5, I give you all the juicy
details for rearranging the columns on the Activities tab — or on any other
ACT! list for that matter — and turning it into a Quick Print report.

Editing your activities

Like all the best-laid plans of mice and men, your activities will change, and
you need a way to make note of these changes in ACT!. Changing an activity
is all in the click — or in this case, the double-click — of the mouse. If you can
see an activity, you can edit it. That means you can edit your activities from
the Activities tab, the Task List, or from any of the ACT! calendars. The only
activities that you can’t change are those that you've already cleared.

Resist the urge to simply change the date for rescheduled activities. Although
this is easy enough to do, you might end up losing some key information.

Say, for instance, that a particularly high-maintenance customer stands you
up four times — and then complains to your boss about your lack of service.
If you had simply edited the original activity, you wouldn’t be able to docu-
ment the dates of all four activities. You might like to think of this as CYA
(um, cover your ACT!) technology!

Clearing activities

After you complete a task, clearing the task is very important because
then ACT!

v~ Stops reminding you about the activity
1 Allows you to add some additional details about the activity
v~ Lets you schedule a follow-up activity if necessary

1 Automatically updates the Last Reach, Last Meeting, or Last Attempt
fields with the current date

v Creates an entry on the History tab of the contact with whom you had
scheduled the activity

Clearing an alarm is not the same as clearing an activity. You might clear an
alarm when you first open ACT! or when the activity is scheduled to occur, and
not actually clear the activity. Eventually, your Task List will grow dangerously
long — in which case, you’re probably going to start ignoring it all together.
Worse, you won’t have a history of the activity because theoretically it never
occurred!
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To clear an activity, follow these steps:

1. Select the activity that you want to clear by doing one of the following:

¢ In any Calendar view, select the check box next to the activity in
the Recap List.

¢ [n the Task List or on the Activities tab, click the check mark column.
¢ Right-click the activity and choose Clear Activity.

Using any method, the Clear Activity dialog box appears (see Figure 8-8).
The current date and time appear automatically. The Regarding infor-
mation that you had originally entered for the activity appears as well.
This information later appears in the Regarding column of the history
that’s automatically created when you clear an activity.

Clear Activity

Type: Call
Organizer: Chris Huffman
Participants:  William Cadbury (Cadbury); Chris Huffman (CH Gourmet Gifts)

Associate With:

CH Gourmet Gits )
Date Time: Duration:

9/5/2005 v 12:00 PM v 1 hour v
Regarding

Call with vendor to discuss new products
Results
(%) Clear | Call Completed eV
() Erase

[] Add Details to History

= @ "5 | Microsoft Sans Ser [v|[@ iv| A - B F U ¥
Talk about potential bundles

|
Figure8-8: | . .
Clearing an Attach.
activity.
V| v
|
\\J

The Clear Activity dialog box enables you to clear just one activity at
a time. You can clear multiple activities from the Activities tab or the
Task List:

a. Hold down the Ctrl key while selecting additional activities to clear.

b. Right-click the selected activities and then choose Clear Multiple
Activities from the shortcut menu.
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2. Select a Result option.

The result determines the type of note that’s added to the History tab as
well as the system field that is affected. For example, if you indicate that
a call was completed, two things happen:

¢ A history is added to the History tab with Call Completed showing
in the Results column.

e The Last Reach field is changed to include today’s date.

The results vary according to the type of activity that you scheduled.

If you schedule a meeting, the results are either Meeting Held or Meeting
Not Held. If you schedule a call, you see different result options including
Call Attempted, Call Completed, and Call Left Message.

3. Select the Add Details to History check box if you want to edit or add
activity details.

Changes that you make to the Add Details area appear in the Regarding
field on the History tab for the contact.

4. (Optional) Click the Follow-Up Activity button to schedule a follow-up
activity.

This is a very cool concept. When you clear an activity, ACT! gives you the
option of scheduling a follow-up activity. Schedule a follow-up exactly like
you schedule an original activity.

5. Schedule the follow-up activity in the Schedule Activity dialog box
and then click OK to return to the Clear Activity dialog box.

6. Click OK again, and you’re done.

Creating an Activity Sevies

Quite simply, an activity series is a series of steps that you might want to
follow to achieve a specific goal. For example, you might have a six-step plan
of action for every prospect that heads your way, or seven things you need to
do during each of your customer-related projects. Every time you meet a new
prospect, you might want to lure him into using your services with a specific
plan of action: send a brochure, follow it up with a phone call, send out a
letter explaining some of the things you discussed in the phone call, and then
finally send an e-mail further explaining your business. After the prospect
becomes a customer, you might want to routinely send a welcoming letter,
send out a proposal, wait for approval, and then wait for the deposit check to
slide into your mailbox.
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|
Figure 8-9:
Creating

an activity
series.
|

ACT! allows you to group these steps into one list in order for you to auto-
mate your process. With an activity series, you can stick to your game plan.
And, hopefully, some of those hot prospects turn into customers because
you don’t allow any of them to fall through the cracks.

Using the Activity Series Template
Creation Wizard

Before you can schedule an activity series, you must create one via the
Activity Series Template Creation Wizard. Here’s where you develop the
series by naming it, setting it as public or private, and adding activities.
The wizard also allows you to edit or delete an existing activity series tem-
plate. Follow these steps to start the wizard:

1. Choose Schedule>Manage=>Activity Series Templates from any ACT!
screen.

2. In the Activity Series Template Creation Wizard, select the Create a
New Activity Series radio button and then click Next.

The wizard walks you through the next three steps.

3. Fill in the name of your new Activity Series, indicate whether it’s public
or private, give it a description (if necessary), and then click Next.

The second window of the Activity Series Template Creation Wizard,
as shown in Figure 8-9, is where you assign the individual activities to

the series.

Activity Series Template Creation Wizard (4 of 5)
Activity Series Template Creation Wizard - Series

Activities in this series @
Activities In the Series

Type From Anchor Date | Regarding Schedule Add

To-do 0 day Send New Customer Packet | Melissa P

To-do 0 day Send Thank You Letter for F| Scheduling

To-do 0 day Change ID/Status tp Custor| Schedulin

0 day Check Credit and Set Up Ne| JulietteR:

Schedulin
How are things going so far| Schedulin:
Do you have other referrals| Scheduling

Follow-up to First Order

call 5 months
Meeting 9 months
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|
Figure 8-10:
Add a new
activity to

an activity
series.
|

4. Click the Add button to add all the steps you want to include in your
activity series.

The Add Activity dialog box opens; you can take a peek at it in Figure 8-10.

Add Activity

Activity information

Activity Type:

Cal R
Starts: Duration:

5 & |Days | | After Anchor Date s | 10 minutes »

Regarding:

follow-up - did they receive the contract eV
Prienty: Color:  Ring Alarm:

Medium - . Mo alarm “

If activity falls on a non-werking day, schedule on the following work day

Schedule for

Activities must have a specified organizer. The organizer is the user who will own the activity or
activities in the series.

() User scheduling the activity series

o

5. Fill in the Add Activity dialog box and click OK.

Here’s where you indicate all the pertinent details for each and every
step of your activity series. You have to enter several key pieces of infor-
mation; don’t worry if you make a mistake because you can always go
back and edit these steps if you don’t get them right the first time.

e Activity Type: Indicate whether you're scheduling a call, meeting,
to-do, or a custom activity. (Skip to Chapter 12 for more info about
custom activities.)

e Starts: Activity series are based on an anchor date. You can either
schedule an activity that occurs after the anchor date (which is
generally the day you begin the series) or activities that must be
completed before the anchor date.

e Regarding, Priority, Color, and Ring Alarm: These fields are the exact
same ones you encounter when scheduling a regular, run-of-the-
mill activity.

e [f Activity Falls on a Non-Working Day, Schedule on the Following
Work Day: Select this check box to prevent an activity from being
scheduled on a Saturday or Sunday.

¢ Schedule For: If you're like me, you like nothing better than delegating
work to another person. Here’s where you can assign each Activity
Series step to a poor, unsuspecting co-worker!
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6. Repeat Step 5 as often as you need and then click Next.

7. Indicate Yes if you want to schedule the series now or No if you want
to start it later and then click Finish.

Scheduling an activity series

After you create the template, you can schedule the series with one of your
contacts and set the anchor date. All the activities link together so that if
one activity changes to another date, you have the option to change only
that activity to another date or to reschedule all the remaining activities.

1. Create a lookup to find the contact or contacts with whom you want to
schedule the activity series.

[ warn you repeatedly that ACT! saves you lots and lots of time. If schedul-
ing an activity series with one person saves you time, just think of what
scheduling one with a bunch of people does for you!

2. Choose Scheduler>Activity Series.
The Schedule Activity Series dialog box appears.

3. Select the activity series template that you want to use, indicate the
anchor date, and click OK.

If you forgot to create a lookup or if you want to include a few more con-
tacts, you can do it. Select one contact from the With drop-down menu,
or select multiple contacts from the Contacts dialog box by clicking the
Contacts button and selecting Select Contacts.

The activities are scheduled and appear on the appropriate spots on the
contact’s Activities tab, the Task List, and on the calendars. No time is
yet associated with any of the activities because activities scheduled as
an activity series are automatically timeless.

No conflict checking is performed when the activities are scheduled via
an activity series. Your tasks are scheduled regardless of whether you
are already scheduled to be on vacation or off attending a conference in
Kalamazoo.

Before scheduling the series with a large number of contacts, test the series
by scheduling it with just one contact. Then take a gander at that contact’s
Activities tab to make sure that the activities appear in a logical sequence.
If something appears amiss, delete all the scheduled activities from the con-
tact’s Activities tab and read on.
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Modifying an activity series

Mistakes happen, and you might make one when initially setting up your activ-
ity series. Or you might want to assign another employee to one of the steps
in the series. Not to worry; here’s all you need to do to modify the series:

1.
2.

Choose Scheduler>Manage~>Activity Series Templates.

Select the Edit an Existing Activity Series radio button in the first screen
of the Activity Series Template Creation Wizard and then click Next.

. Select the activity series template that you’d like to edit and then

click Next.

. Select the activity step that you wish to edit and then click the Edit

button.

. Make the appropriate changes in the Add Activity dialog box and then

click OK.

. Click Next in the Schedule Activity Series window when you finish

modifying all the activities.

. Indicate whether or not you want to run the activity series and then

click Finish.
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In this part . . .

Eltering contacts into ACT! is only half the fun. The
other half consists of communicating with the outside
world. In this part, you find out how to run and create
reports for your internal purposes and also how to reach
an audience of one or thousands through the use of snail
mail or e-mail. You'll even find a large collection of com-
mercial forms for printing (buried deep inside ACTY).




Chapter 9
Using the ACT! Reports

In This Chapter
Getting to know the ACT! reports

Running ACT! reports

Printing calendars, address books, and labels
Making a Quick Report

Modifying reports

A fter you build your database, the fun part is sitting back and using it.

If paper is your game, ACT! is surely the name — at least of the software
that you should use for any type of reporting. In this chapter, I discuss the
various ACT! reports that are available. I also include basic information on
editing report templates.

In this chapter, I show you everything you always wanted to know about ACT!
reports but were afraid to ask. After reading this chapter, you'll be familiar
with the various reports, know how to run them, and also know techniques
for sharing those reports with colleagues. You also find out about some of the
“non-reports” such as labels, address books, calendars, and list views that
are buried in some unexpected places.

Working with Various ACT! Forms

You might feel that ACT! uses somewhat of a fuzzy logic when it comes to
reports. Basically, ACT! has three types of reports: reports, labels, and
envelopes. All three items are edited in pretty much the same way and stored
in the same ACT! folder. You find the actual reports in the ACT! Reports menu,
which seems like a pretty logical place to find them. However, you have to
search in the File menu to find labels and envelopes, which for most of us
seems to be fairly illogical. To further complicate the issue, ACT! throws in a
bunch of address books and calendars with labels and envelopes; these cal-
endars can’t be edited. Finally, ACT! throws in a bunch of Quick Print reports,
which are based on the contents of your various list and tab views.
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Knowing the basic ACT! reports

ACT! comes with a menu of 40 basic reports right out of the box. In the sec-
tion, “Using the Report Designer,” later in this chapter, I show you how to
customize existing reports or create new ones. Here I list the basic reports,
briefly describing each. Chances are good that at least one of the basic ACT!
reports gives you exactly the information that you're looking for without
having to go through the bother of creating a new one.

P If you really want to see firsthand what each ACT! report looks like, open the
Act9Demo database and print the first page of each report. Then stick all the
reports in a notebook. That way, if you ever need to run a report, you can go
back to your sample printouts for a quick reference before you start running
a lot of unnecessary reports.

The first three reports in the ACT! Reports menu are probably among the most
useful because they supply you with information for each of your contacts.
You can determine which one best suits your needs by deciding whether you
want to view a page, a paragraph, or simply one line of information about
your contact:

v~ Contact Report: A one-page report showing all of a contact’s information,
including the notes, history, and activities.

v Contact Directory: Both the primary and home address for each contact
in paragraph form.

v Phone List: The company name, contact name, company phone number,
and phone extension for each contact; the report displays one line of
content for each contact.

The next several reports display information about your notes and activities:

v Activities: Shows you the scheduled and completed calls, meetings,
and to-do’s scheduled with each contact during a specified date range.
This report is sorted by contact so that you can see a listing of all the time
that you spent — or are scheduled to spend — with any given contact.

1 Notes/History: Lists the notes and history items for each contact during
a specified date range.

v History Summary: Produces a tally of the number of attempted calls,
completed calls, meetings held, letters sent, and fields changed for each
contact during a specified date range sorted by contact. Figure 9-1 shows
you the top part of a History Summary report.
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Figure 9-1:
The ACT!
History
Summary
report.
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v~ History Summary Classic: Shows the numerical total of attempted calls,
completed calls, meetings held, and letters sent for each contact during
a specified date range, sorted by contact.

v~ History Time Spent: Shows the date, time, duration, and information
regarding activities scheduled with each contact during a specified date
range. You get a subtotal of the time that you spend with each contact
as well as of the time that you're still scheduled to spend with them —
if you assign a time duration to your meetings, calls, and to-do’s.

The next two reports are based on information in two of the key ACT! fields:

1 Contact Status: Shows you the ID/Status, last reach, last meeting, and
last results for each contact during a specified date range. You likely
want to create a Contact Activity lookup before running this report to
avoid having a lot of empty contact information in your final report.

v Source of Referrals: The Source of Referrals report relies on the infor-
mation in the Referred By field. Figure 9-2 shows you an example of the
Source of Referrals report as well as what happens if you don’t enter
data consistently. Dave Davis and David Davis are probably the same
person, yet they show up in two different spots in the report.

] Print Preview BE|
BS0E %5 b M B[O EDEE-
Chris Huffman, CH Gourmet &~
13 East 54th St.
1. History Summary New York, NY 10008
Date Range:  3{1/2005 - 3/31/2005
Ashley Allan, Tiny Town Productions
Hew Opportunity Total: 1
Thomas Andrews, Mader Electric Supply
New Opportunity Total: 1
Quote Total: 1
Bruce Baker, SimAero
Field Changed Total: 1
New Opportunity Total: 1
Theodore Barrett Jr, Verge Records
Hew Opportunity Total: 1
Or. Daiter Brock, Brack, Lathers and Freedman
New Opportunity Total: 1
Paul Brushman, Brushy's Golfing World
Opportunity Won Total: 1
Hew Opportunity Total: 2
Ethan Campbell, MegaGadgets Catalog Co.
Field Changed Total: 1
New Opportunity Total: 1 v
< *
The report s finished. Total 3
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Figure 9-2:
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Referrals
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[ Print Preview

HSDE#® & TP NEODEEE-®
i Source of Referrals

Chris Huffman, CH Gourmet Gifs
13 East 54t 5t

New York, NY 10003

Avertsement Totd Refarals: 7
Company Contadt Title Phone
HAL's Consulirg Comp Lames Jawsen Men In Charge (3) 5552232
Smero Bruce Baker Chief Designer (480) 5552144
Verge Records Pai Hendersan sssistant Engineer
Sewing Room;The Darielle Middlebury Onner (415) 5552242
Brushy's Golfing World Pai Ershman Chief Gdlf Seles Manager (455) 5552221 ]
Goldfish Recards snnette Sharkey New Media Manager (585) 5552145 1
Coffee Producers of Australia Morgan Kennedy Menager 07959 11234
Tnthony Federic Totd Referrals: 3
Company Contact htle Phone
Hare's Tavern Fhoenix Steven Marsh (07) 4669 1100
Greathorhem Coffee Lous Hi president 509-838-711
Party Perfesion Inc. Melanie Thompson @0 (732) 5555627
Galled In Told Referdls: 1
Company Contact Title Phone
srcadia Ave. Rarist Jackie Jorgensen Proprietor 01742576234
Davebavis Tota Rerarals: 1
Company Contad: Title Bhope

Gary Kan
Davd Davis Tota Referals: 1
Company Contad: Title Phone
Brodk, Lathers and Freedman Dr. Deiter Brock Plastic Surgeon (879) 9 2-33
E-mal Campaign

Totdl Refarals: 4

Total 2

The report is finished.

You can find the Group reports in a subsection of the main Reports menu.
These reports give you different ways to view the information in your groups.
If you don’t use groups (which I explain fully in Chapter 19), these reports
won’t be any benefit to you:

v Group Membership: Lists all groups and their members

v Group Summary: Lists the notes, histories, and activities for all groups
or for specific groups

v Group Comprehensive: Lists all information (including notes, histories,
and activities) for each group, subgroup, and their respective members

v Group List: Lists all groups and their description from the Group
Description field

You find the Company reports in a subsection of the main Reports menu.
These reports give you different ways to view the information in your com-
panies. If I sound like a broken record, it’s because the four Group reports
that I mention earlier all come in a “company version.” Also, included is a
Company Directory report that’s similar to the Contact Directory report.
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ACT! provides you with a variety of Opportunity reports, pipelines, and graphs.
The Opportunity reports use information entered on the Opportunities tab.

If you don’t use the Opportunities feature (head to Chapter 18 for the low-
down), you can’t use these reports. All the Opportunity reports are housed in
a separate Opportunity section in the Reports menu:

v~ Sales Analysis by Record Manager: Shows the total sales by Record
Manager, including everything from the average dollar amount of his
sales to the average number of days it takes to close a sale

1 Totals by Status: Garners totals of all sales opportunities and sorts them
by Closed/Won Sales and Lost Sales

v Adjusted for Probability: Lists all sales opportunities showing a
weighted sales total

+ Pipeline Report: Gives information about sales opportunities at each
stage in the sales process

v Opportunities by Record Manager: Lists sales opportunities, Closed/Won
Sales, and Lost Sales sorted by Record Manager

v Opportunities by Contact: Provides complete sales information for each
contact with a sales opportunity or a closed sale

v Opportunities Graph: Gives forecasted or closed sales, in a bar or line
graph

v Opportunities Pipeline: Gives the number of sales opportunities at each
stage of the sales process, in a graphical form

Unfortunately, more than a dozen more ACT! reports are buried. The Report
menus include several “other report” options, which would lead you to believe
that they would lead you to, well, some of the “other” reports. Not so. If you
click any of the “other report” menu options, you land in a folder that contains
all the ACT! reports. If you look carefully, you find the following reports:

v Birthday List: Shows contact name, company name, and birth date for
each contact

v E-mail List: Lists contact names and their primary e-mail addresses

v Fax List: Lists contact names and their fax numbers

v Task List: Gives the 411 about the activities scheduled with each contact
and the status of each activity

 Lost Opportunities by Competitor: Shows subtotals of lost opportunities
by competitor

v Lost Opportunities by Reason: Shows subtotals of lost opportunities by
reason
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v Lost Opportunities by Record Manager: Shows subtotals of lost oppor-
tunities by Record Manager

v Opportunities by Company: Show information for each company and
any open opportunities

v Opportunities by Group: Shows information for each group and any
open opportunities

v Opportunities Referred By: Shows opportunities subtotaled by who
referred the opportunity

v Gross Margin by Contact: Shows the gross margin by contact

v Gross Margin by Product: Lists each product and gross margin for each
product

v Gross Margin by Record Manager: Shows the total sales, total cost,
average discount, and gross margin as a percentage of sales by Record
Manager

1~ Sales Analysis by Record Manager: Lists Record Manager and total
sales

v~ Sales by Reason: Closed/Won opportunities listed by reason

Running an ACT! rveport

The following steps apply to all ACT! reports. The dialog box is the same for
all reports. Depending on the report that you're running, however, some of
the options might be unavailable — and thus, appear grayed out.

To run an ACT! report, just follow these steps:

1. Perform a lookup or display the contact record or records that you
want to include in the report.

All roads in ACT! lead — or at least pass by — the lookup. Before running
a report, decide which contact’s or group’s data you want to include in
your report. For example, you might run a History Summary report for
all your hot prospects or a Contact report for all contacts in a state or
region. You can include data from the current contact or group record,
the current contact or group lookup, or all contacts or groups.

2. Choose the Reports menu and then select the name of the report that
you want to run. To run a report that doesn’t appear in the menu,
choose Reports=>Other Contact Reports and select the appropriate
report.

The Define Filters dialog box opens, as shown in Figure 9-3. The General
tab is identical for any and all ACT! reports that you create.
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Figure 9-3:
The Define
Filters

dialog box.
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All reports come equipped with a General tab. However, all reports are
not created equally when it comes to the other tabs. Depending on the
report you run, different tabs are available.

Define Filters
;Iééﬁé}é[" Activity | Note || History | Opportunity

Send the report output to: Use data managed by

Preview | | (®allusers
Create report for (O Selected users:
C' Current Contact
(%) Current Lookup
O Al Contacts
[[JExdude ‘My Record'

3. In the Send the Report Output To drop-down list, select an output for

the report.

As usual, ACT! provides you with a plethora of choices. In addition to
printing or previewing a report you can also opt to save the report in
Rich Text (RTF), HTML, PDF, or Text (TXT) format. You can even e-mail
the report if you so desire.

4. In the Create Report For area, specify the contacts to include in the

report.

The choices are self-explanatory. You run a report for the current con-
tact, the current lookup, or all contacts.

5. Select the Exclude ‘My Record’ check box if you don’t want to include

information from your My Record in the report.

This option is not available for all reports.

6. In the Use Data Managed By area, select the Record Manager of the

contacts that you're including in your report.

e All Users: Includes contact records managed by all users of the
database.

e Selected Users. Includes contact records managed by selected users
of the database. If you're the only user of the database, only your
name appears in the list.
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7. Click the Activity, Note, and/or History tabs, if you're running any of
those reports, and make the appropriate selections.

e On the Activity tab, select the type of activities and the correspond-
ing date range of the activities to include in your report.

¢ On the History tab, select the type of histories and the corresponding
date range that you're including in your report.

¢ In the Use Data Managed By area, select the users who imputed the
data that you want to include in the report.

NNG/

&VQ\ By default, any of the activity, notes, or history reports show you data
for the current month. If you don’t change those date ranges, your report
might not give you the information that you're expecting to see.

8. Click the Opportunity tab, if you see one, when running a Sales report.
Seems a bit hokey, but sometimes the Opportunity options appear on
the General tab, and sometimes they appear on their very own tab, as
illustrated in Figure 9-4.
Define Filters
General | Activity | Note || History | Opportunity ;
Opportunities Use data managed by
Open @) Al users
[¥] Closed - won () selected users:
[] Closed - Lost
[v] inactive
Date Range:
I Current Month ~
Figure 9-4:
Using a
report’s
Define
Filter's
Opportunity
tab.
|

Regardless of where you find the Opportunity options, you still have the
same choices:

e In the Opportunities area, select whether you want to include Open,
Closed-Won, Closed-Lost, and/or Inactive sales in your report.

¢ In the Date Range drop-down menu, specify the date range of the
Sales Opportunities to include in the report.

¢ In the Use Data Managed By area, choose to include the opportunity
information from All Users or Selected Users of your database.
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9. Click OK.

ACT! runs the report. If you aren’t happy with the results, run the
same report a second time by using different criteria, or try running
a different report.

Creating labels and envelopes

All right. You create a brochure that’s guaranteed to knock the socks right off
your customers — and potential customers. Now all you have to do is send
out those puppies in the mail. No easier method exists to do this than by cre-
ating mailing labels or envelopes with ACT!.

Some of you might be snickering about now because you’re much too sophis-
ticated to be using snail mail. You probably already raced over to Chapter 10 to
find out how to create e-mail blasts. But you might still want to use the ACT!
labels to create everything from file tabs to name badges.

If you're printing envelopes, [ suggest limiting the number of envelopes that
you print at any one time. If you're just printing a single envelope for one
person to go with a letter that you just created with a document template,
using your word processor to create the envelope is probably easier than
using ACT!. ACT! automatically asks whether you want to print an envelope
after you create a letter when using a document template. (See Chapter 10 for
the details.)

You print labels and envelopes in ACT! exactly the same way. I focus on creating
labels, but these directions also work for envelopes. Just substitute the word
envelope for the word label in any of the directions.

To create labels or envelopes with ACT!, just follow these steps:

1. Create a lookup of the contacts for whom you want to create labels or
envelopes.

If you're creating a personalized mailing, I'd guess that you already created
a lookup of the contacts that get the mailing. By creating the correspond-
ing labels using the existing lookup, you’re guaranteed to have the same
number of contacts and to have your labels print in the same sort order.

2. Choose File=>Print from any ACT! window.

Okay, | know you’re probably scratching your head wondering why I'm
asking you to print when you haven’t created anything yet. That’s the
concept with these non-reports: They aren’t actually reports by defini-
tion, so ACT! just threw them into the Print menu. Go figure!

3. Choose either Labels or Envelopes from the Printout Type list.



130 Part lll: Sharing Your Information with Others

4. Select a template from the list and then click Print.

The available label templates are listed on the Paper Type area of the
dialog box.

Notice that all the labels are Avery labels. Chances are that even if
you’re using a generic label, you find the magic words Same as Avery
Label #XX printed on the side of the box.

The Define Filters dialog box appears which is a simplified version of the
Report Define Filters window you saw in Figure 9-3.

5. In the Send the Report Output To drop-down menu, choose your print
option.

You find all the same printing options that you have when you print
reports. Theoretically, you could save your labels in HTML format or
e-mail them to someone. Previewing the labels before printing them is
always a good idea. You can then print them directly from the Preview
screen if everything looks hunky-dory.

6. In the Create Report For area, specify whether you want to create
labels for the Current Contact, the Current Lookup, or All Contacts.

If you've sorted your database, select the Current Lookup option to
retain the sorting, even if you're printing your entire database.

7. Select either All Users or Selected Users from the Use Data Managed
By area.

This option refers to the Record Manager of each contact. You might
want to print labels for just your own contacts.

8. Click the Position tab.

This is how you’re going to make your first million dollars. According to
the rules of probability — or just your dumb luck — chances are that

if you use labels that come 30 to a page, you end up needing 32 labels.
This leaves you with a sheet of 28 unusable labels — unless you use
ACT!, that is. The Position tab allows you to start printing your labels
on the appropriate spot on your page.

9. Click OK.

You’re the proud owner of a beautiful set of labels.

Printing address books

Printing an address book is probably one of the more common tasks used
by ACT! users, and ACT! makes this chore extremely simple. The following
steps include all the down-and-dirty details for creating your own printed

address book:



Chapter 9: Using the ACT! Reports

|
Figure 9-5:
Choose the
form that
you want
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. Create a lookup if you intend to print only a portion of your address
book that I show you how to create at the beginning of this section.

Refer to Chapter 6 if you need a refresher course in creating an ACT!
lookup.

. From any ACT! window, choose File~>Print.
The Print dialog box opens.
. Choose Address Book from the Printout Type area.

You notice that the Edit Template button is grayed out because unfortu-
nately, you can’t edit any of the address book formats.

. Select the paper type for printing the address book.

You can print all your ACT! information onto preformatted, addressing
systems. ACT! provides you with the most popular, commercially available
addressing systems, including Day-Timer and Franklin. The preprinted
forms are available at any of the large office supply warehouse stores.

If you use an address system from one of these manufacturers, choose it
from the Paper Type list.

Figure 9-5 shows you some of your choices.

=) Print
Prtout Type: Paper Type: Preview Enable Preview []
= At-A-Glance Desk
Glance Folio (2 Col)
Address Book Glance Passport
'T\ Runner Classic
i Runner Entrepeneur (2 Col)
Day Calendar Runner Memo
‘%\ Runner Running Mate
viesk Calendar Timer Desk
Timer Folia (2 Cal)
E\ Timer Pertatle
Month Calendar nklin Classic
ki Compact
E ki Monarch (2 Col)
Reports icin Pocket
n 4 Full Page (L) (2 Col)
n A4 Full Page (L)
Labels n A4 Full Page (F) (2 Cal)
% n A4 Full Page (F)
n 555585 (L) (2 Col)
Envelopes 55285(L)
55285 (P) (2 Cel)
n A5 55%85(P)
Em

Of course, if you don’t want to spend the money on preprinted forms or
you just want a printout of your address book on a plain sheet of paper,
you can always use my particular favorite form for printing an address
book: plain paper.

When you select the Enable Preview check box, a preview of the
selected printout appears in the Preview pane on the right.
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5.

Click the Options button to specify the information to include in the

address book.

The Options dialog box opens, as shown in Figure 9-6.

Options
| Address Book |
Print:
] Frimary Address Addtional fields
¥ s
[] Alternate Address {None) v
[] Phone Mumbers
[[] Secondary Contacts p N
] E-Mail Address (Hane) hd
{None) w
Print Settings
[] Break page on new letter Sort order.
[] Letter at the top of each page Company name b
[] Europezn postal format
Create printout for:
| Curent Lookup i
- . Font size:
Figure 9-6:
. 8 ~
The Options
dialog box.
‘
|

6. In the Print area, select the fields to include in your address book.

7. (Optional) In the Additional Fields drop-down lists, you can add up to

10.

11.
12.

three additional fields.

The choices in Step 6 are based on the default fields that come with ACT!.
If you add several new phone number fields, they don’t appear in the
printout of your address book, but ACT! allows you to add up to three
additional fields.

. In the Print Settings area, select your printing options.

Here’s where you determine how your address book prints.

. From the Sort Order drop-down list, select the order in which you

want entries to appear in your address book — alphabetically either
by company name or contact last name.

From the Create Printout For drop-down list, specify whether to
include the Current Contact, the Current Lookup, or All Contacts.

(Optional) Change the Font Size option.
Click OK.
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Checking out the calendars

Printing a calendar is another chore that ACT! makes as easy as pie. You follow
pretty much the same steps that you follow when printing an address book.
1. From any ACT! window, choose File=Print.
By now you're getting used to looking in the File menu for the non-reports.
2. Choose the Day, Week, or Month Calendar from the Printout Type area.

You'll notice that once again the Edit Template button is grayed out
because unfortunately, you can’t edit any of the calendars.

3. Select your preferred calendar type.

Here’s where you want to make sure that the Enable Preview option is
selected so that you can see what the various calendars look like.

4. Click the Options button to specify the information to include in the
calendar.

The Options dialog box opens, as shown in Figure 9-7.

P As cool as those options look, you might want to have someone handcuff
you to prevent you from clicking too many of them. The more options you
select, the more difficult you might find it is to read your calendar when
it prints.

Options

Calendars

Print :

(] Company Name """ "1
[mEX e

[] Saturday and Sunday

[] Activity Details

Column for Pricrities

Start hour (day calendar only):

[ Print text in black
|
Figure 9-7:
The Options
dialog box.
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5. Click the Filter button to select more calendar options and then click OK.

Here’s where you can indicate the users, the date range, and the type of
activities that you want to appear on your calendar.

6. Click OK to close the Options dialog box and then click Print.

You can now scurry over to your printer and pick up your calendar, hot
off the presses. You can even print out an extra copy to hang on your
refrigerator if you want!

Working with Quick Reports

I like to think of the ability to print the various ACT! lists and tabs as some-
what of a secret weapon. By being able to print these lists, you can report
quickly on just about anything that you can view throughout your database.
This ability enables you to quickly create a report based on the specifications
and criteria that you need immediately.

Basically, if you're viewing a list, such as the Task List or Contact List, ACT!
can print the list. If you're viewing a fab that contains a list of items, such as
the Notes, History, or Opportunities tab, ACT! can print those items as well.

Follow these steps to create a report:

1. Display the list view or tab that you want to print.

e To display a list, such as the Task List or Contact List, choose View
and then the appropriate list.

e To display a tab, click the tab from the Contact, Group, or Company
Detail window.

2. Arrange the columns exactly as you want them to appear on your
printout.

If you need help adding/removing columns or changing the order or size
of existing columns, check out Chapter 5.

All the lists and tabs that you see in ACT! are customized in the same way.
3. Choose File=>Quick Print Current Window.

The Windows Print dialog box opens.
4. Click OK.

Some of you might be thinking that you can print a Quick Report pretty
quickly. You're right! Guess that’s why they’re called Quick Reports!
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Using the Report Designer
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Designing a database report can be a bit intimidating if you’ve never done it
before. I like to think that you can tackle the chore of creating a report in one
of two ways: the hard way or the easy way. The hard way consists of creating
a brand-new report entirely from scratch, which entails placing each and every
element of your report onto a blank report template. The easy way consists
of taking an existing report that’s kind of what you’re looking for and modify-
ing it.

You might want to open the Act9demo database and print out a page of each
of the existing ACT! reports for reference. Doing so helps you decide which
report works as the best starting point for your modifications.

Being familiar with the structure of your existing database can prove helpful
when you attempt to create a report. Thus, you need to know the field names
that you’re working with as well as their location in ACT!. For example, if you
want to include the name of a company, you must know that the field is called
Company and that you find the field in the Contact Detail window. If you want
to include notes that you added, you must know to include the Regarding
field from the Notes tab.

Before starting to create or modify a report, create a lookup of the contacts that
you’re including in your report. This step is optional but can be timesaving.
As you design your report, you'll notice that sometimes certain fields aren’t
large enough to contain their data or that columns don’t line up correctly.

By creating a lookup, you can check the progress of your report-designing
efforts by running a preview of your report each time that you add a new ele-
ment to it.

Changing the report content

[ mention earlier that chances are that you began with a basic report and
decided to modify it somewhat — or even give it a complete makeover.
Probably, the first thing you want to do is decide which fields will — or
won’t — appear in your report. After you make that momentous decision,
you might decide to tweak the order of the fields. Of course, then you're
going to have to realign some of the fields that you moved so that they line
up in an orderly fashion. You also have to decide how long a field should
be — for example, the State field needs to house only 2 letters, but the City
field might need to hold 30. Whew! You have a lot of work to do, so read on!
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Figure 9-8:
Modifying
an existing
ACT! report.

After you pick the report you want to modify — or decide that you're a glut-
ton for punishment and start from scratch — you're ready to begin.

1. Choose the Reports menu from any ACT! screen.
You have two choices here:

e New Template: Even if you choose this option, ACT! shows you a list
of all the report templates. The top choice, Empty Report, is the one
you want to choose if you're adventurous enough to start working
without a net. The problem with designing an ACT! report from
scratch is, well, that you have to create the report from scratch.

e Edit Template: For me and most ACT! users, this choice is safer.
You can now open the report that most closely matches your
desired results. To make things even less confusing, you’ll discover
that the filenames of the reports match the names of the reports.
Figure 9-8 shows you a sample of the Phone List report template.

Notice what appear to be duplicate fields. The first field that you see is the
Field label. You can edit any of these labels by double-clicking the label
and then typing in any desired changes. You can distinguish the actual
field with the colon that appears in each field. The actual data from your
ACT! database appears in this area when you run the report. The letter in
front of the colon indicates the Field type. For example, if you add your
name in the Header section, the field appears as My:Contact. If you add a
contact’s company, it appears on the report template as C:Company.
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2. From the Report Designer, choose Filec>Save As.

[ highly recommend giving your report a brand-new name even if you're
just tweaking an existing report. That way, you still have the original
report to go back to, just in case.

3. Fill in a name for your new report and then click Save.

Most of you have discovered the wonderful Undo feature that allows you to
take back what you just did. You can undo an incorrect change to your report
template by choosing Edit=>Undo (or holding down Ctrl and pressing Z).
Unfortunately, you’ll find that very often, Undo won’t work in the Report
Designer. All the more reason to save early and often. Talk about working
without a net!

Using the toolbox and properties

An ACT! report template consists of a number of elements. For example, you
might have your company logo at the top of your report and a series of
column headings that appear at the top of each page in your report. The ACT!
Report Designer lets you modify those various elements by using the toolbox
and Properties features.

Tooling around in the toolbox

Refer to Figure 9-8 to see the toolbox running along the left-hand side of the
Report Designer. It consists of the following eight tools:

v~ Pointer: You must click the Pointer tool to select any element in the
Report Designer that you wish to modify.

v Field: Click this tool to add a new field to the body of your report.
v Text: This tool allows you to create a descriptive text box.

v~ Rectangle: As its name implies, this tool allows you to draw a box or
rectangle in your report. Use this option to highlight a section of your
report. The rectangle is also used to create lines by making the border
and background solid and the same color.

v Picture: This tool allows you to add a graphic, such as your company
logo, to your report.

v~ Picture Field: This tool allows you to add a contact’s picture to your
report.

v~ System Field: This tool allows you to add fields including date, time, and
number of pages in your report.

v Subreport: Using this tool shows multiple objects for each contact in a
report. For example, you might want to show activity information for
each contact listed on a contact report.
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Saving early and often

Creating a report requires a great deal of
patience. Even the most expert of report design-
ers run into problems at times or (gasp) make a
mistake. Imagine how you'd feel if after spend-
ing several hours working on a report, you made
a huge mistake without realizing it until you ran
your report for the first time. You'd head back to
the drawing board (none too happily, | might
add). For that reason, | suggest that you keep
repeating the following procedure each and
every time you make a change to the structure
of your report.

From the Report Designer, choose Filec>Print
Preview and give your report a good examination:

v Ifyou like what you see, close Print Preview
and choose File=>Save. Your changes are
now safe and sound.

v If something is wrong in Houston (or at least
somewhere in the body of your report),
close Print Preview and then close the Report
Designer without saving your changes.
Cutting your losses is easier now rather
than trying to untangle the mess you might
inadvertently create later.

A\

Using the properties properly

In addition to the toolbox, the Report Designer comes equipped with a
Properties window guaranteed to give you more options than your local ice
cream store. The Properties window runs along the right side of the Report
Designer (refer to Figure 9-8). You can see what [ mean by the options available
to you. The purpose of the Properties window is to show you all the applied
formatting of the selected element.

Feel like the Properties window is infringing on your territory? You can send
it packing. A simple press of F4 closes the Properties window. Want to bring it

back? Simply press F4 again.s

If you want to move the toolbox or Properties window out of the way, you
can drag either by its title bar to whatever area of the Report Designer you're
not using. Want to put one back? Double-click its title bar and whoosh!, there

it is!

The Properties window reflects the properties of the field or element that’s
selected. The left side of the Properties window lists all the aspects available
for the field or element that you select. The right side shows you the selected
choice. If you want to change any particular aspect, simply click the option
on the right side and choose a different formatting option from the drop-down
list that appears. For example, if [ want to change a font color from black to
red, I click the word black that appears to the right of the font color and then
choose red from the drop-down list.
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You can also use the Properties window to change the attributes of several
elements at the same time. You can click several elements at the same time
by holding down either Shift or Ctrl while clicking the elements that you want
to change. After you make your selection, you can change as many attributes
as you want in one fell swoop.

Working with existing fields

Start by tweaking some of the fields already on your report template. You could
start by removing some of the fields from the Contact Report, or you might
want to make the font a wee bit larger to accommodate your 40-something
eyes. The more ornery members of the crowd might not be happy with the
order in which the fields appear in one of the opportunity reports. Like any-
thing else, it’s simple if you know the trick.

1. From the Report Designer, click the Pointer tool in the toolbox.
2. Select the fields you want to modify.

To select multiple fields, hold down Shift or Ctrl while clicking any addi-
tional fields. If you're a mouse lover, you can also drag your rodent around
several adjoining fields to select them.

You can identify selected fields by the little boxes that now appear along
their edges and centers.

After you select the fields you want to work with, you can change your selec-
tion in a couple of ways:

v To change field properties: Select an item from the Report Designer
Properties window and edit the properties. You can also select font attrib-
utes such as bold, centered, and size from the Report Designer toolbar.

v To delete a field or a field label: Press Delete.

When you poke around in the various templates, you'll notice that many
of the ACT! reports include custom fields. Avoid the tendency to delete
these custom fields — they’re there for a reason. Custom fields contain
expressions or link to special scripts to make the reports do special
things. Although custom fields can be moved and resized and the font
can be changed, custom fields should not be deleted. See the sidebar,
“Creating a custom field,” for more information on creating a custom
field. Also, custom fields depend on the presence of regular database
fields in the report. Most often these other fields are hidden but might
not be. The fewer changes you make when modifying a report — especially
deleting fields — the better.
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v To resize a field: Grab one of the selection handles on either side of the
field and then drag to either the left or right, depending on whether you
want the field larger or smaller. If you want, you can modify the size of a
selected field by using the Height and Width properties for the field.

1 To move a field: Place your cursor in the middle of a field or group of
fields and drag them to the desired location. Again, you have the choice
of positioning the field via the Top and Left properties for the field.

v+ To align fields: First select all the secondary fields and then select the
anchor field. The anchor field is the one that is correctly placed on the
report template and the one you should click last; all the other fields are
the ones that you want to align horizontally or vertically with the anchor
field. Choose Format=>Align from the Report Designer menu and indicate
how to line up the fields.

As you modify and move fields, you'll probably start to notice that the
fields no longer line up as neatly as they once did. Although you can
physically drag a field or fields around in an attempt to line them back
up again, you'll probably end up wasting a lot of your valuable time.
Using the Align Fields options is much more accurate — and better on
your blood pressure!

When you use fields like the City, State, and Zip Code on the same line, you might wonder how ACT!
can adjust the field size automatically so that large city names (such as Cincinnati) and smaller names
(such as Akron) can squeeze in comfortably in front of “, OH”. Enter the custom field. You have to
use a custom field and a programming expression that tells the report generator to adjust the field
sizes. After you create a custom field, it can be moved anywhere on the report, so you might want
to create the custom field first.

1.
2.

. Click Close in the Select Field dialog box to return to the Properties window.

. Note the properties of the three added fields.

Creating a custom field

Click F4 to open the Properties window (if it's not already open).
Add the City, State, and Zip Code fields anywhere on the label.

Be sure to deselect the Include a Label check box.

You can accomplish this by clicking each field and looking for the Name that's listed in the
Properties window. Copy the names for the City, State, and Zip Code fields exactly as they
appear in the Properties window because you need them in the custom field expression.




5. Hide the new fields.

You need these fields because they provide information for the custom field you add, but you
don’t want them to appear on your printouts. Follow these steps to hide the fields:

a. Select all three fields (hold Shift or Ctrl and click each field).
b. Change Visible to False in the Appearance section of the Properties window.
c. Setallthe properties to No in the Behavior section.

d. Inthe Layout section, change the Height Property to 0.01, the Width property to 0.15, and the
Left property to 0.01.

6. Move the fields to a convenient location on the template.

1. Click each field individually and change the Top property to 0.01 for the first field, 0.02 for the
second field, and 0.03 for the third field.

8. In the Tools window, click System Field and then draw a field on the label.
9. In the Select System Field dialog box, click Custom and deselect Include a Label.
10. Click Add and then click Close.
A custom field can be sized and positioned in the same manner as you would any other field.

However, to complete your project, you need to add the following in the Expression property: In the
Properties window (press F4), look for the property called Expression. In the field portion of the
property, type the following:

Cityl&", "&Statel&" "&ZIPCodel

Be sure to use the field names exactly as you copied them down earlier and to include the amper-
sands, quotes, punctuation, and spacing.

You can now add the other fields that you want to have on your label.

\\3

You can distinguish between the anchor field and the other fields that you
select by carefully examining the selection handles. If you look at Figure 9-9,
the anchor field has light gray handles whereas the secondary fields all have
black ones.

Adding a field

After you modify, move, or delete fields from your template, you might want
to add fields. If so, follow these steps.
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The Select
Field

dialog box.
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A dozen of the basic ACT! reports are invisible to the naked eye — or at least
not seen on the Report menus. Save yourself a bunch of time and check
whether one of those reports fits the bill. It’s always easier to delete and
move existing reports instead of adding new ones.

1. In the Report Designer, click the Field tool in the toolbox.

2. Place your cursor on the template where you want to insert a field and

then drag down and to the right to define the field’s length and position.

You probably want to add the new field to the Detail section of your
report. However, you can also add fields to any of the other sections,
including the header and footer as well.

When you work with a report, you might find it helpful to enlarge the
sections to give you a bit more elbowroom. You can do this by grabbing
the gray horizontal line that appears at the bottom of each section and
dragging it down an inch or two. Just remember to drag the section line
back up again when you’re finished adding new fields to avoid seeing
huge gaps between the lines of your report.

When you release the mouse button, the Select Field dialog box appears,
as shown in Figure 9-9. You can now choose any of your existing ACT!

fields to add to the report templates.

Select Field

Select a record type:
Tontact Hh

Fields:

Access Level ”~
Account Number

Address 1

Address 2

Address 3

Alternate Extension

Alternate Phone

Birth Date

City

Company

Contact

ContactlD

Country

Create Date

Credit Card Address Address 1

Credit Card Address Address 2 [

Indude a label

Close

3. Select the record type that you want to add from the Select a Record
Type drop-down list.

Typically, you want to add a new Contact field to the body of your report.

However, you might decide to add My Record fields to the header so

that your name and other pertinent information appears at the top of the

report. You might also want to include Secondary Contact information.
You can even choose to add Activity, History, Note, and Opportunity
fields to your report.
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When you make a record type selection, notice that the list of fields
changes. For example, if you add a Note field, the choices include Date
and Time; comparatively, selecting Contact Opportunity allows you to
include any of your Opportunity fields.

. Indicate whether you want to include a field label.

Alabel appears on the report regardless of whether any information
appears in the field. If you don’t want to include a field label for a field
in the template, deselect (clear) the Include a Label check box.

. Click the Add button.

The Report Designer contains the fields and field labels that you added.

6. (Optional) Continue adding additional fields.
7. Click the Close button when you finish adding new fields.

Unfortunately, as great as the ACT! Report Designer is, it does have a few limi-
tations. Here are a few of them:

v You can’t change the sort order of a report, such as the task list that

sorts according to contact name.

v You can’t mix and match too many ACT! tables in a single report by trying

to include contact, note, and opportunity information. The best way to
add information from other tables, such as History or Opportunities, is
to use a subreport.

v You can’t add group or company information to a contact-based report.

» You can’t add contact information beyond Company and Contact to an

opportunity-based report.

v You can'’t directly add product information to an opportunity-based

report. You need to use a subreport.

Adding a summary field
After you add a field to a report template, you might want to add a summary
field. Summary fields can be used to give you a count of all the contacts that

appear in a report or a total for a column containing numeric data.

1. Add the field in the Report Designer that you want to convert into a

summary field.

Although this sounds fairly straightforward, you’'ve got several things to
think about here:

e Summary fields typically appear above or below the rest of your data,
so you must put these fields in a header or footer.
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e The summary fields usually match the data type and field. In other
words, if you want a count of all your contacts, your summary field
will be the Contact field. If you want a total of all your sales, the
summary field will be the Total opportunity field.

e The data doesn’t actually have to appear in the report to be summa-
rized. For example, you might want to have a list of contacts with a
total representing the number of purchases they’ve made.

¢ Subtotals summary fields may be placed in a section header or
footer, but grand totals must be placed in the report footer.

2. Right-click in the field and choose Properties from the Field Properties
displayed.

3. Click the Data tab and select the Summary option from the Field
Type area.

You can check out the Data tab of the Field Properties dialog box in
Figure 9-10.

Field Properties

Font || Style [ Format| Data | Type
Field Type
O petal
©Fummary!

Summary Field Options:
@ Count

O Total
() Average
) Minimum
() Maximum
|
Figure 9-10:
Creating a
summary
field. [ o J[ concel J[ aonly
|

Your summary options include adding a count, a total, or an average of
the items found in your report.

If some of the options are grayed out, those options don’t apply to the
field that you selected. For example, I could count a list of contacts, but
[ can’t add them together because you can’t add character fields.

4. Click OK to add the field to your report.

You recognize a created summary field because ACT! inserts several let-
ters in front of the field name to indicate the type of summary field that
you just created.
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You create sections in a report template to help you organize the information
that you want to include in your report. In general, the main information that
you’re reporting on appears in the body of the report. However, you might
want your own contact information to appear on the first page of your
reports, the page number to appear at the top of every page, the date and
time to show up on the bottom of each page, and your totals to magically
materialize on the very last page. Later in this chapter, | show you how to

do just that.

Defining report sections

A report template is divided into sections of information. Each section has a
section title that appears in the report template but doesn’t appear in the
report itself. You can determine which fields you want to appear in each
given section. A report template consists of five main sections; you can’t
delete or change the order of the sections, but you can hide a section if you
don’t want it to appear in your report (see “Hiding a report section” later in
this chapter. The five main sections are

1 Report Header: Information that appears at the top of the first page of
the report, such as the report’s title and creator

v~ Page Header: Information that appears at the top of each page, such as
column headings

v~ Detail: Area that contains one or more of your Contact or Group fields

The Detail section is the meat and potatoes of the report — where you
find pertinent information, such as the contact’s name, address, and
phone number.

v Page Footer: Information that appears at the bottom of each page in
your report, such as the date and page number

v Footer: Information that appears at the bottom of the last page of your
report, such as a recap or grand total

You can resize a section to make room for additional fields by dragging the
horizontal gray line (that appears at the bottom of the section) lower on the
template.

After you fiddle with your report template and have it exactly the way you
want it, don’t forget to resize each section back to the original size — or close
it up as much as possible. Any blank areas in a section appear as blank areas
in your report!
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Modifying report sections

Most of you will be quite happy to rely on the five default report sections.
However, from time to time, you might want to get a bit fancier. Maybe you
want to list each of your contacts alphabetically by last name, grouped by
city. You need to create subsections within your report to accomplish this.
Not a problem; here’s all you need to do:

1. In the Report Designer, double-click any section header.

Figure 9-11:
The Report
Designer
Define
Sections
dialog box.
|

The Define Sections dialog box opens, as shown in Figure 9-11. Notice
that in addition to adding subsections, you can choose a few other
options as well:

® Page Break: Indicates whether you want to have each section appear
on a new sheet of paper or start a new sheet at the end of a section

e Collapse if Blank: Closes up a section if no information is contained
in it
e Allow Section to Break Across Multiple Pages: Allows a long section
to continue on to multiple pages
. Click the Add button to add a new section to the report.
The Select a Field to Group By dialog box opens.

. Select the field that you want to use to group your report and then
click OK.

. Select an ascending order from the Define Sections dialog box.

After you select the field that you wish to group with in Step 3, you are
returned to the Define Sections dialog box. The new subsection is high-
lighted, and you can indicate whether the new subsection appears in
ascending or descending alphabetical order.

Define Sections

Report Header Section Behavior add
Page Header

Page Footer D Allow section to break across multiple
Report Footer pages

Page Break:
Section 1

Section Header
Detail _—
Section Footer ol

None v




Chapter 9: Using the ACT! Reports ’4 7

After you create a new subsection, you can place as many fields on it as you
want using the techniques in the section, “Adding a field,” earlier in this chapter.

Hiding a report section

There might be times when you want to hide a section. For example, say you
want a report that counts the number of contacts in each of your ID/Status
fields. Theoretically, ACT! needs to list all those contacts so that they can be
counted, but you really don’t want to see all those contacts because you're
interested only in seeing a total. Although you can’t remove any of the default
report template sections, you can hide them, which gives you the same result.
To hide a section

1. In the Report Designer, open the Properties window by choosing
Viewc>Properties Window.

2. Select the name of the section that you wish to hide.

3. Click the Visible property in the Properties window and then change
it to No.

Although you can still see the section in the Report Designer, it doesn’t
appear in your finished reports.

Customizing Labels and Envelopes

After you master the art of editing report templates, it’s easy to edit the
non-reports — that is, labels and envelopes. ACT! uses the good ol’ Report
Designer when editing labels and envelopes although fewer options are
offered.

Performing a label lobotomy

Although the following instructions are geared toward labels and envelopes,
you’ll find that they are applicable to reports as well. To edit a label or
envelope

1. Choose File~>Print from any ACT! screen.

2. Choose either Labels or Envelopes from the Printout Type list and
select the label or envelope type that you’d like to modify.

For this example, | choose Labels; however, you'd follow the same steps
if you were modifying an Envelope template.
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3.

6.

Click the Edit Template button to make changes to an existing label
template.

The Report Designer dialog box opens.

. Before making adjustments to the existing label formats, save the tem-

plate with another name.

Excuse me if I'm boring you, but you accomplish this by choosing File~>

Save As, typing the name of the template in the File Name field, and then
clicking OK. The next time that you run a set of labels, the template that
you create appears as one of the label template choices.

. Modify the label formats to your heart’s content.

You can modify the label using the same techniques that you use to
modify a report.

Click OK.

Creating new labels

ACT! comes equipped with a wide selection of Avery label sheet types, so the
template format that you want should be readily available. However, if the label
that you ordinarily use isn’t listed, you need to create a new label template.
You can specify the custom dimensions for the sheet you use by following
these directions:

1.
2.

From any ACT! screen, choose File=Print.

Choose either Labels or Envelopes from the Printout Type list and
select the label or envelope type that you want to modify.

I'm going to choose Labels; however, you'd follow the same steps if you
were modifying an Envelope template.

. Click the Edit Template button to make changes to an existing label

template.

. Choose Filec>"New and then click No in the Save Changes dialog box.

5. In the New Report dialog box, select Contact Labels from the

Templates column and click OK.

The Create Label dialog box, as shown in Figure 9-12 opens.

. Click the drop-down list in the Choose a Label Product field and look

for the label sheet that you want to create.

If you can’t find the label size you want, select the label product that
most closely matches what you want.



|
Figure 9-12:
Creating
anew

label type.
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New Report
Report Types: Templates:
® Contact Reports Empty Contact Report Contact Envelopes
Company Reports A_Eﬁviﬁes F}euurt
Group Reports Birthday List Report

Contact Directory Report
Contact Report Report
Contact Status Report

E-mail List Report

Fax List Report

History - Time Spent Report
History Summary Classic Report
History Summary Report

Notes - Histories Report

Phane List Report

Source of Referrals Report
Task ListReport

Eontact [abels!

< >

Opportunity Reports
Product Reports

7. Fill in the label specification in the fields provided.

Because variety is the spice of life (and labels), you can indicate the vari-
ous options you want for your label:

¢ Page margins
e Label size
e Space between the labels
® Number of labels (that is, the number of columns per page)
¢ Page orientation
8. Click OK when you finish making your selections.

The Report Designer opens and you now have a blank label template.
At this point, you're ready to place the fields that you need on the label
by using the same techniques as adding fields to a report.
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Chapter 10

Merging Your Information
Into a Document

In This Chapter

Understanding mail merge
Choosing your word processor
Creating a document template
Converting existing templates
Using the Mail Merge Wizard

A particularly useful ACT! feature enables you to create customized docu-
ment templates: forms in which ACT! fills in your selected data fields.
You can send these forms to a thousand people as easily as you can send
them to just one person. You can send out routine documents one at a time
on a continual basis, or you can send out the document one time to all or
part of your database. After you create a form, you can send it out via snail
mail, e-mail, fax, or Pony Express.

Mail Merge Isn’t Just about Mailing

Poor mail merge! Folks often have two common misconceptions about mail
merge. Some people think that mail merge is synonymous with junk mail.
Also, the word mail makes some folks think postage stamps are involved.
However, neither of these common misconceptions are true. A mail merge
simply takes the content of one or more fields and puts that content into a
template or form.
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A good way to understand the concept of mail merge is to visualize this
simple equation:

template + data field(s) = personalized document

Note the (s) at the end of data field, suggesting that you can use either one
name or many names. Some of you might think that you will never perform a
mail merge because you have no desire to send out a mass mailing. Others of
you might have already perfected the art of mass mailing but never realized
that a mail merge can be directed to one person or to thousands of people.

[ hate to be the one to break your bubble, but if you have any kind of routine
documents that you're generating repetitively, you should be using ACT!’s
mail merge to do it.

The three things necessary to create a mail merge are

+ A name or a list of names: If you've followed this book to this point,
you’re the happy owner of a database and know how to create a lookup.
(Don’t know how to create a lookup? Better check out Chapter 6.) You can
merge a document with your current contact, your current lookup, or
the entire database.

v A program that can combine the names into the template: After you
have a list of names and a document template, you need something to
combine them. You could try to use your food processor, but I prefer to
use the mail merge feature in ACT!.

v A document template: A document template is a letter or form that sub-
stitutes field names in place of names and addresses or whatever other
information comes directly from your database. ACT! comes with a
number of document templates that you can either use as is or modify.
You can also create your own document templates by using a word
processor.

Picking Your Word Processor

ACT! can use either its own word processor or Microsoft Word to create
document templates. By default, ACT! is set to use its own word processor.
Most ACT! users prefer using Word as their word processor, and | assume
that you're no different. Although the ACT! word processor gets the job done,
chances are that you're already using Word — and using an application that
you're already familiar with is preferable. You'll also find that the ACT! word
processor offers a far smaller array of features than Word.
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If your word processing preferences inside ACT! aren’t set to use Microsoft
Word as your default word processor, you can’t use existing Word templates
or any templates that you created by using Word. To change your word
processor settings, follow these handy-dandy directions:

1. Choose Tools=>Preferences from the Contact Detail window.

2. On the Communication tab, select a word processor from the Word

Processor list.

In this case, you're choosing Microsoft Word.

3. Click OK.

Using the out-of-the-box templates

For those of you all set to write The Great
American Novel, you might want to create all
your own original documents. That's great, and |
recommend that you skip to the section “Creating
a Document Template.” The rest of you might be
interested in perusing some of the great tem-
plates that come prepackaged in ACT!. Even if
you decide that these templates aren't exactly
what you're looking for, you can use them as a
starting point for developing your own unique
document templates.

You might want to run each of the templates one
time to determine which ones you think will be
most useful to you. Later in the section entitled
“Creating a Document Template,” you find out
how to modify them to your heart’s content. Right
now, | want to point out two of my favorites that
you might want to focus on. These two document
templates are listed for you on ACT!'s Write
menu because you'll probably use these two
templates the most often.

v Letter: The Letter (Let ter . adt)template
is a great template to use when you need to

create a letter on the fly to one of your con-
tacts. It automatically dates a letter and
addresses it to your current contact. It even
includes your name, company, and title on the
bottom (the closing). All you need to do is fill in
the body of the letter and stick on the stamp!
You can also use this template as a boiler-
plate for creating the rest of your form letters.

Fax Cover Page: If you feel that you have no
need for ACT!’s fax cover page because you
already created something rather spiffy with
Word, you can convert that Word document
into an ACT! template to have ACT! auto-
matically fill in all the necessary fields for
you. You'll want to name that template Fax
Cover Page.adt and replace the cur-
rent Fax Cover Page.adt template.

You'll notice the Other Document (from tem-
plate) choice on the Write menu. Click it and
you'll find all the ACT! templates. You might
want to hold off using the Quote template —
it's designed for use with the opportunities
you create. Flip to Chapter 18 for more details.
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Creating a Document Template
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Before you can win friends and influence prospects with your dazzling dis-
play of personalized documents, you need two basic elements: the data and
the document template.

You're creating a template, not a document, to perform your mail merge.

A document is a plain old file that you create and use in Word. You use it once,
save it, and store it away for posterity or delete it as soon as you’'re done with

it. Comparatively, a template is a form that merges with your contact informa-
tion. The convenience of templates is that you use them over and over again.

With your data tucked away nicely in your database, all you have left to do is
to create the document template, which involves creating a form document.
Your document template contains placeholders that are then filled in with
information from your database after you perform a merge. Create a docu-
ment template by following these steps:

1. Choose Writer>New Letter/E-Mail Template.

If you chose Word as your word processor of choice, try not to look too
surprised when Word opens. (To review how to set this preference, see
the preceding section.)

2. Resist the urge to close the Add Mail Merge Fields dialog box that’s
obscuring a portion of Word.

The Add Mail Merge Fields dialog box, as shown in Figure 10-1, is the
main event of this little procedure. If you scroll through the Add Mail
Merge Fields list, the various field names should ring a bell. After all —
they’re all your database fields.

You can drag those pesky fields out of your way by placing your mouse
pointer on the Add Mail Merge Fields title bar and dragging this dialog
box out of the way.

3. Change all your document settings.

Go ahead and change your font, margins, and other formatting items
exactly as if you're working in a regular ol’ Word document.

4. Create the body of your letter or form.

Nothing new under the sun here. You can backspace, delete, and type
just like you do in any Word document.

5. Click the spot in your document where you want to insert a field.
6. Determine what type of field you want to insert into your template.

The Add Mail Merge Fields dialog box allows you to insert three different
types of field information.
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Figure 10-1:
The Add
Mail Merge
Fields

dialog box.
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¢ Contact: If you want your contacts’ information to appear when you
perform a mail merge, you need to insert a Contact field into your
template. In a letter, the name at the top that you're sending the
letter to is the Contact field.

Whatever information you've entered into a field appears in the
merged document. If any of the fields in the contact record are
empty, ACT! skips that field; you don’t see a blank line. In Figure 10-1,
I inserted the Company field; however, if your contact isn’t associ-
ated with a company, that line is skipped.

e Field Label: Selecting the Field Label option inserts the name of the
field, not the information contained in that field. You might wonder
why you want to go through the effort of scrolling through the list
of field names to insert a label when you could just as easily type
in the field label. I wonder the same thing!

e My Record: If you want your own contact information to appear,
select the My Record field option. If you're creating a letter docu-
ment template, the name that appears at the bottom (in the closing)
is your name and is represented by the My Record field option.

Your My Record information resides on the first contact record
that appears when you open an ACT! database.

4] Letter.adt - Microsoft Word

i File Edit View Insert Format Tools Table Window ACT! Help T
: A4 Normal S -|B 7 U EE==is-=
ERNE=N" NERERT= RN <A S @ O R =P e -G
-

+ Tahoma

E@- 1 ' EEE - -
April 15, 2006
Add Mail Merge Fields
<Contact>
<Compary> Select Field Tvpe:
<Business Line 1> [Contact |
<Business Line 2>
<Business City>, <Business State> <Business Postal Code>

Access Level A
Account Number [
Address 1

Address 2

Address 3

Atemate Extension

Atemate Phone

Bith Date

Ciy

Dear <Salutation>:

Typebody, of letter here,
Compary
Contact
Country ]

Sincerely,

<MY.Contact>
<MY.Title>
<MY:Company>

wong

BEEENIE >

Page 1 Sec 1 1 AtL5 Ini cold 553
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7. Insert fields where you want contact information to appear.

Here’s where the fun begins. Every time you get to a part that could
be populated with ACT! information, you must scroll down that long
list of fields, select the one to insert into your template, and then
click Add.

The field name appears in your document set off by a set of lovely
angle brackets. Treat these field names exactly as you do any other
words in your template. For example, if you want to see them set in
bold, bold the field name. You’ll also want to place the appropriate
punctuation next to an inserted field if necessary; you’ll note that in
Figure 10-1 that the <Salutation> field in the greeting line is followed by
a colon.

8. Check your document for accuracy and edit as necessary.
9. Choose Filer>Save As.

Okay, | know that you probably already know how to save a document in
Word, but [ want to draw your attention to an interesting phenomenon
that occurs when saving an ACT! document template in Word. Your doc-
ument is automatically saved with the .adt extension. And, unless you
specify otherwise, your template is saved to your default template
folder. In Chapter 3, [ show you how to determine the location in which
to save your templates and also how to add a document template to the
Write menu.

Document templates created with the ACT! word processor end in the
extension . tpl.

After you create a template, you can change it whenever the need arises.

For example, you might discover a spelling or grammar mistake. Or the con-
tact fields that you’re using might not work correctly. You might even want to
make changes to the wording in some of the templates, including the out-of-
the-box templates. The procedure for editing your document template varies
only slightly from that of creating the document:

1. Choose Write=>Edit Template.

2. When the Open dialog box appears, select the document template that
you want to open and then click Open.

The template opens in Word, and the Add Mail Merge Fields dialog box
automatically appears (refer to Figure 10-1).

When you edit an existing template, you see your field names in angle
brackets within the document rather than your data. If you see actual
data, you aren’t editing the template, and the changes that you make
affect only the current document that you're in; your document template
remains unchanged.

3. Make the appropriate changes to the template.
4. Click Save when you finish editing.
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In general, using an existing template is easier than creating a new template
from scratch. Basically, to create a new template, you simply open a similar
template and follow the same procedure as if you're editing an existing
template — but save the file with a different name. Or, if the document
already exists in Word, you might want to first open the existing document
in Word, highlight the information that you want to appear in your template,
copy it to the Clipboard, and then paste it into the new template.

Grappling with Graphics

So far I've been discussing your basic “vanilla” template. Any of the templates
that you create following the techniques in the preceding section can be
transmitted with either snail mail or e-mail. These templates can all contain
merge fields so that your written letters and your e-mail can be personalized
to contain any of the information found on a contact’s record. They can be
created using any of your font attributes including font type, size, color, bold-
ing, italics, and underlining.

If you want to use ACT! as an e-marketing tool, you probably need to under-
stand a little more about the technology that is involved in sending e-mail.

Basically, the two kinds of e-mail templates that you can create are

v+~ Plain text: These templates consist of plain old, black-and-white verbiage.

v HTML: These templates are colorful and very often contain graphics.

So, what’s the hang-up? In a word — graphics. Those company logos that you
want to include in your templates and send via e-mail can prove to be quite
annoying, troublesome, and just downright exasperating. Graphics need to be
properly embedded into the body of your template or linked to graphics that
are hosted on your Web site in order to avoid being sent as an attachment.

Think about it — have you ever received an e-mail from someone with a
graphic attached to it? You open that e-mail and see a big white box with a
tiny red X somewhere in it. Puzzled, you open the attachment and see a logo.
This is a perfect example of someone who forayed into the exciting world of
graphics and lost the battle. Here are a few tips to consider before sticking a
graphic into one of your templates:

v You need to insert the proper HyperText Markup Language (HTML) code
into your template. The best way to accomplish this is to create the con-
tents of your e-mail in a program that can save it as HTML code, such as
Microsoft FrontPage. You can then insert the HTML-coded file into your
template.

v~ Still feeling dazed and confused when it comes to sending HTML e-mail?
Consider using an add-on product to help you create those templates.
You can read about one of my favorites, SwiftPage Email, in Chapter 23.

157
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Don’t lull yourself into thinking that your e-mail is going to properly transmit
just because it looks perfect when you edit or preview your template.
Consider creating a free Yahoo! or Hotmail e-mail account and send a trial
e-mail there to make sure the graphics display properly before sending them
off to the outside world!

Reaching an Audience of One

\‘\Q,N\BEI?

Re,

QQ,N\BER
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Now that you've created a document template — or edited one of the existing
ACT! templates — you’re ready to fill in your template with contact informa-
tion. Don’t assume that creating a mail merge implies sending out a single
message to thousands of people at one time. A mail merge can also be used
to automate the most mundane and routine of tasks. You can use ACT!’s doc-
ument templates to write a thank-you letter every time that you land a new
client or to write an inquiry letter each time that you receive a new lead.
After you discover this timesaver, [ guarantee that you’ll never go back to
your old way of creating documents again!

To send a document to a single member of your database, follow these steps:

1. Create a lookup to find the contact to whom you want to send a letter.
Feel free to turn to Chapter 6 if you need help creating a lookup.

The current contact record that you have displayed is the one whose
information fills in your template.

2. Choose Write and then choose Letter, Memo, Fax Cover Page, E-Mail
Message (from template) or Other Document.

You can modify any of the ACT! menus. You might want to modify the
Write menu to include some of your own templates. Flip over to Chapter 3
if you need a little refresher course in adding new items to an ACT! menu.
As you start creating new templates, you can add corresponding menu
items to the Write menu.

You use the same templates for both snail mail and e-mail. When you
choose to write an e-mail from a template, ACT! will automatically open
the content of your template as an e-mail message. When you choose
any other option, ACT! will open your template in your word processor.

3. Complete the body of the document.

Depending on the type of document that you choose to create and the
modifications that you made to the document template, you're looking
at the start of a document. For example, by choosing to create a letter,
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the name, address, salutation, and closing are already provided. You just
need to add the body of the letter to complete it. If you choose Other
Document, you can choose either one of the other ACT!’s templates or
one of your own. These, of course, already include the body as well.

If you choose to create a fax cover sheet, you need merely to add the
number of pages in the transmittal and an optional comment to proceed.
If you choose to create an e-mail message from a template, you just need
to fill in the subject line and send it.

4. (Optional) Save your document.

After you complete your document, you can save it to the location of your
choice. If you don’t think that it’s necessary to save the document that you
create from a template (because you can so easily re-create them), you
aren’t required to.

5. Print, fax, or e-mail your document.

If you use Word as the default word processor to create your ACT! docu-
ments, you can now print, fax, and e-mail exactly like you're already used
to doing in Word.

If you choose to print, the Create History dialog box appears after print-
ing is complete (see Figure 10-2). Now this is cool. I like to refer to this as
the “Would you like fries with that?” step. After you create a document
from a document template, ACT! will create a record of the document on
the History tab. You now have a history of the date on which you sent a
document. Better yet, other people in your organization are also aware
of your interactions with the contact. If you don’t want to record a his-
tory, select the No, Do Not Record History radio button.

Create History

Document Printed: Document2

Record History
Would you like to record a history for this contact?
) ¥es, record histony

Regarding

[[] Attach document to history
) No. do not record histary
Print Envelope
Would you like to print an envelope?

O Yes
& No
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¢ To attach the document to a note on the History tab: Select the Attach
Document to History check box. When you enable this option, a
shortcut to the document is automatically added to the History tab;
you can access the document by double-clicking the attachment.

¢ To have additional information appear in the note that’s added to the
History tab: Enter a description of the document in the Regarding
field. This description appears on the History tab regardless of
whether you saved the document or not.

e [f you don’t want to create a history for the document: Select the No,
Do Not Record History radio button.

¢ To specify whether to print an envelope for the contact: You have to
hand it to ACT!: The program really tries to be as accommodating
as possible. After you work your fingers to the bone creating your
latest tome, ACT! gently asks you whether you want to print an
envelope. If you select No, you’re done with the letter-writing
process.

After you complete the special order for your mail merge, all that’s
left to do is to click the OK button, close your word processor, and
return to ACT!. If you select Yes to print the envelope, the Print
dialog box appears.

We're Off to See the Mail Merge Wizard

As easy as it is to create a templated message to a single contact, ACT! pro-
vides you with the Mail Merge Wizard to take the guesswork out of sending
your message to a whole bunch of people at a time. When you create a mass
merge to one or more contacts, follow these four basic steps:

1.
2.

4.

Select the contacts to whom you’re sending the letter.

Select the template that includes both the contact fields that you want
to merge into the letter and the body of the letter itself.

. Choose to send the output to your word processor, printer, fax machine,
or e-mail program.

Perform the mail merge.

Not surprisingly, ACT! takes the laborious task of mail merging and simplifies
it via the Mail Merge Wizard. Throughout the process, you encounter just a
few easy-to-navigate windows. Trust me — there’s no chance of losing your
way because ACT! holds your hand during the entire journey.
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To perform a mail merge, follow these steps:

1. Select the contacts to be the recipients of your mail merge.

To do so, either use a lookup to select certain contacts (such as all con-
tacts in a specific state, city, or company) or select contacts from the
Contact List.

If you're creating one of those charming Christmas newsletters telling all
about your two kids who just graduated from Harvard Medical School and
your recent month-long excursion to purchase two Mercedes — leave
me off the list!

2. From any ACT! view, choose Writec>Mail Merge.

ACT! acts a bit theatrical here, what with all the talk about wizards and
all. The Mail Merge Wizard opens with a screen that announces that you
are starting the Mail Merge Wizard. Like the coming attractions, you can
skip the first screen (just click Next) to go directly to the second wizard
screen.

3. Decide how you want to send the merge and click Next.
Decisions, decisions! The four choices on today’s menu are

e Word Processor saves all the merged documents into a single
word processor document. This choice is good if you want to
review your merged documents before printing them.

¢ E-mail sends all the merged documents as e-mail messages.

“@N\BEH This is a true merging process. If you choose to send out a mail

> merge via e-mail, each recipient receives an e-mail specifically
addressed to that person. No one sees a list of the other recipients
and you don’t have to mess with blind carbon copy (Bcc) options.
Best of all, the body of each e-mail is customized to the recipient.

¢ Printer is a good choice if you're sure that your contact information
and that your template is perfect, as in error-free. This choice is also
popular if you like to chop down trees in the Amazon. This option
sends all the merged documents directly to the printer.

¢ Fax sends all the merged documents as fax transmissions. If this
option is grayed out, you don’t have ACT!-compatible fax software
installed on your computer.

4. Pick your template and click Next.

Indicate the template to use in your mail merge by clicking the Browse
button and selecting the name of the document template that you want
to use.
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The Mail Merge Wizard continues and demands to know, in a loud boom-
ing voice, what contacts you want. All right, you caught me in one of my
Judy Garland flashbacks. You can’t actually hear the question, but it
comes across loud and clear in Step 4 of the Mail Merge Wizard, as
shown in Figure 10-3.

Mail Merge Wizard (4 of 5)
Select Contact
Select the contacts to receive the mail merge

Select contacts from
(& Currert Lookup!
() Currert Contact
() Al Contacts

() Selected Group:
|

Figure 10-3:
Choose the
contacts to
includeina
mail merge.
|

() Selected Company:

5. Choose to whom you want to send the mail merge and then click Next:

e Current Lookup merges your document with the contact records
that you choose in Step 1.

¢ Current Contact sends the merge only to the contact currently
showing in the Contact Detail window.

e All Contacts goes to everyone in your database.

e Selected Group enables you to merge your document with a spe-
cific contact group.

e Selected Company enables you to merge your document with all
the associates of a given company.

Depending on the send choice you pick in Step 3, you're pretty close to
the finish line. You can just click Finish in the recap screen that appears.

e [f you chose the word processor option, you can now spend the next
two hours reviewing 1,001 personalized letters to your dearest
friends and relatives, ensuring that all the information therein is
accurate.

e If you chose the printer option, you hear the happy sound of your
printer spitting out 1,001 personalized letters to your dearest
friends and relatives.

e [f you chose the fax option, your faxing software opens, and you're
ready to fax.
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6. You have a little more work ahead of you if you chose the e-mail

option.

Try not to be discouraged. Your e-mails are going to arrive at their
intended destination long before those people choosing one of the other
options even finish stuffing envelopes or decipher the new area code
rules for a fax transmittal. Besides, you're treated to the options that

you see in Figure 10-4.

Mail Merge Wizard (5 of 7)

Set E-mail Options
Set the options to use for your e-mail mail merge.

Enter subject for e-mail

E-mail record history type

Subject only “

Attach file(s)to e-mail

[1Retum Receipt

L

¢ Type the subject line of your e-mail.

¢ Create a history of your e-mail by including the subject or the sub-
ject and message of your e-mail on the History tab. You also have
the options of attaching the entire e-mail message to a history or

simply creating no history at all.

¢ Send an attachment along with your e-mail.

¢ Specify that each recipient of your e-mail sends you back a Return

Receipt.

7. Click Next to continue and set your options for the contacts who have

missing e-mail addresses.

[ hope you feel appropriately ashamed by the fact that you made ACT!

work so hard while you simply sit back. ACT! now patiently asks you one
final question regarding your handling of those contacts that are missing
an e-mail address. As you can see in Figure 10-5, you have several choices
as to how to handle the MIAs.

8. After you choose all your options, click Finish.
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Mail Merge Wizard (6 of 7)
Set Options for Missing E-mail Addresses %

You may have selected contact records that do not have e-mail addresses. Select an
option for handling missing e-mail addresses.

Select an option:

@ Omit those records from the e-mai

i merge.
() Omit the contact(s) from the &-mail mail merge and record histary as "not sent”
o) Omit the contact(s) from the e-mail mail merge, but create a lookup of omitted contacts to

display when the merge is complete.
|

Figure 10-5:
Determine
the recipi-

ents of your

mail merge.

< Back Next > Cancel
|

() Cancel the e-mail mail merge, and create a lookup of contacts with missing &-mail addresses

Congratulations! You have now completed in a very short time what used to
take hours and hours of work. Well done!
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ACT! E-Mail

In This Chapter

Choosing your e-mail preferences
Working with your contacts’ e-mail addresses
Sending e-mail

In this chapter, I show you how to integrate ACT! with your existing e-mail
client. ACT! enables you to send e-mail through it to an individual contact
in your database, to a selected group of contacts in your database, and to
people who are not in your database. You also discover the various prefer-
ence settings that are crucial in order to e-mail successfully.

Getting Started with ACT! E-Mail

To fully understand the e-mail portion of ACT!, you must understand the
concept of the e-mail client. An e-mail client is an application that runs on a
personal computer or workstation and enables you to send, receive, and
organize e-mail. A senior executive at Sage Software once told me, “ACT! is
not in the business of designing e-mail clients.” What that means is that ACT!
isn’t built to replace your existing e-mail client; rather, ACT! works on top of
it. It also means that if you really want to send out a lot of e-mail using ACT!,
you probably want to investigate one of the add-on products that I mention in
Chapter 23.

As of this writing, ACT! 2007 supports the following e-mail systems:
v Internet Mail (an internal standalone e-mail client that supports the use
of your SMTP and POP3 settings)
v Outlook
v Outlook Express
v Eudora
1 Lotus Notes
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For years, ACT! users could not use America Online (AOL) as their e-mail
client if they wanted to integrate with ACT!. Programs such as Yahoo!,
Hotmail, and AOL use the IMAP protocol. ACT!, like most e-mail clients,
requires the SMTP/POP protocol favored by most Internet service providers
(ISPs). (Don’t sweat all the acronyms; just stick with me here.) However, |
know a work-around for those of you who can’t — or won’t — give up your
AOL. Outlook lets you configure an IMAP e-mail account. When prompted, set
the Incoming mail server (IMAP) to imap.aol.com and the Outgoing mail
server (SMTP) to smtp.aol.com.

The two most commonly used e-mail systems are Outlook and Outlook Express
in the Windows environment. For the purposes of this book, I assume that you
have Outlook configured on your computer and that you want to integrate
ACT! to work with Outlook. For business purposes, Outlook is probably the
e-mail client of choice. With more features than Outlook Express, it’s more
attuned to the business environment. Outlook comes bundled with most ver-
sions of Microsoft Office and is a common fixture on most office computers.
Outlook Express comes as part of the Windows operating system. Because it’s
a much more basic program, Outlook Express isn’t as often used for business
e-mailing.

Setting Vour E-Mail Preferences

If you initially set up your database with the Getting Started Wizard (see
Chapter 3, where I show you how to work your way through the wizard),
you already specified your e-mail system. If you’re working on an existing
database, here’s what you must do to configure ACT! for e-mail:

1. Test to make sure that your e-mail is functioning correctly outside
of ACT!.

Before you configure your e-mail preferences in ACT!, | recommend
testing your e-mail to make sure that it’'s working correctly. Send a test
e-mail to your significant other via Outlook or Outlook Express. Doing so
helps eliminate problems if you have trouble e-mailing in ACT! for some
reason.

2. Choose Tools->Preferences and then click the E-Mail tab.
The E-mail Preferences dialog box appears, as shown in Figure 11-1.
3. Click the E-mail System Setup button and click Next.

The E-mail Setup Wizard opens, as shown in Figure 11-2.
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dialog box.
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Figure 11-2:
The E-mail
Setup
Wizard.
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Preferences
General Colars & Fonts Calendar & Scheduling E-mail Communication Startup
E-mzil system
—= Send e-mail to contacts using
= Microsoft Outlook Ll E-mail System Setup...

Composing Options..

[ Check spelling before sending e-mail

Folder settings
[] Empty Deleted hems folder on exit

[[] When connected. notify me of new e-mail every: minutes

[¥] Mark e-mail as read in preview pane after 2 [&]seconds

[ Play sound when new e-mail amives

After moving or deleting an open item: open the previous item v

Attaching e-mails to contacts
When attaching e-mails with files:

o] (%) Ask me before saving the fil:
(O Mways save the file
(O Never save the fle
E-mail Setup Wizard (2 of 4)
Select E-mail System 2
Select e-mail systems to use with ACT!. k m’j

If you choose to skip e-mail setup now, you can set it up later in Preferences

(%) Set up e-mail
Select one or more e-mail systems
[ Internet Mail

Microsaft Outlook
[[] Outlook Express

() Bestore transfemed &-mail

() Skip e-mail setup

4. Select your preferred e-mail client and then click Next.

e Internet Mail: If you select Internet Mail, you have a bit of work to
do. You're prompted to fill in several screens full of information
including your user name, e-mail address, password, and the
SMTP and POP3 assigned to you by your e-mail service provider.
(You might also be asked for your shoe size and blood type.) If you
don’t have this information you’ll have to call your ISP to get it.
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¢ Outlook: If you select Outlook, you're asked whether you want to
use the ACT! e-mail client or Outlook to view, compose and send
your e-mail. If you choose the Outlook option, which I highly rec-
ommend, then Outlook will open every time that you initiate an
email through ACT!. You can see the choices in Figure 11-3.

E-mail Setup Wizard (3 of 4)
Outloak Settings e
Create or change your Outlook settings. k Eﬁ

When viewing, composing, and sending e-mails

(O Use the ACT! e-mail program (%) Use the Outlook e-mail program

Select a signature

I To create or modify an ACT! e-mail signature, click Edit Signatures.
. ACT for Dummies| v
Figure 11-3:
Usin the To medify e-mail settings such as the location where Dutlook stores e-mail messages and
g e | e e
OUt|00k [ Change Outlook Settings. ]
client with
Always use my Outlook profile when sending e-mail messages.
the Outlook
System.
|

5. On the final screen of the E-mail Setup Wizard, click the Finish button.
6. (Optional) On the E-Mail tab, click the Composing Options button.

Don’t worry if the button is grayed out — you’ll only see this option if
you are using the ACT! e-mail client. If you’re using Outlook, you don’t
have to set any composing options because you set them in Outlook, not
in ACT!.

7. Click OK after you configure your composing options to return to the
Preferences dialog box.

8. Click OK to close the Preferences window.

E-Mailing Vour Contacts

A benefit of sending e-mail from within ACT! is that a history of the event is
added to your contact’s History tab each and every time that you send an
e-mail. There’s even a Last E-mail address system field that automatically
inserts the date each time you send an e-mail. E-mail is an increasingly popu-
lar form of communication, so having a record of all the e-mail that you send
to each of your contacts helps you keep track of it all. You can send e-mail
messages to one or more contacts and attach contact records, group records,
or files to your messages.
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Depending on how you like to reach your contacts, you can send e-mail to
them via ACT! in a variety of ways. You might send a one-time e-mail to an
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individual contact, or you might send a form e-mail to either an individual or

a whole group of your contacts. You might also want to send a spur-of-the-
moment message to one contact — or even thousands of your contacts.
Explore the possibilities.

E-mailing an individual contact
To send an e-mail to the current contact, follow these steps:

1. Create a new e-mail message using one of following four methods:
e Click in the contact’s E-Mail field.
e Choose Writer>E-Mail Message.
e Click the Write E-Mail Message icon on the icon bar.
e Click the E-Mail icon on the Navigation (Nav) Bar.

These methods all result in a new message (see Figure 11-4). You'll

notice that the contact’s name already appears in the To field.

Just confirming that I'll see you and David Sonatore atthe Bruce concert after your stint atthe Camp Getaway weekend. lwill be there with Karen Koenig so be sure to
look for us

Have = greatweekend!

Karen Fredricks
ACT for Dummies Guru

Read:

[ Bruce Concert E]@
File Edit View Insert Format Spelling Actions Tools Help
Bgen = B ez BGEs BB
B 7 U ==z &= &% 6AE
From [Mictosoft Dutlack - Karen Fredricks | Py [Nomal ~|
Kahn, G Cizate =
To... [Kahn, Gary oo [Subiect arly |
Ce [ I~ Retun recsipt
Subject ‘Emce Concert
Hi Gary.
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These methods all bring up the e-mail message in the Outlook e-mail
client. After you select Outlook as your e-mail system and choose to
compose your e-mail via ACT!’s e-mail client, your e-mail opens in ACT!’s
e-mail client.

2. Fill in the Subject field and create your message.

At this point you’re composing your e-mail message exactly as if you
were using Outlook because you are using Outlook!

3. Feel free to pick an ACT! history option.

In Chapter 17, I explain the ACT! history preferences that you can set
from within Outlook. You can choose to record — or not record — a
history each and every time you send an e-mail.

4. Click Send.

Off your e-mail goes. Depending on the History option that you chose, a
message appears on the contact’s History tab.

Sending mass e-mails

ACT! makes a distinction between sending e-mail and sending merged e-mail.
Merged e-mails all share the following characteristics:

» When you send a merged e-mail, ACT! relies on a template.

v When you send a merged e-mail, you must include at least one contact
field in your template.

v E-mail merging in ACT! allows each individual contact name to appear in
the To line rather than having to send the mail via the Bcc (blind carbon
copy) field.

Important things to consider when sending a mass e-mail

Before jumping headfirst into the world of mass e-mailing, consider the fol-
lowing important points:

v Test your e-mail preferences. You should test your e-mail preferences
before sending your missive out to thousands of people. If you don't,
you might find yourself with a thousand e-mails in your outbox that
can’t be sent. Try sending a sample e-mail to a friend or colleague.

v~ Test your e-mail template. Again, testing your message before sending it
across the universe is always a good idea. Try sending the message to a
co-worker or colleague first. Having correct spelling and punctuation
isn’t a bad idea, either. Make sure the graphics can be viewed correctly
as mentioned in Chapter 10.
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You might discover that although your templates look picture perfect when
you first create them in Word, they look a bit spacey when you attempt to use
them as e-mail templates. You might find that your message now appears to
be double-spaced. Basically, something was lost in the translation from Word
to HTML. You can correct this quite simply by returning to the scene of the
crime — or in this case the original template — and holding down Shift each
time that you press Enter to create a new line.

v Check with your ISP. Many ISPs have implemented safeguards against
spam. Before you send an e-mail to all the contacts in your database, call
your ISP to find out how many e-mails you can send at a time. If your
ISP limits the number of e-mails you can send at one time, you need to
send your mailings in smaller groups or purchase an add-on product
that sends your e-mail in batches. You can discover more about these
products in Chapter 23.

+* Read up on the Can Spam laws. Laws are in place that require your e-mail
to contain various elements, including your correct contact information
and a way for recipients to opt out should they not want to hear from you.

Sending non-merged mass e-mails

If you're not entirely comfortable with the concepts of e-mail blasting, you
might want to start out by sending an e-mail to your contacts rather than
attempting an actual e-mail merge. This way is great for less computer-oriented
ACT! users to reach a large number of contacts.

You can send non-merged e-mail at the spur of the moment because it doesn’t
involve the creation of a template. However, you cannot customize the To or
Subject portions of the e-mail with any of your contact’s specific information.

To send an e-mail to any number of your contacts, here’s all you have to do:

1. Create a lookup (Chapter 6 shows you how) to find the contacts to
whom you want to send the e-mail.

The Contact List opens with your contacts. For example, if you want to
send an e-mail to all customers in the Southeastern region, create the
lookup and then narrow it to include only those contacts that have an
e-mail address.

Narrow your lookup by choosing Lookup=>E-Mail Address. Next, select
Narrow Lookup for the current lookup and then click Non-empty Fields.
Voila! Your lookup is narrowed to include only those contacts with an
e-mail address.

2. Click the Tag All button on the top of the contact list.

All the contacts in your current lookup are now magically highlighted in
a stunning shade of gray.

171
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3. Right-click the selected contacts and choose Writec>E-Mail from the
contextual menu.

As quick as a speeding bullet, a new message opens with all your selected
contacts appearing in the To field. If the mood hits you, feel free to cut
all those addresses and then paste them into the Bcc field.

4. Fill in the subject field and compose your masterpiece.
5. Choose your ACT! history option and click send.

ACT!isn’t perfect — although it comes pretty darned close! The e-mail
checker finds contacts with blank e-mail addresses as well as those
missing key pieces of information, such as the @ character. If you don’t
know someone’s e-mail address, leaving it blank is better than inserting
something cute like N/A that can confuse — or at least slow down — the
checker.

Don’t know whether an e-mail address is correct? Right-click any under-
lined name and choose Properties to sneak a peek at the e-mail address
you have on record for that contact.

Sending a templated e-mail to a party of one

Using ACT! to create an e-mail merge enables you to send personalized tem-
plates for each recipient. The cool thing about ACT! templates is that you can
use them for either snail mailing or e-mailing. In Chapter 10, I show you how
to produce a mass mailing. The Mail Merge Wizard provides you with the
option to snail mail as well as e-mail.

If you want to send a thank-you e-mail to just one of your contacts and don’t
want to go through the entire wizard again, here’s a shortcut. From any ACT!
screen, choose Writer>Other Document (from template) and then select the
template that you want to use for the body of your e-mail. Voila — your tem-
plate appears in the form of an outgoing e-mail, which you’re now ready to
send as soon as you enter in the subject line.

Figure 11-5 shows how the message was personalized to include both the
contact’s name and pertinent information.

Mail merge must include at least one mail merge field. If you aren’t personaliz-
ing your e-mails, you need to choose a different method of e-mailing. Also keep
in mind that you’ll probably want to create a lookup of the contacts you want
to e-mail before starting the e-mail merge so that your e-mail will reach the
correct recipients!



Chapter 11: ACT! EMail ] 73

1 New Message - ACT! E-mail (B[]
File Edit View Insert Format Spelling Actions Tools Help
[EE = BS weks B G

B I L|E=z|[-=|EZ|HAE

From | Micrasaft utlack - Karen Fredricks = oy Momal |
To... ‘Fledncks And Ev‘;anla ‘sub‘emnw j
ce. [ I~ Retum recsint
Bee.. ||

Subject [

Saturday, Apri 15, 2006

Andi Fredricks

University of Florida

1300 University

Gainesvile, FL 32601

Dear Andi,

From all of us at Tech Benders, we wanted to wish you a very Happy Birthday!

We thank you for your business and hope that we can continue to serve you for many years to come
Have a great day and a wonderful year!

All the best from everyone at Tech Benders.
I

Figure 11-5:
Sending a
personalized
e-mail
template.
I |r::c

Editing e-mail addresses

The one critical ingredient of sending an e-mail is having an e-mail address.
No doubt you’ve already added many e-mail addresses to your ACT! data-
base, but I'm guessing that you haven’t yet discovered a good way to correct
or change existing e-mail addresses.

ACT!is designed to launch the e-mail window when you click the E-Mail field
in the Contact Detail window. This feature allows you to easily send e-mail in
W ACT! but makes editing existing addresses difficult.

To edit an E-Mail address, try one of these methods:

v Use the Tab key to move the cursor to the E-Mail field. After the cursor
is in an E-Mail field, you can edit it just like you would do in any field.

v~ Right-click the E-Mail field and choose Edit E-Mail. You can now edit the
E-Mail field.

v Hold the cursor over the E-Mail field and wait a few seconds; the cursor
changes from a hand to a vertical line, which is ACT!’s way of telling you
that you can now edit the field.
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In this part . . .

0r1 the surface, ACT! is a deceptively easy program to
master. However, those of you who are so inclined —
or didn’t run fast enough — might want to add ACT! data-
base Administrator to your current job description. The
database Administrator is in charge of adding new fields
to the database and making sure that they are artistically
placed onto your layout. Need to take your database with
you? You'll be able to synchronize your database with

a little help from this section. Need to make sure you
database is safe and secure? This section has your back
covered! Best of all, when things go wrong, guess whom
everyone will turn to? Not to worry, though — just turn to
this section for help.




Chapter 12

Creating and Editing
Contact Fields

In This Chapter

Understanding the field concept
Thinking before adding fields
Adding a custom field

Deleting fields

Limiting access to fields

Managing the ACT! drop-down lists

In this chapter, I show you (that is, all of you who have Administrator- or
Manager-level rights to your databases) not only how to add new fields to
an ACT! database, but also how to set the various field parameters to help
users use the database more effectively and efficiently. [ show you how to
delete fields — or if you have ACT! 2007 Premium for Workgroups, how to
limit the access to a field. Finally, [ show you how to maintain consistency in
your database through the use of drop-down lists.

Understanding the Concept of Fields

[ am a firm believer that a little knowledge is a dangerous thing. Although
adding a field to your ACT! database isn’t hard, it is something that should be
well thought out and planned in advance. This is particularly true if you plan
to share your database with other users. Planning is important because you
usually have a goal in mind for your database. For example, if your goal is to
create a report with three columns — contact name, birthday, and Social
Security number — you need to make sure that all those fields exist in your
database. Planning also prevents you from adding thousands of contacts to
your database, only to find that you have to modify each record to include
information that was omitted the first time around!
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To add a field to your database, you must be a database Administrator or
Manager; the makers of ACT! made this a requirement so that you understand
the importance of this responsibility. So unless you have administrative rights
to the database, you don’t even have to read this chapter! [ suppose you still
could just for curiosity’s sake, but it isn’t necessary.

Before getting started, | want to briefly outline the three steps involved with
adding fields to a database:

1. Understand why you want to add fields and what purpose these fields
will serve.

2. Determine what fields you’re going to add and what drop-down lists will
be available in each.

[ can’t stress enough the importance of this step. Plan ahead! Or you
might end up with a big mess. . ..

3. Add the fields.

And, voila! You're done. (Okay, this one has a whole bunch of steps, but
you get what [ mean.)

For most of you, adding a field to your database will be easy. After all, you're
good at following directions. However, for some of you, knowing why to enter
a field can prove to be more challenging.

To explore the question of why, I first want to reiterate the basic concept of
fields. What the heck is a field? A field is a single piece of information. In gen-
eral, a field contains just one piece of information. For example, you have
only one business ZIP code; therefore, you have one business Zip Code field.
Alternatively, you probably have several phone numbers: home, business,
toll-free, cellular, fax, beeper . .. and the list goes on. Each of these phone
numbers requires a separate field.

A good field holds one fairly specific piece of information. A bad field con-
tains too much information. For example, having a separate field for your
street address, city, state, and ZIP code is a good thing. These separate fields
allow you to perform a lookup based on any of the criteria: You could find
clients by ZIP code, city, or state. An example of a bad field is lumping all the
address information into a single field; in this example, you’'d then lose your
ability to perform a lookup by ZIP code, city, or state. (Need a refresher on
performing lookups? Head to Chapter 6.)

Consider the following basic rules when determining the criteria for adding a
field to your database:

1 A field contains an important tidbit of information.

v~ A field can be used to perform a query or sort. For example, you might
want to send a mailing to all your customers in New York and sort your
mailing by ZIP code. To do this sort, you need separate fields for contact
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type, state, and ZIP code. You also need a field to distinguish your cus-
tomer contact records from your vendor and prospect records.

v~ A field can be used to insert information into a report or template.
If you want to create letters thanking one person for buying a purple
polka-dot vase and another for buying a leopard-print vase, you need a
vase type field.

Do Vour Homework!

Okay, [ admit it — I'm a former secondary school teacher, and I guess that back-
ground just naturally spills over into my ACT! consulting. Well, class, pretend
you’re back in school because you're going to be assigned some homework. I
consider it important homework that you must complete prior to jumping in
and adding new fields to your database, so your assignment is as follows:

1. Jot down all the fields that you want to see in your database.

Most of the fields you want to see such as company, name, phone
number, and address are already included in ACT!. What you need to
decide here is what fields, if any, are specific to your business.

2. Scurry around the office and collect any documents that you want
ACT! to create for you. This includes both forms and form letters.

You’re going to have to get a little high-tech here, but I think you can
handle it. Get out your trusty highlighter and highlight any of the infor-
mation in each document that is contact specific. For example, each
contact has its own unique address. Maybe you're thanking particular con-
tacts for purchasing widgets (as opposed to gadgets, which you also sell).
This means that you need a Product field.

3. Think how to populate the fields with drop-down lists. Then on the list
that you started in Step 1, jot them down to the side of each of the fields.

For example, if you run a modeling agency, you might need a field for
hair color. The drop-down choices could contain red, blonde, black,
and punk pink.

4. Sketch out any reports that you want to create from ACT! and add the
column headings to the now rather long list that you created in Step 1.

The idea here is to get your thoughts down on paper so that you can
visualize how you want your ACT! report to look. If you already have a
sample of your report in Excel, you can use that. If not, get out your
trusty pencil and outline on a piece of paper what you want your report
to actually look like.

5. Get out a red pen. At the top of your paper, write 100%, Well Done
and then draw a smiley face. Hang your list on your refrigerator.

Okay, that last step isn’t really necessary, but now you're well on your
way to having the database of your dreams!
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Dust off your thinking cap while you create your list. Sometimes one field will
do the job, and other times you might need multiple fields. For example, sup-
pose you sell widgets that are red, white, or blue. In one scenario, a customer
needs to buy only one widget; in this case, you create a product field with
three choices in the drop-down list — red, white, or blue. Or perhaps you
manufacture a different kind of widget; in this case, a customer would hope-
fully buy one of each color. This time, your purposes would be better served
by creating three fields — one for each type of widget.

Adding a New Field to Your Database

CMBER

\\3

Believe it or not, after completing your homework (see the preceding section),
you’re done with the hard part of the task. The actual addition of fields is rel-
atively easy; just follow the steps.

Only an ACT! user with Administrator or Manager privileges can add new
fields to an ACT! database. If the Define Fields option is grayed out in Step 1,
you aren’t logged in as one.

1. In any ACT! view, choose Tools=>Define Fields.

The Contact Detail window is generally a good place to start for most of
your customization projects. The Define Fields dialog box appears, as
shown in Figure 12-1. The View Fields For drop-down list indicates that
you're editing or adding new contact fields to the database. You can also
add new group, company, and opportunity fields to your database by
switching the View Fields For list to the appropriate choice.

ACT! does not allow you to add new fields or edit existing fields while
other users are logged on to the database. If other users are logged on to
the database, a warning appears that lists those users’ names and the
names of their computers. What to do? Storm over to their workstations
in a huff and demand that they exit ACT! immediately. If that doesn’t work,
consider bribery. Conversely, as long as you are editing fields, other users
cannot access the database. To avoid frustration on everyone’s part,
you might want to explain this concept to the users of your database.

2. Start by renaming one of the ten user fields. You find all your fields
listed alphabetically by field name. Select one of them.

This is where you need to drag your homework off the refrigerator and
type in one of the fields that you had planned to create in the Field Name
box. ACT! supplies you with ten user fields that you can customize to
better serve the needs of your business. After all, Social Security Number
is a lot more meaningful than User 2.



|
Figure 12-1:
The Define
Fields

dialog box.

|
Figure 12-2:
Defining an
ACT! field.
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Define Fields
Creste new field Create = newfiekd, or select a ield from the list o edit or delete, Selectthe desired action in the
Edit field Field Tasks menu to the left
BT View fields for:
Field Security Contacts
Field Name Field Type Linked ta Company Field ~
e Credit Card Address Addr... Character
Manage product list Credit Card Address Addr...  Character
Manage process list Credt Card Address Cty  Character
Credit Card Address Country Character
ok ot o S Crarcer
MName: Credit Card Number . Credtt Card Address ZIP C... Character
Type: Character | {Credit Card Number Character
?;,?:j T;/p;gfznnrg;ns Customer ID Uppercase
Custom Field Ef:::‘mem g:zm'
BExdension Character
_Fax Butension Character e
£
3. Click the Edit Field option in the Field Tasks section.
As usual, you can do this in more than one way. If you prefer to double-
click one of the existing field names — go for it! Either way, you're
rewarded with a friendly window that looks like the one shown in
Figure 12-2.
Define Fields

@ Back (# fj Home

Name: User 1

Type: Character
Record Type: Contacts
Created: 6/23/2005

For each field, select options to describe the field or specify how the field functions.

Field name
User 1

Select a field data type to convert to
Charscter

Customize field behavior

Alow Blank - This field can accept empty values
[ Generste History - Track changes made to this field's value in history
[ Primery Field - Copy this field when duplicating the record

[ Use drop-down list

<Back | Nea> | Fsh ][ Cancel

a\\J

When you run out of user fields to rename, feel free to click the Create
New Field option in the Field Tasks area.

ACT! rewards you with a blank, new field in the Field Name box and
assigns it the name New Field until you can think of something better to

call it. At that point, the following steps are identical to the steps you
follow for editing a field.
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4. Type a field name.

Try not to get too fancy or long-winded when naming your fields. Using
special characters such as % or # can cause problems when creating
queries, mail merges, or reports, so [ recommend that you not use them.
You can use spaces in the field name, but don’t end a field name with

a space. And because long field names can be hard to place into mail
merge templates and layouts, you're better off keeping field names as
short as possible.

5. From the Select a Field Data Type to Convert To drop-down menu (refer
to Figure 12-2), choose a field type for the field that you’re adding.

You can create a variety of different types of fields. Actually, 18 different
field types are available, but who’s counting? If you’re renaming one of
the user fields, your choices include

e Character: This is probably the most common of the field type
choices; a character field can contain both numbers and characters.

e Currency: This field comes equipped with a dollar sign, appropriate
commas, optional decimal places, and a sunroof (optional).

e Decimal: This field accepts only numbers, a decimal point, and
more numbers.

e [nitial-Caps: The idea behind the Initial Capitals option is that you
can turn KAREN FREDRICKS into Karen Fredricks. Seems like a great
idea on paper. In reality, however, you end up with Ibm Corporation
and Marcus Welby Md.

¢ Lowercase: i suppose you might want to type in all lowercase. i just
can’t imagine why:.

e Memo: This is where you can store a large amount of information
that you don’t want to risk burying away amidst your other notes.
For example, you might want to include your driving directions in
this area.

e Number: This option enables you to enter only numbers into a
field. Say you want to find all your customers that have more than
30 employees. You can easily search for a number greater than 30,
whereas you can’t possibly search for a number greater than thirty.

¢ Upper Case: | NEVER TYPE IN ALL UPPERCASE BECAUSE I FEEL
LIKE I'M SCREAMING. BESIDES, I'M AFRAID I MIGHT DEVELOP
POLYPS ON MY FINGERTIPS.

e URL Address: Use this field type if you need to associate another
Web address with your contacts.

If you're creating a brand-new field, ACT! gives you all the choices on the
menu above plus a couple of brand-new ones:

e Address: Talk about a timesaver! When you designate a field as an
address field, ACT! automatically creates seven fields: three for the
street address, and another four for the city, state, ZIP, and country.
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¢ Annual Event: Like it or not, some events take place once a year.
Use this field to find birthdays, anniversaries, and yearly renewals
regardless of the year.

¢ Date: When the time comes for you to enter information into a Date
field, you see a tiny little calendar that enables you to select a date.
The calendar supplies a useful purpose. If you create a field for a
birthday and make it a Character field, the other local yokels using
the database might get creative and input anything from Jan 1 and
January 1* to 01/01 and 1/1. Finding all birth dates in the month of
January would become an exercise in futility.

¢ Date/Time: When you want to be really exacting, create a Date/Time
field to record the exact date and time of an event.

¢ F-mail: It used to be that everyone you know had several phone
numbers. Now, the chances are pretty good that your contacts
have numerous e-mail addresses. Here’s your opportunity to
include as many as you like.

e Phone: In Chapter 4, [ show you all those nifty things that ACT!
does to speed up the data input process. If you designate a field to
be a Phone field, you automatically get a year’s supply of dashes.

e Picture: A picture is worth a 1,000 words, and here’s where you can
stick a picture of each client or a picture of each product that they
bought.

e Time: If time is of the essence, this is where you can input a time.

e Yes/No: This actually creates a check box field that you can mark.
Call me old-fashioned, but I think Check Box would have been a
more appropriate name. To further confuse the issue, a query on
this field looks for True or False values.

6. Assign any of the four optional attributes for the field being added
and click Next. Feel free to choose several attributes if you wish.

Depending on the field type you select, all these features might not be
available. For example, if you choose the Date field with the cute little
calendar, you won'’t have the drop-down list option.

e Allow Blank: If you want to require that a field must be filled in, you
need to remove the check mark from this field. Use this option if
you want to require a user to enter information into a certain field.

® Generate History: This neat little feature generates a history on the
History tab when you change the contents of the field.

e Primary Field: When you duplicate a contact record, the primary
fields are the fields that are duplicated.

e Use Drop-Down List: When you choose this feature, you can either
pick an existing drop-down list or create a new, unique drop-down
list. I cover creating drop-down lists later in this chapter in the
“Creating a drop-down list field” section.
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7. Customize your field further by choosing from the following optional
selections and then click Next.

The next Define Fields screen — Customize Field Behavior — opens,
offering you a few more choices for your editing pleasure.

¢ Default Value: If 80 percent of your database consists of customers,
you might assign Customer as the default value of the ID/Status field.

e Field Format: If you want dashes or another symbol to appear auto-
matically in a field, here’s the place to do it by inserting the symbol
where you want data to go. For example, a Social Security number
looks like ###-##-####.

¢ Field Length: You might want to limit the number of characters that
a user can enter into a given field; for example, you can limit a field
looking for values of Yes or No to three characters.

P Trim the field length whenever possible. If the longest value in a
field is Yes and the field length is 75, you've created a lot of dead
space. Cutting down the field length helps reduce the size of your
database, which ultimately increases performance.

e Link to company field: You might want to link a contact field to a
company field so that when you update information in the com-
pany record, you're given the option to update all the associated
contact records as well.

8. Set optional triggers.

Adding a trigger to a field causes something magical to happen when
entering data into a field. For example, you might want an Excel spread-
sheet to open when you move your cursor into the field, and an activity
series to start when you leave the field. In Figure 12-3, you see three
ways to start a trigger: when changing a field, when entering a field, and
when leaving a field.

Define Fields
(®) Back %3 Home

Set a trigger on the field to automatically schedule an activity series, launch a program, or
launch a web site when entering exiting. or changing information in the fiskd

When changing a field. launch

Programs a | |C:\Program Files\Microsaft Office \EXCEL EXE
When grtening a field, launch
Activity Series ~
I VWhen leaving a field, launch
Figure 12-3: o -
Attaching
atrigger
to a field.

|
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For each type of trigger, you can assign one of three possibilities:
e None: If you want nothing to occur, choose this option.

¢ Programs: Clicking the Browse button allows you to navigate to
virtually any file in your computer. You can browse to a program,
a URL, or even to a specific file.

e Activity Series: Clicking the Browse button takes you to a list of the
activity series that you created. If you haven’t created any activity
series, pay a visit to Chapter 8 to find out how.

9. Click Finish.

Deleting a Field

If you delete a field from a database, all data in that field is deleted. Forever.
Permanently. Delete a field only if you’re sure that you no longer need

that data. The core fields — including Company, Contact, Address, and
ID/Status — are so important that ACT! won’t allow you to delete them.

As an alternative, you can delete those fields from your layout so that they
can’t be accessed.

Ironically, the monumental task of deleting a field is ridiculously easy to fulfill.
To do so, just follow these steps:

1. From any ACT! window, choose Tools=>Define Fields.
The Define Fields dialog box appears.

2. From the View Fields For drop-down list, select the record type
(Companies, Contacts, or Groups). Then from the list, select the
field to delete.

[ don’t think [ need to mention how important it is that you click the field
you want to delete and not one that you mean to keep.

3. In the Field Tasks list (upper left), click Delete Field.
4. Click Yes to confirm the deletion.

That’s all, folks. If you’re waiting for a second reminder asking whether
you're really, positively, 100 percent sure that you want to delete the
field, you're going to be waiting for a very long time because it’s not
going to happen. However, a ghost of the field will still appear on your
layout, which you will discover can’t be edited. To remove the last ves-
tiges of your deleted field, flip to Chapter 13 where you can read how to
delete fields and field labels from a layout.
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Securing Access to Fields

In Chapter 15, you can read how to secure access to specific contacts so
that some users can see a contact and others can’t. ACT! 2007 Premium for
Workgroups has a brand-new, long-awaited feature — field level security.

A credit card number is a great example of a field that you might want to
secure. The bookkeeper might have full access to the field because he needs to
be able to add or change credit card numbers. The order takers might need to
see the numbers but not change them. Finally, the fulfillment center might not
have any reason to access those numbers; in fact, management would probably
rest a bit easier knowing that the fulfillment center can’t see those numbers!

Field level security is a Premium feature. If you're using ACT! 2007, feel free to
skip to the next section — or upgrade to Premium.

Prior to ACT! 2007, all users were limited to either full access or read-only
access to any one field. Standard users still have this functionality and can see
limited field level security options in the Define Fields dialog box. The standard
users can’t assign specific access rights to teams and/or individual users.

What you see is what you get

Before securing a field, you need to understand exactly what happens when
you limit access to a field. The following are the three levels of access rights
to a field:

v Full Access: Users can see and modify the data in a field.

v Read-Only: Users can see data in a field but can’t change it. The fields
appear to be grayed out in the same manner as a system field.

v No Access: Users can neither see nor modify the data. In essence, they
don’t even know that the field exists.
You can’t limit the access to certain types of fields. These include
v System fields that are populated by ACT!, including Record Creator,
Creation Date, and Edit Date.

v Fields, such as Last Results, that are set to record a history can’t be set
to No Access because obviously a user could find out what was in the
field by reading the contact’s History tab!

v~ Fields that appear in the basic Lookup menu including company;, last
name, and e-mail address.

v~ Contact fields that are linked to Company fields.
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If your access to a field is set to read-only, you can’t import information into
your database — even if you are a database Administrator or Manager. If you

don’t have access to a field, you’ll find that you are limited in a number of
other ways as well:

v With the exception of the Define Fields dialog box, you can’t see the
restricted field name in any of the field lists found throughout ACT!.

That means you won'’t be able to add that field to a report template or
even have it show up on the Contact List.

v The information won’t appear on a report or template.
v The field can’t be used as a duplicate scan criterion.

v The field won’t sync to your handheld device.

Battening down the hatches

As usual, understanding the concept is the difficult part; securing your fields,
however, is quite easy. To secure access to a field, follow these steps:

1. From any ACT! window, choose Tools =>Define Fields.
The Define Fields dialog box appears.

2. From the View Fields For drop-down list, select the record type

(Companies, Contacts, or Groups). Then from the list, select the field
that you want to secure.

3. In the Field Tasks area, click Field Security.

The Field Security window, as shown in Figure 12-4, opens for your edit-
ing enjoyment.

4. Select a Default Permission from the drop-down list.

Define Fields
(&) Back %5 Home
Details [+]
Name: Credit Cand Number Default permission is applied to all users. Edit the user or team permission to override the
Type: Character detault
Record Type: Contacts
Created: 3/28/2008 Default access for all users
Custom Field Field Default Permission
No Access ~
Users | Teams
User permission takes precedence over team and default permissions
— Users Aocess Based On
Alison Mikola No Access Defaut Permission
Figure 12-4: Bety Browser No Access Defauit Permission
g . Chris Huffman Read Orly User Fermission
Emst Anderson No Access Defauit Fermission
Global |y Fred Fenderine No Access Defait Permission
L. Gary Kahn Phd Full Accsss User Permission
Juiietie Rosseux No Access Defauit Permission
limitin g Karen Frecnoks Full Access User Permission
Melisa Pearoe No Access Defauit Fermission
access to Sarzh Whiting No Access Defauit Pemission
a field.
|
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Editing the
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specific
users.
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The concept is that you select a default permission from the menu
choices — No Access, Read Only, or Full Access. That choice deter-
mines how all users in the database view — or not view — the field
unless you then change the permission on a user-by-user basis.

5. Select all the users that you want to give an access right (other than
the default permission).

You can highlight several users at a time by holding down Ctrl while
selecting the desired users with your mouse.

6. Click the Edit button.
The Edit Users dialog box opens, just like the one in Figure 12-5.
7. Choose the desired access level for the selected users and click OK.

You find yourself once again in the Define Fields dialog box; refer to
Figure 12-4. You'll notice that the access level of each user is listed.

8. Click Finish when you’re done and then click Close from the main
Define Fields dialog box.

Not sure which fields you have limited? Sneak a peek at Figure 12-1 to see the
little padlock icon next to the credit card field. That cute little picture is there
to remind you which fields have limited access rights.

Edit Users
Select one or mare users and choose the desired access level for: Contact
Field: Credit Card Number

Users Access
Allison Mikela Mo Access
Betty Browser Mo Access
Chris Huffman Read Cnly
Emst Anderson Mo Access
Fred Fenderine Mo Access
Gary Kahn Full Access
Juliette Rossein Mo Access
{Karen Fredricks Full Azcess
Melissa Pearce Mo Access
Sarah Whiting Mo Access

Access Level:
Full Access R4

Working with Drop-Down Lists

The sure-fire way to destroy a database is by adding information in an incon-
sistent manner. Drop-down lists help ensure that users input data in a uniform
way. As an added bonus, drop-down lists also save you time; when you type
in the first several letters of an item in your drop-down list, ACT! responds by
completing the word for you.
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In ACT!, you find three major list types. Two of them, the Product List and
the Process List, are associated with your Opportunities. The other list type,
Drop-Down, is associated with your contact, group, company, and opportu-
nity fields. Although you can add new items to a list while you're using it,
managing your lists in one central location — the edit fields area — is easier.

Creating a drop-down list field

Associating an existing drop-down list with a field requires two things:

1 Specifying that the field is to contain a drop-down list

v Adding items to the drop-down list
Although which one comes first doesn’t matter — the field or the drop-down
list — I start by creating the field that is to contain a drop-down list:

1. From any ACT! window, choose Tools=>Define Fields.

The Define Fields dialog box opens in all its glory (refer to Figure 12-1).
You might even notice three items in the List Tasks area.

2. Click the field name that you want to contain a drop-down list and
then click the Edit Field option in the Field Tasks area.

The first of the Define Fields dialog box windows opens.
3. Select the Use Drop-Down List check box.

If you want to use an existing drop-down list, here’s your golden oppor-
tunity. For example, the 50 U.S. states are the same for mailing, business,
and home addresses. You could have one State drop-down list and asso-
ciate it with the mailing, business, and home state fields.

4. Click Finish.

Whew! That was pretty easy. If you're using an existing drop-down list, you're
finished. However, if you need to build a drop-down list from scratch, you
have more work. Fortunately, ACT! returns you to the Define Fields dialog
box, which is right where you need to be to create or edit a drop-down list.

Creating a drop-down list

This might seem like a case of “Which came first, the chicken or the egg?”

In the preceding section, I tell you how to associate a field with an existing
drop-down list. In other cases, you need to go back and create the drop-down
list first. Here’s what you need to do:

1. From any ACT! screen, choose Tools=>Define Fields.
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If you just created the drop-down field (see the preceding section), you
can skip this step because you're already there!

2. Select Manage Drop-Down Lists from the List Tasks area.
The Create, Edit, or Delete Drop-Down Lists window appears.

e To create a drop-down list: Click Create Drop-Down List from the
Drop-Down List Tasks area.

¢ To edit a drop-down list: Select the drop-down list and then click
Edit Drop-Down List from the Drop-Down List Tasks area.

The Enter Drop-Down List Name and Type window opens, as shown in
Figure 12-6.

Define Fields
@ Back (% %3 Home

Drop-down list name:

Credit Card Type

Type:

Charactsr v

| [ Automatically add new items users enter to the list
Figure 12-6:
Configuring
adrop-
down list.
|

<Back | [ Mea> ][ Fosh ][ Concel

3. Configure the following drop-down list options and then click Next:

¢ Drop-Down List Name: Use a name that very closely resembles the
name of the field that will be associated with the drop-down list.

e Type: Choose what type of field goes in the list — for example,
character.

e Description: If you have a lot of drop-down lists, you might need to
give your list a bit of further explanation.

e Allow Users to Edit Items in This List: Users have the ability to edit
the drop-down list while they enter contact information.

e Automatically Add New Items Users Enter to the List: This lets your
users define the items that will be used in a drop-down list by auto-
matically adding each item they enter into the drop-down list.

QNING/ Be very cautious about including those last two options. Allowing users
to edit items in the drop-down list can carve away at the standardization
that you've strived so hard to maintain. If you decide to allow users to
automatically add new items to a drop-down list, you might want to do
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so only temporarily. Although this option is a great way to build a drop-
down list from scratch, you run the chance of creating a mess. Make sure
that all users have a good idea of the kind of items that should — and
shouldn’t — be added to the drop-down lists. And, more importantly,
make sure they peruse the existing entries in the drop-down list before
adding new items to avoid duplication.

4. From the Enter Drop-Down List Values window, choose one of the fol-
lowing options:

e Add: When you click the Add button, your cursor jumps down to
the bottom of your list of drop-down items.

¢ Delete: This permanently removes the selected item from the drop-
down list. However, previously entered information based on the
removed drop-down item still remains in your database.

5. If you clicked Add, type in the drop-down list item and an optional
description.

Chances are that you don’t need to include descriptions in your drop-
down list. Once in a while, though, they can prove to be priceless.

For example, the State drop-down list consists of the two-letter state
abbreviations; the description includes the full name of the state for
those of us who can never remember whether MA stands for Maine,
Maryland, or Massachusetts!

6. Click Finish when you finish adding all the items you want to your
drop-down list.

Managing the Product List

In Chapter 18, you can find almost everything you need to know about the
exciting world of Opportunities — and believe me, there are a bunch of cool
things. However, in this chapter, you discover how to modify your opportu-
nity fields — and the drop-down lists associated with them. You'll also find
out how to input a list of the products or services that you routinely sell to
your customers or clients.

Don’t think that because your company doesn’t sell widgets — or some similar
item — that you can’t use the Product List. Perhaps a better name for this field
would have been Products/Services. At any rate, if you are gaining financially
from your customers, use the Product List to help you analyze your profit
centers.

To modify or create your Product List, follow these steps:

1. From any ACT! screen, choose Tools=>Define Fields.

The Define Fields dialog box opens.
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Editing the
Product List.
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2. Click Manage Product List.

The Manage Product List dialog box opens, as shown in Figure 12-7

Manage Product List
Enter product list items:
Name [tem Number Cost f Add |
Bulk Chocolzte 5649 L—j
Bulk Cofiee 275
Chocolate Gift Basket £10.50
Chocolate Truffles $1273
Coffee Basket 51225
Fruit Basket $16.50 Expot
Sunday Park Basket SPE-534582 24260
‘Wine Gift Basket WGEB0122002 £15.00

3. Click the Add button.

A New Product item appears at the bottom of the list of your product
names.

4. Fill in the appropriate fields.
You can move through the various fields by pressing Tab.
a. Assign a name to your product.
b. Enter an item number if you use them.
c. Add the cost that you pay for the item if applicable.

d. Include the price you're going to charge your customers for the item if
you adhere to a set price structure.

If your costs and prices fluctuate, feel free to leave those fields
blank. You can always change them each time you enter a new sales
opportunity.

5. Click OK to close the Manage Product List dialog box and then click
Close to close the Define Fields dialog box.

You might already have your Product List sitting around in another program,
such as Excel or your accounting software. If this is the case, you can easily
import it into ACT! — and avoid having to input the entire list manually. If you're
astute (which I know you are), you noticed the Import button in Figure 12-7.
ACT! can import an item list as long as it is in . csv or . txt format and con-
tains four columns labeled Name, Item Number, Cost, and Price.
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Managing the Process List

The ACT! program was originally developed as a sales tool for busy sales
people. Today, the product has evolved to the point that just about any
industry and individual can benefit by using ACT!. However, the tradition of
sales tracking remains, and the Process List is just one of those examples.
The ACT! Process List allows you to set up the steps that everyone in your
organization follows when trying to close a sale. You can even associate a
probability with each step. It is rumored that you need to contact someone
12 times before you convert them from a prospect to a customer; here’s
where you can be reminded of where you are in that process.

To edit or create a Process List, follow these steps:

1. From any ACT! screen, choose Tools=>Define Fields=>"Manage
Process List.

The Manage Process Lists dialog box appears. If you already set up a
Process List, you see it listed by name, description, and the current
stage number in the Process List.

2. Select one of the following three options and then click Next:

¢ Create New Opportunity Process: Creates a brand-spanking new
Process List.

e Edit Opportunity Process: Allows you to edit an existing
Process List.

¢ Delete Opportunity Process. Deletes an existing Process List. Instead
of deleting an existing list, you might decide to make it inactive.
You see that option on the next screen.

3. Double-click a name, description, or probability to change it.

If you're editing an existing Process List, modifying an entry by double-
clicking is easy. The steps from the previously created Process List
appear, as shown in Figure 12-8. If you're creating a new Process List,
your processes are empty. Don’t worry though — you can fill them up
easily enough.

4. Click the Add or Delete button to further configure your Process List.

ACT! automatically numbers the stages in a Process List, saving you the
effort. If you want, you can change the order by choosing one of the
options to move an option either up or down on the list. When you move
an option, all subsequent stages automatically renumber.

5. Click Finish when you’re done.

193
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Figure 12-8:
Customizing
the stages
in a sales
process list.
|
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2] Manage Process Lists
(#) Back % Home
Import Opportunity Stages
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part Opportunity Stages 1 Intia] Communicatior 10%
2 Needs Assessment 5%
Details =
e 3 Presentation 40%
Name: ACT! Sales Cycle 4 Negotiation E5%
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. 5 Commitment to Buy 0%
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§ Sales Fulfilment soz | Meve Doun

In ACT!, you can often skin a cat or solve a problem in more than one way.
You can access the Product and Process Lists from two other areas of ACT!:

v From any ACT! screen, choose Contacts=>Opportunities=>"Manage
Product (or Process) List.

v Scroll down to the bottom of the Product or Process List when creat-
ing a new — or editing an existing — opportunity. From there, you
can select Edit List.

A Few More Customization Options

Administrators and Managers have all the fun when it comes to ACT! because
they can customize a database to their heart’s content. In this section, [ point
out a few commonly overlooked areas that can be customized.

Adding custom activity types

Out of the box, ACT! gives you five activity types: call, meeting, to-do, per-
sonal activity, and vacation. You can modify this list of activity types by
creating a custom activity type. To add a custom activity type, just follow
the bouncing ball:

1. Choose Scheduler>Manage~>Activity Types.

The Manage Activity Types dialog box appears, which bears a striking
resemblance to Figure 12-9.

2. Click Add.
The Add Activity Type dialog box appears, as shown in Figure 12-10.
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Figure 12-10:
Creating a
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(=] Manage Activity Types
Add, or edit an activity type.
Activity Types
Image |Name Active 2dd
e e e
1= Meeting Active
& To-do Active
14 Marketing Call Aetive
@ Personal Activity Lctive
fiad Vacation Active
Add Activity Type

Name:

Site Inspection

Active - allow new activities of this type

=@

Besutt types {used when clearing activity)

The results for clearing an activity must include a completed
value and a not completed value.

Result Name Set as Default | | )
Completed
Completed - Site Passed Inspecti O

C - Site Failed Inspectia O

a. Type the name for the activity type in the Name field.

b. Select the Active - Allow New Activities of This Type check box if you
want to allow users to schedule activities of this type.

3. Create the result options to use when the task is completed.

Every ACT! activity has results associated with it. These result choices
appear when you clear an activity; after you clear the activity, the result
you selected is automatically entered into the History tab of the contact
associated with the activity. When you create an activity type, two types
of results are automatically assigned to it: Completed and Not Completed.
Although you cannot delete these two options, you can edit them. You can
also add new result types. When you add a new result type, it becomes
available as an option when you clear an activity.

¢ To add a new result type: Click the Add button.
¢ To edit a result type: Click the Edit button.
4. Click OK in the Add Activity Type dialog box.

The activity type appears in the Activity Types list the very next time
you schedule an activity.
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Figure 12-11:
The Manage
Priorities
dialog box.

Don’t ask me why, but for some unknown reason, you can’t delete an activity
type after you create it. However, you can edit the activity type and even

change the name of the activity type. Consequently, you want to think care-
fully before creating a new activity type!

Editing priovity types

If there is a square inch of ACT! that can’t be customized, I haven’t found it yet.
Even the priorities you use when scheduling activities can be tweaked. ACT!
includes five basic priority types: High, Medium-High, Medium, Medium-Low,
and Low. However, only three of the priority types (High, Medium and Low)
are active. A priority must have Active status in order for it to appear when
you schedule an activity. And although you can’t add a new priority type, you
can rename an existing one if you so desire.

1. From any of the ACT! screens, choose Schedulez>Manage~ Priorities.

The Manage Priorities dialog box opens, as shown in Figure 12-11.

Manage Priorities

Customize the names of the prienity levels by clicking the "Edit” button
below. Use the checkboxes to activate or deactivate any level

Manage Priorities

Name Active
High
Kind of High O
Medium
Halfway between Medium and Low [}
Low

2. Select the priorities you want to activate by selecting the check box in
the Active column.

3. Highlight a priority and then click the Edit button to change the name
of a priority.

4. Click OK when you finish editing the Priority List.
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M any ACT! users are confused about the concept of the layout. In fact,
some of you might have ended up renaming a layout label when you
wanted to rename a field. A field is a place to store information. The layout

is how you actually see those fields. Your layout determines both the order
of the fields and the format of each field. A layout is the name for a file

that determines which fields you see and in what order those fields appear.
After you add new fields to your ACT! database, the next step is to stick them
into an existing layout (or design a new one).

In this chapter, [ show you how to use the Layout Designer to modify an
existing layout. Here you master adding or replacing fields and tabs on your
layout, reordering all the fields when you finish, and finally, adding a few
artistic touches to your masterpiece.

Only database users with Administrator- or Manager-level security have access
to the Layout Designer. If you are a Standard, Restricted, or Browse level user,
you get to sit back, put your feet on the desk, and direct the Administrator or
Manager as to how you want to have the layout designed. Be careful what
you wish for, however; if you are an Administrator or Manager, you get to do
all the dirty work, so keep reading!

Modifying an Existing ACT! Layout

Before you begin modifying an existing layout, think about how you want your
fields arranged on your layout. Why not try the layouts that come with ACT!?
This way, you can get a feeling for the one that’s most comfortable for you.

Don’t worry about colors or the names on the tabs — you can change all that.
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Arranging fields the way you want them

Arranging fields the way you want them might sound like a no-brainer, but
many ACT! users never realize the importance of changing the field locations
in their layout. For example, you might choose a layout that has the main
business phone number on the top portion of your layout, the home phone
number on a different tab along the bottom, and the mobile phone number
in a third location. If you're constantly flipping between tabs to find phone
numbers, move them together into one strategic place on your layout.

This organization might not make your layout look better, but you’ll certainly
work better! The point is to design your layout in such a way that data input
becomes easy — and possibly even fun!

Here’s what you do to modify an existing layout in terms of field selection and
placement:

1. Choose the layout that’s closest to the one that you want to have.
If you need help with switching layouts, take a peek at Chapter 2.
2. Choose Tools=>Design Layout=>Contact.

You’re also given a choice of group and company. That’s because you
can also design — or redesign — your group and company layouts in
exactly the same way as you do for your contact layout. In this example,
you’ll be working with the contact layout, but feel free to modify your
group and company layouts in exactly the same manner.

The Layout Designer opens (see Figure 13-1).
Each field consists of two elements:

¢ The field label, which is an optional element, usually appears
immediately to the left of a field.

¢ The field itself is identified by the down arrow that appears at the
field’s right edge.

3. (Optional) Maximize the Layout Designer.

Okay, this step isn’t a necessity, but it sure makes your design chores a
whole lot easier!

4. Make sure the toolbox and Properties window are both open.

These are two important elements that you need to have open in order
to create or modify a layout. The toolbox sits on the left side of the
Layout Designer, and the Properties window sits on the right side. If the
toolbox and/or the Properties window are nowhere to be seen, try click-
ing the View menu to open them. You see both of them listed right there.

If you feel like the toolbox and/or Properties window is cramping your
style — or at least your work space — feel free to move them out of
your way. You can accomplish this feat by simply placing your mouse on
the title bar of either window and dragging it to your desired location.
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You can also close them by going back to the View menu and clicking
them again, but trust me — you’re going to need them momentarily!

\\3
If the Properties window gets in your way on occasion but you don’t
want to keep heading up to the View window every time you want to
open or close it, press F4 to speed up the process.

\\3 If the toolbox and Properties window look vaguely familiar to you, it’s

because they're identical to the toolbox and Properties window found in
the Report Designer. Read more about these features in Chapter 9.

5. Choose File~>Save As and give your layout a new name.

[ recommend saving and naming your new layout with an easily recog-
nizable name. That way, you can later go back to your original layout
(if you totally annihilate this one) and easily identify your layout.

The name of your layout appears in the Layout Designer title bar (refer
to Figure 13-1).

Save changes to your layout early and often. The Save icon on the
Layout Designer is represented by the standard floppy disk icon. Click it
to save your work. Relying on the old Undo standby (Edit=>Undo) is an
option, but saving your layout early and often is always a good idea!

When you save a contact layout, ACT! automatically assigns it the
extension .cly. When you save a group layout, ACT! gives it the
.gly extension. And when you create a company layout, the file is
given the .aly moniker.

Layout Designer - ACT for Dummies BEF
File Edit View Format Help
E-@-8& \ @
Tahoma ~|l8 ¥ A-B 7 U|=|= = -y -
Tookox ~| Propertes
Drawing o o o [L] Company (Field) ]
h Company  Qcompany w0 Address Address 1 v|  Email
Field & et D ERE]
X Pointer Contact Contact ~ Address 2 v|  Messenger =)z
[ Field Salutation  |Salutation ~ Address 3 - Bl Appearance
= ) . Backgroun:_] Window
Memo Field Title Title v city City v ID/Status Border Styl Fixed3D
5 Picture Field Department | Department - State State v Spouse Font Tahoma, 8pt
Yes/No Field
) Phone Phone v | Ext|Exts|w ZIP Code IIF Cade «|  irthday Font Color Il ControlText
[T] Record Manag Text Alignn Left
B Access Mobile Mobile Phone ~ Country Country v ReferredB | |5 gopo o
Fax Fax Phone w Web Site Wieb Site v Enter Stop True
Enter Stop 0
Last Results | Last Results ~|  EditDate Tab Stop E True
Last Reach Last Reach LastAttempt  |Last Att=mpt Last Meetin Tab Stop V. 0
ast Read ast Read - astAttempt |Last Attemp! v B
Field Value Company
o B Layout
Motes | History | Activities | Opportunites | Groups | Secondary Contacts | Documents | Contact Info || User Fields | Home Address :
Location 96, 16
HomeAddress | Home Address 1 v| HomePhone |HomePhone v Size 184,21
Home Address 2 ~|  Personal E-mail |Personal E-mail ~
Home City Home City v
Home State Home State - Alternate Phone  alt=rnate Phone ~
I
Home ZIP Code | Home ZIP Code v|  Pager Pager Phone ~
Figure 13_1 . Home Country Home Country v
The ACT!
Layout
Designer Appearance
~
I < >
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6. Select the Pointer tool in the toolbox.

The Pointer tool, the tool that you’ll probably use most often, enables
you to select fields so that you can move, change, or remove them.

. With the Pointer tool, select the fields and field labels that you want

to move — or remove — from the layout.

Removing unused fields can simplify a layout and make room for other
fields that you want to add. [ recommend removing what’s unwanted
before moving on to other aspects of the layout design process.

Make your selections by any of these methods:
e Click any field or field label to select it.

e Click any field and then press Shift or Ctrl while clicking additional
fields to select multiple fields and labels.

¢ Create a box around the desired labels and fields by holding down
the left mouse button and then dragging to create a selection box.

When you select a field, a border of small boxes (handles) appears around
the field indicating that it’s selected. In Figure 13-1, the Company field is
selected.

. (Optional) To remove fields, press Delete.

The unwanted fields go away.

Removing a field from the layout doesn’t remove the actual field from
the database. The field remains in your database but isn’t visible in the
layout.

. To move fields, select them with the Pointer and then drag them to a

new location on your layout.

If only rearranging the living room were this easy! The idea is to drag the
selected fields and their corresponding labels to the place on your layout
that seems the most logical to you.

If you need to make only a minor adjustment to the field location, you
might try using your keyboard’s arrow keys for really fine-tuning your
layout.

You can move a group of fields by selecting them and then pressing Ctrl+X.
Move your cursor to the new spot on your layout where you want to place
the cells and press Ctrl+V to paste the fields. Voila! — you move the group of
fields en masse.



Chapter 13: Customizing Layouts 20 1

Adding new fields to the layout

In Chapter 12, you find out how to modify existing fields or to create new
ones from scratch. When you rename an existing field in ACT!, you tweak its
label to reflect the change in field name. Typically, you start by renaming one
or all of the ten user fields. At that point, your work is almost over because
the field is already included in your layout. To change a field label, simply
double-click it; you’ll end up in the label edit mode, at which point you can
type in the new field label.

MNG/
s Make sure that the labels in the Layout Designer match the actual names of
the fields. For example, [ might have a field called Men’s Room but give it the
label Ladies’ Room — and end up with very unexpected results!

Adding a new field from scratch to your ACT! database is a bit more compli-
cated because after you create the new field (see Chapter 12), you now need
to find a place for it on your layout. However, if you follow the upcoming
steps, you'll find that adding the new field to your layout is certainly not an
insurmountable task:

1. Click the Field tool in the Layout Designer toolbox, hold down the left
mouse button, and then drag the cursor to the right to define the field’s
initial size and position on your layout.

The Select Field dialog box opens, presenting a list of all the fields that
do not currently appear on your existing layout. The fields are listed
alphabetically. If you add an address block, all the related fields appear
together, which allows you to easily add them all to your layout in one
fell swoop. For example, notice in Figure 13-2 that all the credit card
address fields are lined up together.

Select Field

Please choose a field:

Mtemate Extension HES
Credit Card Address Address 1
Credit Card Address Address 2
Credit Card Address Address 3
Credit Card Address City
Credit Card Address Country
Credit Card Address State
Credit Card Address ZIP Code
Customer 1D

. Fax Extension

Flgure 13-2: First Name:

. First Purchase

Adding a | Home Addrsss 3

Home Extension

new field to | LestEmai
Last Name I
an ACT!
layout.
|

Include a label
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In Chapter 12, I talk about setting up new fields. In general, I recommend
setting up your new fields first and then placing them on the layout.
However, if you add your new fields to your layout and find that you
forgot to add one of your key new fields, don’t worry. Just click the

New Field button, conveniently located at the bottom-left corner of the
Select Field window, to add a new field on the fly.

Clicking the Field button allows you to add the vast majority of new
fields that you've added to your database. However, a few other field
types lurk in the Field section of the toolbox that might be of interest.

The Memo and Picture fields are super-sized fields that need to be made
larger than your other fields. The Yes/No fields are tiny check box fields
that are large enough to hold only a check mark. Don’t worry if you're
having trouble “guesstimating” the size of those fields because ACT!
automatically resizes them for you.

2. Select the field that you want to add to the layout, deselect the Include
a Label check box if you don’t want the field to have a label, and then
click the Add button.

The field is added to your layout. You can add as many fields to your
layout as you like, but you're allowed to use each field only once.

3. When you’re done adding fields, click the Close button in the Select
Field dialog box.

Changing the tabs

Just like you can add, move, or remove the individual fields of your database
on your layout, you can also add, move, or remove the tabs that are on your
layout. Using tabs is a great way to organize the fields in your database. For
example, you might have a Products tab that lists the various products that
you are tracking — or a Personal tab that includes contact info: birthday,
anniversary, blood type, IQ, and shoe size. The whole point of being able to
customize your layout is to make it comfortable for you. If you find yourself
constantly hunting for a field, chances are that your fields are not arranged in
a logical fashion. If that’s the case, consider editing the tabs on your layout:

1. From the Layout Designer, choose Edit=>Tabs.

The Edit Tabs dialog box appears (see Figure 13-3), where ACT! gives
you several tab customization options.

2. Hide any system tabs you no longer want to display in your layout.

The single left- and right-pointing arrows in the Edit Tabs dialog box
allow you to hide a system tab. Although the system tabs — Notes,
History, Activities, Opportunities, Groups, Secondary Contacts, and
Documents — can’t be deleted, you can hide them by moving them into
the Hidden Tabs area on the left side of the Edit Tabs dialog box.
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Edit Tabs
Manage tab display
Hidden Tabs Show tabs in this order:
Notes Add Tab
History
Activities
Opportunities
Groups
Secondary Contacts
Documents
E Contact Info
User Fields
Home Address

3. Customize your tabs according to your own sense of design and order.

e Add Tab: Add an additional tab to your layout. Enter a name for the
new tab in the Add Tab Layout dialog box and then click OK. You
now need to go back and add some fields to that shiny new tab.

e Fdit Tab: Give a tab a new name. Unfortunately, you can’t rename
any of the system tabs.

e Delete Tab: Remove a tab other than a system tab from your layout.

When you remove a tab from a layout, all the fields located on that
tab are removed as well. Consider moving — or removing — all the
fields from a tab before you delete the tab itself!

e Move Up: Move a tab so that it appears before another tab.
e Move Down: Arrange a particular tab so that it appears after another.

4. Click Close when you’re happy with the names and order of your tabs.

Changing the order of things

You can — and should — use the Tab key to progress through your fields as
you input contact information into your database. When you start with an
ACT! layout right out of the box, you can tab through the fields in a logical
order — that is, from top to bottom. However, you might prefer to move hori-
zontally across the layout rather than vertically from top to bottom. Or, you
might find that after adding a few fields, you can no longer tab through your
fields with the greatest of ease.

Although having out-of-sequence field ordering doesn’t damage your database,
it does make inputting data difficult. Each time you press the Tab key, your
cursor skips to the next numbered field instead of to the next field that you
see on your layout. This could be a real bummer if not for the fact that you
can reorder your fields when necessary. A tab stop is associated with every
field on your layout; the Tab Stop number determines the order of the fields.
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Although an important step, consider waiting to change the field order until
you are absolutely, positively, 100 percent certain that you’re happy with how
you placed the fields on your layout. There is no magic way to simply number
the fields consecutively from 1 to 100; unless you want to waste a lot of your
time by redoing your work, you might save this step until after you live with
your layout for a while.

1. Choose Viewt>Tab Stops=>Show Tab Stops in ACT!’s Layout Designer.
The tab stops appears in the Layout Designer.

When you enter the Land of Tab Stops, you’ll probably notice two
things: Little red numbers now appear to the right of each field, and
you no longer have the toolbox and Properties window to play with.
Those little red numbers represent the order your cursor will follow as
you tab your way through your layout.

When you add a new field to your layout, ACT! automatically assigns the
field the next available field number. When changing the field number
order, focus on those fields because that’s where the numbering is out of
whack. If you remove a field number and don’t assign it to another field,
ACT! automatically assigns that number to the next field that you add to
your layout.

2. Select any fields for which you want to change the field order by
clicking them.

Unfortunately, you have to click fields one at a time to remove prior
numbering. When you click the fields whose field entry order you want
to change, the number disappears.

3. Select the fields a second time to reassign the field the next available
number.

When you select the field again, the next available number is assigned to
the field. Feel free to select the fields in any order you want. After all, this
is your layout!

4. Right-click a field, choose Set Index, and type in a field number to
advance several fields at a time.

This is a great party trick in the event that you need to squeeze a field or
two in among all your existing fields and don’t want to have to click and
re-click each and every field in your layout. Say, for example, that your
fields are numbered sequentially from 1 to 61, and you want to stick a
new field smack under field 1. Whew! You're looking at a lot of click time.
But wait! If you right-click field 2, choose Set Index, and change the field
number to 3, you see all the fields 2-61 magically increase by one digit.

[ wish I had a great tip for decreasing the field numbers in the event that
you remove a field. Unfortunately, I don’t. And, [ wish you could undo the
field numbers if you increase them by accident. You can’t. All [ can tell
you is to be careful when setting the field index because it can’t easily be
reversed.
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5. Choose View=>Tab Stops—>Show Tab Stops to leave the tab stop area.

6. Choose Viewr>Enter Stops—~>Show Enter Stops to begin editing the
enter stops.

Just like the tab stops control the order that your cursor follows as you
tab through your layout, the enter stop controls the path your cursor takes
when you press Enter. Think of the enter stop as a bypass, allowing you
to skip merrily from one area of your layout to the next.

The enter stop looks and feels pretty much like the tab stop with two
major differences: The Enter Stop dialog box is tastefully decorated in
green rather than red, and you use a whole lot fewer of them. In general,
you want to place an enter stop at the beginning of each group of fields.
You might want to have one at the beginning of the address, one at the
start of the phone numbers, and a third one conveniently located on the
first of the personal fields.

7. Choose View~Enter Stops->Show Enter Stops to return to the Layout
Designer.

After you finish reordering your tab and enter stops, you want to make
sure you save that layout by clicking the blue diskette icon on the Layout
Designer toolbar.

Beautifying VYour Layout

I'll admit that I count myself among the artistically challenged of this world.

If you read and assimilate everything in the beginning of this chapter,

you’re now pretty much equipped to go forth and design a nifty new layout.
But before tackling that new design project, you might first want to give some
thought to some of the things that can make your layout a bit more artisti-
cally pleasing.

Doing minor touch-up work

At this juncture, you leave the area of function behind you and move on to
some of the more aesthetically pleasing aspects of layout design. You can
also decide whether your layout needs a major or minor makeover. The Edit
Properties dialog box (see Figure 13-4) allows you to make changes to the
font, font size, and other attributes, as well as changes to the basic border
style of the field you click. Right-click the label or field you want to change
and choose Edit Properties. This is great for simple touch-up work but is
rather limiting if your layout needs an extreme makeover. For help with that,
see the following section.
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Creating an extreme makeover

Use the Properties window if you want to create some major changes. There are
two great advantages to using the Properties window over the Edit Properties
dialog box. First, you can edit more than one field at a time. Secondly, you
have a whole lot more choices about which elements you can edit.

If you click around in the Layout Designer, the choices in the Properties
window change accordingly. For example, if you click in a field, you can
change the various color and font attributes; if you click in a label, you can
edit the text of the label.

If you're having trouble reading the various options on the Properties window,
resize it so that you can read it better. Simply place your cursor over the left
edge of the window; when your cursor changes to a double-pointing vertical
line, drag to the left to expand the window.

Changing a field label

In most cases, the field name and the field label are exactly the same.
Having a field label differ too radically from the name of the actual field
proves to be quite confusing when you wander into the area of template and
report creation. However, sometimes you might want to tweak the field label
so that it fits on your layout better. For example, a field named Cellular
Telephone Number might be shortened to a more readable label Cell.

You can change a field label with two different methods:
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v Double-click the label.

The label turns into a text box with a blinking cursor. Delete any unnec-
essary letters and type the new label.

v Type the new field label in the Text section of the Properties window.

Adding color to your drab life

ACT! comes with close to a zillion colors that you can add to your layouts.
Okay, you caught me; there might be a few less than a zillion, but I think just
about every color of the rainbow is represented. To use one of those nifty
colors, follow these steps:

1. Click in the background of your layout in the Layout Designer.
2. Select a background color from the Properties window.

You can now change the background color by clicking the Background
Color drop-down arrow and selecting a color that matches your mood —
or the décor of your office. Like magic, your background color changes.
If it doesn'’t, it’s probably because a graphic is hiding that beautiful back-
ground color. If that’s the case, go on to the next section.

Some of you may be a little hard to please and find that the colors provided
in ACT! just don’t match the décor of your home or office. If you want to add
your own custom-blended color to your layout, mix your very own custom
color via the Custom Color tab. When you create a custom color, the Properties
window displays the RGB (red, green, and blue) number associated with the
custom color. Feel free to change those numbers if you've worked with graphic
programs in the past and want to match your layout to a specific color.

Changing the colors of your fields and labels is just as easy. Just select the
fields or labels and change the color option in the Properties window exactly
like you do for the layout background.

You can select as many fields and/or labels as you like and then change the
color for your entire selection at the same time.

Got a few fields that you want to make sure are used by your users whenever
possible? Make a field mandatory by turning off the Allow Blank option in the
Define Fields dialog box. This option can be an annoying one if you just don’t
have the information needed to fill in the field at the time of your data input;
ACT! demands that you supply the missing information before you leave the
record. An alternative might be to highlight the critically important fields in a
stunning shade of yellow so that users recognize their importance without
being asked to supply information that they might not have.
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Adding the Finishing Touches

Whew! After you add, delete, move, and color your fields, you're ready to sally
forth into the world and start using your new layout. But wait! If you look care-
fully at your layout, things might look a bit, well, cockeyed. (That’s an official
computer term to indicate that your fields seem out of whack because they
consist of various sizes and aren’t aligned properly.) If  didn’t like you so
well, I'd tell you to grab your mouse and start adjusting those whacko fields
by dragging them into submission. Several hours later, after much dragging,
resizing, and probably quite a bit of cursing, you’d probably end up in pretty
much the same place as you started. But because the point of this whole
book is to show you how to do things the easy way, you might want to read
the following sections instead.

Lining up fields and labels

One way to give your layout a truly polished look is to align all fields and
labels. When you move a field to a new location on your layout, there is a
strong possibility that the field is slightly out of line, both vertically and
horizontally, with the other fields. Of course, you can always try to “eyeball it”
by dragging the field around, trying to get it into just the perfect spot. This
method can be very time consuming, aggravating, and hard on your carpal
tunnel. [ have a much easier — and precise — way to accomplish your goal:

1. Select the errant field that is out of alignment.
2. Click the anchor field (the field that is properly aligned).

If you look closely, the selection boxes around the errant field are black,
and the selection boxes around the anchor field are white. This is your
indication that the anchor field stays in place, and the other field lines
up with it.

The last field you click is always the anchor, and all the other selected
fields line up with it. You can align several fields at a time by selecting
them and then holding down Ctrl while clicking the anchor field.

@&“\BE” Hold down Shift or Ctrl while clicking the fields in your layout to select
more than one of those puppies at a time. Alternatively, you can lasso
them by dragging your mouse around them.

Re,

3. Right-click any of the selected fields and choose an alignment option.

As you can see in Figure 13-5, you're given a whole bunch of options from
which to choose. Here are the two you’ll probably use most often:

e Align Lefts: Typically your fields look the best lined up along the
left edges looking vertically down the layout. To do this, you want
to select your fields from top to bottom before aligning.
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e Align Tops: When you have two or three columns in your layout,
you want your fields to align along the top edges as well. Select
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If you choose the incorrect alignment option, you might end up with
a mess in which all your fields are now on top of one another. Quick!
Reach for the Undo button. Don’t see it? Choose Edit=>Undo.

4. Click anywhere in your layout to remove the selection boxes.

Resizing fields

You'll probably find yourself in a number of situations in which you need to
resize one or more fields. Typically, you want to make several fields smaller
to squeeze more fields into your layout. You might want to make several
fields larger to add more data into those fields. Or, you might find that a new
field you just placed on your layout isn’t the exact same size as the other
fields. Again, you can manually resize your fields one at a time. You can also
knock your head firmly against the wall several times, but I don’t recommend
either activity.

v To resize several fields at once: Select all the fields that you want to
resize en masse. Then place your cursor on one of the selection boxes
on either the left or right edge of the selected fields. When your cursor
turns into a single horizontal arrow, drag the selection box to the left or
right, depending on whether you're making the fields larger or smaller.

v To resize against the anchor: Select all the fields that you want to be the
exact same size as an anchor field. Press Ctrl, click the anchor field once,
pause, and then click it a second time so that the selection boxes are
now black. Choose Format=>Make Same Size=>Both.
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Adding a logo or a graphic

Perhaps the best way to truly personalize your layout is by adding your very
own logo to it. Adding a graphic to the layout means that the graphic appears
on each and every one of your contact records. Don’t confuse this with using
a Picture field; a Picture field varies for every one of your contacts. You can
add your chef-d’oeuvre to your layout by following these easy steps:

1. From the Layout Designer, click the Drawing tool from the toolbox
and then choose the Image tool.

2. With your mouse, draw a shape on your layout to match the graphic
you want to insert.

The Open dialog box opens.
3. Navigate to the graphic you want to insert, select it, and then click Open.

The graphic now appears on your layout. You can drag the graphic to a
new, improved location by placing your cursor on any of the edges of
your graphic. When your cursor turns into a plus sign, drag the graphic
to the appropriate spot on your layout.

Your graphic appears exactly the same size as it was originally created. If the
graphic is too large or small to fit your layout, resize it with a graphics pro-
gram. You might find, however, that the frame that you drew in Step 2 doesn’t
exactly fit your graphic. You can resize it by placing your mouse on one of the
white squares that borders the graphic and dragging the border to match the
size of your graphic.

Creating a circle in a square

Admittedly, no one would ever confuse me with Picasso. However, some of
you might be of a more artistic persuasion, or just want to take advantage of
some of the drawing tools to add a little clarity to your layout. By creating a
square that is slightly larger than a grouping of several of your fields, you in
essence create a frame that serves to highlight those fields.

If you click the Drawing tool in the toolbox, notice the Rectangle and Ellipse
options; these are just fancy words for square and circle, respectively. At any
rate, by clicking either of these options, you can draw a square or circle
(okay, a rectangle or an ellipsis) on your layout. After they’re drawn, you can
head over to the Properties window and change the color of your newly cre-
ated shape. This is a great way to emphasize a group of fields, particularly if
your layout is starting to look cluttered.
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Did your newly created square or circle plunk itself down on top of your
existing fields? Although this leads to an interesting work of art, you probably
prefer to have the graphic behind the fields. Don’t panic; simply right-click
the graphic in question and choose Send to Back.

Adding text boxes

If a picture is worth a thousand words, a text box might just be worth a mil-
lion. Inconsistent data input is a sure-fire way to decrease the productivity of
your database. This lack of uniformity is often caused not by lack of knowl-
edge but rather by lack of communication. Adding a text box to your layout is
a great way to help users input key pieces of information in the right place
and to help organize the groups of data on the layout. Use your text boxes to
create a heading for a group of fields or to include data input instructions to
your users.

1. From the toolbox, click the Drawing tool and then choose the
Text tool.

Your cursor now looks like a plus sign instead of the normal arrow.

2. Find the spot on the layout to add a text box, hold down your left
mouse button, and drag the cursor to create a box.

3. Double-click the box and begin entering text in your new text box.

Guess that’s why they call it a text box. Feel free to write a book here

if you want. When you're finished, just click one of the text box borders
and watch in awe as little white squares appear all around your text box.
Feel free to grab any one of those boxes and expand your horizons — or,
in this case, your text box — to accommodate your verbiage.

4. Use the Properties window to customize your text box.

Here’s where you can really have fun. As long as the new text box is
selected, you can change the text, font attributes, font color, and back-
ground color of the text box.

I'm a firm believer in doing things the easy way whenever possible. If you find
yourself longing to have several text boxes all formatted the same way, create
the first text box, customize it just the way you like it, and then clone it by
right-clicking it and choosing Copy. At that point, you can paste it on your
layout — and the only thing you have to change is the text.

Chapter 13: Customizing Layouts 2 ’ 1
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Building a table

If you find yourself running out of room on your layouts because you needed
to add so many customized fields, here’s a workaround. As an alternative to
the traditional concept of listing all your field labels next to your actual fields,
arrange your fields in table format, as shown in Figure 13-6. The idea here is
to save room and allow you to easily fill in vital information.

Excess Flood | | | | | H H
Bankers Flood | H | | ” H
Reliable HO | Il I I Il
Reliable WC | ][ I I Il

Surety Company | I I Il Il
Citizens | | ‘ | | ” H
Fulcrum | | ‘ | | ” H

Focus Financial | | ‘ | | ” H

Consider building a table if you have several products and need to track the
purchase date, serial number, and expiration date for each one. Or maybe
you're a realtor and want to list the dimensions of several rooms. Not all
databases can take advantage of a table format, but those that can, will bene-
fit from freeing a lot of space on their layout.
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Zen and the Art of Database
Maintenance

In This Chapter

Performing routine maintenance
Avoiding database corruption
Backing up the database
Restoring the database
Applying ACT! updates

Editing and replacing field data

In this chapter, I show you how to take care of your motorcycle . . . er,

I mean your database. Would you believe that your ACT! database is
very similar to a motorcycle? Both are made up of many moving parts that
require maintenance. Failure to provide routine maintenance can result in
big problems — for a motorcycle as well as for your database. If something
does go wrong, having a backup is nice and (in most cases) necessary to
keep your job. Sometimes your motorcycle gets dirty; likewise, your data-
base is prone to clutter. You sometimes have to bite the bullet, roll up your
sleeves, and do a little cleaning — and clear out old or duplicate contact
records from ACT!.

Regular maintenance keeps your database running efficiently. When you
don’t provide routine maintenance for a motorcycle, things get corroded;
likewise, when you don’t provide maintenance for your database, your
records become corrupted. Weird things start happening. No, you won't see
a ghost, but you might not see a note that you know you created the day
before. Or that note just might pop up again later — in the wrong place!
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Understanding the Need
to Check and Repair

I love to change the messages on my voice mail, and one of my favorite choices
is, “Have you checked and repaired your database today?” Users often offer up
a variety of excuses for why they don’t perform routine database maintenance.
These excuses range anywhere from “I didn’t have time” to “I didn’t know I
was supposed to.” Of course, many of you give these excuses after your data-
base is already damaged. By then, of course, it could be too late for checking
and repairing. If you are the database Administrator (or the sole user of your
database), you are responsible for the maintenance of the database because
only an Administrator can do the maintenance.

Determining the maintenance frequency

If you're a little old lady from Pasadena who uses your database only once
in a blue moon, you might get away without maintaining your database.
However, if the data in ACT! is extremely important to you, perform your
maintenance on a routine basis. At a minimum, [ recommend that your data-
base receives a bit of tender loving care at least once a week.

My general rule is that the frequency of maintenance is directly tied to the
amount of use that your database receives. There is no such thing as doing
too much maintenance — only too little! Here are some situations that war-
rant more than weekly maintenance:

+ You have a multi-user database.

+ You have a large database.

v You add new fields to your database.

+ You make changes to the drop-down lists in your database.

v You add or delete numerous contact records to your database.

+ You import another database into your existing ACT! database.

v You add — or delete — users to your database.

+ You experienced a power surge, brownout, or outage.

+* You had network problems.

+* You suspect that your database is corrupted.

v You had a really lousy day when everything seemed to go wrong.
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A little shopping list of database horrors

Database corruption comes in many shapes and sizes. The following list
describes some of the more common indications — the warning signs — of a
corrupted ACT! database:

v While trying to open a database, you receive an error message or
ACT! stops responding. Smoke might be seen rising from the back of
your CPU.

+ You receive error messages while working in ACT!.
+ You can’t log into the database as a particular user.

1 Information appears to be missing or mysteriously appears attached
to the incorrect contact record.

+* You notice a significant increase or decrease in the number of contact
records in your database.

v Your database acts funny or runs slower than usual.

If you notice one — or heaven forbid, more than one — of the preceding
warning signs, I'm sorry to say that the time has come to either perform
CPR on your fainthearted co-workers or perform some simple database
maintenance. In the next section, I give you the details on performing the
simple database maintenance (that is, checking and repairing). You’re on
your own with the CPR.

Sometimes determining whether the corruption is in the database or in the
ACT! program itself is difficult. To determine this, try opening the Act9demo
database that installs on your computer when you install ACT!. If the
Act9demo opens and runs correctly, the problem lies with your database.

If you encounter the same problems in the Act9demo database that you're
having in your own database, you might need to reinstall ACT!.

Performing Routine Maintenance

The old adage, “If it ain’t broke, don’t fix it!” does not apply to ACT!. Proper
maintenance enables your database to run efficiently and improves perfor-
mance. Some of the maintenance takes on a rather behind-the-scenes approach;
users don’t detect that maintenance has been performed. They do know, how-
ever, that the maintenance hasn’t been done if they start running into problems
with the database. The other type of maintenance involves actual data cleanup;
astute users can detect that changes have been made to the database.



216 Partiv: Advanced AcT!ing

MBER
@Y«
&

|
Figure 14-1:
Check and
repair a
database
here.
|

Only the database Administrator can perform routine maintenance to
ensure that your database continues to chug away without any problems.
That’s probably to ensure that everyone knows at whom to point if things go
wrong. Some maintenance tasks require that all users log off the database so
that the database can be locked, but those can be scheduled for off-peak or
even overnight hours.

In ACT!, basic maintenance is referred to as checking and repairing. The data-
base Administrator can run the Check and Repair tool regularly to ensure a
healthy database, which consists of two procedures: the Integrity Check and
the Re-index. These procedures are very similar to the Scan Disk and Disk
Defragmenter procedures on a Windows PC. The Integrity Check scours the
database for errors and repairs them if found. After any found errors are
repaired, Re-index squeezes out all the little empty spaces that are left in
your database when you delete contact records in order to ensure maximum
performance.

Yikes! Performing the Check and Repair sounds really important, so you're
probably thinking that it must be really hard. Wrong! Here’s all you need
to do:

1. Log in as an Administrator and make sure that all other users are
logged off the database.

If the Check and Repair command is grayed out from ACT!’s Tools menu,
you don’t have sufficient administrative rights to perform that option.
You might want to jog your database Administrator’s memory a bit to
remind him that his salary is directly proportional to the efficient perfor-
mance of your database!

2. Choose Tools~>Database Maintenance-~>Check and Repair.

The Check and Repair Database window opens, as shown in Figure 14-1.

ACT!

[w]int=arity Check - Checks your databass for emors and repairs any that
are found,

Be-index - Re-organizes the database storage area to increase access
speed

Perform these tasks regularly to maintain database integrity and to
improve performance.

3. Select both the Integrity Check and Re-index options and then
click OK.

Your computer makes a few whirring noises, and a snazzy indicator bar
appears momentarily onscreen. (Try to look important during this time
so as to justify your administrative salary.) When ACT! finishes the main-
tenance, you receive a cheerful message telling you that everything is
hunky-dory.
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Backing Up the ACT! Database
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You probably already know the three rules of real estate: location, location,
location. Similarly, the three basic rules of computing are backup, backup,
backup! With the proliferation of viruses, as well as the poor construction
of many computers, backing up on a daily basis is imperative. Failure to do
so can result in loss of data — as well as time and money! Having a recent
backup enables you to recover quickly when the unexpected happens.

(It might also ensure that you receive a paycheck at the end of the week.)

Only Administrators and Managers of the ACT! database get to back up a
database. After a database is backed up, only an Administrator can restore it.
Because every database requires an Administrator, you automatically landed
the job if you are the only user of the database. If you need to back up the
database and find that the backup option is grayed out on the File menu, you
must find a database Administrator and wheedle him or her into changing
your permissions. In Chapter 3, I explain the various ACT! user permissions.

If you make major changes to your database — such as importing new records,
deleting old contact records, or modifying existing fields — I recommend cre-
ating a backup before you start, just in case!

When you create an ACT! database, ACT! automatically creates several fold-
ers for you. In addition to a database folder that houses the main database
files, ACT! creates subfolders for your attachments, layouts, queries, reports,
and templates. When you back up your database, ACT! compresses all the
data into a single Zip file.

In addition to the aforementioned folders, ACT! also creates a backup folder.
Sounds like a good idea; however, if your database is located on your local
machine, chances are pretty good that the backup folder lives there as well.
One of the main reasons to create a backup is to make sure that you have a
copy of your database just in case something goes drastically wrong with
your computer. If something bad does happen to your computer — and that’s
where your backup is stored — you’ll find yourself without a computer, data-
base, or backup.

In a corporate setting, the ACT! database often resides on a network drive and
is backed up to a tape drive on a daily basis. However, you might be feeling

a false sense of security knowing that this backup is taking place. ACT!is a
Structured Query Language (SQL) database — meaning that unless you have a
special tool, a routine network backup will not back up your ACT! database.
Feeling scared? Remind your IT person that his job security is directly related
to the security of your database. Chapter 15 can give him a few alternatives.

If you use backup software or store your data on an Internet site, remember
that an ACT! database consists of more than a single file. You need to store
the Zip file backup that the ACT! backup creates in order to ensure that you
do indeed collect all the bits and pieces of your database.
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Performing the basic ACT! backup

You must have Administrator or Manager security level to back up your ACT!
database. Open the ACT! database for which you want to create a backup
copy and then follow these steps:

1. From any ACT! screen, choose Filer>Back Up~>Database.

The Back Up Database dialog box appears, displaying the location for
the backup database, as shown in Figure 14-2.

Back Up Database

Back up files to
F\Data"\ACT\ACT! ACT_For_Dummies zip

[ Password protect fils

Cancel

2. To back up the database to a different location from what’s showing,
click the Browse button, select a new location for your backup file,
and then click Save.

ACT! automatically places ACT! in front of your database name and ends
the backup file with the . zip extension.

3. (Optional) Select the option to password-protect your database.

In case you fear spies lurking about, password-protect the backup file.
However, you might not feel the urge to do so, knowing that only data-
base Administrators can use the file.

4. Click OK.

An indicator bar appears, letting you know that ACT! is creating your
backup. The time required to complete your backup varies depending
on the size of your database and the supplemental files that are included
in your backup. When the backup is complete, a message appears telling
you that your backup was completed successfully!

Backing up to various media

Backing up a database is easy. The hard part is knowing where to place your
backup. For nearly 20 years, computer users relied on the floppy disk as their
backup method of choice. You can kiss those floppies good-bye because they
just aren’t big enough to hold your backup. By default, ACT! places your
backup file on your computer’s hard drive. That’s great if your hard drive is
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ultimately being backed up, but not so great if it isn’'t — and your computer
grinds to a painful halt. Here are a couple of good alternatives to your backup
housing dilemma:

v~ USB storage drive: These tiny powerhouses can store the equivalent of
100 floppy disks on a device the size of your thumb. This is my favorite
backup device for single users who need to back up only a few programs.

v~ External hard drive: The price of external hard drives has plummeted
in recent years; you might want to purchase one to store backups of all
your data files.

v CD/DVD burner: Although these puppies come installed on most new
PCs, many users have difficulty using these devices. And, to add to the
confusion, the files that are created are often marked as read-only, which
can sometimes make it difficult to restore your data from them later.

Vg&\“"‘;-’ Those of you with both a laptop and desktop computer might think that rou-
& . . . . .

tinely backing up and restoring your database on each of the machines is a
good way to keep the two machines “in sync.” Wrong! Because SQL allows only
one database of any given name on a single computer, this method requires
you to continuously create new databases, which creates a lot of confusion.
You might want to take a look at Chapter 16, the chapter on synchronization,
which is a much better way to keep your two machines updated.

Restoring a backup copy of your database

A backup isn’t any good if you don’t know how to use it to restore your data.
Although I hope you never have to use a backup copy, follow these steps to
restore a copy of your database:

1. From any ACT! screen, choose Filec>Restorec>Database.

The Restore Database dialog box opens, as shown in Figure 14-3.

Restore Database
Select type
(®)iRestore;
Use a database backup file to recreate a database.
() Restore as
E—— Use a database backup file to create a copy of a database
ina new location or with a new name
F|gure 14'3: () Unpack and Restore Remate Database
H Unpack and restore a remote database packagetoa
REStO rn g a remote user's computer for synchronization
backup.
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2. Select one of the restoration options and click OK.

e Restore: Restores all files to their original locations; this restoration
option is most commonly used when data is lost or corrupted.

e Restore As: Allows you to restore the database to a new location
with a new filename; this option works well when you want to copy
a database or move it to another computer.

¢ Unpack and Restore Remote Database: Allows you to install a data-
base that synchronizes back to the main database.

3. Click the Browse button to navigate to the location where the backup
file is stored; click Save and then click OK.

Backup files end with the . zip extension.

@\\\NG! Many of you are familiar with the . zip extension because you’'ve
S worked with the WinZip software. However, don’t be tempted to unzip
an ACT! backup file with WinZip. The files aren’t placed in the correct
locations, and the backup file is probably rendered useless!

4. Type the backup file password if prompted and click OK.
5. Type the Administrator’s name and password and click OK.

Yikes! ACT! shows you the scary warning message that you see in
Figure 14-4. The warning explains in no uncertain terms that if you con-
tinue, your database will be overwritten with older files. If your current
database is a corrupted mess, that’s a good thing; if your database is
perfectly fine, that could be a bad thing!

Figure 14-4: (acm
Scary
restore
warning
message.
|

'} Files modified after the backup will be overwritten by an older file when restoring the database.
. Any madifications will be lost upon restoring the database. Do you want to continue?

6. Click Yes to acknowledge that you want to continue.

Your computer whirs and hisses for a few moments, and soon the
restored database opens.
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Applying ACT! Updates

Nobody’s perfect. Although it might seem that ACT! comes pretty darned
close, from time to time, a few of those dreaded bugs slip by the program-
mers and annoy the heck out of you. Or, you run out to purchase the latest
and greatest version of Microsoft Office only to find that it won’t work with
your existing copy of ACT!. Enter the update.

Applying a new release update is actually a two-step process. First, you apply
the update; then you need to update your database.

The two ways to update your version of ACT! to the latest release patch are
manually or automatically. With an automatic update, ACT! informs you of
any new updates that are available each time you open ACT!. You also see a
blinking message in the bottom-right corner of ACT!. I highly recommend that
you resist the urge to use the automatic update. By using the manual method,
you can update your version of ACT! — and your database — at your leisure.
You also have time to read up on that update before doing the deed.

You can turn off automatic updating with a simple change in the preference
settings. If you're not sure how to change a preference setting, you might
want to race over to Chapter 3 to find out.

If you're responsible for a multi-user database, you want to make sure that a
renegade user doesn’t attempt to update the database prematurely. In a
multi-user environment, you should update the server copy of ACT! first and
then update the database itself directly from the server. Only then should the
local workstation copies of ACT! be updated. The same procedure holds true
for remote databases; remote ACT! users should update their copies of ACT!
and their databases only after receiving the go-ahead from the database
Administrator.

To update your version of ACT! manually, follow these steps:

1. From any ACT! window, choose Help~>ACT! Update.

A little message appears in the bottom right-hand corner of ACT!. If you
already have the latest and greatest release, the message tells you so;
you can just close the message and go on with your business. If a newer
release is available, the message tells you that as well and encourages
you to follow the directions that are included in it.
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2. Continue updating ACT! to the latest release patch.

Although it might take you a few minutes to complete this task, you’ll
find this entire procedure to be relatively painless. Just be patient and
wait for the prompts while the patch is downloading. After the download
is complete, it is applied to your existing version of ACT!.

3. Close ACT! and any Microsoft products when prompted.

ACT! continues to install the update. When finished, ACT! informs you
that your database now needs to be updated to the newest release
patch.

4. Wait for your database to be updated.

Feel free to watch the paint dry in the next room or, if you prefer, watch
the flashing blue indicator buttons as ACT! completes the updating
process.

Performing Spring Housecleaning

\NG/
&“Q\“

The good news is that if you're reading this, you're probably the Administrator
of the ACT! database; after all, if you're not the Administrator, you don’t
have the necessary permission to perform most of the administrative tasks.
The bad news is that with the job title comes quite a bit of responsibility —
but hopefully a large salary.

In addition to performing the obvious mechanical maintenance chores, you
probably want to do a little bit of extra housecleaning . . . er, database cleaning
from time to time. Having blank, duplicate, or incorrect contact information
serves no purpose other than to make your database perform less efficiently.
So bite the bullet, roll up your sleeves, and get cleaning.

Before you perform any type of maintenance, I strongly recommend that you
back up your database so that you can retrieve any data you accidentally
delete.

Weeding out duplicate contacts

Finding pesky duplicates in your database is tricky but not impossible. Because
having multiple records for the same person or company is common, ACT! lets
you easily check for duplicate records based on predefined criteria. You can
then create a lookup of the duplicate records and delete them. You can also
change the criteria used to find these duplicate records.
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1. From any ACT! screen, choose Tools=>Scan for Duplicates.

By default, ACT! looks for duplicate contact records based on the com-
pany name, contact name, and phone number. If the contents of these
three fields are identical for two or more contacts, ACT! views them as
duplicates. As you can see in Figure 14-5, you can now specify how ACT!
checks for duplicate contact records in the Duplicate Checking dialog box.

Scan for Duplicate Contacts

Find duplicate contacts
Match on:

Comparty

Then on:

Contact

Then on:

Phone

i

Cancel

2. In the Find Duplicate Contacts area, choose the three fields you want

ACT! to use to search for duplicate contact data.

. Click OK.

The Contact List opens, along with a dialog box informing you that
duplicates were found, asking whether you would like to combine them.
From this list, you can delete records, keep records, or combine dupli-
cate records.

. If you want to combine duplicates, click Yes to continue at the prompt.

The Copy/Move Contact Data window opens. This is the first of six win-
dows that you go through when merging duplicate contacts. Merging
duplicates is a slow, grueling task; you have to merge your duplicates on
a pair-by-pair basis.

After contacts are merged together, there is no unmerge function.

Proceed with caution!

As you progress through the wizard, you perform the following six tasks:
a. Select a set of duplicates.

b. Decide whether you want to copy the information from the first con-
tact record to the second contact record — or vice versa.

c. Choose a source and a contact. Depending on your choice, one of
the contacts becomes the source, and the other one is the target.
By default, the new, merged contact contains all the target informa-
tion. If you want to retain any source field information, click in the
field and then click the Copy button.
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Figure 14-6:
Move
additional
information
from the
source to
the target
record.
|

d. Choose whether you want to move additional information from the
source fo the target or have the information remain duplicated on
both records. As you see in Figure 14-6, you indicate this in the

third step.
Copy/Move Contact Data (3 of 6)
Copy Data from Source to Target Record B
You can specify which fields you want to copy from the source contact record to the r ]
target contact record -
To copy data from a source field to a target field, click the field, and then click Copy.
Field Name Copy Contact 1 (Source) |to Contact 2 (Target) ~ Copy
Company CH Gourmet Gifts CH Gourmet Gifts
Contact
Phone
Address 1 13 East B4th 5t 13 East Bdth &t
Address 2
Address 3
City New “ork Mew York
State NY MY
ZIP Code 10008 10008
C it ¥
—

e. Select the additional elements that you want to merge together: notes,
histories, activities, opportunities, secondary contacts and documents.
If the source contact has three notes and the target has four differ-
ent notes, the final contact ends up with seven notes (if my math is
working correctly).

f. Indicate whether to keep or delete the source record. For your conve-
nience, ACT! recaps the information to make your decision easier.

If you decide to delete the source record, click Yes on the scary
warning that confirms that you might be losing information.

5. Click Finish.
Your two duplicate records merge into one.
You cannot undelete deleted records or contact information. If you inadver-

tently delete important information, run — don’t walk — to your backup file
and restore your information.

Copying or moving contact data

For many of you, merging two contact records together is only the tip of the
iceberg. You need to repeat the merge process again for each pair of duplicates
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in your database. And, after you complete the process, you might want to
start over again by changing the duplicate checking criteria.

As I stress throughout this book, having some semblance of uniformity is
very important. Lack of uniformity is a great way to sabotage your database.
A search for all your clients in Ft. Lauderdale does not include those clients in
Fort Lauderdale. In the same way, a company or contact might be duplicated
if it is entered into your database in two different ways. For example, you
might have John Q. Public and John Public, or ABC Company and ABC Co. ACT!
doesn’t recognize any of these examples as duplicates.

To find the duplicates that I mention in the preceding paragraph, you need to
use a different criterion for your search. Changing your duplicate search
parameters might just give you the results that you're looking for. But what if
you just happen to stumble on two contacts that you already know are dupli-
cates? In this case, you can cut to the chase and move the contact data from
one record to another without having to first perform the duplicate scan.

In another scenario, an existing contact might leave a company to work at
another company. You want to create a new record for the individual yet
retain his original record. By using the Copy/Move command, you can copy
specific field information from his old contact record to his new one.

ACT"’s Copy/Move Contact Data function works almost exactly like the Scan for
Duplicates function. (See the section “Weeding out duplicate contacts,” earlier
in this chapter.) The only difference is that unlike the duplication procedure,
you’re not presented with a list of contacts to start with. The onus is on you
to select the two records whose field information you want to copy or move.

To copy or move contact data, follow these steps:

1. From any ACT! screen, choose Tools~>Copy/Move Contact Data.

Look familiar? It’s the Duplicate Checking dialog box (refer to Figure 14-5).
2. Click Next to proceed through the wizard screens.

Proceed through the wizard while remembering a few key points:

e Source record: The source record is the record that contains the
data that you want to copy.

e Target record: The target record is the record you want to copy
data to.

e Copy/move data: You have the option to copy or move data on a
field-by-field basis.

® Keep/delete data: You have the option to keep or delete the origi-
nal source record.
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Figure 14-7:
The Remove
0ld Data
dialog box.
|
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Removing old data

ACT! users tend to be extremely loyal; it’s not unusual to run into ACT!
fanACTics who have been using ACT! religiously for over 15 years. Over time,
the amount of information that is stored in ACT! gets larger and larger, and
that information can become less and less important. ACT! provides you with
a simple tool for clearing the clutter from your database. (I just wish [ had a
similar tool to clear the clutter from my closet!)

1. From any ACT! screen, choose Tools=>Database Maintenance=>Remove
Old Data.
The Remove Old Data dialog box opens, as shown in Figure 14-7.

2. In the Remove from Database area, select the type of data you want
to remove and indicate the number of days that you want to use to
remove that data.

To get rid of data that is older than a year, indicate 365 days; to get rid of
data that is more than two years old, indicate 730 days; and so on.

3. Click OK.

Remove Old Data

To enhance performance, remove the data you no longer need.

If you wart an archived copy of the data, you must back up the database before you
begin

Today's Date:  [4/10/2006

Remove from database

[] Motes older than i
Histories olderthan 1000 {2 days
[¥] Cleared activities olderthan 365 4] davs
[[] Closed-Won and Closed-Lost Opportunities alder than iag
[[]Open and Inactive Opportunities clder than s
[] Document tab entries older than =

Like a champ, ACT! searches, scrubs, and ultimately removes any data that
matches your selection criteria.

If you're still not feeling really comfortable with blowing away some of your
older note, history, and activity information, you can always make an archival
database so that you can refer to that information if necessary.
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If you're concerned about deleting old cleared activities — don’t be. In
Chapter 7, I talk about histories that are automatically created when you
clear an activity. So, even if you delete an old, cleared activity, a history
of that activity remains safe and secure on the contact’s History tab.

Deleting a database

You might wonder why you ever want to delete your database. That’s good
thinking because you’re right — you don’t want to delete your database.
However, you might have inherited several databases that you no longer use,
or perhaps you created a database or two for specific, temporary purposes.
Many so-called ACT! “experts” create a multitude of databases in their attempt
to master ACT!. In general, allowing users to have access to more than one
database is not a good idea; chances are pretty good that one of your users
ends up in the wrong database. Having a multitude of extraneous databases
can also put extra strain on your resources and slow down your general
performance.

Before deleting a database, | recommend backing it up, just in case. You might
also consider moving the database to another location for safekeeping rather
than deleting it.

Deleting a database is ridiculously simple — but impossible to undelete
once deleted. Proceed with caution.

Okay, are you ready? Take a deep breath and follow these steps to delete the
database:

1. Open the database that you wish to delete.

In versions of ACT! prior to 2005, you couldn’t delete an open database —
only closed ones. However, when you send the all-clear to fire away,
ACT! 2007 will delete only the currently opened database. Govern your-
self accordingly!

2. From any ACT! screen, choose Tools>Database Maintenancer>Delete
Database.

The Delete Database window opens, verifying that you absolutely want
to delete, destroy, and make the current database disappear forever.

3. Click Yes to bid your database adieu.

Ironically, ACT! gives you two options to change your mind: No or Cancel
both serve to keep your database safely in place.
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Performing a global edit/replace

Another way to keep your database working well is by ensuring that all fields
contain consistent information. Maybe some of your contacts have the city
listed in all capitals, but others don’t. Perhaps some contacts are listed in
Florida whereas other contacts reside in FL or Fla. This lack of consistency
makes it extremely difficult to query your database. Like a forgiving mother,
ACT! provides you with the ability to correct the error of your ways. After you
pinpoint your inconsistencies, you can standardize them in one fell swoop
(instead of by correcting each field on an item-by-item basis):

1. Perform your lookup.

In the preceding example, you might create a lookup of FLA and then
add Florida to the mix. If you need help, flip to Chapter 6 and review
the section on lookups.

Unless you're planning on changing field data for every contact in your
database, make sure you perform a lookup before proceeding. These
changes are irreversible! For example, say you notice 27 instances of Fla
that you want to change to FL. If you fail to do a lookup first, you end up
changing the State field for every contact in your database to FL rather
than just for the original 27 that you intend to change. Unfortunately,
unless you have a backup handy, you're stuck with the changes because
(again!) these changes are irreversible.

2. From any ACT! screen, choose Edit->Replace Field.
If you prefer, you can choose one of the other two options as well:
e Swap Field: This option swaps the information between two fields.

e Copy Field: This option copies information from one field and
repeats it in a second field.

You now see the Replace Data dialog box, as shown in Figure 14-8.

Replace Data
Replace contents of Value,
State v FL -

Cancel

3. Select your desired field from the Replace Contents Of drop-down list.

You can select from virtually any of your contact fields with the excep-
tion of the system fields.
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4. Enter the desired information in the Value field.

In this example, you type FL in the field. To make life even easier, ACT!
supplies you with the appropriate drop-down list based on the field you
indicated in Step 3.

5. Click OK.
6. Read the warning that appears.

Generally speaking, when life — or ACT! — gives you a warning, it’s a
good idea to heed it. ACT! is politely asking you to verify that you intend
to change all the contact records in the current lookup (see Figure 14-9).
If you're not sure as to the exact number of contacts in the current
lookup, click No, return to the Contact Detail window or Contact List,
and read the record counter in the top-left corner.

Replace/Swap/Copy

:.’/‘ This operation modifies all records in the current lookup. Are you sure you want to continue?

7. Click Yes.

ACT! might have to think about this for a moment depending on the
number of contact records in your lookup. When it finishes, you’ll notice
that the field that you indicated in Step 3 has now changed for each of
the contact records in your lookup.

A few more housekeeping tips

Sure, ACT! can mechanically maintain the integrity of your database.
However, you, as the Administrator, can do a few things to help ensure a
healthy database:

v If your organization has customized the database, limit the number of
users who have permission to edit layouts and add new items to the
drop-down lists.

v Periodically clear unwanted items from the drop-down lists. Insist that
the users routinely pick items from the drop-down lists when entering
new data.
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v To avoid duplication of contacts, emphasize the importance of query-
ing the database for an existing contact before entering a new one.

 Delete any fields not being used.
v Delete outdated attachments, layouts, reports, templates, and queries.

1 Be cognizant of field length. If you have a field that holds a Yes or No
value, consider trimming the field length down to three characters.

v~ Save contact records you rarely use to a different database and then
remove them from the main database. Use a Contact Activity lookup
to locate infrequently used records.



Chapter 15
Calling in the Reinforcements

In This Chapter

Working with database users

Limiting contact and field access
Networking with ACT!

Scheduling your chores automatically
Importing information

C hapter 14 talks about the maintenance procedures that should be

done on a fairly routine basis. This chapter calls in the big guns and is
intended primarily for those of you who use ACT! in a networked environ-
ment. And because you are working in a workgroup, you’re probably using
ACT! Premium for Workgroups. Many of the features, including custom defin-
ing user roles, limiting contact access, and scheduling your maintenance are
found only in the Premium edition of ACT!. Other features, such as adding
users and networking, can be accomplished with the Standard version of
ACT! but apply to only those of you with multiple users accessing your data-
base. Last but not least, the importing feature applies to anyone who needs
to get another database or list of contact information into ACT!.

Working with the Database Users

A Record Manager is a contact in your database who is also a user of your
database. If several people enter data into your ACT! database, I highly rec-
ommend setting up each person as a Record Manager. If you and Jane are
both set up as users of the database, you need to make sure that you log in as
you and Jane logs in as herself. ACT! automatically enters several key pieces
of information based on how you log in to the database. For example, you're
recognized as the record creator of each new contact that you add to the data-
base. Likewise, if Jane enters a note, that note is associated with her name.

If you generate a document from one of ACT!’s templates, your name — not
Jane’s — appears as the generator of that document. Most importantly, your
name is associated with any meetings, calls, or to-do’s that you schedule in
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ACT!. Having unique, identifiable users in a database allows you to view your
own activities on a calendar. Otherwise, you might find yourself driving to
Podunk to visit Jane’s mom on her birthday!

Only the database Administrator has permission to add new users to the
ACT! database.

Adding new users to the database

1. From any of the ACT! screens, choose Tools=>Manage Users.

The Manage Users dialog box opens, as shown in Figure 15-1.

& Manage Users

Create New User

Select a user to change passwords, security roles, and other settings
Edit User Information

Delete User

Contact Name | User Name | Security Rolf Log On Status
Detals 7] |AisonMikola  Alison Mikola  Standord  Inactive
Betty Browser  Befty Browser  Browse  Inactive
Chris Huffman  Chris Huffman  Administrato: Active
EmstAnderson ErnstAnderson Standard  Inactive
Fred Fenderline Fred Fenderline Standard  Inactive
GaryKahn  GaryKahn  Manager  Active
Juliette Ressew Juliette Rossew Restricted  Inactive
Karen Fredricks Karen Fredricks Administrato Active
Melissz Pearce Melissa Pearce Manager  Inactive
Sarah Whiting _ Sarsh Whiting  Standard _ Inactive

Close

2. Click Create New User.

In the next window that appears, you are given a choice to create the
new user from an existing contact or to create a brand-new user who
isn’t a member of your current database.

Always double-check that the new user doesn’t already reside in your
database as an existing contact. When you set up a brand-new user, you
also set up a brand-new contact, which could result in an “evil twin” situ-
ation. For example, although you know only one John Smith, he is repre-
sented twice in your database — once as a user and the other time as
simply a member of your database.

3. Choose either Existing Contact or New Contact and then click Next.

e Existing Contact: If you choose the Existing Contact option, you see
a list of all the contacts in your database.

a. You can sort the list alphabetically — by contact or company — by
clicking the corresponding column heading.
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b. After you sort the list, type in the first couple of letters of the con-
tact’s last name or company (depending on how you sorted the list)
in the Look For text box. ACT! magically takes you to that name.

c. Click Next to continue.
e New Contact: If you choose the New Contact option, a dialog

box opens that is similar to the Manage Users dialog box. (See
Figure 15-2.)

& Man

age Users

@) Back (® ¢ Home

Manage User Tasks

Create

Edit User Information Contact Name:

New User

Specity Acceas Alyssa Fredickes
Add Permissions User Hame:
Add User to Team Alyssa Frednckes
Details []  Securiv Roe:
Standard ~]
Password optians
New Password
Confirm Password
[[] User must change password at next log on.
[T User cannot change password.
[ Passwiord never expires
<Back ][ Med> | [ Frish [ Cancel

. If the new user you added is also new to your database, you need to

type in his/her name.

If you already indicated the name of the user in Step 3, his/her name is
sitting there waiting for you.

. Fill in the user name.

The user name is not case sensitive. Just make sure you remember what
name you decide on. If you set up multiple users for the same database,
consider sticking to a set naming convention: Gary Kahn or gkahn are
good choices; you might want to avoid Gary B. Kahn or Gary Kahn, Esq.

. Fill in the password.

By now you know the drill: You type in the password once, and because
that was so much fun, you type it a second time.

. Choose the security role of the new user.

ACT! provides you with five levels of security. Because you are the
Administrator, you set those levels for all subsequent users.

® Browse: This user has the most limited role; he or she can view con-
tacts, view calendars, and add activities. The Browse user cannot
add, modify, or delete contacts; or modify or add any other data.
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The Browse role is typically assigned to users who need to look up
calendar details and schedule activities. In the real world, the data-
base Administrator typically assigns a user Browse level access if
he has serious doubts as to the user’s ability to add data.

Restricted: This role allows users to access only areas of the appli-
cation to which he or she is granted permission. The Restricted
role is typically assigned to users working in a support capacity.
A Restricted user can access all data that he or she creates but
cannot delete any data, even if he or she created it. This role also
doesn’t allow users to create companies or groups.

Standard: A Standard user is the default user role assigned to new
users. The Standard user can see the records in a database that

he creates or is given explicit access to. Standard users can add,
delete, and modify records as well as synchronize data. A Standard
user cannot add new users to the database, perform database
maintenance, back up the database, import and export data, or
modify database fields and layouts.

Manager: A Manager role is the second-most-powerful user role.
Typically, Managers are people, such as sales managers, who
manage the various users of the database and control the types of
data that is entered into the database. Managers generally don’t
have the time — or sometimes the technical knowledge — to use
the various maintenance tools that I describe in this chapter. The
Manager can access nearly all the areas of ACT!, except for data-
base maintenance and user management. The Manager is also
restricted from viewing, editing, or deleting the private records of
other individuals.

Administrator: The Administrator can perform any database func-
tion and is the chief, the head honcho, the Big Guy — the person
whom everyone blames if something goes wrong with the data-
base. When a user creates a database, he or she is automatically
assigned the Administrator role. This role is the most powerful role
in ACT!, with access to all areas of the application and all data in
the supplemental files folders. The only thing the Administrator
can’t do is access, edit, or delete records marked as private by
another user (and get out of speeding tickets when caught doing 50
in a 35 mph zone).

Assigning two users as database Administrators is always a good
idea. Not only do those two people feel extra special, but it can
also save your little rear end. As hard as it might be to believe, the
Administrator might leave the company suddenly, and without
warning — taking the keys for the restroom and the password for
the database with him. This means you might not be able to access
the database, perform routine maintenance, add users, or make
field changes. You might also find yourself looking for a new job.
Remember: No password, no entry!
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8. Select the password options and then click Next.

Here’s where you can assign a password, specify that the user must
change his password the next time he logs on, or specify that he can
never change his password. You can even indicate if you want that pass-
word to last forever by indicating that it should never expire.

9. Select the Logon Access option and then click Next.

This Active option enables the new user to access your database. If you
don’t want a user to have access to your database, feel free to choose
the Inactive option. [ show you how to delete and disable (but hopefully
not maim!) your database users later in this chapter.

10. Select additional permissions for the user.

These additional options are only customizable for Standard and
Manager level users. These options aren’t available to the Browsers
and Restricted users in the audience — and of course, Mr. Bigshot
Administrator automatically has all these options available to him.

¢ Accounting Link Tasks: Allows the user to install and use an
Accounting link.

e Handheld Device Sync: Gives permission for the user to set up his
hand-held device and synchronize his ACT! data into it.

e Remote Administration: Lets the user of a synchronizing remote
database back up, restore, and check and repair his own database.
In other words, the user becomes an “almost-Administrator” for
his database.

e Export to Excel: Permits the user to export any list view informa-
tion into Excel.

¢ Delete Records: Authorizes the Standard user to delete records
(contacts, companies, groups, activity series, notes, histories,
opportunities, and secondary contacts) that he/she owns. By
default, the Manager already has the permission to delete at will.

The preceding options are available only in the ACT! Premium for
Workgroups edition. Sorry, the alloy wheel option is still available only
for cars!

11. Click Finish.

Deleting login users

After you master adding new users to your database, you need to know how
to delete users when they leave. The first thing that you need to do is to
determine whether you're going to actually delete the user or just deny him
or her access to the database. There is a slight difference.
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If you're the database Administrator and you simply want to stop someone
from accessing the database, you can do so without having to actually delete
that person as a user. You can simply shut off her login privileges.

One of the reasons why you add users to the database is so they can perform
various functions, such as scheduling appointments and creating notes. The
user’s name is also associated with any contact that he may create. Opting to
shut off a user’s login privileges, rather than delete that user entirely, elimi-
nates the possibility of losing this information. Here’s how you shut off a
user’s access to the database:

1. Choose Tools=>"Manage Users from any ACT! screen.

The Manage Users dialog box opens (refer to Figure 15-1).

2. Select the name of the user for whom you wish to change the access
rights.

3. Click Edit User Information.
4. Click Next to bypass the Password window.

If you're removing a user’s ability to log in to the database, he no longer
can use a password.

5. Select Inactive and then click Finish.

The number of active users named in a database is dependent upon the
number of ACT! licenses that you purchased. When someone no longer works
for your company — or no longer needs access to the database — make sure
you change the user information to reflect his or her inactive status to make
room for an additional user.

You still might be determined to permanently erase all traces of past users
from both your database and your mind. You might also have other users
who no longer need to be associated with specific contacts, activities, notes,
or histories. ACT!, being the smart program that you’ve grown to know and
love, allows you to delete a user while preserving the information (notes,
histories, and so on) associated with him by reassigning those items to
another user.

Follow these steps to remove a user from your database:

1. Choose Tools=>Manage Users from any ACT! view.
The Manage Users dialog box appears (refer to Figure 15-1).

2. Select the name of the user whom you want to remove from your
database.
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Figure 15-3:
Deleting a
user with
attached
data.
|
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s

3. Click Delete User.

This is where ACT! shows its true colors — and in fact, shows off a little.
When you choose to delete a user, one of two things happens:

e [f the user never created any information, you receive two message
windows. The first asks whether you really want to remove the
user. If you answer Yes, the contact is no longer a user. The second
dialog box asks whether you want to retain this user as a contact.
If you answer Yes, the user can no longer be one of the contacts in
your database.

If the user did enter information into ACT!, a dialog box pop ups that
looks quite a bit like the one you see in Figure 15-3. If you select the
Delete Records Belonging to This User radio button, you in essence
say adios to all contact records and associated data including notes
and history — no matter who entered that data. You'll also be delet-
ing any notes and activities created by that user. A safer choice is to
select the Reassign Records to Another User option; you retain all
the contacts, notes, histories, and activities created by the user,
and the other user’s name is now assigned to them.

Delete User

‘You are about to delete user Gary Kahn from this database.
To retain records belonging to Gary Kahn, you must
reassign them to another user.

User record options

() Delete records belonging to this user.

(=) Reassign records to another user.

Select User:

Alison Mikola ~
Betty Browser

Chris Huffman

Emst Anderson

Fred Fenderiine

| Juliette Rossewx

iKaren Fredncks i
Melissa Pearce i

After you reassign contact records to a new user, you can’t reverse the
process. From here on, the notes, histories, and contacts that the deleted
user created appear to have been created by the new user. However, if you
simply delete a user without reassigning his records, you risk losing a lot of
contact information. If you don’t want that to happen, I recommend simply
removing the former user’s login privileges.

Rather than deleting a user of your database, you might consider changing
the Record Manager field for all contacts that were associated with the old
user to reflect the Record Manager they are now associated with. Skip to
Chapter 14 to find out how you can change the field data for a whole bunch of
contacts at once.
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Locking down the password

As the saying goes, you can never be too rich or have too much security.
Haven’t heard that one? Okay, | haven'’t either, but the concept is good
nonetheless. If your information is critically important to you — so important
that you're afraid that someone might just walk off with it — you might con-
sider putting a few extra restrictions on the type of passwords that your
users can use. Here’s how it’s done:

1. From any ACT! screen, choose Tools=>Password Policy.

The Password Policy dialog box opens, which looks exactly like the one
you see in Figure 15-4.

Password Policy

Enforcing a stricter password pelicy may reguire users to change
their passwords to conform to the new policy. Azero (0) setting
means no limitation

Requirements

User cannot reuse last |0 [3| passwords
Password must change every |90 2 days
Minimum duration between password changesis |30 % days
Password must be at least |8 |3 charactersin length
|
. Password must contain |2 %/ of 4 character groups
Flgure 15-4: * Lower-case (a-z)
HPH * Upper-case (A-Z)
Building a  Numbers (0-5)
= Special characters (such as |@#5%)
password
policy.
|

2. Choose your password options and then click OK.

If you indicate a zero (0) for any one of the options, you're basically
telling ACT! that you don’t want to use that option. The available options
determine how often a password must be changed, whether a password
can be reused, and whether the password must include character com-
binations (such as a mix of uppercase and lowercase letters, numbers,
and special characters).

Limiting Contact Access

The Premium edition of ACT! includes a neat little party trick: the ability to
assign record level access. Simply, record level access refers to who can see a
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record. A database Administrator or Manager can set a record access level
preference for contacts, groups, and opportunities.

The three levels of access are

v Public: These records are available for the whole world — or at least the
users of your database — to see.

v Private: These records are visible only to the user who created the
record.

v~ Limited Access: Selected users and/or teams of users have the pleasure
of viewing these records.

Here are two good reasons why you’d want to limit access to the various
records in your database:

v Users might feel more comfortable working with only their own con-
tacts. By removing access to other contacts, they virtually work in their
own little world — or in this case, database.

v As hard as it might be to imagine, management might feel somewhat
protective about the records in its database. Management might have
nightmares about salespeople walking out the door and into the offices
of a competitor with the contents of the company database firmly in
hand. By limiting a user to only the contacts that he developed or is
working with, you eliminate the chance that the rest of the database
could end up in enemy territory.

Creating a team

If you have many users in your database, you’ll probably want to divide your
users into teams. After you create a team of users, you can assign as many
records as you want to that team. The members of the team can access all
records that they have been given access to; other database users won’t even
know that those records exist. Fortunately for you, this isn’t as traumatic as
choosing sides for the volleyball team back in middle school. Follow these
three easy steps to set your teams:

1. Choose Tools=>Manage Teams from any ACT! screen.

The Manage Teams dialog box appears. You'll immediately recognize it
because it looks just like Figure 15-5.
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Manage Teams
Create Team
Edit Team Select a Team to delete or to edit, and then choose a Team Task. You
can change a team name, description, or membership.
Delete Team
Team Name Description Mumber of Users
{Europe 2 i
UsA b
|
Figure 15-5:
Creating a
team of
users.
|

2. Click Create Team from the Team Tasks box area.

The Manage Teams window pops open. Let the games begin! Here’s
where you can name the team and assign the players . . . er, users.

¢ To add one or more users: Select the users in the Available Users
list and then click the right arrow button to add the users to the
Include These Users in Team list.

¢ To add all available users to the team: Click the double-right arrow
button.

¢ To create a new user: Click Create User and follow the steps to
create a user. The new user is automatically added to the team.

3. Click Finish when you’re done.

Assigning access vights to the contacts

After you assign the players to the teams, get ready to rumble! The purpose
of the game is to decide who gets to view which contacts. You can do this on
a contact-by-contact basis. This works out well if you assign access rights to
each new contact as you create it.

1. Click the Contact Info tab from the Contacts view.

In Chapter 4, you can read how to add new contacts to your database
and to fill in as many of the fields as possible. One of those fields is the
Contact Access field, as shown in Figure 15-6.



Figure 15-6:
The Contact
Access
field.

|
Figure 15-7:
Select users
and teams
that can
access a
contact
record.
|

Contact Access
() Public

O Private

(%) Limited Access Select Users/Teams
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2. Select the Limited Access radio option and then click the Select
Users/Teams button.

The Select Users and Teams window appears, as shown in Figure 15-7.

Select Users and Teams

@&y Users | Teams |

Eu_rppe

II

Selected usersiteams

%Chns Huffman

% Melissa Pearce
Usa
Administrators
Managers

3. Select the Users and/or the Teams that can access the contact and then

click OK.

Although this seems pretty straightforward, just remember that you're
indicating who can view the contact as well as denying access to those
whom you don't select.

As your database grows, you’ll probably find yourself outgrowing the one-by-
one method of assigning contact access. You might find yourself worrying
about the hundreds of contacts that you have to assign to the Southwestern
regional sales manager. In fact, you might start having nightmares about the
expanding Northeastern territory and the four new key personnel that were
hired to cover the area. Stop fretting!

You can change the contact access for multiple contacts just about as easily
as you do it for a single contact if you follow these steps:

1. Create a Lookup of the contacts for whom you’d like to change the
Contact Access.

I like to think of ACT! as a series of building blocks. Chapter 12 shows
you how to create new database fields; Chapter 6 shows you how to
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|
Figure 15-8:
The Lookup
Contacts by
Access
dialog box.
|

create a lookup on any one of those fields. For example, you might be
looking for all contacts that have the word Northeast in the Territory
field. The results of your search appear in the Contact List.

2. Click Tag All to select all the records.
3. Choose Contacts>Edit Contact Access~>Add Users/Teams.

You should be feeling a sense of déja vu. The Add Users/Teams dialog
box appears. Although the window is slightly different than the one in
Figure 15-6, it works in exactly the same way. From here, you can select
your teams and/or users just like you did when designating the contact
access for a single user.

4. Click OK after you finish assigning the Users and/or Team that can

access the current contact lookup.

5. Click Yes in the message prompt that appears.

ACT! wants to make really, really sure that you want to change the
access rights for your current lookup, so it asks you once more to con-
firm your decision. If you click No, the message prompt closes without
changing the user access.

Finding contacts by access level

Life seems good, you're floating in the swimming pool safe in the thought that
you’ve divided all your contacts and assigned them to the appropriate users.
Suddenly the thought occurs to you that you might just want to produce a
list of the contacts that were assigned to each team. Don’t panic — here’s an
easy way to find contact records assigned to a specific access type.

1. Choose Lookup~>Advanced=>Contact by Access.

The Lookup Contacts by Access dialog box appears. Take a gander at
Figure 15-8 to see what it looks like.

Lookup Contacts by Access

Search for
Limited Access Contacts v
Accessible to

® User. <y Users v

) Team:

For contacts with record manager
<Any Users b
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2. Select your lookup preferences.

e Select an access type: Indicate here whether you're hunting for
public, private, or limited access contacts.

e Select an Accessible To option: Indicate the user or team that has
access to the contacts.

e Select the Record Manager: Variety is the spice of life — or in this
case, the lookup. If you're looking to find all of Joe’s contacts that
the Northwestern sales team has access to, here’s your chance.

3. Click OK to finish.

Securing the Fields

\\J

ACT! 2007 Premium for Workgroups comes with another great feature — field
level security. That means an Administrator or Manager can determine which
fields users will be able to see — and which ones they won’t. Here are the
three levels of access:

v~ Full Access: Users can see and modify the data in a field.

v Read-Only: Users can see the data in a field, but they can’t change it.

v No Access: Users can neither see nor modify the data in a field.
There are two good reasons why you want to limit access to the various fields
in your database. First, a user might accidentally change a key piece of infor-

mation, such as an account number. And secondly, you might want to limit the
information that a user can have access to, such as a credit card number.

You might wonder which comes first — the chicken or the egg. Fortunately,
determining whether the field or the access right comes first is a bit easier.
You need to create a field first and then secure the access to it.

If you're not sure how to create a field, now is the time to head over to
Chapter 12 to do a bit of homework on the subject.

After you set up the field, you're ready to start battening down the hatches —
or at least the access to the field. To assign access rights to a field
1. From any ACT! screen, choose Tools=>Define Fields.
The Define Fields dialog box opens.

2. Select the field to which you want to limit access and then click Field
Security.

The Field Security window appears, as shown in Figure 15-9.
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Figure 15-9:
The Field
Security
window.

Figure 15-10:
Changing
the field
level access
rights for
individual
users.

Define Fields

%3 Home

Name: Account Humber
Type: Character

Record Type: Contadls
Created: 3/29/2006

Default permissicn is applied to all users. Edit the user or team permission to override the
efault.

Default access for all users

Custom Field Default Permission:
Read Cnly o
Users | Teams
User permission takes precedence over team and default permissions.
Users Bocess Based On
Sy Homer ool
Chris Huffman Read Only Defautt Permission
Emst Anderson Read Only Defzutt Permission
Fred Fenderine Read Cnly Defautt Permission
Gary Kahn Full Access User Pemission
Juliette Rossewx Read Only Default Permission
Karen Fredricks Full Access User Pemmission
Melissa Pearce Read Only Defzutt Permission
Sarsh Whiting Read Only Defzutt Permission
3. Set the Default Permission for the field.
The easiest way to set field level security permissions is to first deter-
mine how the majority of your users will be accessing the field. In Figure
15-9, you see that the Default Permission is set to Read Only. This means
that if no other changes are made, all users of the database can see the
information in the field but not change it.
4. Select the users for whom you’d like to change the Field Level Access
and then click Edit.
If you prefer, you can click the Teams tab and edit the access level of an
entire team. In either case, you see a window like the one shown in
Figure 15-10.
Edit Users
Select one or mare users and choose the desired access level for: Contact
Field: Account Number
Users Access
Allison Mikala Read Only
Betty Browser Mo Access
Chris Huffman Mo Access
Emst Anderson Read Only
Fred Fendedine Mo Access
Gary Kahn Phd Full Access
Juliette Rossewn: Read Only
iKaren Fredricks Full Access
Melissa Pearce Read Only
Sarah Whiting Read Only
Access Level:
Full Access |
ok | [ Cancel | fepty |
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5. Change the Access level and then click Apply.

The users you select in Step 4 should already be selected. After you
change their Access level, you can select additional users and assign
them a different access level.

6. Click OK after you finish assigning the field level access rights to all
users.

Networking 101

Your mother probably taught you to share when you were a little kid. Now
that you're grown, it’s still a good thing to share — especially when you’re
talking about a database. This section is designed for those of you who want
to place an ACT! database on an existing network of computers.

You achieve optimum performance in ACT! when using a client-server net-
work in which each computer on the network is either a client or a server.
Servers are powerful computers or processes; their purpose in life is to sit in
a back closet and hold all your data. Clients are the computers that your indi-
vidual users actually sit at trying to look busy.

Another type of network — peer-to-peer — is generally simpler but doesn’t
offer the same performance as a client-server network. A peer-to-peer net-
work doesn’t have a dedicated server; the data is stored on various comput-
ers. The network performance is directly proportional to the amount of work
being done on each computer. If the database is stored on Sally’s computer
and Sally happens to be listening to an Internet radio station, downloading a
file or two as well as instant-messaging her best friends, you might notice a
big decrease in performance.

Getting your network ducks in order

Before you attempt to share a database across a network, digest a few tidbits
of information. Feel free to wash these tidbits down with a slice of pizza and a
beer if you'd like.

v In order to share a database, you must create this database on the com-
puter (server) that will host the shared database.

v A copy of ACT! must be installed on the server and on all workstations
that will be used to access the database.
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v All users must have the same version and build of ACT! 2007.

v All workstations must have full read/write access to the Database folder
and the Supplemental Files folders that are stored on the network.

v You need to ensure that the database share properties are enabled on
the server by choosing Tools=>Database Maintenancer>Share Database
from any ACT! screen on the server version of ACT!.

Padding the workstations

After you install ACT! on both the server and the workstations, your job is
almost finished. However, you still have one last housekeeping task to accom-
plish before you can go home for the day. If you are a standalone database
user, you install both the ACT! program and your database onto your hard
drive. In a network installation, however, chances are that the ACT! program
is installed on your workstation computer and that the database is installed
on the server. Enter the PAD file. Not sure what a PAD file is? Keep reading.

If you create an ACT! database called Mydatabase, three files magically
appear: mydatabase.adf, mydatabase.alf, and mydatabase.pad. The
PAD file stands for pointer to ACT! database because it is quite simply a pointer
to the actual database files. Although this file is small in size, it’s big in stature.
The PAD file doesn’t contain any data per se; its importance lies in the fact
that it lets the workstation computers know where to find the database.

In order to have ACT! perform at its very best level, make copies of the PAD
file and copy it to the workstation of every one of your ACT! users. The most
common method of copying this file to another computer is to use Windows
Explorer (or My Computer) to make a copy of the original PAD file and then
navigate through the network to paste the file to the hard drive of each remote
workstation. You also want to ensure that the remote workstation can access
the folder hosting the original PAD file and that the remote user has Full
Control Permissions for this location.

The ACT! Scheduler

As you can see throughout this chapter (and Chapter 14), the database
Administrator and Manager have a lot of responsibility. The ACT! Scheduler
feature, which is included with ACT! 2007 Premium for Workgroups, auto-
mates database maintenance, backup, and Outlook activity synchronization.
If you're working on a remote, synchronized database and the Administrator
has given you his blessing, you can opt to automate the synchronization
process.
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The ACT! Scheduler is actually a program that runs alongside ACT!; if the
Scheduler is running, you see an icon in your system tray, as illustrated in
Figure 15-11. (The ACT! Scheduler icon is the first icon on the left.) When a
task is created and scheduled for a database, the ACT! Scheduler service lets
the task run whether ACT! is running or not.

|

Figure 15-11:
The ACT! [958 & maw ]
Scheduler.

|

Like just about everything else, creating a task for the ACT! Scheduler is
child’s play:

1. Choose Tools=>ACT! Scheduler.

If you already see the ACT! Scheduler icon in your system tray, feel free
to right-click it and choose Open ACT! Scheduler. In either case, the ACT!
Scheduler opens just like you asked it to do; you can check out its
appearance in Figure 15-12.

=} ACT! Scheduler =
Create a task
Create a new scheduled task or select a task from the list to edit or delete
Select the desired action in the Scheduled Tasks menu on the left. A database
may only have one scheduled task of each type.
Database Machine Name Task
ACT_For_Dummies WTOSHIBA-LUSER Maintenance
Stop Service
View Task Log
About ACT! Scheduler
None
|
Figure 15-12:
The ACT! =] (2
Scheduler. .
|

2. Click Create a Task.

The first window of the ACT! Scheduler Wizard opens up. Like many of
the other setup tasks, ACT! happily steps you through the process. All
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you have to do is fill in the name and location of your database, user
name, and password. Don’t forget to click Next to continue.

3. Select the task you want to schedule and then click Finish.

This step is pretty much of a no-brainer — you have a choice of schedul-
ing a backup.

Importing New Information into ACT!

\\J

You might have nothing but time on your hands and decide that the one thing
you want to do with all that time is to sit down and enter thousands of new
contacts into your database. Or, you might have lots of excess cash in your
drawer and decide to hire someone to enter thousands of new contacts into
your database. My hat is off to you, and all  can ask is that you send me a
postcard in ten years when you finish.

If you're hoping that ACT! has an easier solution — it does! The question you
need to ask yourself is where did that data come from? I have great news for
you if your data came from any of the following sources:

v You purchased a list and received it as a download or on a disk.
v You downloaded a list from an Internet site.

1 You received the list on disk/disc in conjunction with a trade show you
attended.

v Someone in your organization has kept his or her contact information in
another (gasp!) program rather than in ACT!.

v Another piece of software that you're using — for example, QuickBooks —
contains a good portion of the contact information you want to have
in ACT!.

All these situations mean that your data is in an electronic format, which you
can easily import into ACT!. You get to head to the beach rather than head
for your keyboard. ACT! can easily import your information if it is currently in
ACT!, Outlook, dBase, Palm Desktop, or text-delimited format.

If you or someone in your organization is currently using Outlook for contact
management, you need to check out Chapter 17 to find out how easily you
can import that information into ACT!.

Most databases have an option to export data. After you export the data, you
need to save it in text-delimited format. You can easily save data in the cor-
rect format via Excel. If you're using a relatively old program that was written
for DOS, you might not find an Export option. Not to worry because most
DOS programs allow you to print to file, which in essence creates a text file.
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To start importing information and stop spending countless hours hovering
over your keyboard, follow these steps:

1. Open the ACT! database you want to import your information into.

MBER If you're importing another ACT! database, perform routine maintenance
on that database and back it up before attempting to bring in the new
data. Not sure how to perform these feats? Chapter 14 explains them in
more detail.

Vg‘\\\NG! Before you start importing data, be sure to select the Duplicate Checking

S option. This option is particularly important if you suspect that your
current database might include some of the same contacts as the imported
information. Duplicate checking merges any duplicate records with
existing ACT! records. If you don’t have duplicate checking turned on,
you might find yourself merging hundreds — or even thousands — of
duplicate records one pair at a time. Check out Chapter 3 to discover
how to turn on this preference setting.

‘X@“\BER 2. Choose File=>Import.

& Only Administrators and Managers have permission to import data into

the ACT! database.

Holy guacamole! A wizard helps you out; if you follow the instructions,
you have your data imported in a jiffy.

3. Click Next to continue.

The Specify Source screen of the Import Wizard appears (see Figure 15-13).

Import Wizard (2 of 3)

Specify Source
Note: f you do not see the file type that you want. you may need to convert your existing
file to a delimited text file. ACT! 3x - 6 databases must be converted in order to import.

\what type of file do you want to import?

ACT! Database (3x) v
File name and location:
C:\My Documents ' ACT\import_file pad
|
Enter user log on information
Flgure 15-13 User Name Karen Fredricks
Specifying N
the source
file for data
importing.
|

4. Fill in the important information about your import.

e What Type of File Do You Want to Import?: Choose the file type from
the drop-down menu.
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|
Figure 15-14:
Mapping
fields for a
data import.
|

e File Name and Location: Click the Browse button to navigate to the
file that you're importing.

e User Name and Password: If you're importing an existing ACT! data-
base into the current database, you need to supply this informa-
tion for the old database. If you're importing data from another
format, these options are grayed out.

5. Click Next to continue.

6. Specify the type of records you want to import and then click Next.

If you're importing an existing database, you can choose to import con-
tact, group, or company records. If you’re importing a text file, you can
decide whether you want the imported information to appear as con-
tact, group, or company records.

. If importing a text file, specify your import options and then

click Next.

Here’s where you can indicate whether your text file is in tab- or comma-
delimited format and whether you want to include the header row of
your import file. The header row is the row that names each of the fields
you are importing. If you include it, you end up with a contact record
whose company name might be company.

The Contact Map screen of the Import Wizard appears, as shown in
Figure 15-14.

Import Wizard (6 of 8)
Contact Map
The data being imported must be mapped to the individual fields in the curently open g
database
vae 00
exportbxd ACT_For_Dummies
Map from this field To this field - Resst
Address 1 Address 1
Address 2 Address 2
Address 3 Address 3
Alternate Extension Alternate Extension
Alternate Phone Alternate Phone
Birth Date Birth Date
City City
Company Company
Contact Contact
Country Country m

8. Map the fields from the new information to existing fields in the ACT!

database and then click Next.

Mapping fields allows you to associate field names from the import data-
base to the corresponding fields in your current ACT! database. If the
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names of the fields in your import database exactly match the names of
the fields in your current ACT! database, you're home free. You'll notice
in Figure 15-14 that the left side of this screen indicates the field names
of the source database you are importing; the right side indicates the
field names of your current or target database.

Blank fields in the right column are indications that the field in the left
column doesn’t import. To remedy this situation, you need to click the
drop-down arrows for all blank ACT! fields and indicate the name of the
ACT! field you want to use to hold this new data. If your ACT! database is
missing key fields, you need to add them to your database before you
can import information; Chapter 12 tells you how to add fields to your
database.

After you map the fields, you can save the mapping by clicking the Save
Map button. That way, you can click the Load Map button in the future if
you ever import another similar database. It also comes in handy to
save a map in case you have to stop the import in order to add in a few
missing fields.

You'll notice a few arrow buttons along the top. If you click the right-
pointing arrow, you're treated to a sneak preview of what your informa-
tion looks like after the import completes.

To make your life easier, consider renaming the fields in your import
database to exactly match the names of your ACT! fields. For example,
ACT!s main address field is labeled Address 1. Renaming the address
field in your import database to Address 1 causes the fields in both data-
bases to map automatically.

Don’t create new fields that might be lurking incognito in your database.
You’ll want to be very familiar with the structure of your ACT! database
before attempting an import. Many users add a Cell Phone field to their
ACT! database without realizing that a Mobile Phone field was already in
existence. Postal code, ZIP, and ZIP code are pretty much three different
ways of saying exactly the same thing.

. Specify the merge options if importing another ACT! database into

your current one.

ACT! asks for a bit of feedback concerning what happens if a contact
record in the import database matches a contact record in your current
ACT! database. Typically, you want to merge the information together so
that the notes you entered for Nancy Wilson in your import database
combine with the notes you added for Nancy in your current ACT! data-
base. However, if you prefer, you can change the option so either

¢ Duplicated information isn’t imported.

e Information from the import database overrides the information in
your current ACT! database.
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10. Click Finish to start your merge.

You might want to take a quick break after completing the wizard.
Depending on the number of contacts you are importing, this step can
take a while. Just make sure you keep an eye on your computer because
ACT! might run into multiple duplicate contacts and ask you whether
you want to merge them.

After importing your contacts, you can tweak them a bit. For example, you
might want to change the ID/Status field to Prospect, or the Referred By field
to Imported Database. Chapter 6 walks you through creating a lookup based
on the contact’s Create Date field, and Chapter 14 shows you how to perform
a global search and replace.



Chapter 16
ACT!ing with Synchronizations

In This Chapter

Understanding synchronizations
Setting up the master database
Setting up the remote database

Performing a synchronization

n earlier versions of ACT!, synchronization was a very delicate — and

technical — operation. If not done correctly, you had a great chance of cor-
rupting your database. The synchronization process is now much more stream-
lined. Although many steps are involved, they’re not difficult or complicated.

Remote users must have a way to connect their computers to the main com-
puter’s network in order to synchronize. In some cases, that involves bringing
in the remote user’s laptop and connecting it to the network. Synchronization
can also be done by connecting to the host remotely via a Virtual Private
Network (VPN) — or if you have the Premium version of ACT!, by the use of
Internet Information Services (IIS). Creating a VPN or an IIS is beyond the
scope of this book; I assume that you already have the correct info structure
in place.

What in the World Is Synchronization?

To understand synchronization, you need to know the following terms:

v The master database is the main database that contains all your data.

v The remote database is a separate database being used by another user,
generally in a different location.

ACT! users commonly confuse backing up and restoring data with a true data
synchronization. If you back up your database and restore it on a remote
user’s computer, the remote user now has a carbon copy of your database.
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This method works fine if the remote user doesn’t want to make any changes
to his database. However, if you both make changes to your respective data-
bases, you have no way of merging those changes. If you back up your data-
base and restore it once again to the remote user’s computer, you wipe out
any changes he made.

Synchronization means that you can make changes from either the master or
the remote database. It’s the exact same concept that’s used when you syn-
chronize your PDA to your computer. After synchronizing, changes made in
the master database are seen in the remote database and vice versa.

Why synchronize?
Here are several reasons why you want to synchronize your data:

+ You want to share your database information with other remote users
in your organization and vice versa.

v Your database is located on an office server, but you need to keep
your information on a laptop for traveling purposes.

v For security purposes, you want some of your users to have access to
only portions of your database.

Synchronizing ACT! allows you to send and receive changes based on
selected contacts so that your remote user’s database contains only a
portion of the entire master database.

In Chapter 21, I talk about ACT! Premium for Web, the Web-based version of
ACT! If your remote user doesn’t need to carry his database with him on a
laptop computer, consider this alternative method.

The synchronization cycle in a nutshell

Here’s what happens during the synchronization cycle:

1. Any changes that you make to your remote database are compiled into a
packet and sent back to the master database.

2. When the master database “hears” the remote database, it accepts the
changes and sends out any changes that occurred in the master data-
base that affect the remote user.

3. When other remote users sync to the master database, they can also
receive any contact changes that affect them, including ones made by
other remote users.
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Things that change during
a synchronization

When you synchronize your data, you merge any changes that you make
to your database with changes made by your remote user(s), including the
following:

v Contact information: If you change a contact’s telephone number and the
remote user changes the address, ACT! merges both changes into the orig-
inal contact record. If you change the same contact’s telephone number
and the numbers don’t match, ACT! applies the most recent change.

v Notes and histories: If you and the remote user add notes, the contact
record now reflects all the notes and histories of both the master and
remote users.

v The Task List: Any tasks (that either you or the remote users create)
now appear in both the master and the remote databases. You can even
schedule an activity for your remote users.

v Calendars: Synchronization allows you to share the calendars of all the
users in your organization.

v~ Field definitions: If the master database has added, removed, or
changed fields, these changes are sent to the remote users.

v Drop-down lists: Changes made in the master database to field drop-
down lists are sent to remote users.

v Layouts: New or customized contact, company, and group layouts syn-
chronize with remote users.

v Templates: Letters, reports, envelopes, and labels synchronize with
remote users.

v Attachments: All documents attached to the master and remote data-
bases synchronize.

v Opportunities: Sales opportunities that are attached to contacts for
which the remote user has access permission will synchronize.

Documents stored in your personal folders don’t synchronize.

Performing a Synchronization
in Four ACT!s

The synchronization process consists of four parts: understanding the sync
process, setting up the master database, setting up the remote database, and
the actual sync process.
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The synchronization setup must be done directly on the server. Do not
attempt to set up a synchronization using one of the workstations.

ACT! 1: Doing your homework

If your knees are shaking, just relax, take a deep breath, and plot your strat-
egy. Before bravely forging ahead and attempting to sync, you can do a little
preparation. Here are some tips that make your synchronizations run more
smoothly:

v Enter your data consistently. | know I sound like a broken record, but
this is worth repeating: Enter your data consistently. For example, if you
enter a contact’s company name as Tech Benders, Inc. and someone else
enters it as Tech Benders, you have duplicate contact records when you
synchronize data. To help enter data consistently, rely on drop-down
lists whenever possible.

v Determine which contacts to include in the remote user’s database.
This decision might involve setting up a query to identify those con-
tacts. If Joe is to receive all the contacts in the Southwest region, con-
sider adding a region field to your database — or at the very least,
identify those states included in the Southwest.

» Perform a spring-cleaning on your database. Scan for duplicate records
and clean up your database before starting the synchronization process.
Turn to Chapter 14 to do so.

v~ Use the same criteria to search for duplicate records. If both you and
your remote users add the same contact to your databases, ACT!
matches the duplicate records with the criteria you specify. To ensure
that the synchronization process doesn’t create duplicate contact
records, both databases need to use the same criteria for determining
duplicate records.

You can find out how to modify your duplicate record match criteria in
Chapter 14.

v~ All users must have the same product and version of ACT!. You can’t
synchronize an ACT! 2007 database with an earlier version of an ACT!
database. You also can’t synchronize an ACT! 2007 database with an
ACT! 2007 Premium for Workgroups database. Make sure that all data-
bases have the most recent release update of ACT!:

¢ To display your current version: Choose Help=>About ACT!.
e To update your version of ACT!: Choose Help>ACT! Update.
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ACT! 2: Setting up the main database

You must follow a number of steps in order to set up a remote database.
Sound like a lot of work? Don’t worry; only Administrators and Managers
need apply because other users don’t have the appropriate rights to set up
synchronization. And, if you are an Administrator or a Manager, you can stop
hiding under your desk; although there are a lot of steps, they are all very
easy to follow. You'll also want to make sure that you're sitting at the server
when you set up the synchronization.

Enabling synchronization

The first thing you need to do is to turn on the synchronization. Follow these
steps:

1. From any ACT! screen, choose Tools=>Synchronization Panel.

The Synchronization dialog box opens, as shown in Figure 16-1.

Synchronization

Enable Synchrenization

Admin tasks:

3. Create Remote Database
Enables local datsbase for Create 3 remote database from
synchronization this database.

2. Manage Sync Set Manage Main Database Location
Create, edn, delete, and copy Sync Change the location of the main
Sets. database.

User tasks:

Manage Databas:

|
Figure 16-1:
Start syn-
chronization
here.
|

e Handheld Sync Set

Set Sync Schedule

2. Click the Enable Synchronization option in the Admin Tasks area and
then click Yes in the ACT! message dialog box.

Defining a sync set
The sync set is the main list of contacts that the remote user receives. An
Administrator or a Manager of the master database creates the sync set. On
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the simplest level, the sync set consists of all contacts that the remote user
has permission to access. However, the Administrator might set up additional
criteria to limit the number of contacts that the remote user can access. After
you send the database out to the remote user, he has the opportunity to add
additional contacts that he has permission to access to his database. Contacts
that are added to the remote database by the remote user automatically
become part of the remote user’s sync.

Consider these key elements before creating a sync set:
v A sync set is only a starting point; remote users can add additional con-

tacts to their databases if they have permission to view those contacts.

1 A sync set can include only contact records that the remote user has
permission to access.

1 A sync set always includes all the master database Record Manager
contacts as well as all group and company records. The groups and
companies populate only those records that the remote user has
access to.

v Master database Administrators and Managers can create sync sets
based on a query.

v An Administrator or a Manager can copy, edit, or delete sync sets.
v More than one remote database can use a sync set; however, each
remote database has only one sync set.

Follow these simple steps to create a sync set:

1. From any ACT! screen, choose Tools=Synchronization Panel.
The Synchronization dialog box opens (refer to Figure 16-1).

2. Click the Manage Sync Set option in the Admin Tasks area.

3. Click Create New Sync Set.

For the purposes of this section, I show you how to create a brand-new
sync set. Just remember that you can always go back and copy, edit, or
delete your sync set, following these same instructions.

4. Give your sync set a name, an optional description, and then
click Next.

What you decide to call the sync set is a big deal because you need to
recognize it by name later on. If the sync set consists of the contacts
used by the remote sales guys, you might name the sync set something
clever like Remote Sales Guys.
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5. Select the names of the remote users who will use the sync set, click

“\gN\BER the right-pointing arrow, and then click Next.
< . .
< The remote user must be an active user of the master database even if
he doesn’t have permission to access all records.
6. Decide on one of the following options:
¢ To synchronize all the available contacts to the sync users: Select the
Synchronize All Available Contacts option, click Next, and then
click Finish.
e To further limit the contacts the remote user sees: Select the Define
Sync Set Criteria option, click Next, and then click Create Criteria.
The Sync Set Criteria dialog box opens, as shown in Figure 16-2.
Sync Set Criteria
File
028
Select Sync Set Criteria
Type: Field Name: Operator: Value:
Cortat u - - -
( Type Field Name Operator Value )] And/Or
{ Contact State Contains FL Or
Contact State Contains NY ) And
Contact Record Manager Equal To (=) Gary Kahn End
—
Figure 16-2:
Determine
sync set
criteria. |
——

7. Choose the criteria you want to set the sync to:
¢ Type: You have only one choice of Type — Contact.

e Field Name: From the Field Name drop-down list, select one of the
available contact fields.

e Operator: From the Operator drop-down list, select one of the avail-
able items, such as Contains or Equal To (=).

e Value: From the Value drop-down list, select one of the available
items that corresponds to the selected field name.

8. Click the Add to List button.

When you add a criterion, it appears in the bottom section of the
window. Notice in Figure 16-2 that I'm creating my sync set to include all
contacts in Florida or New York that are managed by Gary Kahn.
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9.

10.

11.

To select more than one criterion, repeat Steps 7 and 8.

You might need to use the And/Or column to help you build the query.
And indicates that a contact must match all criteria; Or indicates that a
contact can match any one criterion.

Click the Preview button to see a list of all the contacts that match the
criteria you indicated.

You even see the total number of records that are included in the
sync set.

When you’re happy with your results, click OK, click Next to confirm
your criteria, and then click Finish.

If necessary, you can create or edit additional sync sets, or click Home
to return to the main Synchronization dialog box.

Creating the remote database

After you enable synchronization and create a sync set, you're ready to
create the remote database(s). Depending on the access rights given to them
by the master database Administrator, a remote user might not be able to
perform various functions, such as backing up a database.

The Administrator can assign a Standard user the right to perform various
administrative functions, such as backing up the database and performing
routine maintenance. These permissions must be assigned before the cre-
ation of the remote database. Chapter 15 shows you how to assign these
permissions.

1.

From any ACT! screen, choose Tools~>Synchronization Panel.

The Synchronization dialog box opens (refer to Figure 16-1).

. Click Create Remote Database in the Admin Tasks area.

Like with most of the other ACT! tasks, you now follow a wizard through
the next several steps. Probably the hardest thing you have to do is click
Next at each juncture.

3. Give the remote database a name, click the Browse button to save the

new database to a different location if necessary, and then click Next.

ACT! database names don’t allow spaces or symbols.

. Select a sync set to use with the database and then click Next.

You see the sync set that you created waiting for you.

. Indicate the following choices and then click Next.

e Allow database supplemental files to synchronize.

e Allow attachments to synchronize.
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e Set the number of days after which the synchronization expires. This
ensures that the remote user synchronizes on a timely basis or
risks having the database expire. After a database expires, the
remote user can synchronize to the master database one last time,
at which point the master database Administrator or Manager has
to create a new remote database.

6. If you're using ACT! Premium for Workgroups, make note of the name of
the Master computer and the port assigned to listen for incoming syncs.

Because the Premium version offers an additional sync option, choose
to sync either across the network or over the Internet. If you sync over
the Internet, you're prompted for the computer’s external IP address.
You can find out how to ascertain the server’s IP address in Chapter 21.

7. Give the database a password (optional) and then click Finish.

This might be a good time to wander around the office complaining
about how busy you are. ACT! is going to take a moment to create the
remote database for you, and you might as well look busy!

8. Click the Home button to return to the Synchronization Panel; if nec-
essary, start all over again.

If all remote users will use the same sync set, you can skip that part and
click Create Remote Database.

9. Click Close when you finish creating all the remote databases.
10. Choose Tools=>Synchronize~>Accept Incoming Syncs.

The final step sets the master database in a wait-and-see mode. As the
Administrator, your job is almost finished. Time to sit back, pat yourself
on the back, and figure out a way to get that database to the remote user.

The ACT! 2007 Premium for Workgroups installation CD comes equipped with
two slick programs that can be installed on the ACT! server — Internet Sync
Service and Network Sync Service. These tools allow ACT! to listen for incom-
ing sync packets from the remote users without having to keep ACT! open on
the server. However, should you decide to use one of these handy utilities,
you don’t want to turn on the Accept Incoming Syncs option found in Step 10.

Delivering the remote data

The only thing you have left to do at this point is to get that new database,
along with all the associated files and attachments, out to the remote users.
But wouldn’t you know it? ACT! has solved that problem for you already.
When you create the remote database, you actually create a special backup
file; however, unlike a traditional backup file, this one comes with an . rdb
extension. You can simply e-mail the file to the remote user or burn it to CD
and send it via snail mail. Just don’t forget to send along the password if you
used one to create the backup!
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ACT! 3: Setting up the remote database

When you set up the remote database and send it off by carrier pigeon to
your remote user, the ball is in the other guy’s court. Relax and go float in the
pool — just make sure to keep the cellphone on in case the remote user has a
question. And don’t forget the sunscreen!

If you're the remote user, you have a few chores to do. Thankfully, none of
them are very hard. The first thing you need to do is restore the remote data-
base that the Administrator of the master database sent. This procedure
works pretty much the same way as the restore procedure that I discuss in
Chapter 14; the main difference is that the remote database has a different
backup extension than a traditional database backup file.

Q‘&N\BER
& Traditional ACT! backup files have a . zip extension. Remote database
backup files have an . rdb extension. Could it be that RDB stands for Remote
Database? You be the judge!

You, as the remote user, can follow these steps to set up the remote database:
1. Save the . rdb file that you receive from the master database

Administrator onto an appropriate spot on your hard drive.

My suggestion is that you jot down the location so that you don’t have
to call the Administrator and ask for help. My experience is that
Administrators get very cranky when interrupted in mid-swim.

2. Open ACT!; from any screen, choose Filez>Restorer>Database.
The Restore Database window appears.

3. Select the Unpack and Restore Remote Database option and then
click OK.

The Unpack and Restore an ACT! Remote Database window opens.

4. Click the Browse button next to the Select the Remote Database File to
Restore field to locate the remote database (.rdb) backup file that you
saved in Step 1.

5. Click Browse to select a location to save the restored database.

If you're not going to store the database on a network, you probably find
that the default location, located in your My Documents folder, fills the
bill nicely. If you're sharing the database, you want to perform the entire
restoration operation on the server so that the restored database can be
saved directly on your server.
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6. Select the Share This Database with Other Users option if you're shar-
ing the database with other users.

7. Click OK.

If the database you’re restoring is password-protected, type your secret
password and click OK. Don’t know the password? Your Administrator
might just have to finish his swim and supply you with it!

After you restore the database, you can open and begin using it just like any
other ACT! database. You can also begin to synchronize your data at any
time.

ACT! 4: Synchronizing data

The remote user is the keeper of the synchronization key and the only one
who can initiate a sync. You’d think that having such a big responsibility
would entail a lot of work. Fortunately for you, it doesn’t.

1. From any ACT! screen, choose Tools=>Synchronize.
2. Click the Synchronize Now option.
When you synchronize the database, two things happen:

® Any changes made in the remote database appear in the master
database.

¢ Any changes made in the master database associated with contact
records included in the remote user’s sync set appear in the remote
database.

The synchronization can take a few minutes depending on the number of
changes that have been made to both the remote and the master databases.
You see an indicator bar roll across your screen and then a congratulatory
message celebrating the fact that you performed a successful synchroniza-
tion. You're also asked to refresh your database so that you don’t drive your-
self crazy looking for changes that might take a moment to appear.

Setting up automatic synchronization

In the standard edition of ACT!, the remote user has no other option than

to manually synchronize his database whenever he wants to send — and
receive — the latest and greatest information. As the remote user, you might
want to have ACT! perform your synchronization automatically for you while
you’re at home snoozing. If that’s the case, you need to make sure that you
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and your entire organization use ACT! 2007 Premium for Workgroups; if they
do, you can follow these set-it-and-forget-it steps:
1. Open the remote ACT! database.
2. Choose Tools->Synchronization Panel.
The Synchronization dialog box opens (refer to Figure 16-1).
3. Click Set Sync Schedule in the User Tasks area.

The Sync Schedule window opens, as shown in Figure 16-3.

Synchronization
%y Home
Set the schedule that ACT! will use to automatically synchronize this database
QOccurs
(O None () Every weekday (M - F)
© Houty QEvery |1 1% days
(& Daily
O Weekly
| () Morthiy
Figure 16-3: Onours
Scheduling Start Date Start Time
an auto- 10/ 1/2006 v 100000PM B
matic sync.
!
|
4. Indicate your scheduling preferences.
e Occurs: Indicate the frequency with which you want the synchro-
nization to occur.
e Occurs At: Indicate the date and time that you want to commence
using the automatic synchronization.
5. Click Finish.
A\\J

In the standard ACT! version, you must leave both the master and remote
databases open so that synchronization updates are sent and received auto-
matically at the specified times.

“&\‘I\BER In Chapter 15, I talk about the ACT! Scheduler, which is a feature of ACT!
& Premium. If your organization uses Premium, the remote user(s) can set up
the Scheduler to automatically run the synchronization as well as create a
backup and perform routine maintenance.
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Adding contact records to a sync set

Because a sync set is created based on a query and may be used for more than
one remote user, you might find that your database is missing some contacts.
These contacts represent people that you might have access to but who
didn’t match the criteria the Administrator used for the sync set. Ironically,
these contacts actually reside in the remote database even though you can’t

access them.
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Sound confusing? To put it a little simpler, if you find that you're missing one
of your contacts, you can add it to the database:

1. Choose Tools=>Synchronization Panel from any ACT! screen.

The Synchronization dialog box appears (refer to Figure 16-1).

2. In the User Tasks area, click Manage Subscription List.

You now see a list of all the contacts that you can access. The contacts
that are a part of the sync set are indicated with a check mark.

3. Click Add Contacts to Sync Set in the Subscription Tasks area.

The Contacts dialog box opens, as shown in Figure 16-4.

Contacts
Look for:
Contacts to select from: Selected Contacts
@ Contact 4 | Company ~ @ Contact + | Compamy
Albert Barry Mercury Productiol
Alexander O'Brien | Manxsys Financial
Alyssa Fredricks Florida State Unive --;
Amanda Form A1 Services-US Oy
Andi Fredricks University of Floric
Andy Bosson ‘williams Consultin
Andy Harrison Al Services -
Angela lves Al Services of UK
Aniz Dawson ABS Garages Ltd
Ann Goodall A1 Services of UK
fimmatte Sharla Cnldfioh Barnrds
<
oK ] [ Cancel

4. Select the contact(s) from the list on the left and then click the right-

arrow button to add them to the remote database.

5. When you finish, click OK and then click the Finish button in the
Manage Subscription List window.

The additional contacts appear in your database after your next
synchronization.
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Maintaining the Synchronization

Figure 16-5:
Create a
lookup of
the last
records
synchro-
nized.
|

Wow! The worst is over. Your remote database is synching back to the master
database, and life is beautiful. But meanwhile back at the ranch — or at least
at the master database — the Administrator’s job continues. You might want
to check a few minor details from time to time. Or you might decide that the
fun is over, and you no longer want to continue syncing.

Viewing the last data synchronized

The synchronization process goes so smoothly that you might be left won-
dering what, if anything, actually synchronized. Sure enough, you can easily
determine that by creating a lookup. Here’s all you need to do:

1. From any ACT! screen, choose Lookup~>Advanced=>
Last Synchronized.

The Last Synchronized dialog box opens, as shown in Figure 16-5.

%y Last Synchronized S]=[%]
© Lot St

() Date Range Date Range:

From To

Search these records Look in
Record type N\:des

Corttacts hd Opportunities

Database: Histories

Al databases v Activities

2. Specify the lookup criteria:

e Last Session/Date Range: You can view either the last contacts
synchronized or the contacts that synchronized during a specific
date range.

e Record Type: Indicate whether you want to find contact, company,
or group records.



Chapter 16: ACT!ing with Synchronizations 26 7

A\

e Look In: Specify whether you want to find notes, opportunities, his-
tories, and/or activities that changed during the last synchronization.

3. Click the Find Now button.

The contact records that changed during the last synchronization are
shown in the lower section of the Last Synchronized dialog box.

4. Click the Create Lookup button.

The Contact List displays a list of all contacts that changed during the
last synchronization.

Although creating a lookup of all the recently synched contacts is generally a
job for an Administrator, remote users also have this functionality should
they feel an overwhelming desire to find out what changes other users have
made to their contacts.

Looking up the sync set lookup

As an Administrator, you probably rush through your day; chances are you
occasionally forget something: lunch, your head — or maybe the contacts
included in a sync set. You can easily create a list of all the contacts that are
part of a sync set by choosing Lookup=>Advanced=>Sync Set. The Contact List
magically appears, displaying all the contacts included in the sync set. The
difficult part is figuring out what to do for lunch!

Viewing and printing sync settings

You might want to review the sync settings of your database that were cre-

ated for each of the remote databases. Again, this feat is easy to accomplish:
1. From any ACT! screen, choose Tools=>Synchronization Panel.

The ever-familiar Synchronization dialog box appears (refer to
Figure 16-1).

2. Click Manage Database in the User Tasks area.
The Synchronization window opens.

3. Select the name of your database and click View Settings in the User
Tasks area.

As you can see from Figure 16-6, you see the names of the master data-
bases and the remote sync set, the sync server port, and the expiration
period of the database.
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Synchronization
{®) Back fa Home
Print Preview
Print
Database Name: Gary_Remote
Database Machine: CLASSROOMINACT?
Main Database: ACTDummies
Sync Set: Testing
Sync Server Machine: TOSHIBA-USER
Sync Server Port: 65100
Intemet Server Address: http://
Expiration Period in Days: 30
Database Status: ACTIVE
Created By: Karen Fredricks
Created On: 4/18/2006

4. If you want to print the results, click Print and then click Finish.

Re-creating a remote database

You might find yourself needing to send out another remote database to a
user. For example, a remote user might have forgotten to synchronize and
finds that his database is about to expire. Or maybe the remote user’s com-
puter died a slow and painful death and needs to be replaced. In any case,

here is a simple way to re-create a remote database:

1. From any ACT! screen, choose Tools=>Synchronization Panel.

2. Click Manage Database in the User Tasks area of the Synchronization

panel.

3. Select the remote database you want to re-create, click Recreate

Database, and then click Yes.

4. Click the Browse button to specify a location to save the newly re-cre-

ated database and then click OK.

ACT! whirs and hisses while it busily sets up the remote database again.
ACT! doesn’t complain about having to do this chore a second time. In
fact, you're even rewarded with a happy message confirming that you

have indeed re-created the remote user’s database.

5. Click OK.
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Stopping the synchronization process

All good things must come to an end, and so it is with your remote database.
You can sever the ties that bind the master database to the remote in one of
three ways. After the synchronization stops, the only way to get it going again
is to completely create — or re-create — the remote database. The three
ways to sever the ties are

v~ Letting the expiration date expire: Remote databases are assigned an
expiration date when they’re created. If the remote user fails to synchro-
nize during the allotted time period, the remote database can sync to
the master database one last time after the expiration date.

+* From the master database: The master database can disable synchro-
nization for a remote database and optionally allow one last synchro-
nization before disabling the remote database. The remote database
receives a notification that synchronization is disabled and is allowed
one last synchronization session.

v From the remote database: A user with Administrator rights can disable
the remote database so that it no longer synchronizes to the main data-
base. After a remote database is disabled, it is no longer a remote data-
base. However, the database can still be used as a standalone database.

To disable either a master or remote synchronized database, follow these steps:

1. From any ACT! screen, choose Tools=>Synchronization Panel.

2. In the Admin Tasks area of the Synchronize dialog box, click Disable
Synchronization.

3. When prompted, click Yes to disable the synchronization.
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“T couldn’t get this ‘job skills’ program to
work on my PC, so I replaced the mother-
board, upgraded the BIOS and wrote a
program that links it to my personal
database. Tt told me T wasn’t technically
inclined and should pursuve a career in sales.”



In this part . . .

f you aren’t content with relying on the basic ACT!

functions to keep your life organized and you want to
squeeze every last drop of functionality out of ACT!, here’s
the place to find some of the best-kept secrets of ACT!.
Want to teach ACT! to play nicely with your Microsoft
products? Interested in keeping a record of your ongoing
sales activities? Want the functionality of a high-priced
relational database — without mortgaging the farm?
Looking to share your database with other members of
your organization via the Internet? ACT! can help you
accomplish these goals, and Part V shows you how.




Chapter 17

Integrating ACT! with Microsoft

In This Chapter
ACT! and Outlook
ACT! and Internet Explorer
ACT! and Excel
ACT! and Word

¢MBER

Fice it. Microsoft is everywhere. Most likely, you're running more than
one of its products on your computer. Like many other software prod-
ucts, ACT! 2007 takes the “if you can’t beat ’em, join ’em” philosophy. ACT!
integrates fully with four of the most popular Microsoft products — Outlook,
Internet Explorer, Excel, and Word.

Although other Microsoft products don’t fully integrate with ACT!, you don’t
need to stop using them. For example, you can easily store PowerPoint pre-
sentations on the Documents tab for easy access.

Changing Your Outlook in ACT!

A common misconception I hear from potential ACT! users is that they don’t
need ACT! because they’re using Outlook. You might snicker at that sugges-
tion because by now, you realize that Outlook is a personal information man-
ager (PIM), whereas ACT! is a true contact manager. I like to think of ACT! as
Outlook on steroids; try doing a mail merge, customizing fields, or logging in
notes in Outlook to see what [ mean.

Still, some ACT! users find themselves needing to use Outlook for a variety of
reasons. For instance, your company might use Outlook to maintain the com-
pany calendar. Maybe you use Outlook to keep track of personal addresses
and information that don’t belong in ACT!, though.

Fortunately, you can use both ACT! and Outlook but be aware of a few of the
ground rules first.
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If you read the side of the ACT! box, you’ll notice that ACT! works with
Outlook versions 2000, 2002, and 2003. If you're using an older version of
Outlook, it won’t work with any of the versions of ACT! 2007.

v You can import all your Outlook contact information — including
appointments, tasks, notes, and journal entries — into ACT!.

v You won'’t see new Outlook contact information, notes, and journal
entries unless you re-import your Outlook data. You can, however, con-
tinue to synchronize your ACT! and Outlook calendars.

v Because Outlook appointments and tasks aren’t contact centric (not tied
to a specific contact record), imported or synchronized data appears in
ACT! associated with the My Record of the user who imported or syn-
chronized the information.

v ACT! converts your Outlook notes into one ACT! note.

v You can view all ACT! e-mail addresses in Outlook without synchronizing
or importing.

»* You can view all Outlook e-mail addresses in ACT! without synchronizing
or importing.

v If you indicated in your preference settings that you will use Outlook
with the ACT! e-mail client, ACT! e-mail mirrors the Outlook e-mail client.
Inbox folders created in Outlook are visible in ACT! and vice versa. If you
choose to use Outlook with the Outlook client, the ACT! e-mail client is
bypassed, and you land directly in Outlook when you send an e-mail.

Importing Outlook contacts into ACT!

ACT! very nicely includes Outlook as one of its import options. After all, more
people switch from Outlook to ACT! than from ACT! to Outlook. Here’s all you
need to do to import the Outlook data:

1. From any ACT! screen, choose File>Import.

Backing up your database is a good idea before attempting to try some-
thing as tricky as data import. In Chapter 14, [ explain how to create an
ACT! backup.

The Import Wizard opens with a nice welcoming screen that you can
skip by clicking Next.

2. Select Outlook as the type of data you want to import and then click
Next.

ACT! automatically imports your main Outlook address book. “Sub”
address books won’t be imported unless you move those contacts into
your main address book.



|
Figure 17-1:
Outlook-to-
ACT! import
options.
|
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3. Specify that you want to import contact records and then click Next.

Your contact records include the good stuff, such as the person’s name,
company, address, phone number, and shoe size.

4. Specify your import options and then click Next.

The Specify Import Options wizard screen opens, as shown in Figure 17-1.

Import Wizard (4 of )

Specify Import Options

You will have the option of mapping this data to contacts you import from Outlook orta
other contacts in your ACT! Database

Which cortacts do you want to import?

Select Outlook contacts to import contacts stored on your machine or select Exchange
contacis to import contacts stored on the network.

(#) Outlook Contacts () Bxchange contacts

What additional Outlook data would you like to import 7

You will have the option of mapping this Outlook data to contacts you imported from
Outlook or to other contacts in your ACT! database.

[Jippoirtments and Tasls as ACTT Actvries:
[[] Notes as ACT! Notes
[[] Joumal Entries as ACT! Notes

T

e Qutlook Contacts: Imports your Outlook contacts into ACT!

¢ Exchange Contacts: Imports your Exchange contacts into ACT! if
your company maintains an Outlook Exchange server

e Appointments and Tasks as ACT! Activities: Converts your Outlook
appointments and tasks into ACT! activities

¢ Notes as ACT! Notes: Converts your Outlook notes into ACT! notes

e Journal Entries as ACT! Notes: Impo
as ACT! notes

rts your Outlook journal entries

5. Confirm the mapping of your Outlook fields to ACT! fields and then

click Next.

[ personally love it when my software does most of my work for me.

ACT! has already translated the existing

Outlook fields into ACT! fields.

For example, Outlook’s Business Address Postal Code becomes ACT!’s

Zip Code field.

6. Specify your merge options and then click Next.

The merge options let you tell ACT! what you’d like to do — replace,
ignore, or use the newest contact record (if one of your Outlook con-
tacts matches one of your ACT! contact records).

7. Click Finish.
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E-mailing Qutlook contacts via ACT!

The preceding section describes how to import your Outlook contacts into
ACT! and then transform them into contact records. However, you can still
view all your Outlook e-mail addresses in ACT! even if you don’t import your
entire Outlook address book into ACT!.

Sending an ACT! e-mail to one of your Outlook contacts is almost too easy if
you’re using Outlook integration and the Outlook e-mail client. All you need
to do is follow these steps:

1. To generate a new ACT! e-mail message, click the E-Mail icon on the
ACT! Navigation (Nav) bar, click the contact’s e-mail address, or
choose Writer>E-Mail Message or E-Mail Message (from template) from
any ACT! screen.

The Outlook New Message window appears. At this juncture, you can
send the e-mail exactly as if you were in Outlook because you are in
Outlook!

2. Click the Send button to transmit your message.

Configuring Outlook to Work with ACT!

Although ACT! automatically detects your default Outlook address book(s),
Outlook isn’t quite that bright. You have to tell Outlook where to find your
ACT! data. You also need to decide the type of history that you want to create
in ACT! from each outgoing Outlook e-mail. And, if you're using Word as your
e-mail editor, you'll find that the connection between ACT! and Outlook is
somewhat limited.

Showing Outlook the way
to your ACT! database

Attaching your ACT! database to Outlook is fairly simple when you follow
these steps:
1. In Outlook, choose Tools>E-mail Accounts.
The E-mail Accounts Wizard opens.

2. Select the Add a New Directory or Address Book option and then
click Next.
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|
Figure 17-2:
Selecting
the ACT!
Address
Book(s) in
Outlook.
|

3. In the Directory or Address Book Type window, select the Additional
Address Books option and then click Next.

4. Select the ACT! Address Book option and then click Next.
The ACT! Address Book(s) dialog box opens, as shown in Figure 17-2.

ACT! Address Book(s)

First address book
ACT! Database ACT_For_Dummies. pad

|E Wy Documents W ACTAACT_For_Dummies pad Browsze...

User name: Password
|Kalen Fredricks | xxxxxxx 1

Second address book.
ACT! Database

| Browse...

User name Pagsward

Third address book
ALCTI Database:

| Browse:

User name Pasaward

Press OK to check and save the configuration,

5. Click Browse to locate and select your ACT! database in the First
Address Book section.

6. Enter your ACT! user name and password and then click OK.

If you have multiple ACT! databases, you can specify up to three ACT!
databases. You can specify them in the Second and Third address book
sections before closing the ACT! Address Book(s) dialog box.

You receive a message telling you to exit Outlook and then reopen it
again for your changes to take effect. So. . .

7. Exit Outlook and reopen it again so your changes take effect.

Setting your ACT! history options

When you use the ACT! e-mail client to send an e-mail, you're given a default
option for how you want to record the history of the e-mail back to ACT!.
However, you can change the default option for each e-mail that you generate.
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Unfortunately, Outlook doesn’t offer you the same flexibility. After you set the
default option in Outlook, your only choice is whether to record or not.

Here’s what you do to set the default history option:

1. In Outlook, choose Tools=>Options and then click the ACT! tab.
2. Click the History Options button.

If you've followed these steps correctly, you should be looking at a
dialog box that matches the one you see in Figure 17-3. You’ll notice that
the database you selected in the previous section is indicated.

Options

Preferences | Mail Setup || Mail Format | Spelling | Security | Other | ACT!
Click the History Options button to

-Set text and attachment options for saving e-mails to ACT!
-Select the default option for recording history when sending new e-mail messages
-Change the ACT! database for recording history

History Options...

ACT! History Options
ACTI
Record history to cortacts in the following ACT! database:
| WCLASSROOMIVACT_For_Dummies
Figure 1 7_3: When sent.:hng e-mail, set my defautt history option ta:
3 Record history eV

D Ete rmine History format options

the h|St0 ry () Date, time, and subject text
generated n (%) Date. time. subject. and message text

ACT' frOm e} Ertire e-mail as attachment {includes images and other

* attachmerts)
an Outlook
emall [oc ]
%

|

3. Select the default history option.
You have two to choose from — Record History or Do Not Record History.
4. Select the History Format option and then click OK.

You want to think carefully about your decision here because this option
can’t be changed on an e-mail-by-e-mail basis. After you set this option,
your only alternative is to either create or not create a history of your
e-mail message.

5. Click OK to close the ACT! History Options dialog box.
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Disabling Word as your e-mail editor

Before you sit back and relax, you’ve got a few more changes to make in
Outlook. The first change is making sure that you're not using Word as your
e-mail editor; if you are using Word, you won'’t be able to record ACT! history
or attach e-mail to ACT! contacts.

Follow these steps to make sure that Word isn’t set as your e-mail editor:

1. In Outlook, choose Tools=>Options and then click the Mail Format tab.
By now, you’re probably experiencing ACT! withdrawal pains.

2. Make sure that no check marks are next to either the Use Microsoft
Office Word to Edit E-mail Messages or the Use Microsoft Office Word
to Read Rich Text E-mail Messages options.

Working with ACT! While in Outlook

After you configure Outlook to play nicely with ACT!, you can use Outlook
to send and receive your e-mail but still make use of some of the great ACT!
features.

E-mailing ACT! contacts in Outlook

Any e-mail addresses that you add to ACT! can be used when sending e-mail
with Outlook. You can even create a history of the e-mail sent via Outlook
that appears on the contact’s History tab in ACT!.

1. Create a new message in Outlook.

2. Fill in the recipient’s name.

You have a few ways to accomplish this. If you type in the first couple of
letters of the contact’s name, Outlook catches on and completes the
name for you. If you prefer, you can click the To button to open the
Select Names dialog box, as shown in Figure 17-4.

3. Select the name of your ACT! database from the Show Names from
The area.

4. Select a contact in the Type Name or Select from List search area and
then click the right-pointing arrow.

To speed up the process, type the first couple of letters of your intended
recipient’s name.
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Select Names
Type Mame or Select from List: Shaow Mames from the:
ACT! Address Book - ACT_For_C|w
| Name Company E-mail £
Alyssa Fredricks Florida State University amf0¥s
Andi Fredricks University of Florida andio |
Annette Sharkey Goldfish Records annet!
Anthany Federici MiniSoft Anthc
Ashleigh Caronite becks
Beth Kohler Sage Software Beth.|
Betty Browser CH Gourmet Gifts bbrow
Bob Duff Sage Software bob.d
E—— Brad and Lisa Kruse lisakry
Brandon Sloan Sierra's Cafe Brand
Figure 1 7_4: ?rlan Dla\ldld E‘hx Alliance ?rlanF =
< >
Selecta
t t t Message Recpients
sosiate | 22
:
associate pr——
with a new
Bee ->
Outlook
message.
|

5. Click OK.

Your message looks pretty much like what you see in Figure 17-5.

131 ACT 2007 For Dummies - Message [
i File Edit View Insert Format Tools Table Window ACT! Help P X
£ ACT! History Subjector = =
Sl S SRR
iidSend | ) ~|@H 8 |3 ! B | ¥ || () Options... - |HTML -
[ To... Erank Semerau
ce...
[4l Bec...
Subject: ACT 2007 For Dummies
o= =N | o -lacB 2 U=
—
~
Hi Frank, I
Thank you for your kind comments about the book. | hope you enjoyed reading it as much as | enjoyed writing it!
|
Best Regards.
Flgure 17-5: || Karen Frearicks
.- Tech Benders
E-mallmg Author, ACT 2007 Fgr Dummies
an ACT!
contact in R
Outlook :
| 2

6. Choose an option from the ACT! History drop-down list.

Remember, your only options are to either include or not include the
default history recording option that you set in the earlier section.
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Don’t see the ACT! History option? Right-click the Outlook toolbar and
choose ACT! History.
7. Fill in your message and then click Send.
Once again, you get to sit around twiddling your thumbs while ACT! slaves
away, creating a history of the sent e-mail on the contact’s History tab.
Creating ACT! history from an
e-mail received in Outlook
If you want to attach an e-mail message received in Outlook to a contact’s
History tab in ACT!, follow these steps:
1. In Outlook, open the message that you want to attach to the ACT!
History tab.
2. Click the Attach to ACT! Contact(s) icon on the message toolbar.
You find the icon on the far right of the icon bar. You can see what it
looks like in Figure 17-6.
|
Figure 17-6:
The Attach
to ACT!
Contact(s)
icon that [iisuReply | i @Replyto All | -3 Forward | 1| 3| ¥ [[S]03 X+ -+ - 40 @5
appears on
the received Attach to ACT! Contact(s) icon
message
toolbar.
|

3. Select a contact in the Attach E-mail to Contacts window and then
click OK.

A history of the e-mail message appears on the contact’s ACT! History tab.

Creating a new ACT! contact in Outlook

One of the great new ACT! 2007 features is the ability to create a new ACT!
contact from an Outlook e-mail message. As much as I hate using the phrase
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|
Figure 17-7:
Creating a
new ACT!
contact
from an
incoming
Outlook
message.

\\3

at the click of a button, you'll find that you can indeed create a new contact at
the click of a button:

1. Open the message that you received from the new contact.

2. Click the Create ACT! Contact icon on the message toolbar.

The New Contact dialog box opens, just like the one you see in Figure 17-7.
The contact name and e-mail address are already filled in for you.

&4 FW: New registrant - Message (HTML)

New Contact

i % Reply | (i Reply to All | 5 Forward |

i File Edit View Insert Format Tools A

From:
To:
ce:

Karen Fredricks [karen@techbenders. com]
ugsf@techbenders.com

Select ACT! Database
CLASSROOM3N\ACT_For_Dummies

Contact Data
Company:

Subject: FW: New registrant Contzct [\ Frodricks
Title

Phone Ext:

Regards. Phone/E-mail | Business Address

Karen Fredricks

Mobile:
Fax:
Email:  caran@techbenders.com
Website:

Need more ACT reports and Labels? Go fo
http://www .adsprogramming.com/products.htm
[ Private

~
¥

3. Fill in any other information you might have for the contact and then
click OK.

You might want to drag the New Contact dialog box off to the side so
that you can see other important information that might be lurking in

the signature portion of the message, just waiting to be copied into the
New Contact dialog box.

If ACT! detects that the contact you're adding already exists in the database,
you receive a message telling you that the new contact wasn’t created. If you
plan to add a lot of contacts from your incoming ACT! e-mail, you might want
to consider changing your duplicate checking criterion to e-mail so that you

won’t see double in your database.

Sharing ACT! and Outlook Calendars

After you bring your Outlook data into ACT! including your activities — you’ll
want to keep both your ACT! and Outlook calendars up-to-date by synchro-
nizing your calendars. (See the earlier section, “Importing Outlook contacts
into ACT!,” if you still need to import your Outlook data.)
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|
Figure 17-8:
Synchronize
your ACT!
and Outlook
calendars.
|

Synchronizing your ACT! and
Outlook calendars

To keep your ACT! and Outlook calendars the same, follow these steps:
1. From any ACT! screen, choose Tools=>Outlook Activities=>Update
Activities.

The Update Outlook Activities dialog box opens. Figure 17-8 shows you
the various options from which you can choose.

Update Outlock Activities
Update
@ One-way
From ACT! to Outlook v
O Twoway
If an activity has been changed in both applications,
keep changes made in:
Forthese dates
Detz flangs i
From: To:
3/25/2006 ¥ 4/25/2008 i
G

2. In the Update area, select the type of update that you want to perform
a one-way sync — ACT! to Outlook, or Outlook to ACT! — or a two-way
sync.

3. Select a date option in the For These Dates area.

If you choose the Date Range option, select a start and an end date.
Choosing the Today and Future option is usually a good idea.

4. Click Update.

Removing Outlook activities from ACT!

After you synchronize your Outlook and ACT! activities, you might want to
remove them. If you realize immediately that your synchronization didn’t
work entirely as planned, you can always restore an ACT! backup. You can
also simply remove any synchronized activities.
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1. From any ACT! screen, choose Tools=>Outlook Activities"Remove
Activities.

The Remote Activities dialog box appears.
2. Select the appropriate option:

¢ To remove ACT! activities from QOutlook, select the ACT! Activities
from Outlook check box.

e To remove Qutlook activities from ACT!, select the Outlook
Activities from ACT! check box.

e To remove both types of activities, select both check boxes.
3. Click OK.

Choosing to remove Outlook activities from ACT! removes only those activi-
ties that were added through the synchronization process. It has no effect on
Outlook activities imported to your database through importing.

Displaying Outlook activities in ACT!

You can view — or not view — your Outlook activities in ACT! in a number of
ways. Your Outlook activities appear on your Activities tab, your Task List,
and even your calendars.

Viewing Outlook activities on the ACT! Activities tab

A major difference between ACT! and Outlook is in how the two programs
schedule activities. [ consider Outlook to be somewhat of a free-for-all; sched-
uled activities are not generally associated with a specific contact. Not so
with ACT!; Chapter 8 shows you how every activity must be associated with a
contact record.

Because of this difference in scheduling procedures, you don’t find your
Outlook activities on the Activities tab of an individual contact. You can, how-
ever, see all your Outlook activities on the Activities tab of your own My
Record contact. Here’s how you do it:

1. Display your My Record contact by choosing Lookup=>My Record.

2. Click the Activities tab.
Your Outlook activities show up as Meetings. If you look carefully, you’'ll
notice that the Outlook activities even come with their very own icon.

Now, here comes the really cool part: You can edit every one of those syn-
chronized activities. For example, even though all the Outlook activities
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appear on the Activities tab of your own My Record, you can edit the activity
with a simple double-click and then change the Schedule With person to any
one of your contacts. By doing that, the activity disappears from your own
record and reappears on the Schedule With contact’s record as though the
activity had been originally created in ACT!.

Viewing Outlook activities from the ACT! Task List

Viewing your Outlook activities in your Task List requires some additional fid-
dling, but [ know you're up to the (Task List) task. Please, no groaning!

1. Click the Task List icon on the ACT! Nav bar.
The Task List opens in all its glory.

2. Click the Options button on the Task List toolbar and select Show
Outlook Tasks.

If you don’t see the Task List toolbar, just click the Show Filters button.
(Read all about list filters in Chapter 5.)

Viewing Outlook activities in ACT! calendars

By now, it probably comes as no surprise to you that your Outlook activities
appear magically on all your ACT! calendars. In fact, it would probably have
been a surprise if [ had said that you can’t see them. Because your Outlook
activities appear on all your ACT! calendars, feel free to select Work Week,
Weekly, or Monthly from the Calendar toolbar. You don’t even have to mess
with any filters to perform this feat.

Viewing ACT! activities with Qutlook

All your ACT! activities that you synchronize to Outlook are now accessible —
and editable — in Outlook. Because ACT! and Outlook activities are created
differently, your ACT! activities look a bit different when you view them in
Outlook. The main difference lies in the association between activity and con-
tact that Outlook doesn’t have — you can’t view an Outlook contact and see all
of his or her associated activities like you can in ACT!. However, an ACT! activ-
ity opened in Outlook displays all the associated contacts in the Details area,
as you can see in Figure 17-9.

In Chapter 22, I talk about some of the features that you can find only in ACT!
2007 Premium for Workgroups. Many of you might associate Premium with
large groups of users. However, if you're synchronizing your ACT! and
Outlook calendars, you just might want to shell out a few extra bucks for
Premium. The ACT! Scheduler, a feature only found in ACT! 2007 Premium for
Workgroups, can be set to automatically do the synchronization for you.
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i Voiceover recording for national spot - Appointment 5[]
i File Edit View Insert Format Tools Actions Help
Y 23 i P4 . - | (@
: | Save and Close | = 1] | ¥ Recurrence... | = Invite Attendees | { | X|&-9-l©4
Appontment | _Scheduling
Subject: | Voiceover recording for national spot
Location: | Manhattan ~| Label: |[] None -
Starttime; | Tue §/20/2006 v| [12:00pm [v| [JalIdayevent
End time: Tue 6/20/2006 v| [z00Pm [v
[CIReminder: B show time as: | Il Busy &
e | ACT! Detailg™=*=
H . Scheduled with- Craig Potts; Gary Kahn: Karen Fredricks: Bob Duff, JoAnne Chamar
Figure 17-9:
An ACT!
activity
displayed in
Outlook.
|

Exploring the Internet

The Internet Services button sits on the bottom of the Nav bar. When you
click the Internet Services button, Internet Explorer opens — albeit with a dif-
ferent home page than you're used to seeing because it opens to www.act . com.
You'll notice that all your favorites are intact and that you can navigate through
the Web until the cows come home.

Viewing a contact’s Web site

Because ACT! is all about contacts, it seems only logical that you might
want to view a contact’s Web site. Accomplish this daring feat by following
these steps:

1. Click the Web site address that you entered into the contact record.

You probably already noticed that the Web site address is blue and that

when you hover the mouse over the field, your cursor turns into a point-
ing hand — indicating that this is a kot (hyper-) link. If you click the link,
you’re hurled into the exciting world of the Internet.

2. Internet Explorer launches and displays the contact’s Web site.

3. After you peruse the site and are ready to continue working in ACT!,
close the browser.



Taking advantage of Internet Links

If you're like me, you like to take advantage of the abundance of information
on the Internet. Even more important to me — and probably to you, too — is
the ability to find information about contacts. As its name implies, the ACT!
Internet Links links your contact information to a site on the Internet. Among
the most frequently used informational sites are the various Yahoo! pages
that help you find information on anything from a local weather report to dri-
ving directions and maps. By using an Internet Link in ACT!, you can access
these sites in a new, unique way: Yahoo! searches for your information based
on the information in the current contact record.

If one of your contacts is located in Boca Raton, Florida, you can go to that
contact’s record and click the Yahoo! Weather link to find the local Boca
Raton weather report. If your My Record has you listed in the city of Miami
and you’re currently on the record of a contact located in Fort Lauderdale,
the Yahoo! Driving Directions link supplies you with the driving directions to
get from Miami to Fort Lauderdale.

To use one of those links, do the following:

1. In ACT!, display the contact record containing the information that
you want to use.

2. Choose ViewrvInternet Services—Internet Links.
3. Choose the site that you want to link to.

Depending on the site that you're linking to, you might be asked to con-
firm the information that you've selected in ACT!. Internet Explorer then
displays the results; for example, if you're looking for driving directions,
the My Record information appears on the left side of the screen, and
the contact’s information is on the right.

Internet sites are extremely volatile — here today, gone tomorrow. If an
Internet Link fails to function, maybe the site has changed its content
information or disappeared from the scene altogether.

Attaching a Web page to a contact

ACT! works in mysterious ways. After you install it, you might start to notice
remnants of it — or at least ACT! icons — sprinkled throughout your other
programs. If you look carefully on the Internet Explorer icon bar, you’ll notice
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a new kid — er, icon — on the block. The ACT! icon attaches the current site
that you're viewing to a contact’s History tab. Here are a few more details:

1. Open the Web page you want to attach to an ACT! contact.
2. Click the Attach Web Page to ACT! Contact icon.

The Attach Web Page to the Following Contacts dialog box opens. By
default, the name of the record that is open in ACT! is already selected.

3. Select the contact that you’d like to associate with the Web page and
then click OK.

In the event that you wish to associate a different contact with the Web
page, select one or more contacts from the Contacts to Select From area,
and then click the right arrow to move the contact name(s) into the
Selected Contacts list before clicking OK.

The details of the attached Web page display on the History tab for the
selected contact(s). You can double-click the attachment icon to open the
Web page.

Excelling in Excel

At the risk of sounding like a nerd, my accounting background has turned me
into an Excel junkie. Apparently, I'm not alone because ACT! supplies you
with numerous opportunities to interface with Excel.

Exporting a list to Excel

Very often, ACT! users want to export a part of their database to Excel.
Perhaps they need to get information to a non-ACT! user. Or maybe they want
to manipulate the data in a different way. It could be that they need to import
their ACT! information into another program, and Excel is the vehicle of
choice.

If you look closely, you find hints of Excel throughout ACT! 2007. Specifically,
if you look really closely at the Contact List, Group List, Company List, and
Opportunity List icon bars, you see an icon that looks like a mini-spreadsheet.
If you hover your mouse over it for a second, you see that the button is named
Export to Excel.

Funny enough, the button works exactly as you would suspect. Click it, and
Excel opens, displaying the list view that you're currently in. Don’t see the
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field you're looking for? Does Excel show you a field you don’t want? No prob-
lema. If you customize the list to show just the fields you want (find out how

WING/
&

to do that in Chapter 5), Excel displays those very same fields.

Because other programs can easily use Excel data, only Standard,
Administrator, and Manager ACT! users can export list data to Excel. An

Administrator can also remove this privilege from Standard users if he gets

mad at them.

Excel, the Opportunities List, and pivot tables

Because the Opportunities List deals with num-
bers and dollar amounts, it's probably the list
that you most often want to see in Excel. And,
just like with the Contact, Group, and Company
Lists, one click is all it takes.

Now here comes the cool part: When you
export the Opportunities List to Excel, your infor-
mation is automatically translated into a pivot

table and chart. What that means is that you get
some neat-looking charts — like the one you
see in the figure here — that you can manipu-
late to your heart's content. After Excel opens
with your Opportunities List, just click the
Opportunities Pivot Chart or the Opportunities
Pivot tab to introduce yourself to the exciting
world of pivot tables!
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Importing a product or drop-down list
into ACT!

I've never figured out whether I'm lazy or smart — or a little of each. Whatever,
I love to use shortcuts to save myself valuable time. If you're a new ACT! user,
you might have already developed a rather lengthy list in another piece of
software. For example, you might have created a Price List with Excel or cre-
ated an Inventory List in your accounting software. If I didn’t like you so much,
I'd tell you to start typing, but instead, I tell you how to export that list from
Excel into ACT!.

To import data into ACT!, follow these steps:

1. Save the Excel file as a tab- or comma-delimited file.

You want to make sure your file contains only two columns: one for the
Value and the second for the item Description.

2. In ACT!, choose Tools=>Define Fields=>Manage Drop-Down Lists.

Choose Manage Product List if you're importing into the Opportunities
Product List.

3. Select the drop-down list into which you want to import the data, click
Edit Drop-Down List, and then click Next.

4. Choose the Import Drop-Down List Items option.

From here, browse to the place where you save the Excel file and watch
while ACT! brings in your list of information — and saves you a lot of
typing.

Mapping ACT! fields to Excel

Another excel-lent ACT! feature (pun intended) is the ability to map specific
ACT! contact, group, or company fields to Excel cells. After they’re mapped,
the spreadsheet cells automatically update with the corresponding field
information when the document opens. Sound too cool to be true? Just try
following these steps:

1. Add an Excel spreadsheet to a contact by clicking the Add Document
button on the contact’s Documents tab.

You find the Documents tab located on the Contacts view screen; you
get the 411 on this topic in Chapter 5. Hopefully, you pick a spreadsheet
that you routinely have to type boring information into, such as name,
address, and phone numbers.
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Figure 17-10:
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2. Click the Documents tab, select the spreadsheet, and then click Edit
Document.

The spreadsheet opens. You'll notice that after you install ACT!, Excel is
now the proud owner of a new ACT! menu, just like the one in Figure 17-10.
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If you prefer, you can attach a spreadsheet to ACT! while you’re in Excel
by choosing ACT!=>Attach to ACT!.

3. In Excel, select the Excel cell that you want to map to an ACT! field.
4. Choose ACT!=>Map to Contact (or Company or Group).

The Map Fields dialog box opens. When you scroll through the list,
notice that all the ACT! fields are in it.

5. Select the ACT! field that you want to map to the selected Excel field
and then click Add.

You can easily add as many fields as you want by selecting an Excel cell,
choosing an ACT! field, and then clicking the Add button to map the two.
Each ACT! field name appears in angle brackets in the Excel cell.

6. Save and close the spreadsheet when you finish.

7. In ACT!, select the spreadsheet on the Documents tab and then click
the Map to Excel button.

Sit back in wonder and amazement while your spreadsheet appears. But
wait, if you look carefully — or not even too carefully — you’ll see that
the contact’s information is filled into all the right places.

What's in a Word?

ACT! can use Word as the default word processor (see Chapter 3 to appoint
Word as your default word processor), and you can attach Word documents
to the Documents tab (see Chapter 5). What you might not have noticed,
however, is that after you install ACT!, an ACT! menu is added to Word (as
shown in Figure 17-11).
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Figure 17-11:
The ACT!
menu that

appears
in Word.
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You can use Word’s ACT! menu to help you with several tasks.

Attaching a document to a contact record

Follow these steps to attach a Word document to a contact’s Document tab:

1. Open or create a document in Word.
2. From Word, choose ACT!=>Attach to ACT!.
The Select Contacts window opens.

3. Select the contact you want to attach the document to and then
click OK.

In essence, you create a link to your document. If you look carefully,
you’ll notice something new on the Documents tab — an icon that
matches the type of document you just added. So, if you add a Word
document, you see the familiar-looking Word icon smack dab in the
middle of your Documents tab as well as the name and path of the
attached file. Go ahead, make my day: Double-click the icon. The
attached document miraculously opens in all its glory.

Sending a document as an e-mail

In this age of viruses, you're probably hesitant to send too many attachments
knowing that the recipient might not even open it. If you’re using Word to
create your documents, here’s a simple way to convert the document into the
body of an e-mail or send it as an attachment:

1. Open or create a document in Word.
2. From Word, choose ACT!=>Send Email.

ACT! asks whether you want to send the Word document as an attach-
ment or use it as the body of your e-mail.
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3. Choose your poison and then click OK.
The Select Contacts window opens.

4. Select the contact you want to send the e-mail message to, click the
right-arrow button, and then click OK.

The New Message window appears. Wonder of wonders, it’s all set to go
with either a Word document attachment or with the body of the e-mail
showing an amazing resemblance to the contents of your Word document.

5. Type the subject and then click Send.

Through the wonders of modern science — or at least the wonders
of ACT! — a history of your sent e-mail appears on the contact’s
History tab.

Sending a document in a fax

If you want to fax a Word document, follow these steps:

1. Open or create a document in Word.
2. From Word, choose ACT!=>Send Fax.
The Select Contacts window opens.

3. Select the contact you want to send the fax message to, click the right-
arrow button, and then click OK.

Your fax software opens. At this point, you need to follow the instruc-
tions of your fax software with one big difference — ACT! creates a his-
tory of your fax.

The ability to fax using ACT! is dependent on having access to fax software
and a phone line. The various options for sending a fax depend on the fax
software installed on your computer. If the fax option is grayed out, you can’t
fax because your machine lacks the proper software.

Showing the ACT! mail merge fields

Sometimes in your zealousness, you might close the list of mail merge fields
that opens when you edit or create a template. (See Chapter 10 to find out
how to create a template.) Not to worry, getting them back is easy enough.

In Word, choose ACT!=>Show Field List. The Add Mail Merge Fields dialog box
reappears, and you can continue adding fields to your template.
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Chapter 18
ACT!ing on Your Opportunities

In This Chapter

Creating an opportunity

Completing the sale
Using the Opportunity List

Tracking your opportunities through the various sales stages

In this chapter, I lead you through the entire sales process with ACT!. [ show
you how to create an initial opportunity, make changes to it as a sale makes
its way through the sales pipeline, and view your opportunities via the
Opportunity List and various ACT! reports.

Creating Opportunities

ACT! was originally created by a salesperson for salespeople. Ironically, many
users of the earlier versions of ACT! found the program a bit lacking when it
came to tracking sales opportunities. Happily, that isn’t the case in ACT! 2007.

In ACT!, an opportunity is a potential sale to a contact. Each opportunity must
be associated with a contact. All sales information for a contact appears on
the Opportunities tab of the contact record. (See Figure 18-1 for an example
of the Opportunities tab.) When you create an opportunity, you can list the
names of your products or services, specify a sales stage and forecasted
close date, and make use of eight customizable fields. Click a button, and
ACT! generates a quote. You can even schedule a follow-up activity for the
opportunity.
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Figure 18-1:
The Oppor-
tunities tab.
|
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After creating an opportunity, you can go to the Opportunity List where you
can see all your opportunities listed together or view the contact’s, group’s,
or company’s Opportunities tab. As if that weren’t enough, you can choose
from a slew of sales reports, including a sales graph. Whew!

By automating the sales process using ACT!, you have a better chance of clos-
ing more sales. First of all, if you follow up on your activities as I show you in
Chapter 8, you have significantly fewer contacts falling through the cracks of
your database. Secondly, you can adjust your predictions while the opportu-
nity moves through the sales stages. Most importantly, you can generate
reports based on your projected sales, allowing you to focus on the deals
that you think you have the best chance of closing.

Initiating the opportunity

So why are you sitting around reading a book? It’s time for you to go out there
and make some money. Here’s how you’re going to make your first million:

1. Perform a lookup to find the contact for whom you’re creating an
opportunity.

What? A little rusty on those lookups? Fear not — and head to Chapter 6
for a quick refresher.

2. Create a new opportunity by clicking the Opportunities tab and then
clicking the New Opportunity icon.

If you have a bit of trouble locating the New Opportunity icon, it’s under-
standable; it’s the icon on the Opportunities tab that looks like a graph.
You also know you’re on the right track when you hover your cursor
over the button; a ToolTip proclaiming New Opportunity shows up.

The Opportunity dialog box opens, as shown in Figure 18-2.
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Figure 18-2:
The
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dialog box.
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3. Give the opportunity a name.

After you create the opportunity, you can track it down by doing a Name
lookup, so consider assigning a name that starts with the company name
that you're doing business with or the Purchase Order number. If you don’t
give the opportunity a name, ACT! assigns one for you automatically: New
Opportunity.

4. Assign a sales status.

This option is a fairly simple one. All new opportunities are assigned the
Open status.

For more on the other choices here, see the section, “Closing the deal,”
later in this chapter.

5. Assign a sales process.

Here’s where ACT! really forces you to get organized. Although not nec-
essary, you possibly have more than one Process List with your oppor-
tunities. You might use one for the pre-sales steps that you want
everyone in your organization to follow and another for the steps that
you need to follow after you land that large deal.

Each process comes with its own list of stages. Your homework is to ver-
balize your sales processes and translate them into ACT! (see Chapter 12).
Doing so keeps you organized, lets you know where you stand in the
scheme of things, and allows you to generate some useful sales reports
later on.

6. Assign a sales stage.

If you're hearing a nagging voice in the back of your head, it’s because
I'm nagging you. An important concept in computing is Garbage In,
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Garbage Out (GIGO). You want to set the sales stage so you know where
this opportunity lies in your sales pipeline and so this opportunity does-
n’t fall by the wayside. Too, you’ll want to change the stage as the oppor-
tunity progresses through your sales cycle. For more information see the
following section, “Modifying the opportunity.”

. Enter a probability of closing.

This step could be rather easy because you can assign probabilities to
each sales stage when you set up the sales process. Feel free to over-
write the probability percentage based on your own hunches for each
opportunity.

. Enter the estimated close date.

You use this information for sorting and reporting later.

All that’s left for you to do is fill in the Product/Services, User Fields, Details,
and Opportunity Info tabs — a little time consuming, but you will reap the
rewards later for all your hard work now.

Product/Services tab

If you're like most people, this part is fun. Here’s where you get to count the
cash, bill for the beans, dream of the dollars. . . . In any event, the
Products/Services tab is where you get to add all the line items for your
opportunity and sit back while ACT! crunches the numbers for you.

Although the process of adding products or services to an opportunity is
pretty straightforward, I walk you through it, just in case:

1.

Choose a product or service name from the Name drop-down list.

If you're selling a new item, scroll to the bottom of the list and click Edit
List to add it.

Chapter 12 gives you the full lowdown on creating a Product List.

. Add an item number.

If you fill in all the appropriate item numbers when creating your
Product List, this step isn’t necessary. Or, if you don’t use item numbers,
this step isn’t necessary.

3. Enter the quantity.

4. Double-check the cost and price.

This information fills in automatically from your Product List. If the
information is incorrect, head back to the Product List to correct it. Or, if
this is a unique situation, feel free to edit it here.

. (Optional) Adjust either the adjusted price or the discount percentage.

If you're giving this customer a special price, feel free to overwrite the
default price. If you lower (or raise!) a price, ACT! automatically calculates
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the discount percentage. If you prefer to tinker with the percentage, ACT!
automatically adjusts the price.

6. (Optional) Click the Add button to add products.

Repeat Steps 1-6 as many times as necessary until your opportunity
includes all the necessary line items.

7. Click OK.

User Fields tab

The User Fields tab consists of eight customizable fields. Chapter 12 explains
how you can customize those eight fields by renaming them. Maybe you're a
manufacturer’s rep and want to indicate your eight major lines. Or you might
want to indicate the eight manufacturers you deal with. Don’t forget that you
can query and generate reports with these fields, so use them wisely.

‘x@N\BEH Chapter 22 details several of the differences between ACT! 2007 and ACT!
& 2007 Premium for Workgroups. One of those differences is Premium’s ability
to customize the Opportunity field’s data type so that the fields can include
drop-down lists or be formatted for numbers and currency.

Details tab

In general, a database consists of many fields with each containing a single
piece of information. But people are people, and sometimes storing all your
important information into a bunch of teeny, tiny fields isn’t possible. That
said, you can use the Details tab to write The Great American Novel — or at
least a few important tidbits of additional info — about your opportunity.

Giving ‘em a discount

You can create discounts on an item-by-item 2. Type a name for the discount, such as
basis by changing either the adjusted price or Discount.

the discount percentage. That works pretty well
for most situations, but you might prefer to add
the discount rate as a totally separate lineitem. 1. From the Opportunities tab, add or edit an
To do this, you add a Discount Item entry to your opportunity.

Product List. Because the discount amount
varies, you need to manually insert the amount
of the discount each time you create a new
opportunity.

To use the discount item

2. Add a new item and choose Discount from
the Name list. If you want to make this the
bottom item, you probably want to choose
Discount as your last item.

To create a discount item, follow these steps: 3. In the Adjusted Price field, type a hyphen

1. From any ACT! screen, choose Tools=> (-) followed by the dollar discount amount
Define Fields=>Manage Product List->Add. for the order.
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) If the information that you want to include with the opportunity is in a docu-
ment, such as a word processing file, you can copy the text in the other appli-
cation and paste it on the Details tab.
Opportunity Info tab
\‘&N\BEB By now, your mind is probably fogging over from all the information that you're
& inputting. The inf ti the User Fields, Details, and Opportunity Inf
putting. The information on the User Fields, Details, and Opportunity Info
tabs are purely optional — albeit helpful. If your poor fingers are wearing
down to little stubs, you can always go back and complete the rest of this
information.
Figure 18-3 shows the Opportunity Info tab. After you close an opportunity,
this field automatically pops open.
- Opportunity
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e | =

There’s a bit more information that you can supply here. Although this infor-
mation is optional, you'll find that the little bit of extra effort that you spend
now to enter data will result in huge benefits down the road.

v Open Date: By default, ACT! assigns today’s date to a new opportunity.
This is where you can change it if necessary.

v Record Manager: By default, the name of the logged-on user appears as
the opportunity’s Record Manager. Feel free to change it if necessary.

1 Referred By: If you go by the positive reward theory — the big guys get
big thank-you gifts, and the little guys get a pat on the back — you might
just want to attribute each of your opportunities to the appropriate source.

v Competitor: If you keep one eye on the competition, here’s where you
can do it.
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Getting all your information into a sales opportunity is only half the fun.

The other half consists of sticking to your original course of action. Click the
Follow Up button. You get to set up your follow-up activity in the Schedule
Activity dialog box. You'll notice that ACT! inserts the opportunity name and
stage into the Regarding field. Then click OK. You've just gotta love a pro-
gram that does so much of your work for you!

At this point, you're essentially done with creating the opportunity. Sit back
and relax a moment while ACT! does one more thing for you: creates a his-
tory of the big sales event on the contact’s History tab.

Modifying the opportunity

As your opportunity progresses, going back and modifying the sales stage is
often necessary. Again, this information appears in your various reports, so
updating your opportunities is vitally important. This process is quick and
painless.

1. Find the opportunity that you want to update and open it.
You have several choices here:

¢ Create a lookup. Create a lookup for the contact associated with
the opportunity and then click the Opportunities tab. On the
Opportunities tab, double-click the opportunity.

® Modify an opportunity. From the Opportunity List, double-click the
opportunity that you want to modify.

e Search an opportunity. From any of the ACT! screens, choose
Lookup=>Opportunities and then select one of the field choices. For
example, you can search by opportunity name, product, or status.
ACT! then scurries through your database and opens the Opportu-
nity List, which presents you with all opportunities that met your
search criteria. Double-click the opportunity you want to modify.

The Opportunity dialog box opens (refer to Figure 18-2).
2. Change the information in the Stage field as necessary.

The purpose of ACT!’s opportunities is to allow you to track a potential
sale from its inception to its final outcome. You'll probably find editing
your opportunities useful while they progress through the various sales
stages. This allows you to view any of your opportunities to assess
exactly where you stand.

3. Schedule another follow-up if necessary by clicking the Follow Up
button.

4. Click OK when you finish editing the opportunity.
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The biggest challenge for many people is remembering to take care of all
those nagging little details. Chapter 8 focuses on the activity series. You
might consider creating a sales activity series and including updating sales
stage as one of the steps.

Closing the deal

When you close a sale, you can record the outcome and the closing date.
ACT! records a history on the contact’s History tab. And if you associate the
opportunity with a group or company, ACT! records a history on the History
tab for the group or company as well.

1. Find the contact for whom you’re recording the outcome of an

opportunity.

Step 1 in the preceding section shows you several ways to meet this goal.

. On the Opportunities tab, double-click the opportunity that you want

to complete.

. Change the status to indicate the current state of the opportunity in

the Opportunity dialog box.
e Closed-Won
e Closed-Lost
¢ Inactive

As usual, ACT! scurries around trying to make life easier for you. If you
select one of the close options, the Opportunity Info tab pops up so you
can add a few final details.

. Click OK.

The opportunity remains on the Opportunities tab. The status changes
to Won, Lost, or Inactive depending on the choice you made. The Actual
Close Date updates to reflect today’s date.

Vou Can Quote Me on That

After you create an opportunity, ACT! can convert it into a written quote for
you. The quote template actually consists of two pieces:

v quote.adt file: Word creates this. You can edit the template by chang-

ing the fonts, graphics, and wording. Typically, the . adt file contains
information about both you and your contact and can also contain dis-
claimer information.
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Figure 18-4:
Sample
quote
created

via ACTL.
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v quote.x1t file: This Excel-created file is embedded into the . adt file. It
appears as a table in the center of a quote and contains numeric data,
such as quantity, pricing, and totals. Because of how the .x1t file is cre-
ated, you probably don’t want to make any changes to the file; doing so
can run the risk of leaving the quote generator inoperable.

Only one quote template works directly from the Opportunity dialog box. If
you create other quote templates, you can use them like a regular template
(see Chapter 10); contact information flows into them but not opportunity
information.

Because the quote template consists of both a Word document and an
embedded Excel table, you must have both programs installed on your com-
puter in order to generate quotes via ACT!. You can see a quote in Figure 18-4.

Quote 7: 1234
LAY
Gary Kahn Frone Date: 4/3/2006
Kahmyoicsove Fa: Rep.: Karen Fredricks
8508 Eagle Run Drive Emsi:
New York, NY 10128
Gty Tem # Name Price Total
10[CT016785  |Chocdlate Trfles 4500 5450.00]
5|0G8232004  |Chocolate Gft Basket 53259 516455
5|FB 56722 Frut Bashet 56600 5340,00)
1 [is count 554,35 -554.95
Sub Tdla 5300.00|
Shipging & Handing
Tams 0.000%] 5.00)
TOTAL $500.00|
Comments: Office Us= Only:
Thark you for your business.
o

Creating a quote for an opportunity

You can literally create a quote at the click of a button. And here’s how you
find the button:
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1. Open an existing opportunity.
2. Click the Quote button on the Products/Services tab.

3. If you set your preferences to prompt you for a quote number, type
in the number in the Enter Quote Number window that appears and
click OK.

After a moment or so of whirring and hissing, Word opens, revealing the
quote, which is all filled out and ready to go.

Chapter 3 focuses on the various ACT! preferences settings. Buried away
in those settings is one that determines whether you’re prompted to
supply a quote number every time you generate a quote. At the same
time, you can indicate the numbers and/or letters that you want to
include in the beginning of each quote number. You find those settings
by choosing Tools=>Preferences and clicking the Quote Preferences
button of the General tab.

To change the order in which your products appear on your quote,
simply click the appropriate column heading on the Products/Services
tab of the Opportunity dialog box. To sort the products alphabetically,
click the Name column heading. Want them sorted by price? Click the
Subtotal column heading.

4. Print and save the quote as you do any other Word document.

Editing the opportunity quote template

As [ mention earlier, you can’t do much fiddling with the Excel portion of the
quote template; doing so could cause your calculations to not calculate. You
can, however, modify the font if you’d like. The Word portion of the quote can
also be modified to your exacting specifications. Chapter 10 goes into greater
detail about the exciting world of template modifications, but for now, here’s
a quick refresher course. You also need to set your word processor prefer-
ence to Word in order to edit the quote.adt template; Chapter 3 shows you
how to do that.

1. From any ACT! screen, choose Writer>Edit Template.
2. Choose guote.adt and then click Open.

3. Edit the template as necessary and then save it.

When you click the Quote button in the Opportunity dialog box, ACT! auto-
matically looks for the quote.adt template file. Although I advocate saving
templates and reports as other, unique names when attempting to modify them,
the same theory does not hold true for the quote template. If you change the
name, you can’t access it from the Opportunity dialog box — and your prod-
uct information doesn’t magically pour into it. Do not change the name of the
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opportunity quote! You might however, start off by renaming the original
quote file to a new name such as quote-original .adt before making
changes to the original quote file.

Viewing the Opportunity List

The Opportunity List provides you with a way to view all your opportunities
for all your contacts. You can filter the Opportunity List to display only those
opportunities that match your specifications. You can then print the Opportu-
nity List. Or, if you're really ambitious, you can export the Opportunity List to
Excel where you find pivot tables waiting patiently for you. Not sure what a
pivot table is? Head to Chapter 17 for more details.

Getting to the Opportunity List is almost too easy: Just click the Opportunity
List icon on the Navigation (Nav) bar. A list of opportunities appears, as you
can see in Figure 18-5. The Opportunity List even comes equipped with a status
bar running across the bottom that displays the total number of opportuni-
ties as well as the weighted and grand totals of all the opportunities. You’ll
also notice that the Opportunity List comes equipped with its very own tool-
bar containing icons pertaining specifically to the Opportunity List. Many of
the features that I discuss in the rest of this chapter can be accessed by click-
ing an icon on the Opportunity List toolbar.
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Filtering the Opportunity List

If you hate to make a decision at the ice cream store, you might not appreci-
ate the Opportunity List filters. But if you're the kind of person who loves to
have things, well, exactly the way you want them, you’re going to love the
Opportunity List!

The various filter options are located at the top of the Opportunity List
window. When you change filter options, the Opportunity List changes to
include the options you select. After this is set, you can click the Hide Filters
button in the upper-right corner of the Opportunity List. Don’t see any fil-
ters? Click the Show Filters button that appears instead.

Feel free to choose from the following Opportunity List filters:

v+~ Dates: Limits the opportunities to those matching the estimated closing
date that you indicate.

v~ Status: Indicates whether you want to view Open, Closed-Won, Closed-
Lost, Inactive, or all opportunities. You can also choose None, which
frankly doesn’t make a whole lot of sense because then you don’t see
any of your opportunities!

v Process/Stage: If you set up more than one series of sales processes,
here’s where you indicate which one you like to see and what stage(s)
you want to focus on.

v Probability: Type the percent you want to use; you can find opportuni-
ties that match only a specific percentage or those that are greater than
or less than a given percentage.

v Total: Type the amount of the opportunity you want to use or choose
whether to view opportunities that are greater than or less than a given
amount.

v Select Users: Selects the names of the Record Managers associated with
the opportunities you want to view.

v Options: Actually, you have only one true filtering option here; select
Show Private to display your private opportunities. You’ll also notice the
Customize Columns option that lets you add, remove, and change the
order of your columns.

Resetting the Opportunity List filters

After you diligently work to set all your filters, you probably need to reset
them again sooner or later. You can accomplish that task in either of the fol-
lowing two ways:
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v Click the Reset button from the Opportunity List.
v Choose Lookup~>Opportunities~>All Opportunities.

Printing the Opportunity List

Now comes the exciting part. Okay, it might not be your exact idea of excite-
ment, but seeing all your hard work translated onto a piece of white paper
can at least give you a nice sense of accomplishment. Remember all those
numerous opportunity fields that you so painstakingly filled? Here’s where
you get to display them in all their glory.

1. Click Quick Print (the printer icon) from the Opportunity List toolbar.
2. From the Print dialog box, click OK.

Customize your columns before printing out a copy of your Opportunity List.
[ tell you how in Chapter 5.

Many of you will find the ability to transfer your Opportunity List data into
Excel at the click of a button one of the coolest of the ACT! features. You can
read more about it by flipping to Chapter 17.

Working with Opportunity History
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In Chapter 7, I talk about the nifty histories created by ACT! when you change
certain key pieces of contact information. You create a history for an oppor-
tunity when you create, change the status or stage, generate a quote, or
change the estimated close date. You can view the opportunity history from
the contact’s History tab. If the opportunity is associated with a group or
company, you can view the opportunity from those History tabs as well.

ACT!’s Premium version lets you customize the eight opportunity user fields.
You can also modify them to become History fields so that whatever informa-
tion you put into them is forever recorded on the History tab, even if you
change the content of one of those fields.

Okay, do you want the good news or the bad news? Well, I can’t hear your
response — and don’t you feel silly responding to an inanimate object? — so |
give you the bad news first. You might find the histories that ACT! creates are
a bit terse. The good news is that you can edit them as much as you like by
simply double-clicking the history. The Edit History dialog box opens. Edit
away to your heart’s content — after all, who said you couldn’t change history?
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Reporting on Opportunities

You poor reader, you! You work so hard in filling out the numerous opportu-
nity fields. Knowing that you need a little break, ACT! rewards you with an
abundance of sales reports and charts. Whether you need to report on a
single customer or all your current opportunities, ACT! has a way of giving
you the information.

You can monitor the opportunities that you have at each stage of the sales
development cycle and display this information in a report or graphically in a
sales pipeline or sales graph.

If you feel an overwhelming desire to chop down a few more trees in the rain
forest, ACT! can help. ACT! comes equipped with a dozen opportunity reports
to suit most of your reporting needs. Chapter 9 gives you a synopsis on all
those reports. If you don’t find a report that suits you, a few options are avail-
able to you such as printing the Opportunity List or the contact’s
Opportunities tab.

Reporting on a single contact

The Opportunities tab provides you with the sales information on any given
contact. The columns on the Opportunities tab work just like the columns in
other ACT! areas, such as the History tab and the Contact List. You can
change their order, sort by any column, and add new columns. You can filter
the list by date and status.

You can use the information contained on the Opportunities tab to create a
quick-and-dirty report the same way that you create a report based on the
Contact List. ACT! prints the report in the exact same order as it appears
onscreen — that is, what you see onscreen is what you see on paper. To print
areport on a single opportunity, follow these steps:

1. Go to the contact record of the person for whom you like to track
opportunities.

2. Right-click the Opportunities tab or click the Options button.

You can use a lot of informational fields when you enter a new opportunity.
You can portray each of these fields as a column on the Opportunities tab.
You can customize the tab in any one of the following ways:

¢ Add a column. Select a field from the Available Fields area and click
the right-pointing arrow.

* Change the order of the columns. Select a field from the Show as
Columns in This Order area and then click the Move Up or Move
Down button.
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e Remove a column. Select a field from the Show as Columns in This
Order area and click the left-pointing arrow.

3. Click OK when you finish adding columns.
4. Choose File=>Quick Print Current Window.

Creating an opportunities graph

An opportunities graph can show your sales forecast or your closed sales for
a month, a quarter, or any period of time you choose. Many sales organiza-
tions prefer to see sales information in the form of a graph. As usual, ACT! is

up to the task and can create one for you in the blink of an eye — or at least
in the click of the mouse.

Here’s all you need to do to see all your opportunities translated through the
wonder of modern technology into a graph:

1. Create a lookup of contacts to include in the graph.
Need a warm-up on performing lookups? Head to Chapter 6.

2. Choose Reports=>Opportunity Reports~>Opportunity Graph.
The Graph Options dialog box appears, as shown in Figure 18-6.

Graph Options

General | Graph
Create graph for Display data for Datesto Graph
O Cumert contact [CHie Graph by
() Curert contact lookup () Selected users Wesk ~
() Currert opportunity list Starting
@) Al cortacts 41372006 v
Graph Ending
(® Open Ogpottunities 10/3/2008 v
[ Adjust for probabilty
() Clsed - Won Opportunities Valueto greph
() Closed - Lost Opporturities @ Total
() Inactive Opporturities O Total Quantity
Headsr / Footer
Chart header 1 Opporturity Graph
Chart header 2. Tuesday, June 20, 2006
Chart header 3 Tech Benders
Chart footer: Karen Fredricks

3. On the General tab, indicate the information you to want include in
your graph:

e In the Create Graph For area, select the Current Contact, Current

Contact Lookup, Current Opportunity List, or All Contacts radio
button.
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e In the Graph area, select the type of opportunities to appear in the
graph.

e In the Display Data For area, choose the Record Managers of the
contacts you're including in your graph.

e Enter header and footer information to appear on your graph.

e In the Dates to Graph area, fill in the date range and intervals.

e In the Value to Graph areaq, fill in values to use in your graph.
4. On the Graph tab, make a few more graph-specific choices.

You can make decisions about whether you want a bar or line graph, the
graph size, gridlines, the colors used in the graph, or the scaling used in
your graph.

5. Click the Graph button.

Voila! Your graph appears before your eyes. Try not to look too sur-
prised. If the boss walks by, you might want to make little grunting
noises indicating how studiously you’re working on your graph. You can
see a sample graph in Figure 18-7.

Opportunities Forecast Graph

Opportunity Graph Lok
Tuesday, June 20, 2006

Tech Benders

$16410 Lo

2 2 (%
? | e
1]

Print

£14 587

$12,763

$10,940

Options...

$9.117

Total Amount

$7.293
$5.470
I $3647
Figure 18-7: i
A Sample Jan Apr Jul Oct Jan
opportunity
graph.
|

Month 17172005 - 127312005

Karen Fredricks

6. In the Opportunities Forecast Graph dialog box, you can

¢ Lookup: Change the criteria for the contacts that appear in the
opportunity graph.

e Save: Save your graph as a bitmap (. bmp) or JPEG (. jpg) file to
preserve your artwork for future generations — or for insertion
into another document.
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¢ Copy: Save the graph to the Windows Clipboard in case you want
to perform a little cosmetic surgery on it. After you copy the graph
to the Clipboard, you can paste it into your favorite graphics pro-
gram and change any of its elements. You can also paste it into a
Word document or PowerPoint presentation to really impress the
natives.

e Print: Does just that.
¢ Options: Return to the options you first tangled with in Steps 3 and 4.

e Close: Exit the graph without printing or saving it.

Viewing the opportunity pipeline

A picture is worth a thousand words — or in this case, it might be worth
thousands of dollars! Most large sales organizations are already familiar with
the concept of a sales pipeline. The ACT! pipeline graphic represents the
number of opportunities at each stage of the sales development process.
Each section of an opportunity pipeline represents one of your predeter-
mined sales stages. Opportunities that are marked as closed, or those that
are missing a sales stage, are excluded.

1. Perform a lookup to find the contacts that you want to include in the
opportunity pipeline.

Although you don’t have to assign a sales stage to an opportunity, only
opportunities with assigned stages are included in the opportunity
pipeline.

2. Choose Reports=>Opportunity Reports~>Opportunity Pipeline.
The Opportunity Pipeline Options dialog box opens, as shown in Figure

18-8. Modify any of the pipeline options to reflect how they will appear
in your opportunity pipeline.

e Select the contacts you want to include in your pipeline from the
Create Graph For area.

e Select the Record Managers whose data you want to include from
the Display Data for Sales Managed By area.

e Select the process that you want to track.

¢ Color-coordinate your opportunity pipeline by assigning colors to
each of your sales stages in the Assign Colors area. If you want to
change a color, click the ellipsis button to the right of the color and
select another color.

e Fill in the header and footer information that you would like to
include with your pipeline.
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3. Click the Graph button.

You are now the proud owner of a beautiful opportunity pipeline (similar
to what’s shown in Figure 18-9), guaranteed to impress the heck out of
your boss and other members of your sales team.
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4. In the Opportunity Pipeline dialog box, you have options similar to
those available in the Opportunities Forecast Graph dialog box (see
the preceding section).

e Lookup: Change the lookup criteria for the pipeline.

e Save: Save your pipeline as a bitmap (. bmp) or JPEG (. jpg) file to
preserve your artwork for future generations or for inclusion in
another document.

e Copy: Copy it to the Windows Clipboard and later paste it into a
graphics program for modifications.

e Print: It doesn’t get any more self-explanatory than this!

¢ Options: Modify the pipeline.

¢ Close: Exit without saving or printing the pipeline.
As neat as the opportunity pipeline appears at first glance, closer examina-
tion uncovers a rather annoying fact. The graphic used in the opportunity
pipeline is just that — a graphic. Unlike the opportunity graph discussed ear-

lier, the graphic does not change to reflect the information on which the
pipeline is based.
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Chapter 19
Grouping Your Contacts

In This Chapter

Understanding groups

Creating groups
Establishing group rules
Putting groups to work

Utilizing group notes and activities

In this chapter, I focus on a very commonly overlooked ACT! feature: the
ACT! group. What exactly is a group? Generally speaking, a group is a col-
lection of something. In ACT!, however, a group is a collection of contacts.
More specifically, a group is a semipermanent lookup whose contact records
you assign to the group by any criteria that you want.

The contact record helps you to keep track of all activities as they relate to
an individual; the group allows you to track activities as they relate to an
entire group of contacts. When used correctly, ACT! groups provide you with
the potential to increase the overall power and efficiency of the ACT! program.

Throughout this chapter, after explaining all the ins and outs of groups, |
show you how to create a group. I then show you how to put groups to work
so that you can enjoy all the benefits that groups have to offer. After reading
this chapter, you’ll become a real group pro — knowing when to use them
(and when not to) and how to use them to their greatest potential.

A Few Good Reasons to Create a Group

You shouldn’t just create groups without putting some thought into them. If
you do that, you're liable to end up with bad groups, which consume your
time without offering any real benefits. (See the sidebar, “Don’t create bad
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groups!,” to see what I mean.) So what exactly makes a good group? Here are
a few examples of groups that can really make life easy for you:

1 Managing large projects: Groups are particularly well suited for those of
you who work on large projects. For example, if you're building a home,
you're involved with any number of people from building inspectors and
city officials to subcontractors, your own personnel, and the new home-
owner. Assigning all these contacts to a group allows you to easily zero
in on only those contacts involved in the project.

1 Tracking real estate listings: If you're a real estate agent or broker, set-
ting up a group for each listing allows you to track all clients that see a
particular property and to list all properties that you show to a particu-
lar client.

v Organizing your classes and seminars: If you teach classes and semi-
nars, you can set up groups to track all the attendees for each of your
classes. Then when the time comes, you can print out class lists to
ensure that you contact all class members. You also have a clear listing
as to what classes an individual contact has taken with you.

+ Focusing on a specific group of contacts: Say you go to a trade show
and come back with 75 good, solid leads — all of which you are deter-
mined to call. Your first step is to put all those leads into a group. On
Monday, you might call 20 of those leads, moving each one out of the
group as you make the call. On Tuesday, your list is down to 55, but
maybe you have the chance to call only 5 people. Wednesday finds you
putting out fires around your business, and you don’t have a chance to
continue phoning until Friday; you can easily access those remaining 50
contacts and take up where you left off.

Don’t create bad groups!

Here's an example of a bad group: | once
worked with an ACT! user who had exactly 50
groups — one for each state. He had then sub-
divided each group into subgroups represent-
ing each ZIP code within the state. This user
overlooked the obvious — his database already
contained fields for both state and ZIP code. His
groups provided him with no more information
than he already had before he put all that time
and effort into creating them.

Many ACT! users create groups to track con-
tacts for their newsletter or holiday card mail-
ings. Unfortunately, this situation is another
poor use of a group; although the user sees who
will receive the mailing, he doesn’t find out who
is not to receive the mailing. More importantly,
he doesn't find out who fell through the cracks
and was just overlooked. Setting up a Mailing
field allows you to track all three things.
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What All Groups Have in Common

In the preceding section, I provide examples of using groups that surely give
you an idea of how you can use groups for a wide range of tasks. Despite the
flexibility of groups, however, all groups share a few common elements:

v Volatility: In general, groups and the contacts within them don’t have to
be permanent. A contractor, for example, replaces subcontractors he
works with if they do a poor job. And, after that contractor completes a
house, he might no longer need to use the group that he created for the
project and may choose to delete it. Removing a contact from a group
doesn’t in turn remove the contact from the database.

v No limit to the number of groups: You're allowed to create as many
groups as you want; your only limitation is self-imposed. Working with
thousands of groups, however, is probably rather cumbersome.

v No limit to the number of contacts that belong to a group: Add as
many contacts to a group as you’d like.

v No limit to the number of groups a contact can belong to: Depending
on the type of groups that you set up, you might find that a contact
needs to belong to more than one group. For example, if you use groups
to help with project management, you might need to include the same
subcontractor in several groups.

+~ Relational cross-referencing: By creating a group, you can easily move
between the group as a whole and the individual members within the
group. From the Group Detail window, you can see a list of all the con-
tacts that belong to that group; from the Contact Detail window, you can
see all the groups that a contact belongs to.

v~ Fifteen levels of subgroups: You might be working on a huge project
that requires a greater amount of micromanagement and consequently,
more subgroups. Maybe you’re working with the Federal Government
and want to have a group for each major governmental department sub-
divided into Agencies, subdivided into Districts, subdivided into cus-
tomers, subdivided into. . . . You get the drift!

Creating a Group

Like most of the other ACT! commands, creating groups is as easy as pie. Just
remember that planning is always the first step: If you work in a shared data-
base, all users need to agree on how to use groups before creating groups
and adding contact records to them.

317
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Detail
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A group isn’t meant to be a replacement for the ID/Status field (or any other
existing field for that matter; see the sidebar “Don’t create bad groups!”). The
ID/Status field serves to categorize each contact. For example, you might cat-
egorize each contact as a vendor, customer, or prospect using the ID/Status
field. Limit your groups to help you accomplish something that can’t be done
through the use of fields.

To create a group, simply follow these steps:

1. From any ACT! window, choose Groups~>New Group.

The Group Detail window opens. It should look vaguely familiar — in fact,
it’s nearly identical to the Contact Detail window. Just like the Contact
Detail window, the Group Detail window features tabs along the middle of
the screen. And, just like the Contact Detail window, the Group Detail
window allows you to choose the layout of your choice. As shown in
Figure 19-1, the only differences between the Group and Contact Detail
windows are the list of Subgroups appearing in the Subgroups field and
the Hierarchy field. If you're creating your very first group, the screen is
blank.

If you're in the Group Detail window, you can right-click in the list of
groups and choose New Group. Or, feel free to click the New Group icon
on the toolbar (the third icon on the left). You can even press Insert on
your keyboard. ACT! aims to please!
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2. In the Group field, enter a name for the new group.

When you move to another field, the Group List automatically updates
and your group is saved.

3. (Optional) Create a subgroup by right-clicking the primary group in
the Group List tree to the left of the Group Detail window, choosing
New Subgroup, and then filling in the name of the subgroup.

You can have as many subgroups per group as you like. And, you can
have up to 15 levels of subgroups; in other words, you can further divide
your subgroups into sub-subgroups. And, after you create a group, you
can go back to the scene of the crime and add a subgroup at any time.
After it’s created, you can drag a group into position under an existing
group to transform it into a subgroup or drag a subgroup to the top of
the Group List tree to make it a full-fledged group.

Understanding Group Membership

Just like membership levels at most clubs, groups can also have two distinct
levels of membership:

1~ Static: A static member is one that is more or less handpicked to go into
a group. You might think of these members as having VIP memberships.
These members receive a lifetime membership and are never removed
from a group unless you specifically remove them. By default, you can
see all your static group members displayed on the Groups/Companies
tab of a contact’s Contact Detail window.

v Dynamic: A dynamic member is one that is added to a group through a
query. As long as the contact meets the query requirements, he remains
a part of the group; if he no longer matches the query, he is automati-
cally removed from the group. The Groups/Companies tab doesn’t dis-
play dynamic group membership; you have to click the Display Dynamic
Group Membership button to see a listing of a contact’s dynamic group
membership.

Adding static group members

Here are the two ways you can add static members to a group: from the
Group view or from the Contact Detail view. You'll probably find the Group
view method to be more convenient if you're adding a lot of members at one
time. The Contact Detail method is best used for the stragglers that you want
to add on a contact-by-contact basis.
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Adding multiple contacts to a group

To add a whole bunch of special, static members to a group, follow these
simple steps.

1. If possible, create a lookup of the potential members.

You might want to look for all contacts that you just added to your data-
base, or you can go to the Contact List and handpick those VIMs (Very
Important Members).

2. Switch to the Group view and select the group to which you want to
add the new members.

3. Choose Groups~>Group Membership->Add/Remove Contacts and then
click the Contacts button to add some contact records to your group.

If you prefer, you can also click the Add/Remove Contacts button on the
Contacts tab of the Group Detail window — or even right-click in the
Group Detail window and choose Group Membership>Add/Remove
Contacts.

In any case, the Add/Remove Contacts dialog box appears (see
Figure 19-2).

Select Contacts

Select from
Curment Lookup ~

Look for:

Contacts to select from: Selected contacts:
g Mame Company ~ ‘@, Name Company
Andromidas, Kalle | Fenstersheib Law Offic
Eeasi, Susan Rare Coins & Precious
I Bellitte, Joanne Central Medical Group
Caronite, Ashleigh
Figure 19-2: Chamar, Jofnne
Fredricks, Alyssa Florida State University
Add or @, Fredricks, Karen Tech Benders
Harrington, Susan
remove gron. <<
Katz, Linda -
contacts Mincal. Bella Jake Flakes Inc
Mordstrom, Rudy Jake Flakes Inc
frOm a Ctainman lohn Tam M'Shantar Sountar
group.
|

4. Choose Current Lookup from the Select From drop-down list.

5. Click the double right-pointing arrows to add the current lookup to
your group and then click OK.
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Need to remove contacts from your group? Follow the same procedure you
follow to add a contact to a group — except that you click the left-pointing
arrow in the Add/Remove Contacts dialog box! To add a few more people to
the group, choose All Contacts from the Select From drop-down list and hunt
for those additional folks.

Adding new contacts to a group does not remove existing members of the
group — it just adds additional members.

Adding one or more contacts to a group

In addition to adding or removing several contacts at a time to/from your
group, you can also do this from Contact List view. This is easy to do as well.

1. If necessary, create a lookup for the contact that you want to add to a
group either by using a lookup (query) and selecting all the contacts
found or by tagging the contact in Contact List view.

2. Choose Groups=~Group Membership-~>Add Selected to Group.

3. Select the group to which you want to add the current contact, click
the right-arrow button to add the selected contacts to that group, and
then click OK.

Because a contact can belong to more than one group, you can add the
contact to as many groups as you like. The contact’s Groups/Companies
tab displays the groups the contact is a member of. If you want to remove
the contact from a group, click the group name and then click the left
arrow button.

Creating dynamic group members

In the preceding sections of this chapter, | show you how using groups in
ACT!is a good thing. By now, you're probably an old group pro, qualified to
receive an Official ACT! Groupie certificate. But, like the best-laid plans of
mice and keyboards, there is one small hitch to your otherwise perfect world.
What happens if you forget to add a contact to a group?

For some of you, forgetting to add a contact to a group isn’t a life-threatening
event. In other circumstances, however, it might be absolutely crucial that all
appropriate contacts are added to the proper group. For example, what if you
send a notification to all members of a group about an important meeting,
but the CEO isn’t included in the group?

Step away from the aspirin — this problem is easily licked with the simple
creation of a group definition query. A definition query is ACT!s way of
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|
Figure 19-3:
Create

a group
membership
query.
|

automatically adding contacts to a group based on information in specific
fields. A query runs every time that you look at the Group Detail window or
the contact’s Groups/Companies tab. You create a query based on specific
field values. For example, to set up a group rule to find all the prospects in
New York for whom Mike is the sales rep, base your rule on the ID/Status,
State, and Record Manager fields.

To set up a group definition query, follow these steps:

1. Choose View=>Group List from any ACT! window.

2. Select the group to which you want to add a query, right-click it, and
then choose Group Membership~>Add/Remove Contacts=>Edit
Criteria.

The opening screen of the Group Criteria dialog box opens, as shown in
Figure 19-3.

Q, Group Criteria
File
0@ &
Type Field Name: Operator: Value:
( [Type Field Name: Operator Value ) |AndiOr
( Contact DiStatus Equal To () Prospect or
Contact DiStatus Equal To () Customer ) And
Contact State Equal To (=) NY And
Contact Record Manager Contains Mike End
Remove Al
Freview
Contact 7 [ID/Status Stale Record Manager
Total: 0

3. Fill in the criteria that you need to establish group membership.
e Type: You can query on either the Contact or Opportunity field.

e Field Name: All the fields in your database are included in the
Contact or Opportunity field drop-down lists. Select the field that
determines the membership into your group.

e Operator: Pick an operator from the drop-down list. The choices
are fairly self-explanatory with options like Equals, Contains, and
Ends With. It might even make you feel like you're playing charades!

e Value: Type in the field value that you’re looking to match. If you
select the State field name, for example, the value might be FL.
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4. Click the Add to List button.

Your entry appears in the table portion of the Group Criteria dialog box,
and ACT! is ready and waiting for you to add another criterion.

. Repeat the process until you select all the values.

For example, if you want the contact record to be in one of a series of
states and have an ID/Status of Customer, you can add a second
condition.

. Change the And/Or indicator as needed.

By default, ACT! inserts an And in the And/Or column. That means that a
contact must match both criteria in order to become a member of the
group. The And/Or indicator is actually a drop-down list with two
choices: And and Or. In Figure 19-3, I changed the value to Or, indicating
that [ am searching for either Customers or Prospects.

If you add a second condition, the contact must match both conditions,
not one or the other. For example, if you specify values for both the City
and ID/Status fields, all members of the group have to reside in the same
city and have identical ID/Status values. The only way to avoid this sce-
nario is to change the And/Or value to Or.

The parentheses help you to group your criteria. In Figure 19-3, I'm look-
ing for contacts who are prospects or customers and reside in Florida.

. Click the Preview button.

After a few seconds of contemplation, ACT! presents you with a list of
the contacts that match your criteria.

. Click OK.

Take a look at the Contacts tab in the Group Detail window to see that all
the contacts that appeared in the preview are now members of the
group. And those contacts that didn’t meet the specifications were sent
out in the cold — or at least removed from the group.

Groups consist of both dynamic (based on a query rule) and static (manually
selected) members. When you create criteria to establish dynamic member-
ship, your static members remain in the group even if they don’t match the
group query criteria.

Working with Groups

You can customize groups the same way you can customize the Contact Detail
window. You can add new fields, change the layout, and add tabs. You can



32 4 Part V: Commonly Overlooked ACT! Features

even do a special Group lookup to search for a group based on the informa-
tion in any one of the group fields that you create. For a crash course in
adding new fields, scurry to Chapter 12. For a refresher course in customizing
layouts, scamper over to Chapter 13.

After you create a group and stick a few unsuspecting contacts into it, things
really get exciting. [ love to use the phrase “unleash the power of ACT!” —1
have this vision of Mr. Clean roaring out of my monitor. Okay, maybe I need to
get a life, but I feel that by correctly using groups, you can really get a lot of
bang for your buck with the ACT! program. This is how you can fool ACT! into
believing it’s a relational database. Try not to let too many people in on the
secret — it might just raise the price of the software.

Think of your groups as a program within a program. You have nearly the
same functionality that you do with the contact portion of ACT! — with one
big difference: The notes, histories, activities, and opportunities you create
while in the Group Detail window affect the entire group. After you set up a
group, you can add group notes, histories, activities, and opportunities for
the group in exactly the same way you set them up for a contact. You can even
attach a group-specific file to the group Documents tab. This is a great time-
saver because information that you input belongs to the group and doesn’t
have to be duplicated on the contact level. You also won’t have to wrack your
brain trying to remember which contacts in your group you attached a note to.

Using groups to schedule activities

One of the most powerful aspects of ACT! is its ability to associate a contact
with an activity. (See Chapter 8 to read more about activities in ACT!.) Many
scheduling programs allow you to design beautiful calendars; the problem is
that these calendars aren’t tied to a particular contact record. For example, if
you schedule an appointment to visit Jane Smith and forget the date of the
appointment, your only recourse is to flip through your calendar until you
find the appointment. After you met with Jane, you have no history of the
appointment unless you search again through your previous appointments.

To take this analogy one step further, suppose that you chair a special com-
mittee for your local Chamber of Commerce, and you need to schedule a
meeting. Scheduling the same appointment with each of the 20-odd partici-
pants is very time consuming. Trying to fit each committee member’s name
on your calendar isn’t very practical either. By scheduling the meeting with
the group, however, you achieve your goal without the hassle.

Here’s how it works:

1. Click the Groups icon on the Navigation (Nav) bar.
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2. Select the group with which you want to schedule a meeting by click-
ing it on the Groups tree.

3. Click the Schedule Meeting icon on the toolbar.

The Schedule Activity dialog box pops open (see Figure 19-4). The name
of the group that you select magically appears in the Associate With
field, and you can enter in all the pertinent activity information. At this
point, you can click OK to schedule the meeting. However, if you'd like
to have the activity scheduled for each and every member of your
group, keep reading.

Schedule Activity
Options -
General | Details | Recumence || Availability
Activity Type: Start Date: Start Time: Duration
Meeting | | 7/30/2006 w| | Timeless | |1hour w
End Time:
" [] Use Banner
Schedule With:
Chamar, JoAnne “
Associate With:
Friends; Q
Regarding:
Birthday Bash| v
Resources: Location
Mone d
Priority: Color:  Ring Alarm:
Low w .E] Mo alarm w Schedule For.
Cne 5

4. Click the Contacts button and then click Select Contacts.

In the Select Contacts window that opens, you can add any individual
contacts that you might want to include in your meeting. When you
schedule an activity with multiple people, the activity appears on each
and every contact’s individual Activities tabs.

5. Choose Groups from the Select From drop-down list and then select
the name of your group.

You can see what this whole operation looks like in Figure 19-5.
6. Click the double-pointing right arrows.

Whoosh! All your group members suddenly show up in the Selected
Contacts area of the Select Contacts dialog box.

7. Click OK to close the Select Contacts dialog box and then click OK
again to close the Schedule Activity dialog box.
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Figure 19-5:
Scheduling
activities

for each
member of

a group.
|

Select Contacts
Select from
Groups + | |Fiiends -
Look for:
Contacts 1o select from: Selected Contacts:
(@) | Name: Company fa (@ | Name: Company
Andromidas, Kalle | Fenstersheib Law Offic|
Beasi, Susan Rare Coins & Precious
Bellitte, Joanne Central Medical Group
Bergera, Jos Sage Software
Carey, Rich Sage Software
Caronite, Ashleigh
Carter, Latisha Sage Software

Chamar, Jofnne
Chemauskas, Victor | Sage Software

DeMeuse, Julie Sage Software
Duff. Bab Sage Software
Eradricke Mluses | Flarida State Hniereind 2

8. Flip to the Group Detail window by clicking the Groups icon on the
Nav bar and then click the Activities tab.

Okay, | know I get overly excited about the little things in life, but to me
this is way cool. When you schedule an activity with an entire group,
your friend — the hyperlink — shows up in the Schedule With column.
When you click the word multiple — which shows up when you schedule
a group activity — you’re sent to the Contact List where you're rewarded
with all the contacts invited to the festivities. Or, if you prefer, look on
the Activities tab of any of the individual attendees; once again, you’ll
notice that multiple appears in the Scheduled With column; click it to go
to the Contact List to see the list of attendees.

Using notes with groups

If you're wondering about the benefits of a group note, here are two good rea-
sons. First, say that your contact, Larry Lawyer, is involved in many of your
projects. You created a group for each of these projects like the good ACT!
groupie that you are. Throughout the course of several weeks, you continu-
ally converse with Larry about the various projects. Over a period of time, as
you create more and more notes for Larry, it becomes harder and harder to
determine which notes belong to which project. By assigning a note to a
group, you can keep all the individual project notes together.

Another group note benefit is laziness — which in this case, is a good thing! If
you assign a note to a group, you won’t have to create the note separately for
each of your group members. You also won’t have to scratch your head
trying to figure out which contact record you recorded the note on.
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You can create a note and assign it to a specific group in three different ways.
[ describe each of these ways in the following subsections.

Entering a note dirvectly from the Group Detail window

By far, the easiest way to enter a Group note is via the Group Detail window.
Use this method when all you need to do is add a note that pertains to the
group as a whole.

1. Choose View=>Group List from any of the ACT! windows.

2. Select the name of the group for which you want to enter a note and
give it a double-click.

3. On the Notes tab, click the Insert Note icon.

If you don’t remember the drill on adding a note, you might want to read
Chapter 7.

Entering a note from the Contact Detail

window and assigning it to the group

You can also add a group note via the Contact Detail window as your starting
point. The drill is just about the same as for adding a regular note, with one
extra step.

1. From the Contact Detail window, create a lookup for the contact
record of the group member for whom you want to create a new note.

Scratching your head as to how you’re going to find that contact? You
find the answers to all your lookup questions in Chapter 6.

2. On the Notes tab, click the Insert Note icon.

The Insert Note window pops open. If you want to see a real, live picture
of this window, stroll to Chapter 7 for a better look. To edit an existing
note, give the note a double-click.

3. Click the ellipsis button in the Group/Company area.

For those of you who might not be acquainted with an ellipsis, it’s the
button decorated with the three little dots.

4. Select the appropriate group name, click the right-pointing arrow, and
then click OK.

Creating a group history

Another method of adding a group note is slightly more complicated than the
other methods. So why, you might be wondering, am I including this in a For
Dummies book? The reason is that you might find yourself in a situation
where you need to designate a note as belonging to a group after you have
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had some sort of interaction with the group as a whole. Besides, by now you
know that nothing in ACT! is hard after you master the trick. Here’s how you

doit:
1. Choose View=>Group List to see a list of all your groups.
2. Select the group you want, give it a right-click, and then choose Create
Lookup.
A\ P
You might just want to remember this step because knowing how to
create a lookup of a group often comes in handy.
3. From the Contact List that appears, click the Tag All button.
4. Press Ctrl+H.
The Record History window opens. You can see what it looks like in
Figure 19-6.
-/ Record History
Type: Meeting ~ Result: | Meeting Held ~
Contact nouse & Walkerl: Wison, Nancy [Skin Care by Nancy Wikon]: Wolpin, Noma [Goidstein Lewin & Co.l[w
Date: 3/29/2006 ~ Time: |10:56 AM N Duration: {15 Min | w
Attachment
Group/Company: | Friends: J Record Manager: | Karen Fredricks v
Regarding: Chamber of Commerce Breakfast ~
Details:
I | & %% | Tahoma v[g -A-BFruUF=z==¢=
Figure 19-6:
Record a
history for a
group.
Dfryate
|

5.

Fill in your information, making sure that you include the group name
in the Group/Company field.

ACT! grabs a pen and paper and starts jotting that note down for all
the contacts in your group. Well, maybe no pen is involved but you get
the idea!



Chapter 20
Joining a Company

In This Chapter

Discovering companies

Creating companies

Navigating the corporate maze of divisions
Linking company and contact fields
Working with companies

rle first portion of this book focuses mainly on the contact aspect of ACT!;
after all, ACT! is considered to be a contact manager. In Chapter 19, you
can find out about groups, which (as the name implies) allows you to group
your contacts into more manageably sized pieces. The company portion of
ACT! is one that (quite frankly) not all of you will need to use. However, those
of you who work with larger companies and organizations will find this fea-
ture invaluable.

In this chapter, I lead you through setting up a company — and if necessary, a
division. I show you how to add (or remove) members of a company and how
to use the various company features. You even find out about the company
reports before all is said and done.

The 411 on Companies

Face it: Bureaucracy is alive and well and living in most civilized countries.
Actually, it probably lives in uncivilized ones as well. Your database might
contain the names of the head guy (also know as The Decision Maker), your
main point of contact, the guy who signs the checks, and the person who
actually does all the work (the Administrative Assistant). Seems easy at first,
until the head guy gets fired, the check-signer takes off for Brazil, and new
people replace them both.
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In really large companies (generally those that have their own cafeteria and a
lot of cubicles), various divisions within the company often compound this
hierarchy. Fortunately, ACT! can accommodate your need to track contacts,
companies, and even divisions. Just like navigating your way through a maze
of cubicles can be intimidating, you might be a little hesitant about reading
yet another piece of the software puzzle. Relax! A lot of similarities exist
between the contact and company portions of ACT!; you can apply most of
the concepts that you know about contacts to companies as well. For example

» You can add your own unique company fields and associated drop-down
lists (see Chapter 12).

v Companies come with a variety of modifiable layouts (see Chapter 13).

v You can add company-specific documents, notes, activities, and oppor-
tunities (see Chapters 5, 7, 8, and 18, respectively).

v ACT! provides you with various customizable company-specific reports
(see Chapter 9).

v You can view, modify, and print a list of all your companies (see Chapter 9).
v You can create company-based lookups (see Chapter 6).

» You can create a mail merge to a specific company (see Chapter 10).

Hey Dude, Where's My Company?

Just like with contacts and groups, ACT! provides you with a whole series of
windows that help you manage your companies. Although most of these win-
dows parallel the contact and group windows, you soon see that the correct
usage of companies can transform ACT! into a highly effective relational data-
base. Although you might find navigating this maze of windows a bit confus-
ing, read on and you’ll soon navigate around your companies like a seasoned
veteran.

The Companies tab

Sorry to disappoint you, but in ACT!, the Companies tab doesn’t refer to

the boss’s decision to pick up the check for Friday night’s beer bash! The
Companies tab actually refers to one part of the Groups/Companies tab in the
Contact Detail window. When you click the tab, you have a choice of seeing
the membership information for either the groups or the companies that a
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contact is associated with. I guess you can consider that you're getting two
tabs for the price of one!

In ACT!, you can hyperlink a contact’s company to a single company record;
you can read how to do this later in the chapter. The Companies tab works a
bit differently because a single contact can be a member of multiple compa-
nies. Sound confusing? Think about it. [ am linked to Tech Benders because
that’s the name of my company. But what if [ were a sales rep and assigned to
several companies, all of which I like to cross-reference on my contact page?
Or what if you have a contractor in your database who works with more than
one company? Enter the Groups/Companies tab, as shown in Figure 20-1.

Notes | History | Activities | Opportunities | Groups/Companies | secondary Contacts | Documents || Contact Info || User Fiids | Home Address

Show membership for: Companies and Divisions |+ i.. y p— y f Options ~
Company /| Phone Address 1 Address 2 City State ZIP Code ‘wieb Site

CH Gourmet Coffee

CH Gourmet Gifis (212) 555-2485 13 East 54th St. New York NY 10008 wwew chgourmeigifts.com
CH Gourmet Imports

CH Holding

The Company List

The Company Detail and Contact Detail windows provide two ways you can
see company information. The Company List lets you view a list of all your
companies at one time. As with all lists, you can change the sorting order,
add or remove columns, filter the information, and print the list; feel free to
review Chapter 5 if you need a refresher course in how to do any of that.

You can access the Company List (see Figure 20-2) in a number of ways:

1 Choose Viewr>Company List from any ACT! screen.

v Click the Companies icon on the Navigation (Nav) bar and then click
the Company List button on the icon bar.

v Create a Company lookup by choosing Lookup~>Companies=>All
Companies.

If you create a lookup based on any of the individual company fields, the
resulting Company List includes only those companies that match your
search criterion.
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File Edit View Lookup Contacts Groups Schedule Write Reports Tools Help

& Companies [ Company List|H & § € B &G @ w & of B4 5 § @

“ea = CompanyList
f’\ Look for: [ Include divisions Options ~
“l’ Company # | Phone Address 1 Address 2 | City State ZIP Code | Web Site: Industry ID/Status
Contacts Ace Pet Store (423) 555-1221 925 Cabby St P.O. Box 123 Eugene OR 97401 www scepet] com Customer
(B American Dreams (972) 585-6225 1113 Grainey Suite A Allen ™ 75002 www.americandrea Wendor
‘l Arcadia Ave. Florist (602) 555-4412 7201 N. Arcadia Ave. Suite 100 Phoenix AZ 85020  www.arcadiaaveflol Reseller
From Best Lender Financing (847) 555-1232 4500 Payment Way Currency I 60199 wwaw.bestlenderfin( Customer

Black ForestBaking (211) 554-5641  Grafenburger Allee 15 Miinchen 9865 www blackforest3.c Prespect
Boomer's Artworx (602) 555-4221 8907 E. Resebud Lane  Suite 25 Scottsdale AZ 85258  www.boomersartwe Prespect
Brandee’s Bakery (480) 555-2146 41169 Alec Lane EBoise D 83705  www.brandeebaker Customer
Brushy’s Golfing World Level 35 989 York St. Sydney NSW 2000 www.brushygolf.eol Customer

CH Holding
Circle Photography (214) 555-4652 2256 Circle Lane Suite 4 Dallas ™ 75214 www.circlephotof.c Customer
Calendar | Freemant Corp (735)542-1423 5550 South West Comner NewBrunswick ~ NJ 08901  www.freemonicorp. Customer
= Hare's Tavern Corporate (425) 555-3052 5689 N. Main Street Denver co 80427  www harestavemn.c Customer
E Interactive Gifis (212) 555-4752 3045 N. Gainey NY 12548 www interactive23. Prospect
Task List Mad House:The (310) 585-2454 22 Acacia Ave. Manhattan Beach  CA 90266 www.Imadhousel.c Prespect
MegaGadgets Catalog Co.  (312) 555-6625 17 N. State St. Chicage L 60601 www.megagadgets: Prospect
E Mercury Production Managerr (303) 555-3222 66 Flash Rd Suite 200 Central City co 80427  wwew.mercuryprodn Customer

Opportunity Mix Alliance (225) 5554512 1802 Sandstorm Ave. Suite JS16  Baton Rouge LA 70831 www mixalliance ct Customer
List Mockingbird Southeast 45 Mockingbird Lane Chattancoga ™ 37402 wmew.mockingbirdsc Prespect
= Modern Electric Supply (727) 585-8947 1919 Tecoma Dr. Tampa FL 34655 www.ModernElectri Prospect
= Sewing Room:The (415) 555-2451 2332 Market St San Francisco cA 94114 www thesewingroor Customer
E-m Sierra's Cafe (562) 555-4221 1823 E 2nd St Leng Beach cA 90807  www sierrascafe cc Prospect

Slamitonabingbong Industries (480) 555-3221 3458 E. Poinsettia Dr. Phoenix A7 85028  www sioabb.com Prespect
[ Spaghetteroni's (423) 555-6221 123 Pasta Way Mew Britain T 06051 www.spaghetteroni Customer
H=g) Swing Software (812) 555-4542  One Arcadia Way St. Petersburg Russia 197183  www.swinfsoft27.sp Customer
;[frs:g;; T-Bone's Steakhouse (541) 555-2333 9674 Porterhouse Rd.  Building#2  Eugene OR 97401 wwew.dabone.net Customer
Tiny Town Productions (480) 555-3696 2131/ Tiny Rd Suite 200 Scottsdale A7 85028  www tinytown10.co Customer

UZ! International (310) 555-6666 666 Elm St. Suite 13 Movie City CA 97124 www.uziscripts.com Customer

Verge Records (206) 555-4414 4583 N. Taylor St Suite 50 Seattle WA 98155  www.vergerecords. Praspect

Widget Corporation (480) 555-2245 3950 Easy Street Scoftsdale Az waw widgetcorpo.c Customer

‘williams Consulting (541) 555-3254 488 Country Club Rd. Eugene OR 97405  www williamsconst Customer

wiillis Enterprises (480) 555-2456 1920 Rocky Mountain W/ Scottsdale AZ 85258 www.willis.biz Customer

Lookup: All Companies

Okay, you have three possible ways to get to the Company List, but I actually
use a fourth method. Chapter 3 shows you how to customize the Nav bar.
Consider removing the Company icon from the Nav bar, which simply takes
you to the Company Detail screen of the first company as it appears alpha-
betically in the Company List. Add the Company List icon, and you’re one
click away from accessing a list of your companies.

In addition to allowing you to see a list of all your companies, the Company
List allows you to accomplish various company chores, all of which you can
access by right-clicking your way to the shortcut menu. Your options include
creating or deleting companies and divisions, creating a lookup on any of the
company fields, attaching notes, histories, and files to a company, adding or
removing members from a company and printing the Company List.

After you arrive at the Company List, you might find that your visit is some-
what short-lived because you want to zoom in on one of the companies for
more details. Not a problem — just double-click the company you want to
focus on, and you're transported lickety-split to the Company Detail window.
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Knowing the juicy company details

The Company Detail window has many of the same features as the Contact
Detail window, such as its own definable fields and layouts as well as system
tabs for inserting or viewing notes, histories, activities, opportunities, and
documents. You even have a few user-defined tabs to house additional com-
pany information.

You create and manage companies in the Company Detail window. Not sure how
to get there? Just click the Companies icon on the Nav bar or double-click one of
the company names from the Company List. If you look at Figure 20-3, the
Company Detail window looks almost exactly like the Contact Detail window.

Because the Company Detail window is so similar to the Contact Detail
window, you might find yourself wandering dazed and confused into the
wrong window by mistake. You might think that you're entering new con-
tacts, contact details, or contact notes when you’re actually entering new
companies, company details, and company notes. Just like the importance of
checking the title bar to assure that you are in the correct database, remem-
ber to sneak a peek at the Back and Forward bar to make sure you're in the
Company Detail window. Believe me, the only thing worse than entering lots
and lots of data is deleting it all — and then starting all over again!

At first glance, the Company Detail window looks like a clone of the Contact
Detail window. A couple of major differences, however, are

v~ Division and Hierarchy fields: You can subdivide companies into divi-
sions; the Division field allows you to see all the divisions within a com-
pany. You can zoom into a division by double-clicking it. The Hierarchy
field indicates that you're viewing a division; clicking the Up button
returns you to the main company.

v The Companies tree: The Companies tree (on the left side of the screen)
displays the hierarchy of all available companies and divisions in your
database. If a plus sign appears next to a company, you can click it to
display the company’s divisions.

v The Contacts tab: There is a certain symmetry here. In the Contact
Detail window, you have a Groups/Companies tab; in the Company Detail
window, you have a Contacts tab. This Contacts tab lists all the contacts
that are associated with the current company or division. The neat thing
about the Contacts tab is that you can zoom to any individual contact by
clicking the hyperlink attached to the name.

Chapter 20: Joining a Company 333



334 Part V: Commonly Overlooked ACT! Features

|
Figure 20-3:
The
Company
Detail
window.
|

Company Housekeeping

<MBER
oy

@ ACT! by Sage Premium for Workgroups - ACT_For_Dummies

()

1+ Back

Layoul_v.

File Edit View Lookup

Contacts

Groups

& Company Detalil

All Companies - 32 compa| &
|- Ace Pet Store:
|- American Dreams
|- Arcadia Ave. Flerist
| Best Lender Financing
| Biack Forest Baking
| Boomer's Artwonc
| Brandee's Bakery
| Brushy’s Giolfing Vorl
-~ CH Helding
CH Gourmet Cofie
£—CH Gourmet Gifts:
tm-« Gourmet (
CH Gourmet {
CH Gourmet Impo)
| Circle Photography
{— Freemont Corp
+Hare's Tavern Corpord
| Interactive Gifis
|—Mad House:The
|- MegaGadgets Catalog
| Mercury Production M
| Mix Alliance
|~ Mockingbird Seutheas
| Modern Electric Suppl
| Sewing Room:The
|- Sierra's Cafe
| Stamitonabingbeng Inc
|- Spaghetieroni's
| Suing Software

[—T-Bone’s Steakhouse

Companies

Schedule Write
g8 Companies |8 CompanyList [d % F & @ % F @ ™= & & B} 2 @

Reports  Tools Help

View Groups/Companies...

Hierarchy CH Holding

\Company CH Holding
Phone

Fax

Toll-Free

Web Site

ID/Status

Referred By

Ticker

£

Address

=
™
o o
State v
| Country

v

Contacts | Notes | History | Activities | Opportunities | Documents | Addresses | Company Info

Add/Remove

ZIP Code

B Divisions:

CH Gourmet Coffee
CH Gourmet Gifts
CH Gourmet Imports

Options -

Contact
Cecil Carter

Company
CH Gourmet Coffes
CH Gourmet Gifis
CH Gourmet Gifts
CH Gourmet Gifis
CH Gourmet Gifis
CH Gourmet Gifis
CH Gourmet Gifts
CH Gourmet Gifis
CH Gourmet Gifis
CH Gourmet Gifis
CH Gourmet Imports

Phone
(212) 5554444
(415) 555-2231
01366462200
0208 746534
(212) 555-1758
(212) 555-8421
(212) 555-8431
(212) 555-7321
03 664 62200
8422222343
(212) 555-4447

Extension

E-mail Title
Cecil@chgourmetgifis.com  Public Relations Manager
Emst@chgourmetgifis.com  Vice President of US Oper]
bb m  Sales R

fis.c Sales R
Chris@chgourmetgifts.com  CEO

com Sales

Melissa@chgourmetgifts com Assistant

Julietie@chgourmetgifis. com CFO

Jonathan@chgourmegifis cor Vice President AsiaPac O

Sarah@chgourmelgifis.com  Vice President European (|
com _ Business Devel

The Company portion of ACT! is at the same time both surprisingly powerful
and surprisingly easy to use. Like anything else in life, your companies func-
tion best when you give a little thought to their care and feeding. Here are a

few of the routine tasks you need to know about.

Forming a new company

When you create a company in real life, you have to hire an attorney and sign a
bunch of papers. In ACT!, the procedure is a bit simpler, thank heavens! You can
add a new company from either the Company List or Company Detail window.

1. Click the New Company icon on the toolbar of the Company Detail
window or the Company List.

A blank Company Detail window appears.

Adding a new company works in pretty much the same way as adding a
new contact. When that blank screen appears, you are the proud owner of
a new, albeit blank, company. You need to start entering some information.

2. Fill all the necessary information into the various company fields.
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Creating a division (or subdivision)

You might find yourself dealing with companies that vary in size from the
sole proprietor who runs his business from his backyard tree house to the
Fortune 500 company with locations all around North America (or the world
for that matter). You might even find yourself working with a really super-
sized corporation — like the federal government. ACT! allows you to create
15 division levels so that you can have divisions of a company as well as divi-
sions of your divisions. Sound confusing? It is, but then so is the structure of
many mega corporations.

To create a new division, subdivision, sub-subdivision, or whatever, follow
these steps:

1. Display the company to which you want to add a division.

You can find a list of the companies from either the Company Detail
window or the Company List.

2. Click the New Division icon on the toolbar.

You right-clickers in the crowd can also right-click and choose New
Division from the shortcut menu. Either way, a blank Company Detail
window appears.

3. Enter the pertinent info for the division that you’re creating.

The next time you display the original company, you see the division
you added in the Divisions field. Double-click it to land in the new divi-
sion. To add members to the division, click the Add/Remove Contacts
button on the Contacts tab and add division members just like you add
company members.

After creating a division (or subdivision), the Company Detail window is
probably your best source for navigating through the corporate maze. In the
main company window, all the divisions listed in the Divisions field are along
the right side (refer to Figure 20-3). If you want to hone in on a division, just
double-click the division name; the company name and path now appear in
the Hierarchy field, and any additional subdivisions appear in the Divisions
field. You can keep drilling down through the divisions until you reach the
final subdivision or oil — whichever comes first.

Notice the Include Subdivisions option at the top of the Company List. As

the name implies, clicking it shows you all the divisions and subdivisions.
However, the list appears in alphabetical order, so you’ll find it pretty impos-
sible to figure out which divisions belong to what company. Although you can
perform most of these housekeeping tasks from the Company List, chances
are pretty good that you’ll eventually end up with a muddled mix of company,
divisions, and subdivisions.
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Deleting a company

[ almost hesitate to tell you about this feature because you could easily
delete a company by accident. The good news is that even if you delete a
company, the contacts associated with the company are still alive and well
and living in your database. The bad news is that all the information from the
company fields is lost forever — unless, of course, you have a backup! If you
don’t have a backup, Chapter 14 shows you how to create one.

1. Choose the company you want to delete in one of the following ways:
* Highlight the company or division from the Company List.
e View the company from the Company Detail window.

2. Right-click and then choose Delete Company.

3. Click Yes to confirm that you want to delete the selected company.

If you delete a company that contains divisions, the divisions don’t get
deleted; instead, they get promoted to their very own companies. If your
intention is to delete a company and all its divisions, you need to delete the
various divisions before deleting the company.

Converting a group to a company

You might already be an ACT! fanACTic and have recently converted from
ACT! 6 to ACT! 2007. ACT! 6 users had to be content with groups because the
concept of companies was nonexistent at that time. You might have set up a
group that in actuality is a company. New users in the crowd might set up a
group from time to time and find that the group miraculously transformed
itself into a full-scale company. ACT! thinks of everything, and this is just one
more instance. You can easily convert a group into a company at the click (or
two) of a button by following these steps:

1. From any ACT! screen, choose View~>Group List.

2. From the Group List, choose the group you want to convert to a
company.

3. Right-click and then choose Convert to Company.
If you prefer, you can also head to the menu bar and choose Group=>

Convert to Company. In any case, the Convert Groups to Companies
Wizard appears.

4. Continue clicking Next until you arrive at the last screen; then click
Finish.

If you like, I can try to make these instructions a bit more difficult.
Basically the wizard is confirming that you want to convert the group
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into a company. By default, the group name becomes the company
name, the group address is now the company address, and so on. Feel
free to muddle in there if you want, but don’t blame me if your muddling
efforts are successful!

After the conversion is complete, you might want to race over to the
Company List to have a look at the company you just worked so hard to
create! You'll also notice that the original group has disappeared — or at
least been replaced by the new company.

Adding New Members to the Company

Don’t worry — gaining membership to a company is easy and doesn’t require
a membership application or initiation fee. You can add new members to the
club, er, company from either the Company Detail or the Contact Detail win-
dows. And, you can add individual members one at a time, or you can add a
whole slew of new members all at once. You can even set up an automatic
BER query and let ACT! take care of all the heavy lifting for you!
Company members don’t have to work in the company — they might just be
associated with them.

Getting the entire gang in the company

The simplest way of associating a whole bunch of people with a company
record is by creating a lookup for the critters and then adding them to an
existing company.

1. Create a lookup of the contacts that you want to add as members to
the company.

This seems like a no-brainer, but you will probably base that lookup on
the company name so that all the contacts from ABC Co. can be added
to the ABC Co. company. In any event, you're whisked over to the
Contact List where all the happy co-workers are hanging out.

2. Click the Tag All icon on the Contact List.

All the contacts will turn a lovely shade of gray, indicating that they’re
now selected (or that they had bad chicken at lunch).

3. Right-click in the middle of the Contact List and choose the Add
Contacts to Company option.

4. Select the name of the company you want to add those nice folks to
and click OK.
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Starting a company of one

At times, you just want to associate a single contact with a company. I'm sure
you find it no surprise that ACT! has an easy solution.

1. Create a lookup of the contact that you want to add as a member to
the company.

2. Click the Groups/Companies tab and show membership for
Companies and Divisions.

&,N\BER You’ll probably find that last step a bit unnecessary; I do, too. Just
& remember that Groups and Companies are forced to share the same tab,
so you have to specify that you're interested in using the Company por-
tion of the tab.
3. Click the Add Contact to Company button.
The Add Contact to Groups/Companies window shows up, as shown in
Figure 20-4.
(. Add Contact to Groups/Companies
View
Companies and Divisions w
Is @ member of:
All Companies - 32 company(s), 9 division(s)| Company # | Phone
| Ace Pet Store Arcadia Ave. Florist (602) 555-4412
— American Dreams
— Best Lender Financing
— Black Forest Baking
— Boomer's Artworx
— Brandee’s Bakery
— Brushy's Golfing World
—CH Holding
L — Circle Photography
- . — Freemont Corp
Flgure 20-4' —Hare’s Tavern Corporate
Add”‘]g a |— Interactive Gifts
—Mad House:The
conta Ct — MegaGadgets Catalog Co.
to Groups/ (—Msrﬁnh‘ Praductinn Manzanement 5 d
Companies.
|

4. Select the company that you wish to link to the current contact and
then click the right-pointing arrow.

5. Click OK.
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Following the company rules

Nothing is worse than letting things slip through the cracks, and ACT! works
like a demon to prevent this from happening. Companies are only as good as
the contacts associated with them — so what happens when you forget to
link a contact to a company? Never fear! Once again, ACT! is here with a
solution. Setting up company rules helps automate the process. That way,
whenever you add a new contact to an existing company, that contact is auto-
matically added to that company. To set up a company rule, follow these
steps:

1. Click the Add/Remove Contacts button on the Contacts tab of the com-
pany for which you’d like to create a rule.

You have three choices here:

e Static members: These members were handpicked to be members
of the company. These members generally don’t work at the com-
pany but are associated with it.

e Linked contacts: These contact records are hyperlinked to the com-
pany record. You'll discover how to create that link in the section
“Hyperlinking a contact to a company.”

e Dynamic members: These members automatically become a part of
the company based on your specific criteria.

2. Choose Edit Criteria from the Add/Remove Contacts window.
The Company Criteria dialog box, as shown in Figure 20-5, opens.

3. Indicate the criteria that you’re using to determine how the new con-
tacts are automatically linked to an existing company.

Nine times out of ten, you base the criteria on the company name, so you
fill in your criteria exactly as you see it in Figure 20-5. If you’re working
with a large company with multiple offices, you might need to indicate
the city as well. For those of you who always prefer multiple choice to fill-
in-the-blank exams, you can choose all the values from drop-down lists so
that you can simply select the criteria you want. If you want to create
really fancy queries you can scurry over to Chapter 6 to find out how.

P If this window looks vaguely familiar, you could be having flashbacks —
or remembering the Advanced Query window. Chapter 6 discusses the
Advanced Query window in full detail and will give you additional help
in creating a Company query.
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4. Click the Add to List button.

In general, you add only one criterion — the company’s name. However,
if you need to have more than one criterion, go ahead and add as many
as you like. The criteria that you select display in the center pane.

5. Click the Preview button to preview the contacts linked to the company.
6. Click OK when you finish.

The next time you add a new contact and indicate that he works at an
old company — or at least one of your existing ones — ACT! automati-
cally links the contact to the company.

Hooking Up with a Company

The company feature you probably like the best is the ability to link informa-
tion between a company and the contacts that belong to that company. In
addition to seeing the contacts that are associated with a company on the
Companies tab, Company List, and the Company Detail window, you might
also want to link specific contact fields with company fields. Here are two
ways that a contact can be linked with a company:

v Using a hyperlink in the contact’s Company field

v Specifying that a specific Contact field be linked to a corresponding
Company field



Hyperlinking a contact to a company

Here are two important concepts about creating hyperlinks between individ-
ual contacts and companies:

v You can hyperlink a contact to only one company.

1 Associating a contact to a company automatically creates a hyperlink
from the company record back to the contact record.

When you hyperlink a contact to a company, the company name turns to blue
on the Contact Detail window; click the company name, and you arrive at the
Company Detail window.

Any contacts that are associated with a company are automatically hyper-
linked to the Contact Detail window. Open the Company Detail window, click
the Contacts tab, and guess what? All the contact names appear in blue,
which isn’t a decorative font treatment. Venture forth and click a contact
name; the hyperlink transports you to the Contact Detail window of the con-
tact you clicked.

Sound a bit confusing? It is, but here’s a way to simplify things. Linking a con-
tact to a company is done via the Company field on the Contact Detail
window. In general, the contact is linked to his own company. Earlier in this
chapter, you can read about associating a contact to a company.

A contact can be associated with multiple companies.
With those concepts in hand, follow these steps to link a contact to a company:

1. Create a lookup of the contact that you want to link to a company.

2. Click the ellipsis button next to the Company field in the Contact
Detail window.

The Link to Company dialog box appears, as shown in Figure 20-6.

3. Select the company to which you want to link the contact and then
click OK.

If the company name on the Contact Detail window is an identical match
to one of the companies that you created, ACT! matches them automati-
cally. If the name isn’t identical, you can type the first few letters of the
company name in the Look For field so that ACT! automatically scrolls
down the list of companies and finds it for you.

The company name appears in blue, indicating that a hyperlink is cre-
ated between the contact and the company.
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Link To Company
Linking a contact to a company will make the contact 8 member of that
company and automatically associate their activities, notes. opportunities and
histeries to the company record
Look for:

Slamitonabingbong Industries|

Company /| Phone Fax Phone -~
Jake Flakes Inc.

Mad House:The (310) 555-2454 (310) 555-2155
MegaGadgets Catalog Co. | (212) B55-6625

Mercury Preduction Managen| (303) 555-3222 (303) 5557777
MiniScft 212-538-4562

Mix Alliance (225) 555-4512

Mockingbird Southeast

Modern Electric Supply (727) 555-8947 (727) 555-8952
Sewing Room: The (415) 555-2451

Sierra’s Cafe (562) 555-4221

Slamitenabingbong Industries (480) 555-3221 ~

If you find that you no longer want the link, simply click the ellipsis button
again. ACT! asks you whether it’s okay to disable the link. Click OK, and it’s
history.

Linking the Contact and Company fields

The following feature applies only to ACT! 2007 Premium for Workgroups. If
you don’t have that version of ACT!, feel free to skip this section — or at least
politely mask your yawns if you feel inclined to read it.

Linking company and contact fields is particularly useful if you’re working
with multiple contacts in the same company. Say, for example, that you're
working with the MiniSoft Corporation and that they decide to move their
headquarters from Washington to Hawaii. Because MiniSoft is your biggest
account, you regularly deal with more than 50 contacts working at corporate
headquarters. If you had to change the address (including city, state and ZIP
code) for 50-some contacts — you’d be typing a lot.

By linking the appropriate fields together, you can update the company
record and have all the individual records update automatically based on
that information.

Linking contact and company fields requires a three-pronged operation:

v Define which fields should be linked together.
v Make changes to the company record.

v Push the information down to the individual contact records.
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Matking the field association

Although you’re probably anxious to dive right in and start associating fields,
you might find it easier to first check to determine which fields, if any, are
already linked. Because ACT! believes in one-stop shopping, you can quickly
create the association if necessary.

1. From any ACT! window, choose Companies~> View Linked Fields.

The View Linked Fields window, as shown in Figure 20-7, opens.

View Linked Fields
Company fields have been linked to the following contact fields
The data in the linked contact fields will be updated when the data
in the corresponding company fields is modified
Company Field Linked to Contact Field
Address 1 Address 1
Address 2 Address 2
Address 3 Address 3
| City City
- Company Company
Flgure 20-7: Country Country
« . State State
Determlnlng Web Site Web Site
. ZIP Code ZIP Code
which
company
and contact
fields are
linked.
Define Fields ] [ Close
|

2. Click the Define Fields button.

If the association already exists, you're free to close the open dialog
box and continue merrily on your way. If not, the Define Fields dialog
box opens.

3. Double-click the field for which you’d like to create the association
and then click Next.

The Customize field behavior dialog window opens.

4. Indicate the Company field you want to associate with the Contact
field that you select in Step 3.

Figure 20-8 illustrates how easy that is.

\P
) You probably want to create the contact and company fields before you
attempt to link them. You also want to make sure that the two fields are com-

patible; you’d have trouble linking a phone field to a date field.
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Informing the contacts of new changes

You can update an individual’s Contact fields with information from the
master company record only if the contact is hyperlinked to the company.
Assume that you have 50 contact records that are hyperlinked to the MiniSoft
company record. Here’s all you need to do to update all those contact
records in the blink of an eye — or the click of a button.

1. From any ACT! screen, choose View->Companies.

2. Update the Company Detail screen with the latest and greatest
information.

3. Choose Companies~>Update Linked Contacts.

This might be a great time to sneak in a break. Although this entire
process only takes seconds, your boss will think it took hours!

Creating a new contact from a company record
Sometimes you might think that ACT! is capable of pulling a rabbit out of a hat.
Hardly, but it does come equipped with some neat party tricks, one of which is
the ability to create a new contact at an old company. Here’s all you need to do:
1. From any ACT! screen, choose View->Companies.
2. Select the company for which you’d like to add a new employee.
3. Choose Companies=>Create Contact from Company.
4.

Gasp in disbelief when the Contact Detail window opens — filled in
with all the pertinent company information.

Not only did ACT! fill in all the linked fields, it even created a hyperlink
from the contact back to the company record.

5. Fill in the contact name and any other information specific to the
contact.
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Working with a Company

You might want to think of a company as a mini database within a database.
The Company Detail window includes the same tabs as other views — Notes,
History, Activities, Opportunities, and Documents. However, it has one major
difference: You can filter the Notes, History, Activities, and Opportunities
tabs to show just the information that pertains directly to the contact. This
feature is very useful and powerful and gives ACT! a whole new dimension.

Jotting down a company note

The concept of company notes is a powerful but confusing one. Say you have
12 contacts, all associated with one company. Also assume that each of those
contacts has an average of 20 notes that you've entered. If my math is correct —
and it doesn’t hurt to double-check me here — the combined total notes for
all the company members is 240. Now imagine having to sift through all those
notes looking for the one important one. Yikes! That might take a while.
Conversely, imagine your company just closed a major deal with the other
company; you'd probably find having to enter the same note 20 times, once
for each member of the company, repetitious and a huge waste of your time.
Enter the company note.

Entering a note from the Company Detail window solves both of these dilem-
mas: You don’t have to enter the note repeatedly, and you don’t have to
search through a mountain of notes to find it.

Entering a company note is as easy as 1-2-3:

1. Click the Notes tab in the Company Detail window.
2. Click the Insert Note button.
3. Fill in the details of the note and click OK.
Now comes the fun part. If you look at Figure 20-9, you notice the Show For
drop-down list. Here’s where you can filter the notes to show only company-
specific notes. You have three choices from which to choose:
v All: Shows both company-specific and contact-specific notes
v Company: Shows only company-specific notes
v Company Contact: Shows only contact-specific notes
&,\‘I\BEH When you enter a note from the Company Detail window, you can access it
& only from the Company Detail window. If you enter a note from the Contact

Detail window of a company member, you can view the note from both the
Contact Detail and Company Detail windows.
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Associating a note, history, activity,
or opportunity with a company

The final piece of the company puzzle occurs when you want to create a note,
history, activity, or opportunity with a specific member of a company and
you want to make sure that it’s easily accessible from the Company Detail
window. And, of course, you don’t want to have to plow through numerous
items just to find the specific note, history, activity, or opportunity for which
you’re looking. If you were dealing with another contact management pro-
gram, [ might just tell you to take a hike; however, you're dealing with ACT!,
so of course I have a solution for you.

Actually, the solution is pretty easy. Any time you create a note, history,
activity, or opportunity, ACT! allows you to associate it with a company. By
doing that, you take advantage of the Company filter on the appropriate
Groups/Companies tab so that you can view just the pertinent information
that you want. I show you how to do it for an opportunity, but you can use
the same methodology when creating a note, history, or activity.

1. Create a lookup for the contact with whom you want to create a sales
opportunity.
2. Click the Opportunities tab and then click the New Opportunity icon.

Fill in all the appropriate opportunity information. If you need a little
help, flip over to Chapter 18.

3. Click the ellipsis button next to the Associate With field.
The Associate with Group/Company dialog box appears.
4. Click the Companies/Divisions tab.

5. Locate the company from the list on the left and then click the right-
pointing arrow to select it.

The company name appears in the Associate With list.
6. Click OK.
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After you associate a note, history, activity, or opportunity with a company,
you can view it from the Company Detail window. Filter the History, Activities,
and Opportunities tabs exactly the same way as the Notes tab by clicking the
Show For drop-down list and selecting your desired filtering option. And,
when you quickly find just the item you’re looking for in the filtered list, think
of me before heading out to the pool!

Accessing the company files

Unlike the other systems tabs, you can't filter the Documents tab. Rather, it
sits there like a giant bank vault, just waiting for your deposit. Okay, maybe
all this talk about companies has left me with dreams of Monopoly, but you
can attach as many documents as you like to the Documents tab of the
Company Detail window. This saves you from having to hunt through the
various company contacts looking for the contact to whom you attached an
important file.

Getting the Company Reports

Although ACT! might not be submitting reports to the SEC for you, at times, it
seems like it comes pretty darned close. ACT! comes out of the box with five
reports, all of which you can clone and then customize to fit your needs. If
you haven’t done so already, you can read about customizing your reports in
Chapter 9.

v Company Membership: Lists all your companies and their members.

v Company Summary: Shows the notes, histories, activities, and opportu-
nities for all companies.

v Company Comprehensive: Includes all field information as well as
notes, histories, activities, and opportunities.

v Company List: Provides you with a list of all your companies including
the description, phone, and toll-free numbers.

v Company Directory: Lists the regular and shipping addresses as well as
phone and toll-free numbers for each of your companies.
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Chapter 21

Working with ACT!
Premium for Web

In This Chapter
Understanding the ACT! for Web benefits
Configuring your hardware and software

Making changes to Windows
Installing the Web-based version of ACT!
Sharing the database with others
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u sing the online version of ACT! provides you with a ton of benefits. Best
of all, the program looks and feels like the traditional ACT! that you

can read about in this book. You can perform any ACT! task just as if you're
working back in the main office. However, you need to make sure that your
hardware — and systems administrator — are up to the job. You need to
tweak Windows and then make sure your users know where to find the data-
base on the 'Net.

This chapter is designed to go in a very sequential order. If you haven’t already
configured Windows as describe later in this chapter, ACT! Premium for Web
will point out the error of your ways and prevent you from continuing.

Vou Gotta Love this Product

ACT! Premium for Web is not for everyone. If you're a standalone ACT! user,

you might just want to skip this chapter. However, if your sales force is scat-
tered throughout the country or constantly travels to Kalamazoo and back,

your organization can benefit from using this product.
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You might wonder exactly what data is shared in ACT! Premium for Web.
That’s a pretty easy question to answer — all of it! You can see your core
data, such as contact information, appointments and tasks, notes, histories,
and sales opportunity information. You can also run a report, create a mail
merge, and print labels. And if headquarters decides to make changes to
the layout, you see those changes the next time you log into the database
or refresh your browser. Worried about the customized templates that you
created and want to share with your remote users? Don’t worry: They’re all
included in ACT! Premium for Web.

Here is a list of the benefits in ACT! Premium for Web:

v~ Share real-time information with users. Many salespeople aren’t in the
office on a regular basis, but they want to share updates with the home
office. With ACT! Premium for Web, any changes that they make to the
database are immediately seen by the folks at the home office.

v+ Eliminate the need to synchronize. Synchronization, which I discuss in
detail in Chapter 16, allows you to send and receive updated information
to and from your remote users. However, the data is only as current as
when the remote user last synchronized. With ACT! Premium for Web,
users always have the latest and greatest information available without
having to create and maintain additional databases.

v Access your information anywhere, anytime. ACT! Premium for Web is
particularly suitable for those who spend a good deal of time away from
the office because you can see your database from wherever your trav-
els take you. You have the luxury of accessing your database from home,
a hotel room, a client site, or even an airport computer kiosk. Addicted
to café macchiato grandes?

Not only does ACT! Premium for Web allow you to work where you want
to, but it also allows you to work when you want to. If insomnia sets in

at 2 a.m. from all that coffee, you could jump in your car and zip over to
your office — or you can save yourself a trip and simply fire up your
home computer and work away. (Consider setting your alarm for 3 a.m.,
hopping on to ACT! Premium for Web, and adding a few strategic notes.
You'll find that this strategy goes over very well with your boss, who will
be impressed to see that you’re working all hours of the day and night.)

v View data from a network or the Internet. Throughout this book, you
might find yourself repeatedly humming the “Have it Your Way” theme
song made popular by one of those fast-food places a few years back.
ACT! Premium for Web helps bring that song to your lips because it
allows you the best of both worlds. Unlike a competing product that’s
designed exclusively for Web access, ACT! Premium for Web takes ACT!
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to the next level by allowing you to access your database across your
company’s network, remotely via the Internet, or by a combination of
both methods.

v Lower the cost of deployment and upkeep. If you're anything like me,
you want to get the most bang for your buck. This is especially true of
software. The cost of a software deployment is directly proportional to
the number of users in a company. And, typically the CFO, CEO, and any
other character running around your office with a similar title wants to
keep software and hardware expenditures to a minimum. The cool thing
about ACT! Premium for Web is that after you pay for your software
and any hardware that you might need to run a Web site, you’re done.
Finished. You’re completely through with paying for your database. And,
you can continue to use the software year after year without additional
cost. With other online database solutions, you pay a monthly charge to
keep your database afloat, and those charges are per user, per database,
per month. Ouch.

v Avoid additional costs. Shopping for an online database program is kind
of like shopping for a car — you better read the fine print! With ACT!
Premium for Web, after you pay for the software, your expenses are
final. This is particularly important if your database is going to grow.
And believe me, as you add contacts, notes, attached documents, and
customized fields, your database is going to grow. If you're using ACT!
Premium for Web, the only increase in size you have to worry about is
your waistline. This isn’t the case with other Web-based, database pro-
grams. Typically, you're charged by the size of your database: The
bigger your database, the more you pay.

v~ Use older computers. Many of you live by the motto, “If it ain’t broke,
don’t fix it” — particularly when it comes to your computers. Over the
years, your trusty computer has chugged away; you've become com-
fortable with your current software and know all the intricacies of your
current hardware. Besides, the thought of transferring all your data to a
new machine is a daunting — not to mention an expensive — proposition.
However, technology eventually catches up with you, and you find your-
self lusting over that sexy new software with all those great new features.
Here’s where your pain sets in. While drooling over that new software in
the local computer store, you glance at the system requirements and
realize that your hardware just isn’t up to the task.

Although ACT! Premium for Web won’t magically replace your dog-eared
computer with the latest and greatest computer model, it does allow you
to access all the great new ACT! features from your very own browser.
As long as your old clunker can access the Internet, you can access the
latest version of ACT!.
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+” Keep possession of your information. Many of you feel extremely pro-
tective about your data. Some of you might have purchased your con-
tacts; for others, those contacts represent months — or even years —
of cultivating potential customers. In either event, you don’t want your
data to walk out the door.

If you're considering using another contact management program that’s
available only online, consider this: All your hard-earned data will now
reside on someone else’s computer. And, in the event that you want

to start housing your information internally again, you might find it
difficult — and costly — to get your own information back into your fat
little fists. ACT! Premium for Web offers more benefits than that other
online service without forcing you to house your data offsite (which
might be why the competitor uses the word force in its name!).

v~ Spare your IT department. Pity the poor IT person. When something
goes wrong with your hardware, you blame him. When something goes
wrong with your software, you blame him. And then, when he dons his
white cape and pocket protector and rushes to your rescue, you spew
all your pent-up frustration directly upon his head. It’s only natural that
he’s not going to be particularly thrilled when you casually mention that
you want all your remote salespeople to have access to your database.
He’s going to think that he has to administer a whole new database. And
that he somehow has to get that database — or databases — shipped to
the remote users. And, after those remote users get their new databases,
he has to figure out how to install software on their machines remotely.
And, of course, the fact that those remote users are in a different time
zone, are constantly on the move, and are barely a notch above com-
puter illiterate doesn’t increase his anticipation of the project.

But wait — before your IT person jumps from the nearest window, you
might be able to talk him back in from the ledge with a few words of
reassurance. First of all, he has to administer only one database. Secondly,
he doesn’t have to ship anything by snail mail, e-mail, or carrier pigeon.
He doesn’t have to walk those remote users through any sort of software
installation. In fact, all that he needs to do is send those remote users
the Web site address for the database, along with their user names and
passwords.

Back at the ranch — or company headquarters — Mr. IT can do all kinds
of fun stuff, like set up passwords and user preferences, without having
to deal with his remote users. He can customize the database in exactly
the same way he’s used to customizing the traditional versions of ACT!.
In fact, he’ll probably love the fact that he’s in complete control of the
database and won'’t have to spend his time fixing menus that users inad-
vertently lost or modified. And, best of all, he can send those remote
users a copy of this book so they know how to use the database.
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Looking Before You Leap

On paper — or at least on the side of the software box — placing a database
on the Web sounds easy. All you need in order to put your database on the
Internet for all the world (or at least your company) to see is a Web server
with Internet Information Services (IIS) installed, a licensed copy of ACT!, and
a Web site. And configuring ACT! Premium for Web is simple if you know all
about IIS. However, for those of you who think IIS is simply a misspelling of is,
you might want to read on.

Handling the hardware

Before you install the ACT! Premium for Web software, you need to ensure
that your hardware is up to the task. You need a server with the following
specs:

v A Pentium 4 processor

v 300MB of free hard drive space for the software and additional space
for the actual ACT! databases and related files

v At least 1GB of RAM

If over ten people are coming to the party — or Web site — you want at
least 1.5GB of RAM and extra pigs-in-blankets. Accommodating over 25
attendees requires at least 2GB of RAM and shrimp cocktail.

»* A CD drive

v A high-speed Internet connection

Going on a Windows fact-finding mission

All versions of Windows are not created equal, at least when they pertain to
hosting a Web site. Some of the lesser versions — like Windows Millennium
Edition (Me) or XP Home Edition — just won’t cut the mustard here. You
need one of the big guns to do the job:

1 Windows 2000 Server or Small Business Server

v Windows 2003 Standard, Web or Enterprise
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Figure 21-1:
The
Windows
Components
setup
screen.
|

In addition, if you are going to have a maximum of ten concurrent (at the same
time) users, you can also use

1 Windows XP Professional

v Windows 2000 Professional

Installing I1S

After you have your hardware (check) and the proper operating system, you
need to start transforming your computer into a full-fledged Web server. This
is actually easier done than said if you follow these directions:

1. Choose Start=>Control Panel=>Add or Remove Programs-~>Add/
Remove Windows Components=~Internet Information Services (IIS)
and then click Next.

The cool thing here is that Windows takes the guesswork out of
everything — and even tells you what those IIS initials stand for. You
can see the Windows Components wizard setup screen in Figure 21-1.
Your computer will buzz along for a minute.

Windows Components Wizard

‘Windows Components
“ou can add or remove components of Windows XP.

Ta add or remove 3 companent, click the checkbox. A shaded box means that anly
pait of the component will be installed. To see what's included in & component, click
Dietails.

Components:

[ &P Indexing Service 0oMe |-
& Intemet Erplorer 0omMe

[} %Intemet Information Services (I1S) 1325 MB

O gﬂ tanagement and Monitoring Tools 20ME

[ 52 Wsaane (usiing nnwp ¥

Description:  Includes ‘Windows Accessones and Ulities for your computer.

Total disk space required: RE.E MB -
Details...
Space available on disk: 438461 ME S

< Back ][ Mest » ][ Cancel ]

2. Pop in your original Windows installation disc when prompted and
then click Next.

What I like about this is that you can accomplish a very high-tech feat
with a fairly low-tech skill level.
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What's in an 1P name?

Although you and I might name our computers with endearing names such as
Hal or Son of a Pitchfork, programmers think in terms of numbers and name
their computers with names such as 192.168.2.38. Guess that has a ring to it,
if you're a computer. This name/number is a computer’s infernal IP address. A
computer’s internal IP address identifies it from the other computers in your
internal network: hence, the modifier internal. Within your network, you can
assign IP addresses at random as long as each one is unique.

When you connect to the outside world, you have an external IP address. This
number identifies you to the outside world — the great big world outside your
internal network. Your external IP also has a cute name such as 67.87.243.62.

External IP addresses come in two flavors: dynamic and static. A dynamic IP
address is like a cute little toddler — it bounces around all over the place. A
dynamic external IP address is assigned to you by your ISP (Internet service
provider) on a round-robin, first-come-first-served basis. Consequently, one
day, your name is 67.87.243.62; the next day, it’s 1.160.10.240.

Your remote users log on to your Web server via your Web server’s external
IP address. The trouble is that remote users might feel like they’re playing a
giant game of keep-away if they have to use a different I[P address every time
they want to get into ACT!. Enter the static IP address. A static IP address
doesn’t change, making life much easier for your remote users.

Stop the 1P, ] want to get on

If you have a dynamic IP address, you have to get a static one or risk having
your remote users not being able to access the database. This is the hardest
part of the entire procedure: You have to check with your ISP to get one.
Surprisingly enough, if you pay your ISP a little extra money each month,
most will be happy to accommodate you.

Getting your ISP to assign you a static IP address is the easy part. The hard
part is getting the static IP so that it’s visible to the outside world. This feat
requires a bit of router tweaking. Unfortunately, you're probably going to
have to enlist the help of your ISP, which is not always so easy!

If you really want to get fancy, consider registering a domain. You can substi-
tute it for your external IP address number so that you can go to your Web
site by using mywebsite.com instead of 12.34.567.89. Use any one of the
many domain registering services or check out one of the free services such
as DynIP.com (www.dynip.com), No-IP.com (www.no-ip.com), or DNS2Go
(www .dns2go . com).

355
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Giving Windows an Internet Makeover

After you gather all your supplies — pencils, paper, Web server, operating
system — now’s the time to put them all together. The following steps aren’t
hard, but there sure are a lot of them. Just remember that paying attention to
the details will ensure that your installation proceeds without a hitch.

Figure 21-2:
The
Windows
Computer
Manage-
ment
window.
|

Confirming that IIS is alive and well

In the preceding section, you can read how to install IIS. However, just like
the light switch, you need to turn it on if you expect it to work.

1. Right-click the My Computer icon on your desktop and choose

Manage.

The Computer Management window opens, as shown in Figure 21-2.

2. Expand the Services and Applications area by clicking its plus sign.
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3. Expand Internet Information Services by clicking its plus sign.
4. Expand the Web Sites item by clicking its plus sign.
5. Right-click Default Web Site.

If this service isn’t running, the word Start shows up after the Default
Web Site item; right-clicking it gives you the choice of Start to start it
again. If the contextual menu includes Stop, you're already started, and
you should close the Computer Management Window.

Inviting an Internet Guest Account

An Internet Guest Account (IUSR) is a special account that you create in
Windows. The IUSR can access your Web site but not the rest of your server.
ACT! Premium for Web needs to have an IUSR set up so that it can be secure
in the knowledge that the outside world can access your database — and
only your database. The IUSR account is generally created when you install
IIS, but it’s always a good idea to check for its presence. If it’s missing, you
need to go back to the drawing board and reinstall IIS.

1. Right-click the My Computer icon on your desktop and choose
Manage.

2. Expand the Local Users and Groups area by clicking its plus sign; click
the Users folder.

Usually, the [USR is named after his father — which, in this case, happens
to be the name of your computer. In Figure 21-2, you can see that my
Internet Guest Account is named IUSR_HP_SERVER.

3. Close the Computer Management window.

Making an ASP.NET of yourself

In a nutshell, ASPNET is used to create Web pages and Web services. ASP.NET
impersonation allows outside users to access an application — in this case,
your ACT! database. With ASP.NET impersonation, IIS becomes responsible
for who is let into the party and who is denied admission.

1. Right-click the My Computer icon on your desktop and choose
Manage.

2. Expand the Services and Applications area by clicking its plus sign;
then click the Services folder.
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|
Figure 21-3:
Creating a
Windows
user.
|

3. Confirm that ASP.NET is listed as one of the services by right-
clicking it.

This works exactly like the IIS service that you verify in the earlier sec-
tion, “Confirming that IIS is alive and well.” If this service isn’t running,
the word Start shows up on your contextual menu. If the contextual
menu includes Stop, you're already started, and you should close the
Computer Management Window.

Just call me APFW

The final thing you want to do is to create your own Windows user. The bottom
line is that the IUSR you create earlier in this chapter has access to all your
Web files; the Windows user you are about to create has access to only the
ACT! Web files.

To create the Windows user, return once more to the scene of the crime —
the Computer Management window.
1. Right-click the My Computer icon on your desktop and choose Manage.

2. Expand the Local Users and Groups area by clicking its plus sign; then
click the Users folder.

3. Click the Actions menu and choose New User.

The New User dialog box appears, as shown in Figure 21-3. Although you
can name the user name anything your little heart desires, [ would stick
to something simple and relatively nonconfusing — like APFW — which
is an acronym for ACT! Premium for Web.

4. Clear the User Must Change Password at Next Logon option.

New User 2%

User name: APFW

Full name:

Diescription; For use with ACT Premium for Web

Password: ~ |seesses

Confirm password: LLLLLL

[1User cannat change password
Password never expires
[ &ccount is disabled




Chapter 21: Working with ACT! Premium for Web 359

5. Assign a password to the user.

Think of a good password — just make sure you remember it again later!
To jog your memory, you have to type it in twice.

6. Click Create to create the new user.

The New User dialog box snaps shut — or at least closes with a quiet
click. You once again find yourself in the Computer Management window,
which is a good thing because you have a little more tweaking to do.

7. Expand the Local Users and Groups area by clicking its plus sign; then
click the Groups folder.

8. Right-click the Administrators group and choose Add to Group.

The Administration Properties window opens. As the name implies,
here you add the newly crowned ACT! Premium for Web user to the
Administrators group so that the remote has full access to all the data-
base files and folders.

9. Click the Add button.
The Select Users dialog box opens.
10. Click the Advanced button and then click Find Now.

If you've been following along, your dialog window should match the
one in Figure 21-4.
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11. Select APFW from the name list and click OK.

At this point, you are probably so excited you can hardly contain your-
self. Take a deep breath and think of that mango margarita you're going
to be treating yourself to.

12. Click OK two more times to close the Select Users and the
Administrators Group windows and then close the Computer
Management window.

Installing ACT! Premium for Web

After you make Windows willing and able to host your database online, you
need to install ACT! Premium for Web on your Web server. This requires that
you stick the ACT! CD in the CD drive and follow the directions. If you already
have an older version of ACT! installed on your computer, the installation
wizard won'’t let you continue until you uninstall the product.

\‘&N\BER
& This chapter is designed to go in a very sequential order. If you haven’t already
configured Windows as described earlier in this chapter, ACT! Premium for
Web will point out the error of your ways and prevent you from continuing.

Opening your database

After you install ACT! Premium for Web, you need to specify the database(s)
that you want to access. You have a few options here:

v Create a new database. You find this an extremely easy option because
the installation wizard asks you whether that’s what your intentions are.
A simple click of the Yes button when prompted — followed by the sev-
eral clicks of Next, Next, and Next — does the deed.

1 Use an existing 2005, 2006, or 2007 database. Your easiest route here is
to first create a backup of your database and then restore it in ACT!
Premium for Web. If you're not sure how to accomplish that feat, you
can read up on it in Chapter 14.

v~ Use an ACT! 6 or earlier database: This option is a bit trickier but
doable. You want to move the ACT! database on to the server and then
open it using the following instructions:

a. Choose Filew>Open.

Here’s where you navigate to the place where you've moved your
database.

b. Choose ACT! 3-6 Database from the Files of Type drop-down list.
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c. Select your database and click Open.

Just relax and put your feet up on your desk for a moment while
ACT! cheerfully converts your database for you.

In most cases, the ASP.NET user is automatically given full rights to the folder
that houses both your ACT! database and all the supplemental folders. How-
ever, it never hurts to double-check that the ASP.NET user does indeed have
full access rights to all these folders.

Web Site Administration tool

If you're familiar with ACT!, you're familiar with ACT! Premium for Web. For
the Administrator accessing the database from the Web server, everything
seems to be safely in the correct place. But wait — those Administrators with
sharp powers of observation might notice something new that’s been added
to the Tools menu: Web Site Administration. The database Administrator
makes use of this tool to specify the database that can be accessed over the
Internet and the name of the Windows account that is used by the remote
users when they first log in to the server.

1. Choose Tools=>Web Site Administration.

The Web Site Administration tool opens, as shown in Figure 21-5.

Web Site Administration

wieb Server | |ser Account | Add/Remove Database | Optiong
ACT! Premium for ‘Web runs on your Wweb server using ASP.MET
An ASP.MET user account must be present for ACT! Premium for
Web ta function onh pour server
Additionally, some software may conflict with the operation of

ACT! Premium for Web. If conflicting software is detected,
additional steps may be required

Click Test ta check pour &5P-MET user account configuration.

Close

2. Click the Web Server tab and then click the Test button.

If all systems are go, you are rewarded with a cheerful message announc-
ing that the test was successful. If the test was unsuccessful, you might
want to head back to the beginning of this chapter and try again.
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3. Click the User Account tab and then click the Edit button.

The Edit User Account window appears. You're asked to supply three
key pieces of information:

e Windows Domain: You can use the drop-down arrow here to select
the domain or workgroup that hosts your ACT! database. By
default, the name of the domain or workgroup that you're logged
into appears.

e Windows User Name: Enter the name of your ASP.NET imperson-
ation user that you set up. See the earlier section, “Making an
ASP.NET of yourself.”

® Password: Enter the password that you assigned to that user.
4. Click OK to close the Edit User Account dialog box.
5. Back at the Web Site Administration tool, click Test.

Hopefully, you're treated to yet another message telling you that the
test was successful. At this point, you could go out and celebrate.
Alternatively, you might stand up, pump your fist a few times, and read on.

6. Click the Add/Remove Database tab.

You have to tell ACT! which database should be added to the Virtual
Directory. Don’t be scared of all the high-tech language; ACT! Premium

for Web has already created the virtual directory and will be more than
happy to move any database(s) into it that you’d like. On the Add/Remove
Database tab, click the Add button to navigate to the location of your
database. After you select the database, you're asked to supply the data-
base user’s name and password. When you get by the gatekeeper with
the correct credentials, the Add/Remove Database tab looks just like
Figure 21-6 — with the name of your database appearing in the data-

base area.
Web Site Administration
‘wieb Server | User ccount | Add/Remove Database | Options
wieb site:
Default *Web Site v
Virtual directories:
ser
| Databases:
. [Database [Host ] Add
Figure 21-6: [Tech Benderst [FP_SERVER ] [ ]
Adding a [ Aenove ]
database to
the virtual
irectory.
directory
|
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7. Click the Test button and hold your breath.

Okay, you don’t really have to hold your breath to proceed, but you
might consider crossing your fingers. You've worked really hard to get
to this point, and now is your chance to see whether your database is
going to fly on the Internet. If the test is successful, your browser opens
up to the ACT! Premium for Web login screen, as shown in Figure 21-7. If
the test proves unsuccessful, you need to replicate all the steps you cov-
ered earlier to see whether you missed one of them.

[ETACT: Promium for Web - Log on - Microsoft Internet Explorer Ten
File Edit View Favorites Tools Help "
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5| hitp:fjtechbenders.comjapff v B s 7
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ACT! Pzt ]

ACT! Premlum for \.Ieb Log on
Type ord, and then clck Lag o

8. Close your Web browser to return to the Web Site Administration tool.
9. Click the Options tab and set the session timeout value.

I guess ACT! saved the easiest step for last because all you need to do
here is set the session timeout option for the remote users. This setting
determines how long they can keep the database open on their browsers
without having to log back in again.

10. Click Close to close the Web Site Administration window.

Inviting Others to the Party

If you've followed this chapter to this point, you've done a really great job
configuring your Web server to house ACT! Premium for Web — or at least
hiring the right person to configure your Web site. Now you get to reap your
rewards, harvest your fruit, and introduce your Web-based database to your
remote users.

Chapter 21: Working with ACT! Premium for Web 363
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The hardware configuration isn’t as important for the remote users as it is
for the Web server. Remote users can use older operating systems, such as
Windows 98 or Windows Me. They can even access the database with an old-
fashioned, dialup connection although a higher connection speed would cer-
tainly prove to be much faster and less frustrating.
CMBER
Remote users don’t have to install any software on their machines because
they access ACT! via their Web browsers. They do, however, need to use
either version 5.5 or 6 of Internet Explorer.

The remote users might also have to change a few of their security settings:

v Accepting cookies (the Web type, not chocolate chip) must be enabled
in Internet Explorer.

v The ACT! Premium for Web site should be added to the Trusted Sites
Zone so that pop-ups won’t be blocked when accessing the database.

v Two ActiveX security controls must be installed to use the ACT! word
processing function: TX Text and Common Dialog.

Remote users also have to make sure the following software is installed on
their machines:

+ Internet Explorer 5.5 or higher
v Adobe Reader 5.0 or later

Vou can’t drive without a license

You need a license for every one of your remote access users. Although the
Administrator can set up as many new users as he’d like, those users can’t
log in to the database unless there are sufficient licenses to go around.
However, if a user is going to access the database both from the office net-
work and over the Internet, he needs only one license.

Can you see me now?

At this point, you're pretty much home free. However, savvy techies — or at
least those that like to ensure that they won’t end up with egg on their little
pointed heads — might want to test out the new Web system before trying it
out on their co-workers. You can test it out by typing your external IP address
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into your Web browser. For added excitement, you can follow the address
with a forward slash and the ASP.NET user that [ show you how to create
earlier in this chapter.

Not sure about that IP address? You can determine the external IP address of
your Web server in a number of ways. The easiest is to pull up your Web
browser, go to one of these sites, and jot down the number provided there:

v WhatlsMylIP.com: http://whatismyip.com

v ConfirmIP.com: www.confirmip.com

For some reason known only to the computer gods, some firewalls or fire-
eating dragons prevent users outside of the network from accessing the static
IP. Unfortunately, you don’t always know that this will happen until you start
receiving frantic phone calls from users who can’t access your database. You
might want to take a trip to http: //babelfish.altavista.com, type in
your IP address, and click the Translate button. If all systems are go, you soon
see the ACT! for Web login screen.

Logging in to ACT! Premium for Web

Remote users access ACT! Premium for Web with the external static IP
address that you determine earlier in this chapter, followed by the name of
the Virtual Directory that houses your ACT! database. A Virtual Directory is a
folder that houses all your Web site data; ACT! Premium for Web creates one
called APFW when you install the program. If you purchase a domain, remote
users might log in to http: //mywebsitedomain.com/APFW, assuming that
you named your Virtual Directory APFW. Alternatively, they might log in with
something a bit more cryptic, such as http://12.34.567.89/APFW.

After you access the Web site, you see the ACT! Premium for Web login
screen (refer to Figure 21-7).

As in all versions of ACT!, you need to provide your correct user name to con-
tinue. You might also request that your Administrator assign you a password
(show him Chapter 15 if he needs a little extra help) to give you a bit more
security.

Feeling a sense of déja vu

From here on out, your remote users should be pretty much on their own. As
you can see from Figure 21-8, ACT! Premium for Web looks, feels, and smells
like its more traditional counterpart.
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Some of you cynics in the crowd dive into ACT! just looking for some minute
differences. I go ahead and make life easy for you by highlighting a few of the
minor distinctions between the two products:

v Administrative functions need to be done on the server. Therefore, the
File and Edit menus are missing in ACT! Premium for Web, and the Tools
menu is abbreviated.

v The Lookup menu is also missing. However, notice the Quick Lookup
feature at the top of the Navigation (Nav) bar. Click the Lookup field to
see a list of all your fields to make life easier should you want to query
any one of your fields. You'll also notice an Advanced Query option
directly under it.

v Companies is now its very own menu instead of being a submenu
under the Groups menu.

v ACT Keyboard shortcuts won’t work.

+ Your top menus belong to Internet Explorer — not to ACT! — because
you're viewing your database via Internet Explorer. Double-clicking
won'’t work, and a right-click brings up an I[E menu — not the ACT! menus.

v Reports run in HTML format.

+* Word processing uses the ACT! word processor. Word is not an
option. Templates use the . tpw extension.

v Synchronization isn’t necessary for ACT! Premium for Web users but
is still available if desired.



Part VI
The Part of Tens

The 5th Wave By Rich Tennant




In this part . . .

Every For Dummies book has a Part of Tens. By golly,
this book is no exception to that rule. Think of this as
the icing on your ACT! cake. Here’s where [ answer a few
of your more burning questions:

»* What in the world is the difference between ACT!
2007 and ACT! 2007 Premium for Workgroups?

v Is there a way that I can have ACT! jump through a
few more hoops for me — or at least add a few
items to make ACT! work even “more better?”




Chapter 22

Ten Cool Things Available Only
in ACT! 2007 Premium
for Workgroups

In This Chapter

Increasing the maximum size of your database
Increasing your security options
Playing with fun features

Sparing your IT department big headaches

A s I mention elsewhere in this book, ACT! has two flavors: ACT! 2007 and
ACT! 2007 Premium for Workgroups. You want to be aware of the basic
differences between the two versions, so here they are.

ACT! 2007 is geared toward either an individual user or a small business user
who has fewer than ten users. Most small environments typically don’t use the
corporate, enterprise features found in ACT! 2007 Premium for Workgroups.
ACT! 2007 Premium for Workgroups contains all the features found in ACT!
2007; however, the Premium version also includes several extra features that
the corporate user might find appealing.

") Users of a shared database must all use the same version of ACT!. A user
of ACT! 2007 can’t open a database created with ACT! 2007 Premium for
Workgroups. However, an ACT! 2007 database can be updated so that it can
be opened by users of ACT! 2007 Premium for Workgroups. A user of Premium
can also copy a Premium database and save it to ACT! 2007 format.

Allows More Users

ACT! 2007 uses the Microsoft Sequel Express version of Structured Query
Language (SQL), which allows a maximum of ten active, named users per
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database. The Premium edition of ACT!, based on Microsoft (MS) SQL Server
Standard Edition, doesn’t place a limit on the number of database users. If you
have more than ten users named in your database, you must use ACT! 2007
Premium for Workgroups. This limitation is imposed by Microsoft, not by ACT!.

Allows More Database Scalability

Wow! That was a mouthful. I know this is a For Dummies book, but I feel oblig-
ated to equip you with all the latest buzzwords. Scalability refers to how well
both your software and hardware can adapt to increased demands. If your
database is more scalable, you probably won’t outgrow your database. The
ACT! 2007 database has a size limitation of 2GB per database. However, ACT!
2007 Premium for Workgroups allows you to far surpass this limitation.

Limits Access to Uarious Contacts

ACT! 2007 has no way of allowing someone access to only a portion of the
contacts in a database. ACT! 2007 considers contacts as either Public (view-
able by all database users) or Private (viewable only by the Record Manager
who creates the record). If you want to limit the contacts that a particular
user sees, you have a couple of options. You can supply the user with his
own database and synchronize just those contacts that he has access to from
the main database, as [ show you in Chapter 16. Or, you can upgrade to ACT!
2007 Premium for Workgroups, which allows access to user records, based
on user and/or team preferences.

ACT! 2007 Premium for Workgroups takes the issue of security one step
further by adding a third level of contact access — limited access. Database
Administrators and Managers can allow users — or teams of users — to access
these limited access contacts on a contact-by-contact basis. That means that a
salesman might see only the customers in his own territory, the sales manager
could access all customers but no vendors, and the president could access the
whole kit and caboodle. ACT! 2007 Premium for Workgroups throws in cascad-
ing access as well; this means that if you aren’t allowed to access a contact
record, you won’t be able to see hide nor hair of that contact in all areas of
ACT!, including group and company records and sales opportunities.

Includes Field Level Security

Field level security secures fields from being accessed by specific users or
teams of users. ACT! 2007 has an all-or-nothing mentality: All users can either
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have full or read-only access to a field. ACT! 2007 Premium for Workgroups
expands this concept by allowing Administrators and Managers to decide
which users are allowed to access any given field. For example, the account
manager may have the ability to edit a customer’s Account Number, sales-
people may be allowed to view the Account Number but not change it, and
other users might not even be able to view Account Numbers.

Group Scheduling

The Group Scheduling feature in ACT! 2007 Premium for Workgroups allows
you to check the availability of database users and shared resources when
scheduling activities. When you schedule an activity with another user of the
database, that user receives an invitation to the scheduled event. The user
has the discretion of accepting or declining the invitation; the response is
then noted on the calendar of the contact who originally scheduled the activ-
ity. When scheduling an activity, you can actually view the availability of all
database users by going to the Availability tab of the Schedule Activity dialog
box. Shared resources, such as conference rooms and audio-visual equip-
ment, can also be viewed and scheduled in the same way.

Customizable Opportunity Fields

You can rename any of the eight, customizable Opportunity fields that come
with both versions of ACT!. Both versions also allow you to add a drop-down
list in the Reason, Referred By, and Competitor fields found in the Opportunity
Info tab. In ACT! 2007 Premium for Workgroups, you can customize these 11
fields even further by specifying the field attributes. For example, you could
rename one of the fields Credit Card Number and specify that only numbers can
be imputed into that field.

Advanced User Settings

In Chapter 4, I explain the art of adding new users to your database. Again,
this procedure is performed in exactly the same way for both ACT! 2007 and
ACT! 2007 Premium for Workgroups. ACT! 2007 Premium for Workgroups
gives you a few more options that large organizations might find appealing.
These options allow you to Export to Excel, delete records, and sync to hand-
held devices and accounting software.
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The ACT Scheduler

[ like to think of the ACT! Scheduler as the set it and forget it feature because
that’s exactly what you do: You set up your scheduled maintenance tasks
and then forget about them. This Premium feature allows Administrators and
Managers to schedule database maintenance and backups on an hourly, daily,
weekly, or monthly basis. The ACT! Scheduler runs as a service, so the task
runs even if your database isn’t open; however, you do need to make sure
that your computer is turned on!

The end user can also take advantage of the ACT! Scheduler. In addition to
scheduling the routine maintenance tasks mentioned earlier, the Scheduler
can be used to automatically synchronize your database if you're a synchro-
nization user. You can even schedule two flavors of synchronization: the ACT!
synchronization that I discuss in Chapter 16 and the Outlook synchronization
that I mention in Chapter 17.

Integrates with ACT! for Web

I mention earlier that all users sharing a database must use the same version
of ACT!. However, ACT! 2007 Premium for Workgroups and ACT! for Web is
the exception to this rule. ACT! for Web interfaces with ACT! 2007 Premium
for Workgroups. Some of your database users can access ACT! from their
browsers, and others can access the database from network workstations
with ACT! 2007 Premium for Workgroups. If you're even considering using
ACT! for Web, you want to start with ACT! 2007 Premium for Workgroups.
Then if and when you upgrade to ACT! for Web, you won’t have to worry
about converting your database to a different format.

Internet Sync

Both versions of ACT! have two methods of synchronizing remote data.

(You can read more about data synchronization in Chapter 16.) Both methods
require that the synchronized database can directly access the master data-
base either through a direct network connection or remotely via a Virtual
Private Network (VPN). Additionally, ACT! 2007 Premium for Workgroups
includes a third method of synchronization — Internet synchronization. If
your server is set up with Internet Information Services (1IS), your remote
users can sync their information back to the master database as long as they
have Internet connectivity.



Chapter 23

Ten Tips to Make ACT!
Work Better

In This Chapter

Getting help from an expert
Joining a User Group
Linking ACT! to other devices and software

Checking out various ACT! add-on products

If you’ve read this book to this point, you know about the various powerful
and timesaving features that you can find in ACT!. Still, I believe that you
can never have too much of a good thing. With that thought in mind, here I
give you ten suggestions that help ACT! to work even better — if that’s possi-
ble. Although most of my suggestions include a price tag, you'll find that all
the products that I mention have an amazing high ROI (return on investment).

A plethora of great ACT! add-on products are available; limiting myself to talk-
ing about just a few is extremely difficult. I look for two things in a software
vendor — innovative ideas and great service. | include only those vendors
with whom I've had personal experience; I know that these products work
and that the service and support are reliable. Most importantly, all my sug-
gestions can help you take ACT! to the next level.

Feel free to visit the products page on my Web site, http: //techbenders.
com, to read about these and other products as they become available.

Augmenting Your ACT! Knowledge

[ like to say that ACT! is kind of a “good news, bad news” product. The good
news is that ACT!’s MSRP (manufacturer’s suggested retail price) is fairly
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inexpensive; the bad news is that ACT!’s retail price is fairly inexpensive. You
might assume that because this software’s price is low, it’s a fairly easy prod-
uct to master.

ACT! is a very powerful tool. And, although the basic elements that I cover
in this book are pretty easy to master, many complex processes are running
behind the scenes that require advanced Windows knowledge that are beyond
the scope of this book. These two suggestions are not products per se but
rather are advice for maximizing your ACT! experience.

Hire an expert

ACT! Certified Consultants (ACCs) like myself continuously hone their ACT!
skills. An ACC helps ACT! users discover the full power of the program. In
addition to showing you various tips and tricks, consultants can help clients
use the program to its fullest potential. You can find a local consultant by
choosing Help=>Service and Support=>ACT! Consulting from any ACT! screen.

Some ACT! consultants also have an additional certification as an ACT!
Premier Trainer (APT). An APT can help you customize your database and
also help you discover how to use it. You can find a list of APTs by going to
www.act.com/partners/apt.

Join a User Group

Joining an ACT! User Group is a great way to further hone your ACT! skills.
Regular attendees find invaluable information about ACT! and ACT! add-on soft-
ware at meetings. They also get tips and tricks from other ACT! software users.
Attendees find User Groups to be a really great way to stay updated on new
and innovative ways to use the ACT! software for their businesses and to test-
drive some of the add-on products before actually purchasing them.

[ run an online ACT! User Group where ACT! fanACTics regularly hang out to
find out more about ACT!. You can register for one of our meetings by visit-
ing http://techbenders.com/usergrp.htm. Prefer getting out of the
office to attend a meeting? Don’t worry; User Groups are in virtually every
state of the union. To see whether a User Group is in your area, go to
http://act.com/community/usergroups/find.
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Improving Your Reporting

For many of you, entering data into ACT! is only half the fun; the other half is
getting that data back out again in a usable format. The typical way that most
users want to view their data is in a report.

ACT! comes with an amazing array of reports right out of the box. In Chapter
9, you can read just how easily you can tweak those basic reports. Because
variety is the spice of life, you might find yourself wandering outside the box
and hankering for a different report. The ACT! Report Designer is both power-
ful and very complex. Some of the more complex reports that involve multi-
ple levels of grouping, filtering, and sorting are beyond the scope of this book
because they require a certain level of programming skill. Consequently, you
might spend a lot of time trying to develop the report of your dreams and
come up empty-handed and frustrated.

Don’t fret. Roy Laudenslager, who just happens to be the technical editor of
this book, is the ACT! report guru. From years on the front line as a technical
support specialist for ACT!, he has a good idea of the types of reports that
the typical user looks for. This experience led him to develop Royel’s Reports
(a collection of over 20 customized reports) and Royel’s Labels (an assort-
ment of everything from Rolodex cards to home mailing labels). Roy has even
included a label that gives you the option of using either the contact’s main
or home address on the label.

Linking ACT! to Other
Products or Devices

No man is an island; I guess that logic holds true for databases as well. Maybe
you need to take your database with you on the road. Or maybe you envision
a streamlined office environment in which crucial data is keyed in one time
and then miraculously appears in the various other software products that
you use in your office. Never fear! With ACT!, almost anything is possible.

Link ACT! to your PDA

Who doesn’t use a hand-held these days? They’re great for people on the
go, and ACT! lets you take your database along with you. And, if you believe
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that the best things in life are free, you’ll be happy to know that ACT! 2007
includes both the ACT! Link for Palm OS and the ACT! Link for Pocket PC right
on the installation CD.

These links allow you to sync your ACT! information (including notes and his-
tory) with your hand-held device in just seconds. Your ACT! information syn-
chronizes to the basic fields that are included with the Palm or Pocket PC,
such as phone numbers and address information.

ACT! links allow you to

v Map basic ACT! Contact fields including phone numbers, snail mail,
e-mail addresses, several custom ACT! fields, and the ID/Status field.

v Synchronize ACT! contact notes and histories for each ACT! contact.

v Synchronize a select group of contacts when you use the Group feature
in ACT!.

In addition, mini-versions of ACT! are available for Palm, Pocket PC, and
BlackBerry hand-held devices. These mini-versions of ACT! allow you to view
your customized ACT! fields. You can schedule activities and create notes
exactly as you do in the full-blown version of ACT!.

Link other software to ACT!

Most business owners need at least two pieces of software to run their
business: database software to keep track of customers and to market to
potential customers, and accounting software to help keep an eye on the
bottom line. Other businesses make use of proprietary software designed for
their specific industry to track anything from inventory to Internet leads.
Unfortunately, a single piece of software that does it all often comes with a
whopping price tag and a very steep learning curve. As a result, maybe you
chose to use ACT! for your contact management and one of two other prod-
ucts for the other aspects of your business.

Enter the folks at Information Optics Corporation (I0C). IOC has developed
a way to link and synchronize data from just about any source to and from
ACT!. For example, loan originators who use Calyx Point and Genesis can
have their data flow seamlessly between the two products. Or, users of
QuickBooks can have not only their contact information synchronize
between the two pieces of software, but they can also have QuickBooks
invoice information flow into ACT! opportunities and vice versa. Have a pro-
prietary Access database? IOC can get the two programs talking seamlessly
to one another.
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Sending E-Mail Blasts

In Chapter 11, I talk about mail merging and also mention some of the pit-
falls you might encounter when attempting an e-mail blast. A common prob-
lem is not knowing how to create cool-looking HTML (HyperText Markup
Language) templates. Well, worry not, my friends. One of my favorite prod-
ucts, SwiftPage Email (www. swiftpageemail.com), can help speed you on
your way — or to at least speed your e-mail blast to your customers.

[ highly recommend using SwiftPage Email to help you with large-scale
e-blasting. Although SwiftPage is fully integrated with ACT!, your actual e-mail
is sent via the SwiftPage servers. Large companies like this concept because
their internal e-mail servers don’t have to handle a large amount of e-mail
running through them. Small office users like this concept because of the
restrictions that are sometimes placed on them by their Internet service
providers (ISPs). SwiftPage includes dozens of customizable templates that
take the hassle out of working with HTML.

SwiftPage also provides you with lists of bounced, forwarded, click-and-
opened, and opt-out e-mail addresses. With the addition of SwiftPage Pro for
ACT!, you're given a tool to mail merge custom fields, create custom branded
surveys, schedule e-mails to send at times you provide, and download all
click-and-open data into ACT!.

SwiftPage is sold on a monthly subscription basis. Pricing, which is generally
a great bargain, is determined by the amount of e-mail that you send.

Automating Your Sales Process

Northwoods Technology is the developer of several really cool add-on prod-
ucts. Northwoods has been working with ACT! for years and often includes
some freebies that are available for download. My most favorite of the
Northwoods products include

1 Sales Automation Mania (SAM): Think of this as the Activity Series on
steroids. The Activity Series reminds you that certain tasks need to be
completed on specific dates. SAM literally does your work for you by
automatically printing your mail merges, sending your birthday greet-
ings, or e-mailing your newsletters in the middle of the night.

v Mail Merge Mania: ACT! is great if your e-mail marketing consists of
100 or fewer contacts. However, when you decide to send hundreds —
or thousands — of e-mails a day, you’ll start running into all sorts of



378 Partvi: The Part of Tens

problems, including duplicate or inaccurate e-mail addresses, bounces,
un-subscribes, and even limitations on the number of e-mails that your
ISP lets you send. This product is an inexpensive way to help you over-
come those barriers.

v Google Desktop: This product integrates Google Desktop Search into a
Contact tab in ACT! 2007. Just click the Desktop Search tab to instantly
see all e-mails, files, and Web history related to that current contact,
whether that information is stored on your computer or on the Internet.

Grabbing Tidbits of Information

Like many of you, I have been using ACT! for years, but I couldn’t live with-
out a few add-on products. eGrabber products ranks high on my list of must
haves. Basically, if you can see the information, you can use eGrabber to grab
that information by highlighting it, clicking a button, and then having it magi-
cally appear in ACT!.

[ use Address Grabber to take signatures from incoming e-mail messages

and Web response forms and to automatically create a new ACT! contact.
Recruiters use Resume Grabber to capture résumés from online sources, such
as Monster, to pull them into ACT!. And realtors use List Grabber to snag list-
ings off the Internet and plunk them instantly into ACT!.

Checking Your Dashboard

Staying on top of a database that only contains a few hundred contacts

is pretty easy. However, when you have thousands — or even tens of
thousands — of contacts and many users entering data, it’s easy to feel that
you and your data are spiraling out of control. TopLine Dash allows you

to view and analyze any and all of your company’s data with ease. The infor-
mation can be viewed in a series of customizable dashboard windows or
exported to Excel or PDF format to make ACT! reporting a snap!

In Chapter 9,  mention an ACT! reporting limitation that makes it pretty much
impossible to combine various tables into a single ACT! report. TopLine Dash
lets you overcome this obstacle. For example, the ACT! Report Designer is
hard-pressed to show you all the activities associated with your largest sales
opportunities over the course of the last month; ironically, this is one of the
16 out-of-the-box templates that comes with TopLine Dash.
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Overcoming Some ACT! Weaknesses

[ love people who listen. Jim Durkin of Durkin Computing is one of those
people. No matter how great the software, you always have times when you
have to shake your head and wonder, “What were they thinking?” Other
times, you might wonder how a seemingly easy feature could have been over-
looked. Jim listened to a whole lot of ACT! users and came up with a couple
of very slick products. Best of all, he compiled seven of his products into a
package that saves you 50 percent off the original retail prices.

Here’s a rundown of a few of my favorites:

v~ Associator: Although ACT! isn’t a true relational database (that is, a
database that allows you to view contacts in a one-to-many scenario),
the Associator surely makes ACT! feel like one. By adding an Associator
tab to the contact screen, you can set up an unlimited number of free-
form associations between contacts and group them by type. For exam-
ple, you might pull up the contact record for an attorney and want to see
a list of your clients that use his services. You might also want to see a
list of all the clients you have referred to him. Finally, you might want to
see all the clients that he referred to you. All those associations — and
then some — can be viewed on the Associator tab.

v~ Contact List Plus: Quite simply, Contact List Plus allows you to save
lookups to the Contact List. Too, it allows you to color-code certain
contacts based on your criteria. You might not think this is a big deal
until you keep pulling up a list of all your contacts in four states who
have e-mail addresses and you want to divide them into the hotshots,
prospects, and deadbeats — and see all your information at a glance.

v ACT! Memory Manager: Unfortunately, new software isn’t built for
old hardware. If you find yourself in a situation where ACT! is running
sl-0-0-ow, you might want to try ACT! Memory Manager.

v Calendar View Plus: The good news is that a ton of loyal ACT! users are
wandering this Earth. The bad news is that those same users get quite
upset with change. You might find yourself disliking the new ACT! calen-
dar and longing for the old one. In addition to including an easy-to-see
calendar, Calendar View Plus adds some great new functionality includ-
ing the ability to schedule multiple users or resources in one handy-to-
view calendar. If you are scheduling anything from nail appointments to
appliance repair, you need this product.
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Enhancing ACT!: Those Little
Things That Count

Geoff Blood of The New Hampton Group modestly calls his products enhance-
ments rather than add-ons. Whatever the name, Geoff offers over 20 of these
little puppies at ridiculously low prices. Here are a few of my favorites:

v AutoFill ACT! Fields loads any number of ACT! fields with values deter-
mined by the contents of another field.

1 Copy Fields Contents duplicates the contents of one or more sets of
ACT! fields into other sets of fields on the same ACT! record.

v~ Joint Salutation creates a salutation for couples, partners, agents, or
any pair of fields.

1 Layout Manager switches the ACT! layout based on a field value on the
contact, group, or company record.

+* Lookup Contacts in Companies creates a lookup of all the contacts
belonging to the current company (or group) lookup.

Saving Yourself Time

With all the great ACT! add-on products that are available, [ can’t keep up
with them all. However, | do mention several companies by name because
of their long-standing love for the ACT! community. Exponenciel (www .
exponenciel.com) offers some great, free add-ons that you might want to
check out as well as a couple of really cool fee-based products:

v Excel Templates with Quote/Invoice Maker makes generating quotes
and invoices a snap by merging sales opportunity data into your Excel
spreadsheets.

v AutoNumbers For ACT! Records automatically gives your contacts,
companies, and/or groups a unique account number and your opportu-
nities a unique quote number.

1 Automatic Field Calculations gives you the ability to perform calcula-
tions ranging from the most basic to the most complex, using the con-
tent of one or more of your fields.
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Internet synchronization, 372
limits access to contacts, 370
Opportunity fields, customizable, 371
Scheduler, 372
standard version versus, 13
users, maximum number, 369-370
ACT! User Group, 374
activities
company, associating, 346-347
lists, 60
types, adding custom, 194-196
Activities report, 122
Activities tab
clearing, 112-114
editing, 112
multiple activities, clearing, 113
Outlook calendars, viewing, 284-285
viewing, 111-112
activity series
described, 114-115
modifying, 118
scheduling, 117
template wizard, 115-117
triggers, 185
Address Grabber, 378
addresses
contact field, 49, 182
editing, 173
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addresses (continued)
incoming e-mail, grabbing from, 378
printing, 130-132
Adjusted for Probability report, 125
Administrator, database. See also database
maintenance
described, 17, 31
fields, adding to database, 178, 180
passwords, setting, 32
remote database, setting up, 257, 260-261
sync set, creating, 257-260
updating shared database, 37
user access, controlling, 234, 236
Advanced Query, 88-90
alarm, schedule
clearing, 112
setting, 104, 105, 116
aligning
anchor field, 208
fields, 140, 208-209
labels, 208-209
Allow Blank field, 183, 207
anchor date, 116, 117
anchor field, 140, 208, 209
Annual Event, 83-84, 105, 183
AOL (America Online), 166
application. See program
appointments. See scheduling
APT (ACT! Premier Trainer), 374
ascending order, sort, 63
ASP.NET, impersonating, 357-358
Associator tab, 379
asterisk (*), 77
attachments
ACT! database to Outlook, 276-277
documents to note on History tab, 160
files to contact record, 94
synchronization changes, 255
AutoFill ACT! Fields, 380
Automatic Field Calculations, 380
AutoNumbers For ACT! Records, 380

ol e

Back and Forward bar, 23
backups
basic, 218
deleting contact records, 57
described, 217

restoring data, 219-220

to various media, 218-219
Birthday List, 125
blank contacts, 48
blank sections, reports, 146
blasts, e-mail, 377
Browse user security role, 233-234

oo

calendar
current day’s activities, 106
mini-calendar, 108

Navigation page icon, replacing, 38

preferences, 35-36
printing, 133-134
Recap List, 108-109
synchronization changes, 255
viewing, 106-107, 285
calendar, Outlook (Microsoft)
Activities tab view, 284-285
described, 282
removing activities, 283-284
synchronizing with ACT!, 283
Task List view, 285
viewing ACT! activities, 285-286
Calendar View Plus, 379
calls, 102, 116
Can Spam laws, 171
CD/DVD burner, 219
character field, 182
city, sorting contacts by, 63
classes, 316
clients, 245
closing dates, opportunity, 302
color
activity, adding, 116
layout, 21, 207
Notes and History tabs, 100
preferences, 35
scheduling, 104
columns
lists, adding or removing, 62
printing lists and tabs, 134
width and order, changing, 63
Communication preferences, 36
companies

associating note, history, activity, or

opportunity, 346-347
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Company Detail window, 333-334
Company List, 331-332
Company tab, 330-331
contacts, linking, 339, 340, 342-344
contacts, looking up, 380
deleting, 336
described, 329-330
division or subdivision, creating, 335
files, accessing, 347
forming new, 334
group, converting to, 336-337
lookups, 78-79, 337
notes, adding information to, 94, 345-346
Opportunities by Company report, 126
reports, 347
rules, 339-340
single contact, associating, 338
Company Detail window, 333
Company List, 60, 331-332
Company tab, 330-331
competitors, 125, 300
Computer Management window, 358-360
confirming schedule, 104
consistency in data entry
copying/moving, 225-226
global edit/replace, 228-229
synchronization, 256
Contact Detail window, 16, 23, 327
Contact Directory, 122
contact fields. See also drop-down lists
adding, 49, 180-185
concept described, 177-179
deleting, 185
planning, 179-180
securing access, 186-188
Contact List
described, 60
finding contacts, 65
lookups, saving, 379
sort order, changing, 71-72
tagging contacts, 65-66
viewing, 64-65
Contact List Plus, 379
Contact Report, 122
Contact Status report, 123
contacts
activity lookup, 84-86
adding, 47-51
appointments, scheduling with, 101-106

changing, 57
deleting records, 55-57
described, 60
drop-down lists, 53-55
formatting, 51-53
Gross Margin by Contact report, 126
importing from Outlook, 248, 274-275
information, showing during mail merge,
155
linking to company fields, 342-344
Opportunities by Contact report, 125
Outlook creating, 281-282
synchronization changes, 255
viewing scheduled activities by, 105-106
Web site, viewing, 286
Contacts tab, Company Detail window, 333
Contents tab, Help system, 26
corruption, database maintenance, 215
Create Date, 47
credit card number fields, securing,
186-188
currency field, 182
current day’s activities, 106
custom activity, 116
custom fields, 139
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daily activities, scheduling, 105
Daily calendar, 106, 107
dashboard, 378
data entry, consistency
copying/moving, 225-226
global edit/replace, 228-229
synchronization, 256
database
ACT! Premium for Web, 360-361
ACT! 2007 features, 12-13
attaching ACT!, 276-277
creating new, 29-32
dashboard, checking, 378
key terms defined, 12
naming, 31
opening, 15-17
password, 31
scalability, ACT! 2007 Premium for
Workgroups, 370
supplemental files, 17
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database Administrator. See Administrator,
database
database maintenance. See also backups;
housecleaning
corruption, 215
frequency, 214
importance, 213
routine tasks, 215-216
updates, 221-222
date
contact field, 53, 183
formatting, 53
note, changing, 93
opportunities outcome and closing,
recording, 302
opportunity field, 300
Opportunity List, filtering, 306
ranges in reports, 128
rescheduled activities, 112
synchronization expiry, 269
decimal field, 182
default database location, 16
default value field, 184
deleting
activities, 283-284
company, 336
contact records, 55-57, 185
criteria from lookup, 89
data, 226-227
database, 227
fields or field labels, 139, 200
note or history, 99-100
Secondary Contacts tab, 68
tabs, 203
descending order, sort, 64
design. See layouts, modifying
detail, report, 145
Details tab, opportunities, 299-300
Dialer feature, 36
discounts, 299
Divider bar, 24
Division field, Company Detail window, 333
division or subdivision, creating, 335
document
attaching to note on History tab, 160
described, 60
mail merge template, 152, 154-157
Word, attaching to contact record, 292

Documents tab

adding, 70

described, 69

opening, 70

removing, 71
domain, registering, 355
drawing tools, 210-211
drop-down lists

associating with field, 189

Contacts, 53-55

creating, 189-191

described, 188-189

Excel, importing, 290

Process List, 193-194

Product List, 191-192

synchronization changes, 255
duplicate contacts, removing, 222-224
duration, scheduling, 103
Durkin, Jim (Durkin Computing ACT!

products), 379

dynamic members, 321-323, 339

oF o

editing
Activities tab, 112
addresses, 173
criteria in lookup, 89
e-mail, 279
envelopes, 147-148
global edit/replace, 228-229
History tab, 99-100
labels, 147-148
notes, 99-100
opportunities quote, 304-305
priority types, 196
tabs, 203
edit/replace, global, 228-229
eGrabber products, 378
e-mail
ACT! contacts from Outlook, 276, 279-281
blasts, sending, 377
client, 165
editing addresses, 173
editor, disabling Word as, 279
field, 183
HTML template, 157
incoming, grabbing addresses from, 378
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individual contacts, 169-170
list, 125
mass, 170-173
Outlook contacts, 276
preferences, 36, 166168
program, choosing at installation, 30
sending to contacts, 168-169
systems, supported, 165-166
Word document, sending, 292-293
Empty Field, 76
enhancements, 380
envelopes
creating, 129-130
editing, 147-148
printing, 160
error messages, 215
Excel (Microsoft)
ACT! fields, mapping to, 290-291
list, exporting to, 248, 288-289
Opportunities List and pivot tables, 289
opportunity quotes, 303
product or drop-down list, importing, 290
templates with Quote/Invoice Maker, 380
Exponenciel add-on products, 380
exporting data, 248
external hard drive, 219

ofF e

fax

cover page template, 153

list, 125

Word document, sending as, 293
Feature Tours, Help system, 26
field

copying, 380

custom, 139

defined, 12

deleting, 139, 200

format field, 184

length field, 184

Reporter Designer toolbox, 137

security level, 243-245, 370-371
field label. See labels
Field Name, 76
files

attaching to contact record, 94

database supplemental, 17

defined, 12
importing information, 249-250
personal supplemental, 17
remote data, delivering, 261
filter
calendars, checking, 106
Opportunity List, 306
Private, Timeless, Cleared, and Outlook
activities, 111
tabs, 61
folder, database, 31, 217
fonts, 21, 35, 100
footer, report, 145
forgotten password, 34

oG o

General settings, preferences, 35
Generate History field, 183
Getting Started Wizard, 27, 29-31
global edit/replace, 228-229
Google Desktop, 378
graph, opportunities, 125, 309-311
graphics
layout, 21, 210
mail merge, 157-158
gross margin reports, 126
group
common elements, 317
company, converting to, 336-337
creating, 317-319
customizing, 323-324
described, 61
dynamic members, creating, 321-323
history, 97, 327-328
notes, using with, 94, 326-328
Opportunities by Group report, 126
reasons to create, 315-316
reports, 124
scheduling activities, 324-326
static members, adding, 319-321
Group Detail window, entering note from,
327
Group List, 60
Group Scheduling, 371
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hardware
ACT! Premium for Web, 353
memory, managing, 379
remote access user configuration,
363-364
header, report, 145
hiding sections, 147
Hierarchy field, Company Detail window,
333
history field
company, associating, 346-347
creating from e-mail, 281
described, 60
fields, formatting, 53
group, 97, 327-328
opportunities, 307
options, setting, 277-278
synchronization changes, 255
History Summary Class report, 123
History Summary report, 122
History tab
clearing activity histories, 96-97
described, 94-95
editing, 99-100
field histories, creating, 95-96
manually recording a history, 97-99
result option, 114
History Time Spent report, 123
housecleaning
copying or moving contact data, 224-225
deleting database, 227
duplicate contacts, removing, 222-224
global edit/replace, 228-229
importance, 222
removing data, 226-227
before synchronizing, 256
tips, 229-230
HTML (HyperText Markup Language),
e-mail, 157
hyperlinks
company contacts, 341-342
Internet, 287
Web site, contacts’, 286

o]e
icon bar, 38-40
ID/Status field, contacts, 49
IIS (Internet Information Server), 354,
356-357
IMAP protocol, 166
importing information, 248-252, 274-275
Index tab, Help system, 26
Information Optics Corporation (I0C), 376
initial-caps field, 182
Internet
contact Web site, viewing, 286
links, 287
synchronization, 372
Web page, adding to contact, 287-288
Internet Guest Account (IUSR), 357
Internet Information Server (1IS), 354,
356-357
Internet Mail, 167
IOC (Information Optics Corporation), 376
IP address
server, finding, 365
static, 355
ISP (Internet Service Provider)
bulk e-mail, 377
mass e-mails, checking rules on, 171
protocols, 166
IT department, advantages of ACT!
Premium for Web, 352
IUSR (Internet Guest Account), 357

° ] °
Joint Salutation, 380
oo

keyboard shortcuts, 22
keyword, lookup by, 81-83

o/ o

labels
changing, 206-207
creating, 129-130, 148-149
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deleting, 139, 200
editing, 147-148
mail merge, 155
naming, 31
laptop computer, 219
Layout Manager, 380
layouts, modifying
adding new fields, 201-202
aligning fields and labels, 208-209
color, adding, 21, 207
drawing tools, 210-211
field label, changing, 206-207
fields, arranging, 198-200
fonts, 21
logo or graphics, adding, 21, 210
minor touch-up work, 205-206
order, changing, 203-205
planning, 197
resizing fields, 209
synchronization changes, 255
tables, building, 212
tabs, changing, 202-203
text boxes, 211
left alignment, 208
legible text color choices, 35
letter template, 153
licensing remote access users, 364
linking
companies and contacts, 339, 340,
342-344
to other software, 376
to PDA, 375-376
listings, Internet, 378
lists. See also Contact List
adding or removing columns, 62
column order and width, changing, 63
customizing, ease of, 61
Excel, exporting to, 248, 288-289
finding, 59
most commonly used, 60
of names, mail merge, 152
printing, 134
sorting, 63-64
login
remote access users, 365
screen for ACT! users, 17-18
logo, adding to layouts, 210

lookup

Advanced Query, 88-90

Annual Event fields, 83-84

companies, 78-79, 337

by contact activity, 84-86

criteria, adding, 76, 89

described, 20, 55, 73-74

fields, using, 178-179

groups, 77-78

by keyword, 81-83

Lookup By Example function, 86-88

opportunities, 79-80, 301

report, preparing, 126

saving to Contact List, 379

special, 80-81

steps, 74-77

sync set, 267

synchronized data, viewing last, 266-267

Task List, 110

wild cards, 77
Lookup By Example function, 86-88
Lost Opportunities reports, 125-126
lowercase field, 182

ol o

mail merge
described, 151-152
document template, 152, 154-157
graphics, 157-158
sending document to single member of
database, 158-160
wizard, 160-164
word processor, choosing, 152-153
Word, showing fields, 293
Mail Merge Mania, 377-378
main database, synchronizing
delivering remote data, 261
described, 17
enabling, 257
remote database, creating, 260-261
sync set, defining, 257-260
maintenance. See database maintenance
Manager user security role, 234
master database, 253, 269
media, backups to various, 218-219
meetings, 102, 116
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membership, group, 124
memo field, 182
memory, managing, 379
menu bar, 22
menus
additional items, adding, 41
custom command, adding, 41-43
ease of changing, 40
Microsoft. See individual products listed by
name
monthly activities, scheduling, 105
Monthly calendar, 106
monthly reports, 128
moving
contact data, 224-225
fields, 140
tabs, 203
multiple activities, clearing, 113
multiple-page sections, 146
My Computer, dragging and dropping files
from Documents tab, 70
My Record field, 18-19, 155

o\ o

names of contacts
automatic formatting, 52
combining for mail merge, 152
continuous list, tagging, 66
group lookups, 78
mail merge, 152
scheduling with, 103
naming
database, 31
field label, 31
User Fields information, importance of
changing, 25
narrow lookup, 76
Navigation (Nav) bar, 24, 37-38
networking
described, 245-246
workstations, padding, 246
Non-Empty Field, 76
notes
adding, 92
associating companies, 94, 345-347
described, 60, 91-92
editing, 99-100
group, using with, 94, 326-328

synchronization changes, 255

working with, 93-94
Notes/History report, 122
number field, 182

o () o

online Help system, 25-27
Online Manuals, Help system, 26
opportunities
company, associating, 346-347
creating, 295-296
customizable fields, 371
described, 60
Details tab, 299-300
graph, creating, 309-311
history, 307
initiating, 296-301
lookup, 79-80, 301
modifying, 301-302
Opportunity Info tab, 300-301
outcome and closing date, recording, 302
pipeline, viewing, 311-313
products or services, adding, 298-299
quote, converting to, 302-304
quote, editing, 304-305
reports, 126
single contact, reporting, 308-309
status report, 125
synchronization changes, 255
User Fields tab, 299
viewing Opportunity List, 305-307
Opportunities List, Excel (Microsoft), 289
Opportunity Info tab, 300-301
Opportunity List
defined, 60
filtering, 306
lookup, 79
opening, 305
printing, 307
resetting filters, 306-307
viewing, 305-307
Outlook Express (Microsoft), 166
Outlook (Microsoft)
attaching ACT! database, 276-277
calendars, sharing, 282-286
choosing, 168
contact, creating, 281-282
disabling Word as e-mail editor, 279
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e-mailing contacts from, 276, 279-281

history, creating from e-mail, 281
importing contacts, 248, 274-275
Outlook Express versus, 166
reasons to integrate, 273-274

setting ACT! history options, 277-278

versions, 273

opPoe

page break, report, 146
password
changing, 33-34
database, 31
logging into ACT!, 17-18
setting, 32-33
user security, establishing, 235
PDA, 375-376
percent sign (%), 77
permissions, setting user, 235
phone field, 183
Phone List, 122
picture
contacts field, 183
Reporter Designer toolbox, 137
pipeline report, opportunities, 125,
311-313
pivot tables, Excel, 289
plain text, e-mail template, 157
Pointer tool
layouts, customizing, 200
Report Designer, 137
preferences
Calendar & Scheduling, 35-36
Colors & Fonts, 35
Communication, 36
e-mail, 36
General settings, 35
pre-set, 34
Startup options, 36-37
price discounts, 299
Primary field, 183
printing
address book, 132
calendar, 133-134
envelope for contact, 160
lists and tabs, 134
Opportunities tab, 308
Opportunity List, 307

quantity, envelopes and labels, 129
synchronization settings, 267-268
Task List, 110-111
priority
activity, adding, 116
scheduling, 104
types, editing, 196
private opportunities, 306
Private, Timeless, Cleared, and Outlook
activities, 111
probability, opportunity, 125, 306
process, filtering Opportunity List by, 306
Process List, managing, 193-194
product list, 191-192, 290
products
Gross Margin by Product report, 126
opportunities, 298-299
sales, finding, 79
program
e-mail, choosing at installation, 30
linking to other, 376
triggers, 185
protocols, ISP, 166

.Q.

query. See lookup
quote, converting opportunities to,
302-304

o R o

real estate listings, 316
reason, lost opportunities report, 125
Recap List, 108-109
record, 12, 20-21
Record Creator, 47
record level access
assigning to contacts, 240-242
described, 238-239
finding contracts by, 242-243
teams, 239-240
Record Manager
described, 47
Lost Opportunities by Record Manager
report, 126
Opportunities by Record Manager report,
125
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Opportunity List, selecting, 306
pairing with opportunity, 300
sales analysis by, 125
sales, finding by, 79
users, setting up as, 231
rectangle, Reporter Designer toolbox, 137
recurring activities, scheduling, 105
referrals, Opportunities Referred By
report, 126
Referred By field, 49, 300
remote access users
hardware configuration, 363-364
licensing, 364
logging in, 365
synchronization, 253
testing, 364-365
using, 365-366
remote database
creating, 260-261
described, 253
disabling, 269
re-creating, 268
setting up, 257, 260-261
synchronization, 262-263
removing. See deleting
replacing

database entries with global edit/replace,

228-229

lookups, 76

reports. See also envelopes; labels
adding fields, 141-143
address books, printing, 130-132
calendars, printing, 133-134
company, 347
content, changing, 135-139
creating Quick Reports, 134
custom field, creating, 140-141
defining sections, 145
described, 121-126
designing, 135
existing fields, working with, 139-141
group, 124
hiding sections, 147
improving, 375
modifying sections, 146-147
running, 126-129
saving, 138

summary field, adding, 143-144
rescheduling activities, 112
resizing

fields, 140, 209

report sections, 145
resources, scheduling, 103
Restricted user security role, 234
résumés, 378
ring alarm. See alarm, schedule

oS e

Sales Analysis by Record Manager report,
126

Sales Automation Mania (SAM), 377
Sales by Reason report, 126
sales, potential. See opportunities
sales process

automating, 377-378

recording in field histories, 95
Salutation field, contacts, 49
saving

e-mail documents, 159

layout changes, 199

lookup as group, 78

reports, 138
Schedule For activity, 116
schedule for/by task, 104
Scheduler feature, 246-248, 372
scheduling

activities, 101-106

activity series, 117

Calendar View Plus, 379

group activities, 324-326

preferences, 35-36
Search tab, Help system, 26
searching for contacts. See lookup
Secondary Contacts tab

adding, 67-68

deleting, 68

described, 61, 66-67

promoting, 68-69
security. See access control
seminars, 316
servers

described, 245

IP address, finding, 365
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Service and Support tab, Help system, 27
services, 298-299
single contact
company, associating, 338
opportunities, reporting, 308-309
SMTP/POP protocol, 166
software. See program
sorting
Contact List order, 71-72
contact lists, 63-64
fields, 178-179
user lists, 232-233
Source of Referrals report, 123
spam, 171
spell-checking notes, 94
SQL (Structured Query Language)
database, 217, 369-370
stage
Opportunity List, filtering, 306
sales, finding, 79
Standard user security role, 234
start date and time, scheduling, 103
starts, activity, 116
Startup options, 36-37
static members, 319-321, 339
status, opportunity, 125, 306
sticky notes. See notes
Structured Query Language (SQL)
database, 217, 369-370
subreport, 137
summary field, adding to report, 143-144
SwiftPage Email, 377
sync set, 257-260, 267
synchronization
ACT! Premium for Web versus, 350
automatic, setting up, 263-264
benefits, 254
changes, 255
contact records, adding to sync set, 265
cycle, 254
described, 253-254
initiating, 263-265
last data, viewing, 266-267
main database, 257-261
preparation, 256
re-creating remote database, 268
remote database, 262-263

settings, viewing and printing, 267-268
stopping, 269
sync set lookup, 267
system field, Reporter Designer toolbox,
137
System tabs, 24, 60-61
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Tab key, 48
tables, building, 212
tabs
customizing, ease of, 61
filters, 61
layout, adding to, 21
printing, 134
sorting, 63-64
System, 60-61
User, 61
TAPI (Telephone Application Programming
Interface), 36
Task List
calendars, Outlook, 285
described, 60, 109-110
lookup, creating, 110
multiple activities, clearing, 113
printing, 110-111
report, 125
synchronization changes, 255
teams, record level access, 239-240
Telephone Application Programming
Interface (TAPI), 36
telephone numbers, automatic formatting,
51
template
activity series wizard, 115-117
custom fields, 139
document for mail merge, 152, 154-157
Excel with Quote/Invoice Maker, 380
mass e-mail, testing, 170
names, combining for mail merge, 152
synchronization changes, 255
testing remote access users, 364-365
text
boxes, modifying layouts, 211
Reporter Designer toolbox, 137
time field, 183
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time-saving tools, 380
title bar, 19-20
to-do item, 102, 116
toolbar

ACT! 2007, 23

adding items, 38-39

customizing icons, 40
top alignment, 208
total sales, finding, 79
triggers, 184-185
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undo command, 57
updating
ACT!, 27
database, 221-222
shared database, 37
upper case field, 182
URL address field, 182
USB storage device, 219
use banner, scheduling, 103
Use Drop-Down List field, 183
user name, 31, 47
users. See also access control
ACT! 2007, typical, 11
contacts fields, 49
lists, sort, 232-233
maximum number, 369-370
Recap Lists, accessing others’, 108-109
renaming information, importance of, 25
tabs, 61, 299

oo

Virtual Directory, 365
VPN (Virtual Private Network), 372

o[/ o

warnings, record deletion, 57
web. See ACT! Premium for Web
Web Site Administration tool, 361-363
Web site, viewing contact’s, 286
weekly activities, scheduling, 105
Weekly calendar, 106, 107
width, column, 63
wild cards, 77
Windows Explorer (Microsoft), dragging
and dropping files from, 70
Windows (Microsoft), 353-354
WinZip, 220
Word (Microsoft)
ACT! menu, 291-292
choosing during ACT! installation, 30
disabling as e-mail editor, 279
e-mail, sending document by, 292-293
fax, sending document as, 293
opportunity quotes, 302
showing ACT! mail merge fields, 293
word processor, choosing, 30, 152-153
Work Week calendar, 106
workgroups. See ACT! 2007 Premium for
Workgroups
workstations, padding, 246

° y °
yearly activities, scheduling, 105
Yes/No field, 183

o/ o

zip code, sorting contacts by, 63





